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The major sections of NetSuite Basics are as follows:

■
■
■
■
■

Artificial Intelligence (AI) in NetSuite

Getting Help

Navigating NetSuite

Logging in to NetSuite

Setting Personal Preferences
Using SuiteAnalytics Workbook

Working with Records, Transactions, and Lists

Working with Your Calendar and Activities

Working with Email

■
■

File Cabinet Overview

Exporting Reports, Searches, and Lists
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Artificial Intelligence (AI) in NetSuite

You may have questions about how the NetSuite application uses artificial intelligence (AI) and machine
learning (ML). AI is computer software that simulates how humans think and reason. ML lets computer
systems learn and improve from experience, without explicit programming.

NetSuite continues to add and enhance features that employ artificial intelligence and machine learning.
The most recent AI and ML features include:

■ Text Enhance uses generative AI to help you create and refine content, like descriptions of items
for sale and job descriptions. Text Enhance is enabled by default. No additional permissions are
required for any user with access to a page where Text Enhance is available. However, users with the
Administrator role in NetSuite can disable Text Enhance for the entire account.
Text Enhance is currently available in accounts located in the United States, Canada, and the United
Kingdom to assist with English language content only.
Text Enhance is now available for users whose language preference is set to English (U.S.), English
(CA), and English (UK), for accounts in supported locations.
See Using Text Enhance and Setting Text Enhance Preferences for more information.

Bill Capture uses AI and ML technology to scan invoices from your vendors to create NetSuite
bills. Bill Capture provides matches or suggestions for review, and over time, learns from correct
suggestions. See the help topic Email or Upload Vendor Bill Files Into NetSuite Using Bill Capture. See
also Enhancements to Bill Capture for information about the most recent changes.

■

Some NetSuite features you may be familiar with also use AI, including the following:

■ Intelligent Recommendations uses AI algorithms to calculate and display items that your customer
may be interested in buying.

□ Your customers (and your business) benefit from showing alternative items. See the help topic
Intelligent Item Recommendations for Websites.
Your sales reps have also found this feature useful. See the help topic Add Recommended Items to
Sales Orders, Estimates, and Opportunities.

□

■ AI in the Supply Chain Control Tower feature lets you simulate inventory supply and demand across
your supply chain. NetSuite uses these forecasting simulations, or snapshots, to analyze whether
inventory levels are in line with demand or planned levels. The power of AI helps you match customer
requests with supply availability.

NetSuite also uses AI behind the scenes, monitoring for anomalies to help keep your NetSuite account
secure.
Oracle NetSuite is continuously developing features and enhancements powered by AI. As we incorporate
more AI into NetSuite, you will be able to learn more about it in this article, in the NetSuite Help Center, in
SuiteAnswers, and in the Oracle Help Center.
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Note: For more information and resources, see the help topic Getting Help for Administrators.
This page is only visible for administrator roles.

Getting Help

The NetSuite Help Center is organized into sections corresponding to different NetSuite functions. Some
tasks in NetSuite are common to most users, regardless of the functional area in which they work.
These are covered in NetSuite Basics. For an outline, see NetSuite Basics Overview.
The following topics include descriptions of the activities that are included in specific NetSuite product
areas and links to the corresponding documentation:

■

■

■

■

ERP Documentation Summary

CRM and SFA Documentation Summary

Commerce Documentation Summary

SuiteCloud Platform Documentation Summary

NetSuite provides a variety of resources to give you help when you need it. From self-service tools like the
Help Center and SuiteAnswers to NetSuite customer support and training, you can always find answers to
your questions.

Watch the following video for a quick introduction to using the Help Center, Field-level help, SuiteAnswers,
and NetSuite Support.

Documentation Overview

The following resources are available:

Documentation Resources

For more information about contacting NetSuite Support Services, see Support Cases in SuiteAnswers
and NetSuite Support.
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NetSuite Documentation Overview

■

■

NetSuite Documentation Overview - a list of NetSuite Help Center resources.

- a library of Help Center videos that work alongside the Help Center content to make difficult tasks
easier.

User Guides - all of the Help Center content provided in PDF format.

Developer Documentation - a summary of the resources NetSuite provides for SuiteCloud and
Commerce developers.

SuiteAnswers Overview – a description of the resources offered in SuiteAnswers.

■

■

■

      Using the Help Center Window - tips and tricks to help you use the NetSuite Help Center effectively.

■

■

■

Searching for Help - a description of the search tools you can use to find the help you need.

Getting Field-Level Help - an explanation of help provided for each field on NetSuite pages.

Training Resources - an extensive on-demand library in the SuiteAnswers Learning Center, training
and feature videos in the Help Center, and Oracle video hub.

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_162160010710.html
https://videohub.oracle.com/media/Documentation%20Overview/1_or3y04fw
https://system.netsuite.com/app/help/helpcenter.nl?fid=preface_3710621755.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=preface_1531238762.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=preface_3710623483.html
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Enterprise Resource Planning (ERP) in NetSuite encompasses several areas of your business, including
accounting, inventory, order management, project management, and employee management. The
following help is available for ERP in NetSuite:

The following topics outline the documentation for activities that are not specific to a product area:

Many help topics also are available as User Guides in PDF format that you can view and print. These are
available in the User Guides section of the Help Center. For more details about using the NetSuite Help
Center, see Using the Help Center Window.

In addition to the Help Center, SuiteAnswers provides support knowledge base articles, training videos,
and best practices information. For more information, see SuiteAnswers Overview.
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Accounting

Purchasing and
Receiving

Items and Inventory

Project Management

The accounting area includes the following chapters:

For information about purchase order management, including vendor records, bills and
payments, requisitions, approval routing, and expenses, see the help topic Vendors,
Purchasing, and Receiving.

To learn about using NetSuite to manage your project tasks and resources, see the help
files in the Projects section.

■
■
■

SuiteAnalytics Documentation Summary

SuiteApps Documentation Summary

Account Administration Documentation Summary

      OneWorld Documentation Summary

■ Country-Specific Documentation Summary

■

■ accounting periods

bookkeeping

banking
currencies

■
■

■
■

journal entries
managing the chart of accounts in NetSuite

financial statements and accounting reports
revenue recognition

taxes
■

■
■

fixed assets management

statistical accounting
multi-book accounting

■

■
■

■

For information about accounting topics, see the help topic NetSuite · Accounting. Several
accounting-related user guides are also available for download from the User Guides
help topic.

For information about setting up inventory management, item records, shipping
methods, bar coding, manufacturing, and more, see the Inventory Management Guide,
available from the User Guides help topic, and the help files located in the Item Record
Management and Inventory Management sections.

For more about customer order handling, including placing orders, fulfilling orders, and
billing, see the help topic NetSuite · Order Management.

Customer Order
Management

https://system.netsuite.com/app/help/helpcenter.nl?fid=set_N2360130.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=set_N2360130.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=set_N2360130.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=preface_3714107248.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3944673.html#bridgehead_159963695851
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3944673.html#bridgehead_159963695851
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_N3928624.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_N3928624.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_N2164398.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_N2164398.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_N2249433.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3944673.html#bridgehead_159963742511
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3944673.html#bridgehead_159963742511
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see the help topic Setting Up Case Management.

For information about working with cases including creating, escalating, tracking time, and
more, see the help topic Working With Cases.
For information about issue management including statuses, severities, reproducibility, and
more, see the help topic Issue Management.
For information about the knowledge base including creating topics, solutions, and more, see
the help topic Knowledge Base.
For information about monitoring support performance including case alerts on support
cases, performance metrics, and more, see the help topic Monitoring Support Performance.
For access to all of the NetSuite user guides, see the help topic User Guides. For information 

about marketing automation including capturing leads, marketing campaigns,
and more, see the help topic Marketing Automation Overview.
For information about sales force automation including set up, sales forecasting, commission,
and more, see the help topic Sales Force Automation Overview.
For information about managing partners including creating partner records and more, see
the help topic Managing Partners. For information about partner commissions and royalties
including schedules, plans, and more, see the help topic Partner Commissions & Royalties. For
access to a variety of partner reports, see the help topic Partner Reports.
For access to all of the NetSuite user guides, see the help topic User Guides.

NetSuite commerce enables you to create and manage web stores, and point of sale applications. The
following help is available in the Commerce section:

Customer Relationship Management (CRM) and Sales Force Automation (SFA) with NetSuite includes
sales, marketing, partners, and support management. The following help is available for CRM and SFA in
NetSuite:

Store Front

Employee and Payroll
Management

Site Management Tools

For information about managing employees and using NetSuite for payroll, see the help files
in the Employee Management section. You can learn about SuitePeople Overview, NetSuite’s
integrated Human Capital Management (HCM) solution. These topics also include information
about time tracking, expense reporting, and purchase requests.

Learn how to implement a web store that includes the full shopping, checkout, and my
account experiences. SuiteCommerce lets you create, customize, and configure dynamic
and engaging web stores without requiring in-depth development. SuiteCommerce
Advanced provides full permissions to the front-end code, allowing you to fully customize
your web store.

See the help topic Store Front. SuiteCommerce Site Management Tools let you manage

 content, add landing pages,
and enhance existing pages on your SuiteCommerce web store. See the help topic Site
Management Tools Overview.

For information about setting up case management including case types, origins, and more,

Customer Service &
Support

Sales and
Marketing

Commerce Documentation Summary

CRM and SFA Documentation Summary

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2421072.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2421072.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2421072.html
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product line. See NetSuite Point of Sale User Guide.

register component of the SuiteCommerce

NetSuite Documentation Overview

The SuiteCloud platform provides a comprehensive set of tools that you can use to customize and extend
NetSuite to fit your business needs. Customizations developed on the platform automatically migrate with
every NetSuite upgrade. The following documentation is available for the SuiteCloud platform:
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SuiteCommerce InStore

Built on industry-standard JavaScript, SuiteScript and SuiteScript 2.x enables full-featured
application-level scripting capabilities throughout NetSuite, supporting sophisticated
procedural logic and featuring robust debugging capabilities. Many NetSuite records
support SuiteScript. See the help topic SuiteScript.

SuiteCloud Development Framework (SDF) is a development framework and deployment
mechanism. It provides developers and partners with IDE tools that customize NetSuite
accounts and deploy solutions. See the help topic SuiteCloud Development Framework.

SuiteCloud Software Development Kit represents tools allowing customization of
accounts through SuiteCloud Development Framework. Available tools are SuiteCloud
IDE plug-in, SuiteCloud CLI, and other extentions. See the help topic SuiteCloud SDK.

SuiteCommerce InStore (SCIS) is a web-based point-of-sale application available for the
U.S. market. It provides a touch-based user interface specifically designed for tablets.
See the help topic SuiteCommerce InStore (SCIS).

Using the developer documentation you can learn how to set up and use all the tools
you need to customize and manage your web store. You can learn how to access
NetSuite APIs and create extensions to enhance your web store experience. See the
help topic Commerce Developer Documentation

Site Builder is the legacy commerce solution. You can build Standard NetSuite Web
Sites, Sites Hosted in NetSuite, External Catalog Sites, or Site Builder Combination Sites.
See the help topic Site Builder Overview. NetSuite Point of Sale (POS) is the in-store

SuiteCloud Platform Documentation Summary

Learn how SuiteCloud Platform allows you to customize NetSuite to your own needs.
Learn about the records reference tools available and review the SuiteCloud platform
glossary for new terminology. See the help topic SuiteCloud Platform Introduction.

Customizing NetSuite fields, forms, record types, transaction types, segments, and
centers is a point-and-click experience. You can define how information is accessed and
entered by each user of your NetSuite account. For more information, see the help topic
Customization.
Copy a custom object to another account with Copy to Account. Select a target account,
choose dependencies, specify whether to include instances, if applicable, and then
preview and deploy the custom object. See the help topic Copy to Account.

SuiteFlow provides developers and customers with point-and-click tools to customize
and automate business processes, such as lead nurturing, transaction approval, record
management, and more. See the help topic SuiteFlow (Workflow).

Define and manage your SuiteApp distribution process in a single location. Upload
SuiteApp projects to SuiteApp control center and distribute them in the SuiteApp
Marketplace, from which users can install and upgrade SuiteApps. See the help topics
SuiteApp Control Center and SuiteApp Marketplace.

Use the SuiteApp Marketplace to find and install SuiteApps. SuiteApps can include
customizations and configuration settings useful to your organization. To learn about the
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SuiteAnalytics tools include built-in ad hoc reporting, real-time dashboards, and ODBC access across
NetSuite and all customizations. These business intelligence tools help you to identify issues, trends,
and opportunities, and support instant drill-down to underlying records, for quick action. The following
SuiteAnalytics documentation is available:

Plug-ins

Dashboards

Integrations

Supported Records
and Samples

NetSuite dashboards provide a visual workspace that gives you instant access to the
personalized data needed to make decisions and edit records. Dashboard content is displayed
in dynamic data display windows called portlets. Some portlets provide direct access to raw
data, and others display data that has been synthesized into critical business metrics, such

SuiteTalk SOAP web services enable customers and partners to integrate NetSuite with
existing on-premise investments and third party cloud applications. Integrations can use
Java, .NET, or any other programming language that supports SOAP-based web services.
See the help topic SuiteTalk SOAP Web Services Platform Guide.
SuiteTalk SOAP web services records guide contains a description of each record, which
generally includes information about supported operations, field definitions, usage
notes, and code samples. The guide includes links to the SOAP Schema Browser. See the
help topic SuiteTalk SOAP Web Services Records Guide.
SuiteTalk REST web services provide a REST-based interface for interacting with NetSuite.
See the help topic SuiteTalk REST Web Services API Guide
SuiteTalk REST web services records guide contains a list of records accessible through
REST web services. See the help topic SuiteTalk REST Web Services Records Guide.
The Import Assistant supports bulk transfers of data from other applications into
NetSuite using CSV files. This wizard enables visual mapping of CSV file columns to
NetSuite fields. See the help topic CSV Imports.

SuiteAnalytics Documentation Summary

nformation that is available for each SuiteApp, see the help topic Viewing SuiteApps in
the SuiteApp Marketplace. For those who create SuiteApps, use the SuiteApp Control
Center to define and manage your SuiteApp distribution process. You can upload
SuiteApp projects to SuiteApp Control Center and distribute them as SuiteApp versions
to the SuiteApp Marketplace. For more information about getting started with SuiteApp
Control Center, see the help topic Accessing SuiteApp Control Center.

See a comparison of record types supported for SuiteScript, Web Services
integration,SuiteAnalytics Connect, and CSV import. See the help topic SuiteCloud
Supported Records. 
For information about the record types, fields, and relationships available for a specific
NetSuite channel, see the Records Catalog. The Records Catalog includes the custom
records, forms, and fields in the current user’s account and only includes data based on
the features currently enabled in the account. See the help topic Records Catalog.
NetSuite offers a collection of sample customizatio projects created with SuiteCloud
platform tools. Explore these samples to determine which SuiteCloud tools suits you
best to customize NetSuite for your organization. Also, a variety of tutorials are included
here that walk you through how to create sample customization projects using
SuiteCloud concepts. See the help topic SuiteCloud Customization Tutorials.

NetSuite develops core plug-ins and releases them to partners or customers. You can
create a new core plug-in implementation and test it using the SuiteScript Debugger. See
available core plug-ins in Core Plug-ins. NetSuite also allows you to develop, implement
and manage your own custom plug-ins.
See the help topic Custom Plug-ins.

https://system.netsuite.com/app/help/helpcenter.nl?fid=book_156388532579.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_156388532579.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_156388697975.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_156388697975.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_1559132836.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_1559132836.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_157830111504.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_157830111504.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_4470700566.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_4470700566.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1539797977.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1539797977.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1539797977.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1526317441.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1526317441.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=preface_3710625923.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=preface_3710625923.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_159368199162.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_159368199162.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=article_159163143019.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_4616046155.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_4616046155.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_4060648050.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_4060648050.html


NetSuite Documentation Overview

SuiteApps are applications that extend NetSuite functionality beyond what is available natively in the
product. SuiteApps are developed on the SuiteCloud platform, packaged using SuiteBundler, and
delivered as a bundle or a collection of bundles. See the following for more information about SuiteApps:
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NetSuite SuiteApps

Installing SuiteApps

Some SuiteApps are built, distributed, and supported by NetSuite. These are usually features
that can benefit from more frequent release cycles. For a list of currently supported NetSuite
SuiteApps, see the help topic NetSuite SuiteApps.

For information about SuiteApps developed and supported by third parties, see
SuiteApp.com. On SuiteApp.com, you can search partner SuiteApps by industry, business
need, or keyword. In addition, you can read customer reviews, try out solutions, and find out
where to buy these SuiteApps.

If you are the administrator of a NetSuite account or you have the SuiteApp Marketplace
permission, you can install any public bundle, as well as any bundle that has been shared
with your account. See the help topic SuiteApp Installation and Update.

The SuiteBundler feature supports the creation and distribution of SuiteApps. The Bundle
Builder is an assistant that steps you through the process of packaging customizations into
bundles. See the help topic SuiteBundler.

as key performance indicators (KPIs), performance scorecards, trend graphs, and report
snapshots. Other portlets enable the display of data from website RSS feeds. See the help topic
Dashboards.

Create and fully customize datasets and workbooks that leverage the analytics data source.
In the dataset, define your workbook source data by selecting record types, fields, and criteria
for further analysis in a workbook. In the workbook, visualize and analyze your data using
tables, pivot tables, and charts. Visualizations in a workbook can all be based on different
datasets. You can author your datasets and workbooks using field data from multiple record
types, including custom record types. You can also create and add fields with dynamically
calculated values, and easily view data for fields with parent-child relationships. See the help
topic Workbook.

NetSuite provides a variety of search tools that you can use to retrieve real-time data from your
account. You can search for a single record by keywords, return a set of records that match
filters you define, customize the display of search results, export results to other applications,
email results to other users, and save search definitions for reuse. See the help topic Search.

NetSuite supports reporting capabilities that you can use to retrieve, present, and analyze real-
time business results. You can run prebuilt reports as is, or modify them by setting per-user
preferences, selecting per-report viewing options, or defining custom reports in the Report
Builder or Financial Report Builder. See the help topic Reports.

The SuiteAnalytics Connect Service enables your business to archive, analyze, and report on its
data using a third-party tool or custom-built application. NetSuite supports the use of ODBC,
JDBC, and ADO.NET drivers to connect with NetSuite from any device running on a Windows,
Linux, or OS X operating system. You can use Microsoft® Excel, BIRST, Adaptive, or any other
compatible application to work with the Connect Service. You can also access the Connect
Service using the NetSuite2.com data source only. See .

The NetSuite Analytics Warehouse enables you to broaden the analyses of your NetSuite data.
After you transfer your data to the Analytics Warehouse, you can combine your NetSuite data,
historical data, and data from other sources, to analyze all of your data with a wider assortment
of visualizations. See the help topic NetSuite Analytics Warehouse Overview.

SuiteApps Documentation Summary
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NetSuite account administrators need to perform many tasks to set up and maintain the NetSuite
application and related customizations. The following documentation is available for these tasks:

Note:
features.

To take advantage of new features for packaging and distributing customizations,
you can use SuiteCloud Development (SDF) features instead of SuiteBundler.
SuiteCloud Development Framework is a development framework that you can use
to create SuiteApps from an integrated development environment (IDE) on your
local computer. For more information, see the help topic SuiteCloud Development
Framework.

SuiteCloud
Developer Network

If you are interested in creating SuiteApps for distribution and sale, you should join the
SuiteCloud Developer Network (SDN), the NetSuite third-party developer program. For
information about this program, see Developers Overview.

SuiteBundler is still supported, but it will not be updated with any new

Account Administration     
Overview

Setup of DomainKeys identified mail, information about blocklists and spamlists, setup
of scriptable templates, size limits of emails and attachments, and DMARC-compliant
messaging in NetSuite. See the help topic Email for Administrators.

NetSuite supports a variety of authentication methods, including two-factor
authentication, token-based authentication, OAuth 2.0, Device ID authentication, Single
Sign-on (outbound, SAML, and OpenID Connect), Digital Signing, SSH Keys, secrets
management, and RESTlet authentication. For more information about password
requirements and policies in NetSuite, see the help topic Authentication.

The Import Assistant supports bulk transfers of data from other applications into NetSuite
using CSV files. The wizard enables visual mapping of CSV file columns to NetSuite fields.
Learn about the guidelines for the CSV import and explore additional import and export
options. See the help topic CSV Imports.

Account Setup

Email for
Administrators

Authentication

CSV Imports

Auditing and Data
Management

System Notes

Account Administration Documentation Summary

Setup of a NetSuite account requires enabling features, setting company preferences,
defining classifications for NetSuite records, managing NetSuite roles and permissions,
and incorporating approval routing. See the help topic Account Setup. For information
about NetSuite OneWorld, see OneWorld Documentation Summary.

NetSuite uses System Notes to track any changes made to a record. A system note for a
change on a record captures the date when the change was made, who made the change,
the role of the user who made the change, the type of change, and the old and new value
in the record. System Notes v2 captures detailed changes such as sublist information
and groups the changes under high-level actions. Learn about the differences between
System Notes and System Notes v2. See the help topic System Notes Overview.

NetSuite supports tracking changes, internal controls, managing transactions, removing
personal information, auditing data changes, and avoiding duplicates. See the help topic
Auditing and Data Management.

Guidelines for setting up NetSuite and maintaining and upgrading your NetSuite account.
 You can also see the Account Administration guides summaries. See the help topic 
 Account Administration Overview.
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NetSuite OneWorld enables you to manage multiple areas of your multinational, multicompany business
including financial statements, customers, e-commerce, services resource planning (SRP), business
intelligence, and tax and compliance management. The solution crosses product areas, and the
documentation for OneWorld is integrated with the various functional areas.

NetSuite has localized features for business needs that are specific to some countries. These country-
specific features help your company adapt to business practices and comply with business regulations or
requirements in the countries that you are operating in.
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Country-Specific Tax
Topics

Getting Started with
OneWorld

Country-Specific Topics

This section of the help introduces OneWorld and its features across all NetSuite product
areas. Begin here and follow the links to learn how OneWorld affects accounting and ERP,
CRM, SRP, and analytics. See the help topic Introduction to NetSuite OneWorld.

As part of its global offerings, NetSuite provides solutions for a growing number of
countries. For many of them, help can be found under the Overview of Country-Specific
Features. This section includes an overview of features and SuiteApps for individual
countries, best practices for account setups, and country-specific information related
to taxes and payment formats.

For countries that currently have no separate country-specific help topic (yet they do
have their own specific features supported by NetSuite), see the help topic General
International Tax Topics or Setting Up Payment File Formats.

In a global business, taxation is an area with both general international topics and
country-specific requirements. For some countries, country-specific tax help topics
have already been moved to Overview of Country-Specific Features. For countries that
do not have their separate country-specific help topic yet, see the help topic General
International Tax Topics. This section contains an introduction to general tax topics and
links to those that are country-specific.

Cloud Infrastructure

Customize the NetSuite UI and business logic through scripting or through point-and-click
options in the UI, create custom roles and customize access, share your customization
with other accounts, and integrate information from other systems. See the help topic
SuiteCloud Platform Customization.

Account Customization

NetSuite provides customers with various test accounts for developing and testing new
applications and customizations. You can use release preview, sandbox, and development
accounts without impacting the production account. See the help topic Understanding
NetSuite Account Types.

Best practices and troubleshooting tips enable you to optimize NetSuite performance. To
help troubleshoot performance issues, use the Application Performance Management
(APM) SuiteApp to monitor and manage NetSuite performance for business-critical
operations. See the help topic Performance.

NetSuite supports multi-language features, managing translation collections, and
localization context filtering for user event and client scripts. See the help topic
Globalization.

Performance

Globalization

OneWorld Documentation Summary

Country-Specific Documentation Summary

Best practices for accessing NetSuite through the UI, SuiteTalk web services, SuiteScript,
RESTlets, Single Sign-on, SuiteAnalytics Connect
or other NetSuite services. Learn about NetSuite accounts in a cloud environment, traffic
health, NetSuite URLs, DataCenterUrls REST service, the REST role service, and more. See
the help topic Best Practices for Cloud Accounts.

NetSuite Account 

Types 
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https://system.netsuite.com/app/help/helpcenter.nl?fid=book_4607560702.html


NetSuite Documentation Overview

Many pages in NetSuite have context-sensitive help topics. So, if you click the help link while viewing a
page in NetSuite, the help topic for that page is displayed automatically when the Help Center opens.

Note:Some pages, such as those provided by a SuiteApp, do not have context-sensitive help
topics. So, if you click the help link on a page with no context-sensitive help, the help center
displays the home page.

You can also open the help center and perform a search against it all in one step by using the Global
Search field in NetSuite.
In the Global Search field, type Help: followed by the text you want to search for. For example, Help:
Using the Help Center. The help center opens in a new window and shows you a list of topics matching
your search criteria.

Watch the following video to know how to access the help center.

Accessing the Help Center

The NetSuite help center contains the technical documentation that details how NetSuite features work.
You can access the help center in a couple of different ways.
You can click the Help link in NetSuite on the header. The help center opens in a new tab. You must be
logged in to NetSuite to open the help center.

Watch the following video about how to use the help center.

Using the Help Center

The help center includes many features to help you find the information you need to work with NetSuite.
For information about how to access the help center, see Accessing the Help Center.
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Country-Specific Payment
File Formats

The Electronic Bank Payments SuiteApp provides payment file formats for payments,
receivables, and Positive Pay transactions. For some countries, country-specific
payment formats help topics have already been moved to Overview of Country-Specific
Features. For countries that do not have their separate country-specific help topic yet,
see the help topic Setting Up Payment File Formats.

Accessing the Help Center

Using the Help Center Window

https://videohub.oracle.com/media/Accessing+the+Help+Center/1_bm5591eh
https://videohub.oracle.com/media/Using+the+Help+Center/1_22owhxtu
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_4169633414.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_4169633414.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_4169633414.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1675118.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1675118.html


appears at the top of each help topic.

 Videos to view a list of help videos that demonstrate how to perform specific tasks in NetSuite.
 When you click a link, you are redirected to the Oracle Learning Library to view the video.

Training – Click Training to go to the SuiteTraining site. This page opens in a new tab. It includes complete
information about the courses and certification programs that are offered.

SuiteApps – Click SuiteApps to open a list of current SuiteApps. This page includes a link to SuiteApp.com where
you can get information about SuiteApps developed by SDN Partners and other third parties.

User Guides – Click User Guides to open a list of available PDF files. These User Guides provide conceptual
details and setup information for specific areas of NetSuite. Click the PDF icon beside the desired User Guide to
launch the PDF in a new window.

New Release – Click New Release to open a page with links to Sneak Peeks, Release Notes, and other important
information for the newest release of NetSuite.

Using the Help Center Window

When you view or search for help topics, you can submit feedback about the helpfulness of the topic
content or search results.

■ At the bottom of search results, select Yes or No to answer whether the search results helped answer
your question. Then click Submit Feedback.
At the bottom of help topics, rank the helpfulness of the topic from Five Stars for the most helpful to
One Star for not helpful. Type suggestions and comments in the text box. Then click Submit Feedback.

■
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You can also set the language of the Help Center using the Set Preferences link. See Setting
Personal Preferences, specifically, the entry for Language of the Help Center in the User Profile section.

Search – To search for help topics for the pages and features of NetSuite, type a keyword or phrase in the
Search field of the Help window, and press Enter. For more information, see Searching for Help.

Language Preference – If your account has the multi-language feature enabled, you can set your preference
for the language displayed in the NetSuite Help Center using the dropdown list at the top right corner of the
page. This language preference is independent of the language preference you specify for the NetSuite user
interface. You can switch back and forth between languages in the Help Center, if desired. The next time you
open the Help Center, it opens in the language of the preference last set.
The following languages are available: 
(Japanese), Español (Spanish).

(Chinese Simplified), Deutsch (German), English, 

Home – Click the home icon on the toolbar to return to the Help Center home page. A home icon also

Table of Contents – Click the arrows 

Click the Show in Table of Contents icon 

at the top of the divider to hide or show the Table of Contents.

in the page header to find the current topic in the Table of Contents.

Print Icon – Click Print icon 
the browser’s Print function.

in the page header to print the current help topic. Or, you can right-click and use

Note:

Submit Feedback for Help and Search

SuiteAnswers – Click SuiteAnswers to go to the SuiteAnswers site. This page opens in a new tab. SuiteAnswers
is a searchable repository of support solutions, best practices, training videos, and help topics.

Developers – Click Developers to view a list of resources for SuiteCloud and Commerce developers. Videos – Click

6

Seeing a topic within the organization of the Table of Contents can help you find related topics or begin to
understand where you are in a process or a feature.
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If you want access to a page in NetSuite you do not currently have permission to view, speak to your
account administrator about assigning you a new role, customizing your existing role, or enabling
features in your company's NetSuite account.

Help topics often provide navigation steps to help you locate pages in your NetSuite account. In most
cases this navigation provides the tab, heading, and link that are specific to the role you are logged in
with.

Consequently, you may see different navigation for the same help topic if you use more than one role.

For example, Krista Barton is a sales rep who is assigned the standard Sales Rep role. When Krista
reads a help topic about creating a customer record, she is directed to Customers > Relationships >
Customers. If Krista was logged in with the Marketing Assistant role, the help topic would direct her to
Leads > Relationships > Customers.

Sometimes, help topics may refer to pages in NetSuite that you do not have access to or to features that
have not been enabled in your account. In these cases, the navigation steps are shown as if you were
logged in as an account administrator.

For example, Krista is logged in with her Sales Rep role and wants to read about how marketing
campaigns work in NetSuite. When reading a help topic on the creation of marketing campaigns, the
navigation directs her to Lists > Marketing > Campaigns. This is the navigation she would see if she was
logged in as an account administrator.

When you have questions about NetSuite, you can search the NetSuite Help Center for help.

The header of the NetSuite Help Center Home page has a search area in the center. Your cursor starts in
the search area when you open the Help Center.

Help Topic Navigation

Searching for Help



Searching for Help

The NetSuite Guided Learning tool provides you with contextual step-by-step instructions to help you
complete tasks within NetSuite. The feature is available in all NetSuite accounts and includes more than
350 guides in 24 languages.

NetSuite Guided Learning consists of three general categories:

■

■

Overviews – Guides that help you work with the Home page and the NetSuite Center Tabs.

Useful Tools – Guides that help you get started with personalizing NetSuite, using global search,
creating shortcuts, and other useful tips and tricks.

Help & Support – Guides that introduce you to all help options available to you with NetSuite.■

Field-Level Help

For specific information about a field on a NetSuite page, click the label next to the field. A popup window
opens and displays text that describes how to use that field.

Type a search term and press the Enter key to get a list of topics that most closely match your search.

If you do not find the topics you expect, or if your search returns too many results, try one of the
following:

■

■

If you know the exact phrase, type it inside quotation marks.

Unless you know the exact words or phrases in a help topic, use general keywords or phrases to find a
greater number of help topics.

Avoid phrasing your search as a question.

Look for links to related topics. Most topics include links to other help articles. Often these related
topics are found at the bottom of the article.

Look through the table of contents to find the topic you want.

■

■

■

The search process for the NetSuite Help Center follows these general rules:

■

■

All words you type in the search area must match 66%.

An exact match within quotation marks appears first in the list of results, but other close matches are
also listed.

The search looks for the stem of the words you type rather than their inflected forms. You do not have
to try both the singular and plural of nouns, for example, or different verb forms.

■

Additionally, the search for the NetSuite Help Center supports search by synonyms and typo correction.
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Getting Field-Level Help

NetSuite Guided Learning

https://videohub.oracle.com/media/Field+Level+Help/1_7wh3fxui


To open the Help Panel, which appears on the right side of the screen, click the i button.

To close the Help Panel, click the close button at the top of the Help Panel.

A list of all available NetSuite Guided Learning guides is accessible through the Help Panel.

You can set a preferred language for NetSuite Guided Learning by clicking the Languages
the bottom of the left side of the Help Panel.

 button at

Important:If you disable NetSuite Guided Learning globally, users with other NetSuite
roles will not be able to enable NetSuite Guided Learning in their accounts. If you enable
NetSuite Guided Learning globally, users with other NetSuite roles will be able to enable or
disable NetSuite Guided Learning in their accounts individually.

As an administrator, you can also see the Set NetSuite Guided Learning Application ID and Set
NetSuite Guided Learning Environment fields on the General Preferences page. These fields are
internal. They are used to determine the instance of the NetSuite Guided Learning tool. Ensure that you
keep the assigned values of these fields. If you change them, NetSuite Guided Learning may stop working
correctly.

To start using NetSuite Guided Learning, open the Help Panel, and then click any guide title in the list. The
guide then walks you through the selected task using pop-up windows and pointers to help you enter all
required fields, click buttons, and complete the task.

To look for a specific guide, enter a keyword into the search bar at the top of the Help Panel and press
Enter.
To learn more about using NetSuite Guided Learning, complete the Tell Me About Guided Learning
guide. The guide is available under the Navigation and Welcome in the Help Panel.

Note:To disable NetSuite Guided Learning, go to Home > Set Preferences and clear the
Enable Oracle Guided Learning box. To enable NetSuite Guided Learning, ensure the
Enable Oracle Guided Learning box is checked.

As an administrator, you can enable/disable NetSuite Guided Learning globally for all other NetSuite roles
in your company account. To do this, go to Setup > Company > General Preferences, and check or clear
the Enable NetSuite Guided Learning box, and click Save.

NetSuite Guided Learning 16

Language Preference

Using NetSuite Guided Learning

Accessing NetSuite Guided Learning
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The following languages are available:

■
■

■
■

■
■

■
■

■
■

■
■

■
■

■
■

■

CHS (Chinese Simplified)

CHT (Chinese Traditional)

CZE (Czech)

DAN (Danish)

DUT (Dutch)

ENG (English)

FIN (Finnish)

FRE (French)

GER (German)

IND (Indonesian)

ITA (Italian)

JPN (Japanese)

KOR (Korean)

NOR (Norwegian)

POR (Portuguese)

RUS (Russian)

SPA (Spanish)

      SWE (Swedish)
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THA (Thai)

TUR (Turkish)

VIE (Vietnamese)

Yes, the guide gets interrupted. You need to use the Help Panel to run the guide anew.

In the following table, you can see a list of available shortcuts that you can use with NetSuite Guided
Learning.

To get assistance, you can submit a support request in several ways. In the NetSuite Guided Learning
tool, open the NetSuite Features + Get Help Now guide for a direct link.

You can also get assistance from the Help Panel.

Note that the Help Panel is not displayed on all pages of NetSuite. However, if you have the feature
enabled, it should always be visible on your home page. If you can't see it there, go to Home > Set
Preferences and ensure that the Enable Oracle Guided Learning box is checked. If the feature is
enabled but the Help Panel remains unavailable, contact your account administrator or, if you have the
permission, submit a Support case.

■

■

■

Keyboard Shortcuts

Submitting a support request

From the Help Panel, click the Submit a Support Request.

In the pop up window, click Go to form....

Fill in all required fields. You can also submit a screenshot by clicking the Choose File button.

Click Submit.

1.

2.

3.

4.

To submit a support request:

Ctrl + Alt + L

Esc

Keyboard Shortcut

Alt + Ctrl + H

Description

Open and close the Help Panel. The Help Panel opens with focus on the Search bar. You
can then use the Tab key to move within the panel.
Open or close language selection menu while the Help Panel is open.

Press the Esc key to close the Help Panel and return the focus to NetSuite.

Troubleshooting
NetSuite Guided Learning is enabled in my account, yet I can't see the
Help Panel. What does this mean and what should I do?

I launched one of the guides but did not follow it and clicked elsewhere
in the user interface. Does this interrupt the guide?



NetSuite Guided Learning

You can find out what's new in NetSuite in several ways. To see what's new, click on New Release on the
NetSuite Help Center toolbar or on the What's New topic in the table of contents.

Sneak Peaks

Sneak Peeks are provided prior to a new version when there are significant new features. They give you a
preview of what to expect of the new features and enhancements. To use Sneak Peeks, see the help topic
NetSuite Sneak Peeks.

Release Notes

Release Notes document all changes made in the latest version of NetSuite. This includes new features,
preferences, enhancements, and issues that have been resolved.
Release notes help you quickly learn about new features and enhancements. For current Release Notes,
see the help topic Release Notes.
Help Center Weekly Updates

Use the Help Center Weekly Updates topic to find out which help topics and PDF files have been added or
updated in each build of the NetSuite Help Center.
To open Help Center Weekly Updates, see the help topic Help Center Weekly Updates. The main Help
Center Weekly Updates page is broken into sections. Select a build date to see the changes made that
week.

Release Preview

Release Preview is a temporary and isolated test account that is running the new version of NetSuite
software. The Release Preview account enables you to become familiar with the new features in an
upcoming release.

The Release Preview Guide provides instructions for using Release Preview and examples of features you
might want to test.

Not right now. The NetSuite Guided Learning tool is currently undergoing a phased release to all NetSuite
customers. When Guided Learning gets optimized for use in NetSuite, information regarding your
eligibility for the free offering of NetSuite Guided Learning and additional paid customization options will
be communicated. At that time, your account representative and other members of the NetSuite team will
be able to provide details on how to access Guided Learning.
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Can I create my own guides or customize the existing ones?

Finding Out What's New in NetSuite

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3859207.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_N3865324.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=book_N3865324.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_3798389663.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_3798389663.html


The following table lists the differences between SuiteAnswers and the NetSuite Help Center:

Note:If you do not see the SuiteAnswers portlet on your Support tab, click Personalize
Dashboard in the upper right. In the Add Content portlet, click SuiteAnswers to add the
SuiteAnswers portlet to your Support tab.

Finding Out What's New in NetSuite

For more information about Release Preview and to access the Release Preview Test Plan, see the help
topic Release Preview Guide.

Watch the following video to see the overview of SuiteAnswers features.

SuiteAnswers Overview

SuiteAnswers is the NetSuite self-service support site where you can view announcements, support
articles, videos, help topics, and best practice documents for NetSuite. From SuiteAnswers, you can also
submit a question or issue by email or contact NetSuite Customer Service by phone.

You can access SuiteAnswers in the following ways:

■
■

In the NetSuite Help Center, click SuiteAnswers on the toolbar.

In the NetSuite user interface, choose the Support > Go to SuiteAnswers menu option, or: on the
Support tab, click the Go to SuiteAnswers button in the SuiteAnswers portlet.

You must be logged in to NetSuite to access SuiteAnswers.

Note:You cannot access the SuiteAnswers portlet if you are logged in with an Employee Center,
Customer Center, Vendor Center, or Partner Center role. If you are using any of these roles, you
must switch to another role to be able to access SuiteAnswers.
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SuiteAnswers Overview

Accessing SuiteAnswers

SuiteAnswers vs. Help Center

https://system.netsuite.com/app/help/helpcenter.nl?fid=preface_4019941373.html
https://videohub.oracle.com/media/SuiteAnswers+Overview/1_0qwqfigh


SuiteAnswers Overview

Critical announcements dealing with performance issues or planned maintenances are displayed at the
top of the page in SuiteAnswers. Critical announcements are displayed on every page until user closes
them by clicking X on the top right of the announcement. The announcement reappears only after the
user logs out and logs back in to SuiteAnswers.

SuiteAnswers provides you with the following tools that you can use to search through the SuiteAnswers
knowledge base:

■ Search options – You can search by using natural language, keywords and article ID. You can use
quotes to include certain phrases or you can use them to search for specific errors you encounter.
Search bar features – The search bar features suggested Type-ahead and search history.

Search filters – You can filter by content type, product categories and target audience.
■
■

NetSuite Support Services has two support offerings for customers: Basic and Premium.

To view your account's support subscription level, go to the Support tab in your NetSuite account, select
Go to SuiteAnswers, and then click Contact Support at the top.
On the Contact Support page, you can find the NetSuite Support phone numbers, your account number,
and your Call support subscription level. In addition, you can also find information about our Phone Menu
and details about our issue resolution process.

See the tables below for the options available in the Basic and Premium Support offerings.
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Resource

Help Topics

Videos

NetSuite Knowledge Base

Help Table of Contents

User Guides

OpenAir Knowledge Base

Multi-language Content

Context Sensitive Help

NetSuite Virtual Support Assistant

Basic SuiteSupport Overview

Inquiry Type

Critical Problem

Support Channels

Phone Support

SuiteAnswers

yes yes yes no

yes yes no no

yes

Help Center

yes yes no

yes yes no

yes yes no

Availability

24x7

Critical Announcements

Using Search in SuiteAnswers

Support Cases in SuiteAnswers



To create a support case, see one of the following procedures based on your support offering:

■
■

To create a support case (Basic Support):

To create a support case (Premium Support):

SuiteAnswers Overview

Go to the Support tab in your NetSuite account, select Go to SuiteAnswers, and then click Contact
Support at the top.

Start with an AI-powered chatbot - NetSuite Virtual Support Assistant - for quick answers to your
basic NetSuite questions. A chatbot icon is visible on all SuiteAnswers pages. Click the icon to
bring up the NetSuite Virtual Support Assistant.

Chat with the Virtual Assistant for your query. If the Virtual Assistant cannot find a satisfactory
answer, you can connect to other support channels available to you by requesting Additional
Support options. This will bring up 2 options – Ask in the NetSuite Support Community and Report
a Problem.

Select Report a Problem. This will open the form to create an online support case.

Note:Basic support only entitles you to submit critical problems that prevent you from
doing business. For other problems or questions, you can ask for advice from NetSuite
professionals and a dedicated team of Support Gurus in the NetSuite Support Community.
Registration is required.

Enter a brief description of your problem, and answer the provided questions if possible.

Attach any relevant files. The maximum file size for one file is 10MB.

Optional: enter a contact number and select a time zone from the dropdown list.

Optional: check the Allow a NetSuite Representative to log into a replica of your account for
this case box. For more information, see NetSuite Support Login

Click Submit Case.
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Premium SuiteSupport Overview

Inquiry Type

Report a Problem

Support Channels

Phone Support

Online Case

Online Case

NetSuite Virtual Support Assistant

NetSuite Community

Ask a Question

Availability

24x7 24x7

24x7 24x7

24x7

Basic SuiteSupport Overview

Report a Problem

Ask a Question

Online Case (Through NetSuite Virtual Support Assistant)

NetSuite Virtual Support Assistant

NetSuite Community

24x7

24x7

24x7

1.

2.

3.

4.

5.

6.

7.

8.

9.

To create a support case (Basic Support):

https://suiteanswers.custhelp.com/app/contact
https://suiteanswers.custhelp.com/
https://suiteanswers.custhelp.com/
https://community.oracle.com/netsuite/english
https://suiteanswers.custhelp.com/
https://suiteanswers.custhelp.com/
https://suiteanswers.custhelp.com/
https://community.oracle.com/netsuite/english


SuiteAnswers Overview

If your role permits, you can check the status of your support cases in the NetSuite Account Center. For
more information, see NetSuite Support and Checking the Status of Support Cases.

To provide feedback, click the Feedback button on the main header. To provide feedback about specific
SuiteAnswers articles, use the Was this article helpful? buttons at the bottom of articles.

1.
2.
3.
4.
5.

Go to Contact Support > Create Support Case.

Enter a query and check if an existing help topic relates to your issue.

If no help topic matches your query, select a type of case from the dropdown list.

Select a case severity.

If creating a C1 case, check the 24 x 7 availability box, or complete the additional fields as
requested.
Enter a brief description of your problem, and answer the provided questions if possible.

Attach any relevant files. The maximum file size for one file is 10MB.

Optional: enter a contact number and select a time zone from the dropdown list.

Optional: check the “Allow a NetSuite Representative to log into a replica of your account for this
case” checkbox. For more information, see NetSuite Support Login

Click Submit Case.

6.
7.

8.
9.

10.

You will receive a response by email as soon as possible. Response times vary depending on the level
of support you have purchased and the support team's case load. To improve response times, please
complete as many of the case specific questions as possible. The case quality indicator provides a useful
visual guide about the optimum level of information to provide to Support.

Access to SuiteAnswers is only possible for users with values in the first name and last name fields on
their employee records. Users with blank first or last name fields on their employee records in any
NetSuite account receive an error message when they attempt to access SuiteAnswers.

Verify that the employee records of your users contain the correct values in the first name and last name
fields. For more information, see the help topic Employee Information Management.

Review the questions and answers below to learn more about SuiteAnswers. The questions and answers
are ordered by topic in the following way:
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SuiteAnswers FAQ

Access Requirements for SuiteAnswers

General Questions
Can I provide feedback about my experience using SuiteAnswers?

To create a support case (Premium Support):

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N894090.html


Click Clear History under the Search History list.

New feature previews are available from the Videos page.

Yes, you can use this method for both text and video-based articles.

Click Contact Support on the main header to find your account number.

Currently, there are around 50,000 help topics and support articles in SuiteAnswers.

We use an algorithm to calculate the approximate reading time which also considers images.

SuiteAnswers Overview

Be specific and use keywords. One-word queries return too many results, whilst long sentences return
limited results. You can also use advanced search features, such as quotes, to specify a phrase that
must be a part of the results. The new filtering options also help narrow down your results. Type-ahead
suggestions can also help you to get the results you are looking for.

Go to Contact Support > Create Support Case. In Step 2, select Request an Enhancement and complete
the necessary fields.

It provides a visual prompt to help you provide the optimal level of information for Support to resolve
your issue as quickly as possible. It’s not necessary to complete all of the case specific questions but doing
so will help us help you most effectively.

No, you can also click NetSuite Release Notes in the menu next to the SuiteAnswers logo in the header.
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Can I search by article ID?

Where can I find my account number?

Where can I find new feature previews?

Do I have to search to find Release Notes?

How is the reading time in articles calculated?

How can I clear the history of my search queries?

How can I suggest improvements or request a feature?

What does the case quality indicator on the case form do?

How many help topics and support articles does SuiteAnswers have?

What is the best way to phrase my question to get the most accurate search results?

Support

Searching



If you know the name of the feature, you can type it into the Search feature field.

It works best with short questions, for example, How can I create a Purchase Order?

It provides fast, direct answers and minimizes the need to filter through search results.

The Virtual Support Assistant is most knowledgeable in the ERP and SuiteCloud product areas.

The NetSuite Virtual Support Assistant is able to provide answers from SuiteAnswers based on your
queries, and high-level answers related to the specific NetSuite product area.

SuiteAnswers Overview

The Virtual Support Assistant is focused on answering the most frequently asked support questions. It
currently covers more than 5000 questions.

No, this is an early release. The final version will have improved performance and answers, as well as UI
changes.

You can access the feedback form through the menu button. For more information, see NetSuite Virtual
Support Assistant.

The NetSuite Virtual Support Assistant can be accessed by either clicking the chat button , or from the
Contact Support page, by clicking Chat with our NetSuite Virtual Support Assistant under Online
Support.

You can find information about requesting a Release Preview account and the login page at the bottom of
the Contact Support page.
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Is this a final production version?

What are the benefits of the Virtual Support Assistant?

Can the Virtual Support Assistant answer any support question?

How can I provide feedback about the Virtual Support Assistant?

What is the best way of asking the Support Assistant a question?

How can I request a Release Preview account and how do I log in to it?

What areas of the product can Virtual Support Assistant help me with most?

Do I need to select a feature from the feature list when creating a support case?

NetSuite Virtual Support Assistant

Using the NetSuite Virtual Support Assistant

Accessing the NetSuite Virtual Support Assistant

NetSuite Virtual Support Assistant



SuiteAnswers Overview

Use the chat box to type in your queries or questions. To submit,

press Enter or click Send icon. The conversation history is saved

throughout your session until you close the Virtual Assistant.

From the Menu icon you can access the following:

Account Info – Provides you with information about

your account, account name and support type.
Virtual Assistant Feedback – Allows you to submit
feedback regarding your experience with the
Virtual Support Assistant.

Help – Redirects you to the NetSuite Virtual Support

Assistant help article.

Privacy Policy – Redirects you to the Oracle Privacy
Policies website at https://www.oracle.com/legal/
privacy/.

When you submit a query, you will get a reply with a list of applicable questions sorted from the most
relevant to the least relevant. Clicking one of the questions will get you a reply with relevant information.
Your queries can be either questions or simple sentences.

      "What is SuiteCommerce?"

■
■

"How can I create a SuiteBundle?"

"Show me my customers."

26

Queries

■

■

■

■

■

You can minimize the Virtual Support Assistant by clicking the Minimize button. To open the Assistant again, click the chat
button         on the bottom right of your screen. The Virtual Assistant retains your conversation history throughout the
session when you minimize the chat window or refresh the page. You can submit a feedback to the result by clicking the
Rate button when you hover over the result



Try to close the chat window, refresh the page and ask again.

I'm getting an "Oops I'm encountering a spot of trouble. Please try again later..." message.

Try to ask the question again. If that doesn't help, try to close the chat window, refresh the page and ask
again.

Support Assistant may become unresponsive when changing connections during the
session.

This may happen when you switch VPN connections in the middle of your sessions. Please make sure you
start a new session when you switch connections.

SuiteAnswers Overview

The authorized NetSuite staff may need additional information about the network requests that are
generated in your browser while an issue occurs. You may be requested to record a HAR file while an
issue is occurring and provide it for further analysis.

HAR files on Chrome and Microsoft Edge provide more detailed information and help in resolving your
issue.

Important:HAR files may contain sensitive information that you submit during recording
including personal details and passwords.

   "I want to create a saved search." 

   "I want to add a new employee."

The Virtual Assistant provides you with support options after it fails to answer your questions three times.
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Frequently Asked Questions
I'm getting one of the following messages: "Hey, Nice to meet you! Allow me a moment to
get back to you.", "I'm still working on your request. Thank you for your patience!"

To generate HAR file on Edge:

To generate HAR file on Chrome:

Generating a HAR File for Troubleshooting

1.  Press F12, Ctrl+Shift+I or go to More tools>Developer tools. 
2. Go to settings by clicking the Settings button or by pressing F1. 
3. Under Global settings check Auto-open Dev tools for popups. 
4. Go to Network tab. 
5. Make sure the Record button in the upper left corner of the Network tab is red. 
6. Check the box next to Preserve log. 
7. Click the Clear button to clear out any existing logs from the Network tab. 
8. Reproduce the issue. 
9. After you have reproduced the issue, right-click anywhere on the grid of network
requests. 
10. Select Save as HAR with Content.

■

■



Press F12 or go to Tools>Web Developer>Network.

Reproduce the issue.

Right-click on the loaded results.

Select Save all as har.

Press F12, Ctrl+Shift+I or go to More tools>Developer tools.

Go to settings by clicking the Settings button or pressing F1.

Under Global settings check Auto-open Dev tools for popups.

Go to Network Tab.

Click the Clear button to clear out any existing logs from the Network tab.

Press the play button at the top left to start recording.

Reproduce the issue.

After you have reproduced the issue, right-click anywhere on the grid of network requests.

Click Save all as HAR with content.

Open the Develop menu and select Show Web Inspector.

If you don’t see the Develop menu in the menu bar, go to Safari>Settings, click Advanced and
select Show Develop menu in menu bar.
Click the Network tab.

Reproduce the issue.

Click the Export icon on the far right of the network tab and save the HAR file.

SuiteAnswers Overview

Oracle provides a variety of resources you can use to find answers to your questions about NetSuite.

From the Support tab, you can access the following:

■ SuiteAnswers – In the SuiteAnswers portlet, click Go to SuiteAnswers to open the SuiteAnswers page.
You can search on the SuiteAnswers page to find support articles, training videos, help topics, and
best practice documents on any subject need help with.

For more information, see SuiteAnswers Overview.

From SuiteAnswers, you can also submit a question or issue by email or contact Customer Service by
phone. For more information, see Support Cases in SuiteAnswers
Support Online – To submit a question or issue to support professionals, click the Support tab, and
click Go to SuiteAnswers. On the right side of the page, click the Contact Support Online button. You
can send questions or comments by email 24 hours a day.

Note that you must be on the Authorized Contact list to be able to submit an online support request.

You will receive a response by email as soon as possible. Response times vary depending on the level
of support you have purchased and the support team's current case load. To improve response times,
please provide lots of information (more is better), and if applicable, include steps to reproduce the
problem.

■
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To generate HAR file on Safari:

To generate HAR file on Firefox:

NetSuite Support



NetSuite Support

Tip:To improve your experience with NetSuite Customer Support, remember to select your
preferred time zone in the Timezone field. The Timezone field is located below the Phone field
on the Case Submission form. For Authorized Contacts the value of the field defaults to the
time zone set in the Authorized Contact record. You can select a different time zone from the
list, if you want to. For Non-Authorized Contacts the Timezone field is blank and you can select
a time zone from the list.

■ Support By Phone – Phone support is available 24/7. Call the number provided by your account
manager. Note that you must be on the Authorized Contact list to receive support by phone.
For quicker assistance, please have your account ID ready when you call. To view your account ID, use
one of the following methods:

□ Find your NetSuite account ID at the beginning of the NetSuite URL. For example, if the URL is
https://1234567.app.netsuite.com/, your account ID is 1234567.
If you are an account administrator, in the NetSuite UI, go to Setup > Company > Company
Information. The account ID field is located near the bottom of the right column.
In the NetSuite UI, Click the Support tab, and click Go to SuiteAnswers. Then click Contact Support
by Phone.
In the NetSuite UI, right-click the page and select View Source. Scroll to the bottom of the page.
The second-last line shows your account ID and your login ID.

□

□

□

■ NetSuite Account Center – If your account administrator has provided you a role with access,
click the link in the NetSuite Account Center portlet. From the NetSuite Account Center, you can
view support cases and issues, and contact Support. You can submit support cases and receive
responses in English, Chinese (Simplified), French, German, Japanese, Latin American Spanish, and
Portuguese(Brazil). Few employees in a company have access to the NetSuite Account Center. For
information, see Accessing the NetSuite Account Center.
NetSuite User Group – You can register for the Oracle NetSuite community at Oracle NetSuite
Community Registration FAQ. After you register, you can go directly to the site at https://
community.oracle.com/community/netsuite. You also can access the user community by clicking the
link in the NetSuite User Group portlet on the Support tab of the NetSuite application.
Follow NetSuite – To follow NetSuite on Facebook, Twitter, YouTube, or the official NetSuite blog, click
the links in the Follow NetSuite portlet on the Support tab.

■

■

You can find the following options on the Setup tab:

■ NetSuite Support Login – available at Setup > Company > NetSuite Support Login. On this page,
select when you want to enable Support to log in to your account: always, never, or for the duration of
your case. For more information, see NetSuite Support Login.

Note:This setting only allows NetSuite Support to access a backup copy of your account in
the QA environment to investigate cases you enter. This setting does not give NetSuite Support
permission to access your production, sandbox, or release preview account.

■ Billing Questions – To submit a question about your bill, go to Setup > Company > Billing Questions.
You can submit billing questions 24 hours a day.
Your billing questions are answered by email and are prioritized by the level of support you have
purchased.

      Order Forms – To order envelopes, check forms and other items, go to Setup > Accounting > Order
Forms.

In addition to these resources, Oracle also provides NetSuite Help Center and other documentation. The
help documentation is available by clicking Help in the upper right corner of any page in NetSuite.
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For more information, see Using the Help Center Window.

Other topics included in this section of NetSuite Basics are as follows:

■
■
■
■
■

Accessing the NetSuite Account Center

Checking the Status of Support Cases

NetSuite Issue Resolution

Support Phone Menu Routing Options

NetSuite Support Login

If the portlet displays a link, click the link to access the NetSuite Account Center.

NetSuite Support

Click the Support tab to view the NetSuite Account Center portlet.

For most users, the portlet displays a message indicating you do not have permission. If you feel
that you should have permission to this portlet and the NetSuite Account Center, contact your
account administrator.

The NetSuite Account Center portlet is located on the Support tab. What you see in the portlet depends
on whether you have been assigned either the NetSuite Support Center role or the NetSuite Support
Center (Basic) role. Not many employees of any company are assigned to either of these roles, so you
should not expect to have access.

Note:Employees given access might need to log out and log back in again to refresh the portlet
to see the NetSuite Account Center link.

Employees with permission access the NetSuite Account Center from the same portlet whether they are
assigned the NetSuite Support Center or the NetSuite Support Center (Basic) role. The difference is in the
functions they are able to perform after they enter the center. The NetSuite Account Center displays the
following portlets and tabs:
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Accessing the NetSuite Account Center

To access the NetSuite Account Center:



Locate your name and role at the top right of any NetSuite page.

Hover over the Change Roles list, and select View My Roles.

On the My Roles page, click the desired role.

Note:In some instances, you will also see the Return to Previous Role option in the
Change Roles list. You should select View My Roles.

NetSuite Support

Any issue that is logged by the Support team is categorized as either a defect or an enhancement.

■ An issue is categorized as a defect when the problem occurs with an existing NetSuite feature that
does not work as designed.

If you have a role with permission to do so, you can log in to the NetSuite Account Center to see the
status of support cases you have submitted. When you check the status of your support cases, you can
learn details about the actions being taken to solve your issue.

You can check the status of support cases by going to the Support tab and clicking the link in the NetSuite
Account Center portlet. If you do not see the NetSuite Account Center link in the portlet, contact your
account administrator to see if you can be given access. See Accessing the NetSuite Account Center.

You can click Open Cases in the Quick View portlet for quick access to your open cases, or you can click
See Support Cases in the Home Links portlet to view a list of cases entered for your company. The Cases
list shows a list of the support cases submitted for your company. A Quick Sort dropdown list enables you
to sort by Incident Date or Last Message Date, or to select a subset of cases: Recently Created, Recently
Modified, Recently Closed, Recently Reopened, or Recently Viewed.

For example, if you want to see a list of all the cases currently entered for your company, select -All-. The
list refreshes automatically to show you all the cases entered for your company.

      On the Customer Center - Home Links portlet – users with the NetSuite Support Center role may
make payments, review statements, transactions, and estimates, review support cases and issues, edit
the user profile, and contact Support. Users with the NetSuite Support Center (Basic) role can view
support cases and issues and contact Support.

Note:If you do not have permission to view cases (even a case that you may have submitted)
contact your NetSuite account administrator. The administrator should be able to check on the
status of the case for you.

       On the Multi Language Support tab – NetSuite provides online case support in English, Chinese
(Simplified), French, German, Japanese, Latin American Spanish, and Portuguese(Brazil). To submit a
case in one of these languages, click Cases and select the preferred language from the dropdown or
click the country logo.
On the SuiteIdeas tab – Click the link to launch the SuiteIdeas site and review and vote for NetSuite
product enhancements. For information, see Voting for Enhancements.

■

Exiting the NetSuite Account Center is slightly different than the usual procedure for switching to another
role.

To exit the NetSuite Account Center:
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NetSuite Issue Resolution

Checking the Status of Support Cases

■

■



NetSuite Support

Oracle NetSuite’s process for handling customer-reported defects has the following goals:

■ Resolution of customer-reported defects within a targeted timeframe that is appropriate to each
defect's urgency.
Consistent and clear communication to customers throughout the defect resolution process.■

As part of this process, an urgency level to each defect, based on the following key inputs:

■ Business Impact – business categorization that reflects the defect's impact on operations. Defined
levels are B1-B4, with B1 representing the biggest impact.
Severity - technical categorization that reflects the defect's effect on functionality or performance.
Defined levels are S1-S4, with S1 representing the greatest severity.
Other factors - such as the number of impacted customers, whether the problem is a recently
introduced defect, or a sudden change to operational behavior has occurred.

■

■

The urgency level of a defect determines the target timeframe for resolution. See NetSuite Issue
Resolution Process for an up to date timeframe.
During the resolution process, the Support team communicates the following milestones to impacted
customers:

■

■

■

■

Assignment of the defect to an engineer

Assignment of a target date for the release of a fix

Completion of code review, testing, and authorization to release the fix

Release of the fix to NetSuite’s production environment

The Support team can also provide further assistance as needed. If you want to request additional
information or discuss an issue's urgency level, please update your support case for assistance.
For the e-Fix release schedule, see NetSuite E-Fix Release Schedule.

When you call Support by telephone or enter an online support case, it is important that you select the
correct category for the question or problem you have to ensure that it is routed to the correct support
person.

If you have a role with permission to access the NetSuite Account Center, you can view defects and
enhancements associated with your support cases. See Accessing the NetSuite Account Center.

On the NetSuite Account Center page, click See Support Issues in the Customer Center - Home Links
portlet to view a list of issues entered for your company. A Quick Sort dropdown list enables you to select
a subset of issues to display: Recently Created, Recently Modified, or Recently Viewed.

An issue is categorized as an enhancement when the issue is a request for additional functionality for
an existing feature or for a new feature.
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Defect Resolution Process

Viewing Defects and Enhancements

Support Phone Menu Routing Options
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Important:To make sure it works as intended, set the permission up in the Production
account. Your Sandbox accounts do not keep the permission set up when they refresh.

NetSuite Support

Please review the latest NetSuite Support Phone Menu Routing Options for a detailed map of support
case menu routing options. This file also is available by going to the Support tab and clicking the
SuiteAnswers portlet. On the right side of the page, click Contact Support by Phone.

The authorized NetSuite staff may occasionally need to access a copy of your account in an internal QA
environment to investigate and fix any cases and issues you have reported. To give you better flexibility
and control over how and when you allow the authorized NetSuite staff to have such access, we provide
both a company and a case level preference.

The NetSuite Support Login preference is a company-wide preference that takes precedence over the
case level preference. It provides three different modes of permission to access a copy of your account
data.

Important:The NetSuite authorized staff never accesses live accounts. This preference is
only ever used to give access to a copy of your account in an internal QA environment. We never
access any of your live environments such as Production, Sandbox, and Release Preview.

The Allow NetSuite Login for this Case field works in conjunction with the value set at the NetSuite
Support Login preference. This field must be enabled to allow the NetSuite staff to access a copy of your
account for investigating your cases and issues.

To enable the Allow NetSuite Login for this Case field, you must be logged in to the NetSuite Account
Center, which is only available to employees with either the NetSuite Support Center role or the NetSuite
Support Center (Basic) role. The NetSuite Account Center can be accessed through the NetSuite Account
Center portlet (located on the Support tab). For more information about accessing the NetSuite Account
Center, see Accessing the NetSuite Account Center.

An administrator can go to Setup > Company > NetSuite Support Login.

Select from one of the following three options:

■ Always - with this permission, the authorized NetSuite staff will be able to access a copy of your
account in an internal QA environment for the sole purpose of troubleshooting reported cases
and issues. Such access is granted for any open case during first 90 days. You may be asked
for additional approval by re-checking Allow NetSuite Login for this Case after this period to
reset the timer. Case Duration - with this permission, the authorized NetSuite staff will be able to

access a copy
of your account in an internal QA environment for the sole purpose of troubleshooting reported
cases and issues. Such access is granted on a case-by-case basis. The Allow NetSuite Login for
this Case field must be marked on the case form when it is created or updated to set 90 days
access timer. You may be asked for additional approval by re-checking Allow NetSuite Login
for this Case after this period to reset the timer
Never - with this permission, the NetSuite staff has no access to copies of your account in
internal QA environments.

■

■
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NetSuite Support Login

To set the NetSuite Support Login preference

1.
2.

Allow NetSuite Login for a Case

https://system.netsuite.com/core/media/media.nl?id=13727838&c=NLCORP&h=b87c11d4aef551e18d74&_xt=.html


The field can be enabled when creating new cases or when editing existing ones.

NetSuite Support

Choosing the most appropriate level of access depends on your company's business requirements to
limit how, when, and if authorized NetSuite staff access a copy of your account data in an internal QA
environment.

Authorized NetSuite staff are specific members of the Support, QA, and Development teams, who have
been granted permission to access a copy of your account data for the sole purpose of troubleshooting
and rectifying the case which you have reported.

The NetSuite Support Login preference takes precedence over the Allow NetSuite Login for this Case
field on the NetSuite case form.

If the NetSuite Support Login preference prevents access, even if the Allow NetSuite Login for this
Case field is enabled, when creating or updating the case, authorized NetSuite staff cannot access a copy
of your data

The NetSuite Advanced Customer Support (ACS) helps you be proactive about optimizing NetSuite. Business

needs change over time—due to growth, evolving strategies, and changing markets. You may
start to realize there is a growing gap between what your business software does and what you need it to
do. Or you may determine that you need additional support to keep up with software enhancements.

NetSuite ACS offers guidance and assistance for optimizing your use and setup of NetSuite. ACS team
members are NetSuite product and industry experts who can help you optimize your NetSuite solution.

Key Benefits of ACS:

■

■
■

■
■

Optimize the use and performance of your NetSuite solution

Collaborate with the world’s leading NetSuite experts

Overcome common business challenges with prescriptive solutions

Adopt new features from NetSuite releases

Resolve issues rapidly when you need it most
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Which option should I choose?

Who are NetSuite Authorized staff?

Advanced Customer Support



Improves operational efficiencies by optimizing key financial methodologies such as:

■ Align your business goals with tailored, strategic roadmaps

For more information about Advanced Customer Support, see the following Help sections:

■
■
■

Advanced Customer Support Services

Advanced Customer Support Playbooks

Advanced Customer Support Resources

Optimize provides expert solution management for a deeper and more proactive engagement. You
partner with a designated Customer Success Manager (CSM) to ensure strategic milestones are
accomplished and work with a functional consultant to optimize your solution.

Advanced Customer Support

As the entry-level ACS offering, advise is available for customers who are getting started with NetSuite.
Advise has access to NetSuite specialists to provide product guidance and system troubleshooting.

For established organizations seeking simple technical and functional support, Monitor includes more
hands-on execution. A designated functional consultant assists with project activities to ensure key
milestones are met in a timely fashion.

Advanced Customer Support (ACS) offers four levels of support: Advise, Monitor, Optimize, and Architect.
As you move up subscription levels, the amount of engagement, proactivity, and resource expertise
increases.

Advanced Customer Support (ACS) Playbooks guide organizations along their growth journey with expert
direction and leading practices based on over 20 years of helping businesses achieve their goals. ACS
Playbooks offer a set of prescriptive services to help overcome business challenges and support key
growth milestones, ensuring that NetSuite can enable your business growth.

The following ACS Playbooks are exclusively available to ACS Optimize and Architect customers:

For enterprise businesses with complex international or subsidiary configurations, Architect delivers
a best-in-class solution designed for optimal scalability and performance. Architect also provides
comprehensive support with a senior CSM and a named team of expert technical, functional, and support
resources.
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Advanced Customer Support Services

Advanced Customer Support Playbooks

ACS Advise

ACS Monitor

ACS Optimize

ACS Architect

Financial Management



Payroll

Workforce management
Compensation

■
■

Performance management
Onboarding new employees

Simplifies key project-related processes, such as:

■
■
■

Project accounting and billing

Project and resource management
Timesheet and expense management

Planning and budgeting

Forecasting

Accounts payable and accounts receivables automation

Revenue recognition

Month-end closing

Improves customer engagement tactics around deploying:

■
■
■
■
■

Unified ecommerce experience

Mobile and point of sale revenue streams
Customer relationship management

Order management
Customer analytics reporting

Increase efficiencies across the supply chain in areas such as:

■
■

Inventory and warehouse management

Demand and supply planning

Outsourcing

Procurement

■ Production management

Handles the financial complexities of entering international markets with guidance on:
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■
■
■
■
■

Customer 360

Human Capital

Project Profitability

International Expansion

Supply Chain Operations

■
■
■

■
■



Operating in multiple countries

Managing multiple currencies and languages

Tax compliance

Bank automation

Localization

Optimizes business functions through NetSuite’s more than 20 years of industry-specific KPI’s and
insights across industries - retail, software, services, manufacturing, wholesale distribution, and more.

Ensures NetSuite maintains peak performance and security as the business scales, providing guidance
on:

System architecture

Capacity planning

Integrations

■

■

■

Access controls

Environment management

Script reviews

Prepares for a public listing or merger/acquisition by establishing and optimizing required governance
and internal controls or developing the financial reports needed to comply with audit requirements and
tax regulations.

Leverages the power of NetSuite ensuring cross-functional processes, like quote to cash and procure to
pay remain optimized.

If you would like to learn more about Advanced Customer Support (ACS), contact your Account Manager.
Your Account Manager can answer your questions and help you choose the right ACS solution for your
business needs.

To learn more about ACS, see the following links:

■ Advanced Customer Support

      What is NetSuite Advanced Customer Support Video

■ Using ACS to Maximize the Value of an ERP Investment

       New Advanced Customer Support Playbook Help Pave the Way for Business Growth
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■

■

■

■

Industry

Capital Markets

Cross-Functional

Performance and Risk Management

Advanced Customer Support Resources

■

■

■

■

■

https://www.netsuite.com/portal/services/support-services/advanced-customer-support.shtml
https://www.youtube.com/watch?app=desktop&v=nc2JAPnHjcw&feature=youtu.be&ab_channel=NetSuite
https://6262239.extforms.netsuite.com/app/site/crm/externalleadpage.nl?compid=6262239&formid=1073&h=AAFdikaIsLretBVh5DpB0mQih0KNX4ZJLzSwRoHf2PEAkxIgDWk&subsidiary=1&redirect_count=1&did_javascript_redirect=T&vid=5TrKCKLQApr5Wd6M&cktime=184530
https://www.netsuite.com/portal/resource/articles/erp/new-advanced-customer-support-playbooks-help-pave-the-way-for-business-growth.shtml


NetSuite Communities (User Groups)

1.

2.

See the Oracle NetSuite Community Registration FAQ.

Follow the instructions on this page to join the Oracle NetSuite community.

After you register, you can go directly to the Oracle NetSuite community site at https://
community.oracle.com/community/netsuite. This site includes a banner at the top that links to tips for
getting started with Oracle communities, as well as an introductory video. You also can access the user
community by clicking the NetSuite Community link on the Support tab of the NetSuite application.
Regional user groups provide other NetSuite community resources that are hosted and owned by third
parties. You can find these by searching for ‘NetSuite user groups’ in your browser.

Your NetSuite account may be configured using the SuiteSuccess methodology. This methodology
uses a value-driven dashboard model to improve the efficiency and effectiveness of NetSuite users.
SuiteSuccess accounts are delivered with pre-defined components based on leading practices, specific to
your company's industry and your users’ roles.

Your SuiteSuccess account includes the following components tailored for your particular industry:

■
■

■

Business processes delivered through NetSuite SuiteApps

Center tabs

Chart of accounts

Dashboards

■ Enabled features necessary for your business

Forms

■ KPI scorecards

Modules

■ Pre-defined preferences

Reports

■ Saved searches

SuiteSuccess editions are currently available for the following industries:

■ Apparel, Footwear, and Accessories

Join a NetSuite community to communicate with other customers and Certified Consultants to ask
questions and trade tips. As a member of a community, you can start your own discussions or respond
to discussions initiated by other members. The communities are monitored by NetSuite Certified
Consultants and Support Specialists to ensure that you are receiving the best advice possible.

Membership is available to general access users with current NetSuite accounts. Users with Center roles,
such as Customer Center, Partner Center, and Vendor Center, are not eligible for membership. NetSuite
communities are not available to users of Test Drive accounts.
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To register for the NetSuite Community:

Roles

■
■
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Click File a New Idea on the SuiteIdeas home page.

Enter a description of your idea, and click Search Idea.

Review the list of search results to see if your idea has already been entered.

If your idea is not in the list or results, click File a New SuiteIdea at the bottom of the page.

SuiteSuccess

Financials

■ 
■

Food and Beverage

Health and Beauty

Non-Profit

■ Retail and Hospitality

      Software

      Wholesale Distribution

For more information, see http://www.netsuite.com/portal/services/suitesuccess.shtml or contact your
NetSuite account manager.

When you want a feature or functionality added to NetSuite, visit SuiteIdeas to submit a new
enhancement request or vote for an existing idea. SuiteIdeas is only available to users with the NetSuite
Support Center role or the NetSuite Support Center (Basic) role.

From the Support tab, use the SuiteIdeas portlet to visit SuiteIdeas and search through all existing
NetSuite enhancement requests. You can vote for the ideas of your choice, or enter your own new ideas
for making NetSuite better.

1. Go to the Support tab, and click Go to SuiteIdeas in the SuiteIdeas portlet.

Note:If you do not see the Go to SuiteIdeas button in the SuiteIdeas portlet, ask your
account administrator if you can be given access. See Accessing the NetSuite Account
Center.

The SuiteIdeas site opens in a new tab or window, depending on your browser preferences.

Click one of the following links within the SuiteIdeas site:2.

■
■

■
■

Search to see if your idea has been requested by others.

Browse for ideas by categories.

View new ideas, the most recently updated ideas, and ideas that have received the most votes.

View the ideas you have voted for.

Clicking an idea opens it in a new window.

3.

4.

If you find the idea you are looking for, click Vote for this Idea.

Rate the idea, and click Submit Vote.

If you do not find the idea you are searching for, you can enter your own.
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Voting for Enhancements

To enter a new idea:

To search and vote for enhancements:

■
■

■

■

http://www.netsuite.com/portal/services/suitesuccess.shtml


Event Reports: View reports that describe downtime events or service notifications. Downtime
events are service interruptions or, in some cases, application defects severe enough to cause

Voting for Enhancements

5.
6.
7.
8.

Enter a title for your idea.

Select the product area and feature your idea is related to.

Enter a detailed description of your idea.

Click Submit Idea.

Each SuiteIdea is reviewed, and after it is approved, it is listed and can be viewed and voted on by other
NetSuite users.

Important:When you are finished with SuiteIdeas, return to your original NetSuite tab or
window. The Support tab changes to the NetSuite Account Center when you go to SuiteIdeas.
To exit the NetSuite Account Center and return to your previous NetSuite center, click Return to
Previous Role in the upper right corner.

The NetSuite Service Status Page is a communication tool used to inform you of service interruptions,
degraded performance, and unplanned outages. If you are unable to access the NetSuite user interface at
https://system.netsuite.com, you can check the service status at https://status.netsuite.com.

The status page includes the following sections:

      Metrics: View the aggregate number of application requests made and the average uptime across the
NetSuite service over a rolling 12-month window, updated monthly.
Subscribe to Updates: Click Subscribe to Updates to receive email or phone updates regarding
incident reports that are published to the status page.
Current Status: View the current status of NetSuite services across the different data center regions.

■

■

Note:To find your data center, go to Setup > Company > Company Information. For more
information, see the help topic Enter Basic Company Information.
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Checking NetSuite System Status
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NetSuite services fall into one of four statuses and are indicated by the status icons below: Normal
Performance, Degraded Performance, Partial Outage, and Outage.

■ Event History: View a history of event reports published to the status page in the past 30 days.

The NetSuite services displayed on the status page are:

1.
2.
3.
4.
5.

Application UI: NetSuite user interface

SuiteCommerce - Websites: web stores running on NetSuite

SuiteCommerce - Checkout: web store checkout processing

Email: email infrastructure

Asynchronous Services: backend processes, for example, ERP processes and SuiteScript
processors
SuiteTalk: SOAP Web Services, REST Web Services, and partner integrations

SuiteAnalytics Connect: ODBC, JDBC, and ADO.NET connections to NetSuite data

SuiteAnswers: NetSuite self-service support site

6.
7.
8.

For details about the Oracle NetSuite service level commitment, see the Service Level Commitment
document.

Checking NetSuite System Status

degraded performance or outages which limit NetSuite service availability. Service notifications
provide additional details about ongoing events or security concerns that Oracle NetSuite has deemed
important enough to notify users. In both cases, posts are updated with the time of event resolution.
To receive notifications only for a specific event, click Subscribe beside that specific event report.

41

Status Icons

Status Icon Meaning

Normal Performance

Examples

No issues affecting any NetSuite accounts.

https://www.netsuite.com/slc


The version of NetSuite that you are currently using is displayed on your Home page.

Log in to NetSuite.

On the Home page, scroll down to the bottom of the page.

Find the NetSuite version number in the page footer. The version number should look like this:
NetSuite (Edition: United States) Release 2020.1 Copyright © NetSuite Inc. 1999-2020.

You can unsubscribe by clicking the Manage your Subscription link in any of the notifications that you
receive from the status page. You will receive a notification confirming that you have unsubscribed
successfully.

For subscription help, please contact NetSuite Customer Support.

Checking NetSuite System Status

The NetSuite Help Center content can also be viewed in its entirety in the NetSuite Applications Suite
section of the Oracle Help Center. The NetSuite Help topics in the Oracle Help Center provide an updated
look and feel, with the benefit of being able to access the content without your NetSuite credentials.

When searching through the Oracle Help Center for NetSuite topics, be sure to leave the NetSuite filter
in the search bar. If the NetSuite filter is not included, you can add it using the menu in the upper left
header of the page. Go to Cloud Applications > NetSuite Applications.

This site is available through docs.oracle.com and can be accessed here: Oracle Help Center.

Click the Subscribe to Updates button to opt in to receive email or SMS notifications about the status of
NetSuite services. Provide your email address or phone number, and then you can choose to subscribe to
all updates, or you can choose to subscribe to updates for specific data centers and NetSuite services.

You will receive a notification prompting you to confirm the subscription. When you have confirmed, you
will receive a subscription confirmation message.
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Status Icon Meaning

Degraded Performance

Partial Outage

Outage

Examples

No service interruption, but there may be performance issues.

There is an issue that impacts only a subset of NetSuite accounts.

There is a system-wide issue impacting all NetSuite accounts.

How to Subscribe to Updates

How to Unsubscribe from Receiving Updates

Oracle Help Center

Finding Your NetSuite Release Version

To find the version of NetSuite your company uses:

1.

2.

3.

https://docs.oracle.com/en/cloud/saas/netsuite/index.html
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Navigating NetSuite

The header area of NetSuite pages is locked and always remains accessible at the top. The elements of
the header are identified in the following screenshot.

You do not need to know your NetSuite account ID to use NetSuite. In special cases, however, you may
want to know what your account ID is.

You can find your NetSuite account ID at the beginning of the NetSuite URL. For example, if the URL is
https://1234567.app.netsuite.com/, your account ID is 1234567.
Account IDs for Sandbox and Release Preview accounts contain an underscore, for example 123456_RP.
The underscore is transformed into a hyphen in the generated account-specific domain URL and the
capital letters of the acronym are transformed into lowercase letters. For example, the URL for a Sandbox
account may look as follows: https://1234567-sb.app.netsuite.com. For more information, see the help
topic URLs for Account-Specific Domains.

Watch the following video to see the common elements and tools of the NetSuite user interface (UI).

Navigating NetSuite

This section introduces you to the elements of the NetSuite user interface (UI). It includes topics for
common UI elements and tools.
The UI uses progressive disclosure. This means that the pages focus on your content. When you move
your pointer over areas of a page, the links, menus, and icons that are appropriate for that area appear. If
you do not see a link or button you expect, move your pointer around the area and see what appears.

Best practice is to always use the NetSuite Back button for navigation, rather than your browser Back
button. If you use the browser Back button, you may create duplicate entries.
Instructions for common UI elements and tools are included in the following help topics:

■ Header and Menus

Centers

Dashboards

■
■

■

Global Search

Create New Menu

Popup and Dropdown Lists

QuickViews

■
■

■

Keyboard Shortcuts

Buttons and Menus in NetSuite

Text Enhance

If you are using NetSuite on a mobile device, see the help topic NetSuite for Mobile Overview.
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Navigating NetSuite

Header and Menus

Finding Your NetSuite Account ID

■

■

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1498251763.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1498251763.html
https://videohub.oracle.com/media/Navigating+NetSuite/1_ea5uv3r9
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_1553504120.html


1
Oracle NetSuite logo – If you have issues with performance in NetSuite, you can double-click the Oracle NetSuite
logo to open a popup window with details that your administrator can use to help identify the source. For more
information, see the help topic Gathering Performance Details.

2 Global search field – Enter a keyword to search for any type of record. For more information, see Global Search.

3 Create New menu – Use this dropdown menu to create new records of various types. For more information, see
Create New Menu

4 Help – Click Help to open the NetSuite Help Center. The help center usually opens to a topic related to the page you
are working with. For more information, see Getting Help.

5 User name and role – Move your pointer over this area to open a dropdown list to change your role or log out
ofNetSuite. For more information, see Roles and Accounts.

6 Navigation menu bar – This bar contains tabs that become navigation menus when you hover over them. Formore
information, see Navigation Menu.

Header and Menus

The navigation menu bar is located at the bottom of the header. The tabs in the bar depend on your user
role. Users with the Administrator role and users with the Custom Center Tabs permission can create new
tabs. For more information, see the help topic Creating Center Tabs.

Notice the ellipsis at the right end of the menu bar. It appears when the page is too narrow to display
the full menu. The ellipsis means that more menus are available. When you hover over the ellipsis, the
additional menus drop down so that you can access them without scrolling.

All of the tabs expand automatically to become navigation menus when you move your pointer over
them. Navigation menus often have multiple levels. Hover over a menu to display submenus, and click a
menu option to select it. For example, hovering over the Transactions tab displays the Transactions menu.
In the following screenshot, the pointer has followed the Transactions menu to the Bank submenu, then
to the Make Deposits menu, and is hovering over Search.
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Navigation Menu

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_48151513026.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2890512.html


Header and Menus

Note:Your personal settings and preferences are accessible from the Settings portlet on your
Home page dashboard. For more information, see Settings Portlet.

A role is a defined access configuration that is assigned to you. Roles and their permissions determine
the pages that you can see in the NetSuite interface and the tasks that you can complete. You may have
more than one role assigned to you. If you have more than one role, you can switch among those roles
and select a default role in your account to use when logging in. For more information about roles, see
the help topic NetSuite Roles Overview.

An account is a place where you work in NetSuite. There are multiple types of accounts provided by
NetSuite that you can use, such as production, sandbox, development, and release preview. The live
production account is the main account where you do the daily work necessary to run your business. You
can access your production account by going to system.netsuite.com and entering your login details. To
know more about different types of accounts, see the help topic Understanding NetSuite Account Types.

When you select a menu option, the tab remains highlighted to show you the context of the page you are on.

Three of the tabs on the navigation bar use icons instead of words. These are:

 Recent Records – NetSuite remembers the records you have viewed recently. Click this icon to
open a dropdown menu of recent records. For more information, see Using the Recent Records Menu.

■  Shortcuts – When you click this icon, you open the shortcuts menu. It contains links to your most
frequently used records, transactions, lists, or reports. These shortcuts also appear in the Shortcuts
Portlet. Often your administrator sets them up for you. For more information, see the help topic
Shortcuts Portlet.

■  Home – Click this icon to go to your home dashboard page. When you hover over it, you can also
see a link to the Set Preferences page. For more information, see Dashboards.

46

Roles and Accounts

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N285436.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N285436.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4413974567.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N587785.html


Hover your cursor over this area to reveal the Change Roles list.

Click this area to display the My Roles page.

Locate your name and role in the upper-right corner of the NetSuite page.

Hover to open the Change Roles list.

A check mark indicates your current role.

The role that you use determines the pages and records you can access in NetSuite. You may have
multiple roles in NetSuite.

The upper-right corner of every NetSuite page displays your name and current role.

Header and Menus

Only administrators can set up and manage roles and grant access to accounts. For more
information, see the help topic NetSuite Users & Roles.

If browser history is available, when you log in to NetSuite, you are logged in with the role you used when
you logged out of NetSuite. You may want to switch to a different role, or switch to a role in a different
account.

NetSuite pages that prompt you to select a role or an account display the choices available. You may
encounter these pages during the login process, or when you are switching roles.

■ Role and account selection pages and menus are organized into two sections:

□
□

The upper section displays the roles available to you in the current account.

If you have access to more than one account, your other accounts are listed below a Or switch to
another account section. The roles available to you in these accounts are not shown in this lower
section. When you switch to another account, the upper section displays your roles in that account.

■ If you have access to more than one NetSuite account, you can select a default role for each account.
For example, you could specify a default role for production, sandbox, and Release Preview. For more
information, see Specifying a Default Role.

See the following sections for more information:

■ Switching to a Different Role

□
□
□
□

Opening the My Roles Page

Hiding a Role

Showing Hidden Roles

Specifying a Default Role

■ Switching to a Different Account

□
□

Hiding an Account

Showing Hidden Accounts
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Note:

Switching to a Different Role

Switching to a Different Role or Account

■
■

1.
2.

To switch to a different role:

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N284861.html


Click your name and role in the upper-right corner of any NetSuite page.

See the following topics for more information.

■
■
■

Hiding a Role

Showing Hidden Roles

Specifying a Default Role

When you hide a role, you hide the role from your view only. You do not disable the role.

Header and Menus

On the My Roles page, you can switch to another role or another account. You can also hide a role from
view, show all your hidden roles, and set a default role for the current account.

Select the role you want to use.

If a company name is associated with the role, that information is shown. The source of the
information is the Partner/Vendor column on the My Roles page.

Note:The Role section shows only roles available in the current account. If you are
looking for a role in a different account, select the account in the Or switch to another
account section to view the roles in that account. Sandbox accounts are indicated by an SB
icon, and Release Preview accounts are indicated by an RP icon.

To see your changes reflected in the Change Roles list, refresh your browser and open the Change
Roles list.

Open the My Roles page. For more information, see Opening the My Roles Page.

In the row of the role you want to hide from view, hover over the More icon 
the page.
Select Hide. The role disappears from the Role list.

on the right side of

Note:If you hide your currently logged-in role, the role is not removed from the Role list.
Instead, a Hidden icon identifies the role as hidden.
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3.

1.
2.

1.
2.

3.

4.

Hiding a Role

Opening the My Roles Page

To hide a role:

To open the My Roles page:



You can see any roles that you previously hid from view by clicking
corner of the My Roles page.

Open the My Roles page. For more information, see Opening the My Roles Page.

Click Show All.

■

■

To show a role, hover over the More icon and select Show.

To remove your hidden roles from view, click Show All again.

 Show All in the upper-right

Open the My Roles page. For more information, see Opening the My Roles Page.

Note:The Roles section shows only the roles in your current account. To specify a default
role in a different account, select that account in the Or switch to another account
section. Then you can see the roles available in that account.

In the row of the role you want to make default, click the More icon 
page.
Select Make Default. Your default role preference for this account is saved.

on the right side of the

If you do not indicate a default role in an account, your browser history is used to log you in with the last
role you used. However, if you want to specify a default role, you can do this on the My Roles page.

To set a default role in an account, first you select the account, then you select the role in that account
that you want to make your default role.

Note:Only one role in an account can be selected as the default role. However, you can set up a
default role in each account you can access.

You can access all your accounts from the Change Role list or from the My Roles page, including your
production, sandbox, Release Preview, and development accounts. To open the My Roles page, click your
current role in the upper-right corner of the NetSuite page.

On the My Roles page:
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Showing Hidden Roles

Specifying a Default Role

To show hidden roles:

To specify a default role:

1.
2.

1.

2.

3.

Switching to a Different Account



You can see any accounts that you previously hidden from view by clicking
right corner of the My Roles page.

Open the My Roles page. For more information, see Opening the My Roles Page.

Click Show All. A Hidden icon identifies any hidden accounts.

Your current role is indicated with bold font, a check mark, and Logged in shown in the Last Login
column.

When you hide an account, you hide the account only from view. You do not remove your access to the
account.

 Show All on the upper-

To reorder the list of your other accounts, click the Account Name or Account Type column
header. You can sort the column in ascending order or descending order.

To see this reordering of accounts reflected in the Change Roles list, refresh the browser and open
the Change Roles list.

□
□

The ordering of accounts is the same in all accounts you can access.

Your preference for ordering accounts is stored in your browser. If you use a different browser or
device to access NetSuite, you must click to sort the columns for that browser or device.

Open the My Roles page. For more information, see Opening the My Roles Page.

In the row of the account you want to hide from view, hover over the More icon 
side of the page.
Select Hide.

To see these changes reflected in the Change Roles list, refresh the browser, and open the Change
Roles list.

on the right
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■

■

■

1.
2.

3.
4.

1.
2.

Hiding an Account

Showing Hidden Accounts

To hide an account:

To show hidden accounts:



The Home page displays every time right after you log in to NetSuite.

To show an account, hover over the More icon and select Show.

To remove your hidden accounts from view, click Show All again.

The following pages (or tabs) are included in all centers and are accessible to all roles:

■
■

The Home Page

The Activities Page

The following pages (or tabs) are not included in the Customer Center, Employee Center, Partner Center,
or Vendor Center, but are included in all other centers and accessible to all other roles:

■
■

The Documents Page

The Setup Page

The following pages (or tabs) are not included in the Customer Center, Employee Center, Partner Center,
Vendor Center, Advanced Partner Center, or Support Center but are included in all other centers and
accessible to all other roles:

■ NetSuite SuiteApps

A center is a set of tabbed pages that adjusts accordingly to your role. There are different types of centers
in NetSuite, including standard centers, and a special NetSuite Account Center. Each NetSuite center
provides the pages and links that you need to do your job. For example, the Accounting Center’s tabbed
pages provide data and links that are relevant for Accountants, Bookkeepers, Payroll Managers, and
Clerks. For more information about the standard centers, see the help topic Centers Overview.

Each tabbed page displays a collection of real-time data called a dashboard. You can personalize
your dashboard and see dashboards that are published by administrators. For more information, see
Dashboards.

When you log in to NetSuite, the system determines your last used role and account, or a default role that
you set up, and displays the associated center. For more information, see Roles and Accounts.
SuiteSuccess customers have predefined centers for their users. SuiteSuccess takes a holistic approach
to product adoption. Extensive product experience, domain knowledge, and leading practices dictate
the built-in business process flows and KPIs that are provided for a specific business and industry.
SuiteSuccess customers have custom roles and centers that are appropriate for their edition of
SuiteSuccess. The role-based user dashboards provided enable you to meet your business needs more
effectively.
Some pages are included in all centers and accessible to all roles. For more information, see the help
topic Pages Common to all Centers.
If you have a role with the Administrator permission or the Custom Centers permission, you can
customize the user interface of a center. For more information, see the help topic Custom Centers.
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■

■

Centers

Pages Common to all Centers

The Home Page

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3409913.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N131898.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N133606.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2890160.html


Centers

Some of the features of the Home page are:

■
■
■
■
■

A quick search tool by type of record

Key Performance Indicators that show the business statistics most important to you

Shortcuts that link to the areas you use most

Reminders that alert you to important things that need to be done

Settings that include:

□
□
□
□

Adding information to your Home page

Individual preferences for working throughout the entire NetSuite application

A tool for synchronizing events, contacts, and tasks

A link for changing your email and password

To set up your Home page, click Personalize. In the Add Content panel that appears, you can choose the
other content items to include on your dashboard.

The Activities page is used to display your calendar, events, tasks, and phone calls, and other activities.
You can customize this page by adding individual portlets such as Phone Calls, Tasks, Activities Links,
Calendars, Quick Add: New Events, and more. For information about personalizing your dashboard, see
the help topic Adding a Portlet to a Dashboard.

For example, the Activities Links portlet provides links to quickly access various activity list pages. You can
also create new records (for example: events, tasks, and phone calls) or search existing activity records.
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The Activities Page

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N580906.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N580906.html


On list pages, you can customize your view, filter the listed records, create new records, and perform
other actions as appropriate for the record. Clicking Events, for example, displays a list page of your
events. Your first day on the job, it might look like this:

Centers

You can view your calendar and scheduled events using the Calendar portlet. For more information, see
Navigating Your Calendar.

In the Tasks and Phone Calls portlets, you can quickly create new tasks or phone calls or edit existing
records.
To reorganize the portlets on the page, click and hold the upper right corner of the portlet and drag it to
where you want it positioned on the page.
For more information about the various types of activities and records on this page, see: 

■

Working with 
Your Calendar and Activities
Working with Events
Working with CRM Tasks or Project Tasks
Working with Phone Calls
Attaching Events, Tasks, and Calls to Records and Transactions

The Documents page and navigation menu allow you to manage your documents and templates. You can

click the Documents tab or Documents Overview menu to access the NetSuite File Cabinet, where
you can store and organize your business documents online and then associate them with company,
customer, contact, vendor, other name, partner, task, event and case records.

In the File Cabinet, you can quickly search for, download, move, and delete existing files. You can use Add
buttons to upload additional files to the File Cabinet. For more information, see File Cabinet Overview.
Additional menu items on the Documents page include: 

■ Templates has the following menu items:

      Email Templates: see the help topic Working with Email Templates.

□

□

Fax Templates: see the help topic Using Fax Templates.

Letter Templates Using Letter Templates.
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The Documents Page

■
■
■
■

■

 Files■

□

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1192913.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1084924.html
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□

□

PDF Templates: see the help topic Advanced PDF/HTML Templates

Select Template Files to access the template files in the File Cabinet.

For more information, see the help topic Working with Email Templates.

Available menu items vary based on the features you have enabled in your account. If Mail Merge is
enabled in your account, see the help topic Working with Mail Merge.

Centers

When you log in, NetSuite opens your home page. Your home page is a dashboard, a collection of real-
time data. The specific content of your home page depends on your user role. Here is an example of a
portion of a Home page for a fictitious company.

The Setup page is where NetSuite account administrators (and other users with a role granting
permission) manage the details of your NetSuite account. The menu items available on the Setup page
depends on your assigned role and permissions. If you are not an account administrator, many setup
tasks are unavailable to you. Some menu items available on the Setup page are unique to a specific role or
roles. See the following topics for information about Setup page menu items.

      Company: see the help topic Set Company Preferences.

■

■

Accounting: see the help topic General Accounting.

Sales: see the help topic Setting Up SFA.

      Marketing: see the help topic Setting Up Marketing.

■

■

Support: see the help topic Support Management.

Issues: see the help topic Issue Management. In particular, see the help topic Setting Issue
Management Preferences.
Import/Export: see the help topics CSV Imports Overview and Additional Import and Export Options.

■

■

Users/Roles: See the help topic NetSuite Users & Roles.

Integration: see the following topics:

   Company-Wide Preferences

   Using the SOAP Web Services Usage Log

   SOAP Web Services Security

□ Setting Up SuiteSignOn Integration (Outbound single sign-on)

You may also see the following menu items on the Setup page, depending on what features are enabled
in your account.

■ Payroll: depending on which payroll feature your company is using, see either SuitePeople U.S. Payroll
or Payroll Solutions.

      Customization: see the help topic Customization.

■ Site Builder: see the help topic SuiteCommerce Site Builder. See also Site Builder Overview.
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The Setup Page

Dashboards

■

■

■

□

□

□

■
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Dashboards

Links to your personal settings, preferences, and login information are included in the Settings portlet on
your NetSuite dashboard. By default the Settings portlet is in the lower left of the dashboard as shown in
this screenshot of a Home page with all portlets minimized except the Settings portlet.

Dashboard content is displayed in a variety of portlets, dynamic data display windows. Some portlets
provide direct access to raw data, and others display data that has been synthesized into critical business
metrics, such as key performance indicators (KPIs), performance scorecards, trend graphs, and report
snapshots. For more information, see the help topic Dashboard Portlets.

Your Settings portlet may contain more links than are shown here. Some links are dependent on your role
and the features that are enabled in your account. You cannot delete this portlet, but you can move it to a
different location on the dashboard.

For more information about the standard links in the Settings portlet, see the following topics:

■
■
■
■

Dashboard Personalization
Setting Personal Preferences
Change Email Link
Change Password Link

55

Settings Portlet
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refresh the portlet content and ensure includes the latest data.

You can rearrange the portlets on your dashboard to fit your needs. For instructions, see the help topic
Arranging Dashboard Portlets.
To minimize a portlet, click its title bar. When you move your pointer over the title bar, it changes to
crossed arrows. To maximize the portlet, click again.
Additionally, you can expand some portlets to full-screen view by clicking the double arrow icon 
some of the portlets, the full-screen view displays more columns and rows in the search.

Update Security Questions Link

Portlets with content from current data include a icon on the right of the title bar. Click the icon to

. For

Keywords in global search can include letters, numbers, dashes, underscores, and the % wildcard.
The colon (:) and the caret (^) indicate a prefix that limits the search to a specific record type. All other
characters are considered white space. For details about prefixes, including some examples, see the
help topic Global Search Prefixes. For more information about the % wildcard, see the help topic Tips for
Effective Global Searches.

Keywords should be between three and 32 characters long. Global search begins the searching as soon
as you type three characters. Characters in excess of 32 are ignored.
By default, global search provides a list of suggested matches as you type. You can select a suggested
match or press Enter to open a list page with all matching results.

The NetSuite global search tool enables you to find any type of record from a single keyword query.
Global search is often the quickest way to locate data in NetSuite.

The global search box is prominently located near the center of the header. The header is anchored at
the top of the page so that it is always accessible. The keyboard shortcut Alt+G moves the cursor into the
search field.

Portlet controls are hidden until you move your pointer over the portlet. For example, look at the following
screenshot of a Reminders portlet with a pointer in it. The menu icon appears on the right of the title bar.
The title of the record that the pointer is over is underlined to show that you can click to view the record. An
Edit link or icon      also appears to the right of the record name so that you can reopen the record in edit
mode.

■

Portlet Controls

Global Search
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Global Search

The Create New menu appears in the NetSuite header. The visibility of the menu depends on your role
and permissions. For more information, contact you administrator.

1.
2.

Open the Create New menu, and click Personalize to open the Set Up Create New Menu page.
Check the Include box next to the links you want to show on the Create New menu, and clear the
Include box for the links you do not want to include.
If the link you want is not listed, you can create a shortcut instead. For instructions, see the help
topic Shortcuts Portlet.
Click Save.3.

To reorder links in the Create New menu, drag a link up or down the list to change the order in which the
links are listed. You also can select a link and use the Move to Top or Move to Bottom buttons. Click Save
when you are done.

To open a suggested record:

■
■
■

Click on the record name for view mode.

Click Edit that appears on the right for edit mode.
Click Dash that appears on the right of a customer record to open the customer dashboard. When you type

keywords and press Enter, the keywords are compared to record name and ID field
values. The values of the Vendor Name/ID and UPC Code fields in item records are also compared. The
default behavior is as follows: 

When multiple records match, a page opens with a list of results.
When only a single record matches, the record opens in view mode.

Global search is a powerful tool, and this topic includes only basic information. To learn all the details, see
the help topic Global Search.
NetSuite offers a variety of tools in addition to global search to help you find the information you need.
This includes the ability to save your search for reuse. For information about all of the search tools
NetSuite offers, see the help topic Search Overview.

You can gain quick access to the most relevant details of a record through record QuickViews. Depending on
the record type, the QuickView can also allow you to make changes to a record without having to open it.

This menu includes links to create new instances of different types of records. Each link in the menu
represents a type of record related to the record or transaction you are currently viewing. Click a link to
create a record of that type.

The options available on a record are limited by the role you are logged in with, but you can change which
options are listed in the menu.
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QuickViews

Create New Menu

To add or remove links in the Create New menu:

■
■
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The following are useful keyboard shortcuts you can use in NetSuite.

Note:If you do not have permission to view a record or record type, you cannot view it in
QuickView.

QuickViews

The QuickView for some record types contains buttons that allow you to make changes to the record. In
the following figure, for example, a QuickView of an event record in the Events list includes the Accept,
Decline, and View buttons. To view the event record, click View.

The fields that appear for a record QuickView are predetermined. You can add, remove, or rearrange the
fields in a QuickView by customizing the entry form. See the help topic Configuring QuickViews for the
steps to configure QuickViews for custom forms and custom records.

Note:Some item types in NetSuite contain images. To change the image that appears in an
item's QuickView, edit the image on the item record rather than on the form customization page
where you configure QuickViews.

Wherever a record is listed in a list, sublist, or on the main body of another record, you can hover your
pointer over the link to get a QuickView of the record's key data. In the following figure, for example,
hovering the pointer over an customer name in a sales order record opens a QuickView of the customer.
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Viewing Record Details

Customizing QuickViews

Taking Action on Records

Keyboard Shortcuts
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Use these shortcuts to complete and edit data on forms and records:

■
■

■
■

■
■

Press and hold Alt and type a letter to move to a subtab. See Navigating Subtabs.

In transaction headers, press Enter to save the transaction.

On a transaction line, press Enter to save the line and go to the next line.

Press Tab to move the cursor between fields and buttons.

Use the Spacebar to check or clear a box.

In Amount fields, enter numbers to calculate by addition, subtraction, multiplication, and division.

For example, enter 10 + 15 to calculate a total amount.

Press and hold Ctrl and click with your mouse to select multiple choices in a list.■

Note:Some keyboard hot keys and shortcuts function depends on the browser you use. For
more information, see Supported Browsers for NetSuite.

Keyboard Shortcuts

In date fields, use the following keyboard shortcuts to change dates:

■
■

■
■

■

Press T (upper case t) to enter tomorrow's date.

Press p to enter the end of the current period (if you use accounting periods).

Press l (lower case L) to enter the end of the previous period (if you use accounting periods).

Press t to enter today's date.

Press y to enter yesterday's date.

      Press m to enter the last day of the month.

■
■

Press the Plus Sign (+) to increase one day.

Press the Minus Sign (-) to decrease one day.

Note:These keyboard shortcuts are supported only in full date fields that include the month,
day, and year.

On transactions and records that have buttons with popup lists, you can select the non-default button
option. Use the Tab key to go to the list button. Then, use the down arrow key to expand the dropdown
list. Click Enter to select the desired action. To collapse the list, use the up arrow key to return to the top.

You can press Alt+G to move the cursor directly to the Global Search field.

To initiate only the current page search, press Alt+Shift+G. If you want to see results from both the global
search and the current page search, press Esc. For more information, see the help topic Global Search
Overview.
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Date Fields

Multi-Choice buttons

Searching Data in Your Account

Entering Data and Completing Forms

■
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When viewing reports, you can do the following:

■
■

Press Page Up to go to the previous page of a report.

Press Page Down to go to the next page of a report.

      Press Home to go to the first page of a report.

■ Press End to go to the last page of a report.

Instead of selecting from a dropdown list, you can type the first letters of a value and the field is
completed automatically.

When working with search results filters, you can use the following keyboard shortcuts:

■
■

Use the Tab key to switch between filters.

Use the Down Arrow key or the Up Arrow key to select an option from a filter dropdown list.

When typing a value into a filter field, use the Tab key to apply the value.

Please note that pressing Enter does not apply the filter value.

Keyboard Shortcuts

When using tabbed pages, you can quickly switch between subtabs by using keyboard shortcuts. Each
subtab has a single letter underlined in the title. Press and hold Alt and then press the corresponding
letter to switch to that subtab. The cursor appears in the first field on the subtab.

When you select from a long list of records to populate a NetSuite field, you can use various built-in
functions to save time. These functions include autocompletion and popup lists. Many fields also include
links to search, edit, and create related records.

■
■
■
■
■
■

Autocompleting Dropdown Lists

Accessing Related Records from Dropdown Lists

Using Popup Lists

Using Popup List Search Links

Popup Multi-Select Lists

Using Popup Auto Suggest

Some dropdown lists include buttons to access related records, so you can quickly add, review, or change
a record before you select it for a field. These buttons appear when you hover over the dropdown list.

■ Click the new button to create a new record in a popup window.
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Viewing Reports

Navigating Subtabs

Filtering Search Results

Autocompleting Dropdown Lists

Accessing Related Records from Dropdown Lists

Popup and Dropdown Lists

■

■

■



Popup and Dropdown Lists

Click the open button to view or edit an existing record. The record opens in view mode in a new
tab. Click Edit on the record to change to edit mode.

For example, to create a sales order for a customer in Alaska, click Search next to the Customer:Project
field. When the Customer Search window pops up, type AK in the state field, and click Submit. The
pop up changes to show only your customers in Alaska. Click the name of the customer you want, and
NetSuite inserts it into the Customer:Project field.

On transaction forms, NetSuite searches the full name of the item or the name of the final
subitem and autofills the item field with any matching names. For example, typing bas would find
Summer:Picnic:Basket and Basket:Welcome.

■
■

Click the new button to open a popup window and add a new record.

Click the open button to open the selected record in view mode in a new tab. Click Edit on the record
to change to edit mode.

To clear a value that you have previously entered in the list, select the value and press the Delete key.

Alternatively, you can click the double arrows to display a popup and choose to open a list or search. The
new and open buttons also appear when you click the arrows as shown in the following screenshot.

Most fields with a popup list also have a search link. Click the Search icon, and a search window pops up.
Enter criteria for the search, click Submit, and a list of items matching your search criteria appears. Select
the item you want, and it is inserted into the field.

You can use the Maximum Entries in Dropdowns preference to force popup lists instead of dropdown lists
for fields with large numbers of possible values. To set this preference, go to Home > Set Preferences.
The Maximum Entries in Dropdowns field is on the General subtab. Enter the maximum number of
records you want to appear in a dropdown list. If the possible values in a list exceeds this number, the
list automatically becomes a popup list. If the possible values do not exceed this number, a dropdown list
appears.

Tip:Enter 0 in the Maximum Entries in Dropdowns field to always use popup lists. To always
use dropdown lists, enter a large number that exceeds the number of entries in any of your lists.

Each popup list includes double arrows in place of the single arrow for a dropdown list. Start typing
and press the Tab key to open a popup window that contains only records that begin with the letters you
typed. For example, in the following screenshot, a user typed “ac” and pressed the Tab key to display a list
of customers.
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■

Using Popup Lists

Using Popup List Search Links



When you have selected all required records, click Done.

Popup and Dropdown Lists

Note:After you inactivate a record, it will not show on transactions for selection in popup or
dropdown lists. However, if the Search option shows in the popup or dropdown for a field, the
search will return inactive records if the Inactive filter is set to Either or Yes. Inactive records in
these search results can be added to transactions. To filter inactive records out of search results,
be sure to set the Inactive filter to No in the search criteria.

To search for records, enter the first letters of the record name and click Search. To add fields to your
selection, click the record name in the left column. The item moves to the Current Selections column on
the right.

On fields that allow you to select multiple values, you can access popup multi-select lists. To quickly enter
a single value in this type of field, type the first few letters and press Tab. To enter multiple values, click
the double arrow button to display a popup with a complete list of records that you can select and search.
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Popup Multi-Select Lists



Click the X button beside the selection that you want to remove, and then click Done.

Note:To change or remove values in a multi-select list, do not edit the list directly. Click the
double arrow button to open the popup and make the required changes.

To remove a value from a multi-select list, click the double arrow button beside the field.

NetSuite provides an auto suggest function for popup lists. As you type three letters or more, a list of
suggested matching records displays. You can select from this list to quickly populate the field.

Popup and Dropdown Lists

Each button in NetSuite serves a specific purpose and has the ability to fulfill individual business needs.
By using the appropriate button, you can successfully complete the task at hand. The following table

If you do not want this list of suggested matches to display, you can disable the auto suggest feature by
clearing the Popup Auto Suggest box on the Analytics tab of Home > Set Preferences.
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Using Popup Auto Suggest

Buttons and Menus in NetSuite



Buttons and Menus in NetSuite

describes the function of standard buttons that can be found on most NetSuite pages and shows where
the button is located. The table does not include buttons that are specific to a particular feature or record
type.
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Open Button 
On records in edit mode, the open button is a square icon with a diagonal
arrow that appears to the right of a field when the pointer moves over it.
The button opens the selected record in a new tab for viewing.

New Button 

On records in edit mode, the New button is a plus sign icon that appears to
theright of a field when the pointer moves over it. The button opens a
window in which you can create a new record. Most lists also have a New
button. For example, the New button at the top of the Employees list is
called New Employee.

Example

Back Button
The Back button appears when a record is in View mode. Clicking the Back
button takes you back to the page where you first initiated a particular action

Cancel Button 
The Cancel button appears below the record title when a record is in either
new or edit mode. Clicking the Cancel button aborts whatever action you
were performing.

Create New Button 
The Create New button is an icon with a dropdown menu. You can create
new records or perform new tasks. The options on the Create New button
vary on a per-record basis, as the options are specific to each record type. To
create records unrelated to the current record, use the Create New menu in
the NetSuite header. For more information see, Create New Menu.

Sublist Row 
Buttons Sublist row buttons such as Add, Insert, and Delete appear on the
left side of the sublist. The buttons that are available and the button names
change depending on where you are in NetSuite.

Action Menu 
The Action menu offers a dropdown menu. The dropdown menu may include
various options, such as Download and Delete. These options depend on the
record you are editing. 

Edit Button 
The Edit button opens the current record or transaction in a format that you
can make changes to. When you are finished, submit changes by clicking
Save

Mark All/Unmark All Buttons 
Mark All places checks in the check boxes next to all items listed on the page
where the button appears. Unmark All clears the checks. 

Button Description



Print Button

If multiple printing options are available, the print icon includes all options in
the dropdown menu. If the record allows only a single print action (to print the
page, for example), the print icon does not include the dropdown arrow.

Save Button

The Save button sends the transaction or record you are working on to
NetSuite for posting or changing. The Save button often includes a dropdown
menu for variations of save as shown in the example. NetSuite remembers the
option selected and makes it the default.
Save As Button

The Save As button creates a duplicate of the visible record. A unique name
is required. For example, a customer may have multiple locations, Art Gallery
I and Art Gallery II. The home office in Gallery I is the main office for both
locations. You can create a record for Gallery II by editing the Gallery I record,
changing the name to Art Gallery II and clicking Save As.

Save and New Button

The Save and New button sends the transaction or record to NetSuite for
posting, and then a blank page of the same kind opens.
Save and Next Button

The Save and Next button sends the transaction or record to NetSuite for
posting, and then the next existing record of the same type opens for editing.
Save and Edit Button

The Save and Edit button saves your edits and remains in edit mode where you
can continue editing.

Enhance Text Button

The Enhance Text button appears next to fields where the Text Enhance
generative AI feature is available. Click the button to display a dropdown menu
of the available actions. For more information, see Text Enhance.

Buttons and Menus in NetSuite

Text Enhance uses generative AI to assist you with writing business content in NetSuite. It can help you
create and refine content, as well as make your content the right length for your needs.

Text Enhance uses information from the page you are editing when it generates content. For example,
when you use Text Enhance to generate a sales description for an inventory item, it uses information such
as the item name, vendor description, display name, and stock description from the inventory item page.
Text Enhance can also help you write different item descriptions for the same item, depending on how
you will use the description. For example, when you use Text Enhance to generate text for the Purchase
Description field of the Purchase/Inventory subtab, the generated text can include different details and
even a different tone than what Text Enhance generates for the Sales Description field of the Sales/Pricing
subtab.
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Example

Text Enhance

Button Description 



Text Enhance

Text Enhance is:

Enabled by default, but can be disabled by users with an Administrator role.

Available for accounts located in the United States, Canada, and the United Kingdom.

Available for users whose language preference is set to English (U.S.), English (CA), and English
(UK), for accounts in supported locations.
Available for assisting with English language content only.

Available to any user with access to a page where Text Enhance is available (no additional
permissions are required).

On the page where Text Enhance is supported, complete the required fields. You can also add
additional details that you want Text Enhance to use into the field with Text Enhance.

The field with Text Enhance displays the Enhance Text 
available actions.
Select an action. Available actions may include one or more of the following:

button. Click the button to display the

■ Generate: Using information that you have already entered, Text Enhance generates text
appropriate for the field.
Clean Up: Text Enhance refines the existing text. This option corrects grammar and spelling
errors, and it may also rephrase some text to use effective style and tone. Only available when
there is text in the field.

■

Make Shorter: Text Enhance shortens the text. Only available when there are more than 200
characters (about three sentences) in the field.

Tip:A free learning path for Text Enhance is available on NetSuite MyLearn. Take the AI in
NetSuite learning path to learn about Artificial Intelligence (AI) in NetSuite and how to use Text
Enhance. You can also access the learning path from the NetSuite MyLearn home page: search for
AI and then choose AI in NetSuite from the search results.
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Note:

Using Text Enhance

1.

2.

3.

■
■
■

■
■

To Use Text Enhance:

■

https://mylearn.oracle.com/netsuite/learning-path/ai-in-netsuite/141401
https://mylearn.oracle.com/netsuite/learning-path/ai-in-netsuite/141401
https://mylearn.oracle.com/netsuite/home
https://mylearn.oracle.com/netsuite/home


Text Enhance

When enhancing text, keep in mind the following:

■ If you want to start over or remove the text, you need to clear the field manually. You can revert to the
original content by using Undo or by canceling out of the page.
If you choose another action from the Enhance Text menu, the text in the field will be replaced
completely. Use Undo or Redo to move between previously generated content.

■

The following table lists potential Text Enhance issues and their associated solutions:

      Make Longer: Text Enhance takes the text entered in the field and expands it into well-written
business prose. Only available when there is sufficient space in the field (less than half the field's
character limit).
Undo: Reverts the last Enhance Text action and changes the content to the field’s previous
content. To go back to an earlier result, choose Undo again, until you get back to the result you
want. Text Enhance stores its previous results while you are working on a page.

Redo: Restores the last Enhance Text action and changes the field's content to what it was
before you selected Undo.

■

■

Note:On first use, Text Enhance displays a confirmation message to inform you that you
are using an artificial intelligence (AI) feature. The message is as follows: "Text Enhance is
an AI feature that generates content for your use. Your data may be processed globally
according to the Oracle Services Privacy Policy." Click the link if you want to view the policy,
which opens in a new web browser tab or window. Click OK to close the message and
continue the Text Enhance action that you selected.

To complete an action, Text Enhance uses data from the required and optional fields that you have
already completed. The system displays the new or updated content in the field when the action
has finished.

Review the content carefully and refine it as desired. Optionally, you can click Enhance Text again
and select another action. You can also make your own changes manually and override any text
provided by Text Enhance.

Important:Always read the Enhance Text content carefully before you save your
changes to the page. Generative AI services, such as Text Enhance, use creativity in their
responses. A person should always validate the generated content for accuracy and quality.

When you are finished, click Save.
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4.

5.

Tips and Troubleshooting

You don't see the Enhance Text button next to
any text area fields, even after you type text into
the fields.

You can't select Generate from the Enhance Text
menu.

 Your NetSuite account location, the language setting in your
personal preferences, and your company's Text Enhance
Preferences setting all affect whether Text Enhance is available
for you. See the note at the beginning of the Using Text Enhance
section for Text Enhance availability information.

Generate is only available when the required fields on the page
are completed. Complete the required fields and try again.

Clean Up is only available when there is text in the field where
you are using Text Enhance. Add content to the field and try
again.

■

You can't select Clean Up from the Enhance Text
menu.

Issue Solution 

https://www.oracle.com/legal/privacy/services-privacy-policy.html
https://www.oracle.com/legal/privacy/services-privacy-policy.html


Text Enhance 68

You can't select Make Longer from the Enhance

Text menu. 

You can't select Make Shorter from the Enhance
Text menu. 

You can't select Undo from the Enhance Text
menu.

Issue Solution 

Make Longer is only available when there is sufficient space in
the field (less than half the field's character limit). Remove
some of the content from the field and try again

Make Shorter is only available when there are more than 200
characters (about three sentences) in the field where you are
using Text Enhance. Add more content to the field and try again

Undo is only available after you have already completed a
Generate, Clean Up, Make Longer, or Make Shorter action.

You can't select Redo from the Enhance Text
menu. 

Redo is only available after you have used the Undo action.

When you click the Enhance Text button, you
receive the message, "Sorry, text enhancing is
currently not available. Please check your
internet connection and try again. If the issue
persists, contact NetSuite Customer Support." 

This error may occur if you have an internet connection issue. It
may also occur if there is an issue with NetSuite or with the
generative AI service. If the issue persists, contact NetSuite
Customer Support. For more information, see NetSuite Support.

When you click the Enhance Text button, you
receive the message, "Enter the following fields
before enhancing text:" and a list of one or
more fields.

The fields required for Text Enhance are a subset of the
required fields on a page. Complete the required fields and try
again. 

When you click the Enhance Text button, you
receive the message, "The last request is still in
process. Please wait for it to finish. " 

You may see this message if you try another action while Text
Enhance is still processing the previous action you selected.
Wait until the field updates with the generated text, and then
try the action again if needed. 

When you click the Enhance Text button, you
receive the message, "Response has timed out.
Please try again." 

You may see this message if the generative AI service doesn't
respond to NetSuite within the allowed amount of time. Try the
action again. If the issue persists, contact NetSuite Customer
Support. For more information, see NetSuite Support.

When you click the Enhance Text button, you
receive the message, "Text Enhance is at
capacity. Please wait and try again." 

You may see this message when NetSuite is trying to handle
many requests for Enhance Text actions made at the same
time.

When you click the Enhance Text button, you
receive the message, "Monthly quota of Text
Enhance requests has been met." 

Your account has reached its monthly usage limit, so Text
Enhance will not be available until the next month. Users with
an Administrator role can verify account usage by viewing the
Text Enhance Preferences page. For more information, see the
help topic Setting Text Enhance Preferences.

https://td2958635.app.netsuite.com/app/help/helpcenter.nl?fid=article_1181703735.html&whence=
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This section contains information about the most basic way you can log in to the NetSuite UI, using your
email address and password, which are your user credentials. In this section, you will also find directions

Watch the following video for information about how to log in and out of NetSuite.

Logging In and Out of NetSuite

Authentication is the process of verifying your identity when you log in to an application. This section
contains procedures describing the ways that your identity can be authenticated when you log in to
NetSuite.

The most familiar form of authentication occurs when you log in to the NetSuite UI with your email
address and your password, which are your user credentials. Depending on the role or roles you are
assigned by your account administrator, you might also be required to provide a second factor for
authentication, known as two-factor authentication, or 2FA.
See the following sections for more information about how your identity is authenticated when you log in
to NetSuite.

■ Logging in to the NetSuite UI

This section contains the following topics:

□
□

□
□

□
□

□
□

Supported Browsers for NetSuite

Your User Credentials

Finding Your Settings Portlet

Change Email Link

Change Password Link

Setting Up Security Questions

Update Security Questions Link

If You Forget the Answers to Your Security Questions

Getting Access When You Forget Your Password

□ My Login Audit Portlet

■ Logging In Using Two-Factor Authentication (2FA)

This section contains the following topics:

□ Set up Your Preferences for Two-Factor Authentication (2FA)

▬

▬
▬

Complete Your 2FA Setup

Supported Authenticator Apps

Troubleshoot Authenticator Apps

□ Using 2FA

▬

▬
▬

▬

The Logging in Page for 2FA

Managing Your Trusted Devices

Reset Your 2FA Settings

Backup Codes for Two-Factor Authentication (2FA)

Logging in to NetSuite

Logging in to the NetSuite UI

□

https://videohub.oracle.com/media/Logging+In+and+Out+of+NetSuite/1_fvd7and3


Browser Versions Platform

NetSuite is supported in the following browsers and operating systems:

Logging in to the NetSuite UI

Important:This topic describes browser support only for the NetSuite application, which is
different from the browser support for Commerce websites. For more information, see the help
topic Supported Browsers for Commerce Websites.

 Cookies settings may affect the ability to use this browser when accessing SuiteAnswers. If you
encounter any issues, open your Safari browser, go to Safari > Preferences > Privacy and turn off the
Prevent cross-site tracking option. Then close your browser, reopen it, and access SuiteAnswers through
NetSuite.

for locating the Settings portlet, which contains links for changing your email address, changing your
password, updating your security questions, and other tasks. You can also find information about creating
strong passwords, answering security questions, and what to do if you forget your password.

See the following topics for more information:

■

■

■

■

■

■

■

■

Supported Browsers for NetSuite

Your User Credentials

Finding Your Settings Portlet

Change Email Link

Change Password Link

Setting Up Security Questions

Update Security Questions Link

If You Forget the Answers to Your Security Questions

Getting Access When You Forget Your Password

■ My Login Audit Portlet
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Supported Browsers for NetSuite

Browsers by Platform

■

Google Chrome Two most recent stable major versions. Windows 10 or newerMac OS 10.15 or
newer

Microsoft Edge 
(Chromium-based)

Two most recent stable major versions. Windows 10 or newer

Mozilla Firefox

Safari

Two most recent stable major
versions.The latest stable Extended
Support Release (ESR).

Windows 10 or newerMac OS 10.15 or
newer

Two most recent stable major versions. Two most recent stable major versions.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_160979742962.html#subsect_161229675996


Click  to verify that you are on the Home page, also called the dashboard.

There is a NetSuite app for mobile devices. For information about system requirements for mobile
devices, see the help topic System Requirements.

Most user interface actions are supported on touch screen devices. However, in rare cases you may
encounter minor issues.

Logging in to the NetSuite UI

Important:Some third-party plugins and extensions in web browsers may lead to problems
with the NetSuite user interface.

Use the links in the Settings portlet on your Home page to change your password and to perform other
setup and configuration tasks in NetSuite.

Note:Some ad blocker plug-ins can prevent you from creating pivot tables or charts in
SuiteAnalytics Workbook, regardless of the browser you use to access NetSuite. To avoid errors
with SuiteAnalytics Workbook, deactivate these plug-ins. For more information about SuiteAnalytics
Workbook, see the help topic SuiteAnalytics Workbook Overview.

The combination of your email address and your password are your user credentials for accessing
NetSuite. Your email address is considered, and often referred to, as your username in NetSuite.

If you have access to NetSuite accounts for more than one company, you can either use the same
username for all of them, or you can use a different username for each company.

■ If you use the same user credentials for all companies, all of your roles in all companies are listed on
the My Roles page and the Change Roles list. Hover over the upper right corner to display the Change
Roles list. The list displays your roles in the current account. You can select a different role from the
list, or select View My Roles to open the My Roles page. Click the name of the role name you want to
switch to. If the required role is in a different account, you must first switch to that account from the
My Roles page.
If you use separate user credentials for different companies, you must log out and then log in again to
switch to another company.

■

Important:You are uniquely identified in NetSuite by your email address, it is your username.
There is a one-to-one relationship between username and password. That is, one username can
only have one password, no matter how many accounts or companies you can access with that
username.

71

Mobile Devices

Touch Screen Device Support

Your User Credentials

Finding Your Settings Portlet

1.

To find your Settings portlet:

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_156518940453.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_1503949328.html


NetSuite Basics

Important:The Settings links you are looking for are not in the list that appears when
you hover over the Home icon.

The Settings portlet can appear anywhere on a customized Home page. By default, the Settings
portlet is located on the left side of the page. You might need to scroll down to see it.
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2.



Click the appropriate link for the task you need to complete.

For more information about these links, see the following topics:

■

■

■

■

■

Change Email Link

Change Password Link

Reset Your 2FA Settings

Backup Codes for Two-Factor Authentication (2FA)

Update Security Questions Link
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If you cannot find your Settings portlet, contact your account administrator.

The email address you use to log in to NetSuite is also used for email notifications and other
communications from administrators. You can use the Change Email link in the Settings portlet to
change your email address.

Important:Before you change your email address in NetSuite, verify that this change is OK
with your account administrator.

Find the Settings portlet on the Home page. If you cannot locate the Settings portlet, see Finding
Your Settings Portlet.

Tip:The Settings portlet can appear anywhere on a customized Home page (or
dashboard). By default, it is located on the left side, and you might need to scroll down to
see it.

2.

3.

Click Change Email.

In the Current Password field, enter the password you currently use to log in.

You must provide your password when you are changing your email address, to ensure the
security of your account.
Enter the new email address in the New Email Address field, and re-enter the same address in the
Confirm New Email field.
Check the Just This Account box to change your login information for only the account to which
you are currently logged in. This option only applies if you have access to multiple NetSuite
accounts.

If you clear this box, you can log in to all of your NetSuite accounts with the updated email address
you entered.

Click Save.

4.

5.

6.

After you have saved the change to your email address:

■

■

A notification message is sent to your current email address.

A validation message is sent to your new email address, with a link that you must click to complete the
change.

You must continue to use the current email address to log in to NetSuite, until you have clicked the
validation link to confirm the change.

■

The new email address is listed in the Pending Email Change field on the Change Email page, until
either you have clicked the validation link, or the link has expired.

The times in the notification and validation messages are based on the time zone preference that you
have set at Home > Set Preferences.
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Note:

Change Email Link

To change your email address:

1.

■



You can change your password using the Change Password link in the Settings portlet when you are
logged in to NetSuite. You must first enter the password you used to log in to your account, and then
enter a new password. You must provide your password to ensure the security of your account.

Important:If you receive a notification message about an email change that you did not
initiate, you should alert your account administrator to a possible security issue. If you receive a
notification message and you realize that the change is in error, for example you made a typo in
the new email address, you can let the validation link expire. You can then enter a change to the
correct email address.

Note:You will receive an email notification when the password associated with your email
address is changed. This email notification enables you to be more aware and proactive in
cases where there is a fraudulent attempt to change your password.

Tip:The Settings portlet can appear anywhere on a customized Home page (or
dashboard). By default, it is located on the left side, and you might need to scroll down to
see it.

Click Change Password.

In the Current Password field, enter the password you currently use to log in to NetSuite.

If you provide five consecutive wrong passwords, you are locked out of NetSuite for a period of 30
minutes.

Find the Settings portlet on the Home page. If you cannot locate the Settings portlet, see Finding
Your Settings Portlet.

Important:If you do not find the Change Password link in your Settings portlet check the
role you are currently logged in with. It is possible that the role does not have the permission
needed to change the password. Try switching to another role, or contact your Administrator.

How to Change Your Password

You can also reset your password if you are unable to log in because you forgot your password. For more
information, see Getting Access When You Forget Your Password.

Note:If you cannot remember your current password, see Getting Access When You
Forget Your Password.

In the New Password field, enter a new password.

As you type, the Password Criteria fields provide feedback, ensuring that the password you enter
meets the criteria shown. For more information, see Creating a Strong Password.

Re-enter the new password in the Confirm New Password field.

Click Save.

The next time you log in to NetSuite, you must use the new password.
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Change Password Link

To change your password:

1.

2.

3.

4.

5.

6.

7.

https://videohub.oracle.com/media/NetSuite+BasicsA+How+to+Change+Your+Password/1_flljb5a8
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Your NetSuite password will expire. The length of time that a password remains valid depends on the
password requirements configured by your account administrator. You can view the date and time your
password will expire in the My Login Audit portlet on your Home page.

Tip: After changing your password, refresh the portlet to see the new password expiry date.

You will receive advance notice of the date that your password will expire. This notice helps to eliminate
uncertainty and problems associated with having to change your password at an inconvenient time. The
first notice is sent 14 days before your password expiration date. As soon as you update your password,
the notices stop. If you do not change your password, the next notice arrives seven days before your

It is important to choose a password that cannot be compromised. Your password is validated to ensure it
meets minimum requirements. The validation is based on a combination of password settings that can be
modified by your account administrator and system requirements that cannot be modified.

Note:For information about how to change your password, see Change Password Link.

By default, all NetSuite accounts are set to have a Strong password policy. This policy enforces the
following requirements:

■ Minimum length of 10 characters
      At least 3 of the following 4 character types—uppercase letters, lowercase letters, numbers, non-

alphanumeric ASCII characters
No non-ASCII characters, which are considered illegal
Not something that someone could easily guess, such as common names, words, and strings like
abcd123456
Significantly different from your most recent password

■
■

■

The length and character type requirements for your password may vary if your account administrator
has changed the password policy or minimum password length. Ask your administrator if you have
questions about the password requirements for your company.

The Password Criteria fields provide immediate feedback as you type a password on the Change
Password page. This feedback shows you whether your entered password complies with all of the
password requirements for your company. The Password Criteria fields appear on any entity record where

it is possible for you or an administrator
to enter a password for granting access to your NetSuite account.
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Creating a Strong Password

Password Expiration Notifications

■



password expires. If necessary, you will receive an additional notice each day for the final three days
before your password expires.

The password expiration notification includes a link to let you change your password. A table lists the
Company ID, Company Name, Days to expiration, and account type helps you to identify the role and the
account where your password is expiring.

You can also use the Change Password link in the Settings portlet to change your password. For more
information, see:

■
■

Change Password Link

Finding Your Settings Portlet

Be aware of the following:

■ Users can have roles that provide access to more than one NetSuite account. It is possible that
some of the accounts to which a user has access have a stricter password requirements than other
accounts. On rare occasions, users may attempt to access a role in an account that has stricter
password requirements and encounter a password expired error message. For example, users
assigned to the NetSuite Support Center or the NetSuite Support Center (Basic) role are accessing the
Oracle NetSuite account through the NetSuite Account Center portlet. These users are then subject
to the Oracle NetSuite password requirements. In this case, users must change their password before
they can access the NetSuite Account Center.
You might be required to comply with Payment Card Industry Data Security Standard (PCI DSS)
password requirements. If you have a role with the View Unencrypted Credit Cards permission,
you must change your NetSuite password at least every ninety (90) days. If your company policy for
NetSuite password expiration is greater than 90 days, the 90 days limit is automatically enforced for
anyone with the View Unencrypted Credit Cards permission. In addition, the required length for a
password is a minimum of 12 characters. Everyone with access to unencrypted credit card numbers
must comply with PCI password requirements.

Roles to which the SAML Single Sign-on permission has been added, and roles that have been
designated as Single Sign-on Only, are exempt from password expiration notifications. SAML user
credentials are not managed by NetSuite, but by the Identity Provider (IdP).

■

■

Note:Users with multiple roles will receive the password expiration notification if one or
more roles are not designated as Single Sign-on Only. This also applies to roles deactivated on
the Role page.

The first time you log in to NetSuite, you are prompted to answer three security questions. These answers
are used to verify your identity if you forget your password, or if you log in from a new browser or a new
computer. This process helps to maintain application security by preventing unauthorized use of your
NetSuite user credentials.

If you are under time pressure, you can click Remind Me Later to dismiss this prompt and log in to
NetSuite immediately. However, the next time you log in to NetSuite, you will be prompted again to set up
these questions.

Note:You can dismiss this prompt a maximum of five times. After that, you will be required to
set up security questions to proceed with your login to NetSuite.

See the following sections for more information:

■ Set Up Security Questions Link
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Setting Up Security Questions
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Security Questions Details

See the following sections for details about security questions:

■
■

Requirements for Answers to Security Questions
Exemptions from Setting Up Security Questions

      When Security Questions are Asked

Requirements for Answers to Security Questions
If any of these requirements is not met, you will receive an error when you attempt to save security
answers.

■
■
■
■

You must answer all three questions.

Each answer must be unique.
Each answer must be at least three characters long.

You cannot use your email address or password as an answer.

Note:Answers are not case-sensitive.

If you log in to NetSuite with certain roles, or with certain types of access, you are exempted from the
requirement to set up security questions. The following roles are exempted:

■ Customer Center
Web Store Shopper

If you dismiss the prompt, then decide you would like to set up your security questions, click the Update
Security Questions link in the Settings portlet.

Tip:The Settings portlet can appear anywhere on a customized Home page (or dashboard). By
default, it is located on the left side, and you might need to scroll down to see it.

If you cannot locate the Settings portlet, see Finding Your Settings Portlet. See also Update Security
Questions Link for more information.

Important:Remember your questions and answers! NetSuite does not often prompt you to
answer a security question, you forget you set them up. However, there are several situations
when you will be prompted, and it is important that you know the answers. See When Security
Questions are Asked for more information.

When you save your security questions and answers, a confirmation is displayed. Also, an email is sent to
the email address you used to log in, as notification that this setup has occurred.
You have the option of changing your security questions and answers later. See Update Security
Questions Link.
Security questions and answers are shared across all NetSuite accounts associated with the same
production account.

■

Security Questions Details

Set Up Security Questions Link

Exemptions from Setting Up Security Questions

■

■
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Note:Users with two-factor authentication (2FA) roles, or roles with IP address restrictions
enabled are prompted to set up security questions. However, users with 2FA or IP address
restricted roles are only asked to answer security questions if they forget their passwords.

The following types of access are exempted:

      Web Services
      SuiteScript
■
■
■

SuiteAnalytics Connect
OpenID Connect (OIDC) Single Sign-on
SAML Single Sign-on

Find the Settings portlet on the Home page. If you cannot locate the Settings portlet, see Finding
Your Settings Portlet.

Tip:The Settings portlet can appear anywhere on a customized Home page (or
dashboard). By default, it is located on the left side, and you might need to scroll down to
see it.

Click Update Security Questions.

The first time you log in to NetSuite, you are prompted to set up three security questions that are used to
verify your identity, as described in Setting Up Security Questions. You have the option of changing these
questions and answers.

You are the only one who can update your security questions. If you cannot answer your security
questions, see If You Forget the Answers to Your Security Questions.

To change security questions and answers:

You will be prompted to answer a security question before you can log in to NetSuite in the following
circumstances:

    When you attempt to log in:

□
□
□
□

using a new browser
after the browser cache has been cleared
with the browser set to private mode (also called incognito browsing)
from a new or different computer

Note:This additional authentication requirement does not apply to you if you are using two-
factor authentication roles, or roles with IP address or device ID restrictions enabled.

      When you forget your NetSuite password, and must reset it.
■ If it has been more than 90 days since your last login.

If you answer the security question correctly, your login to NetSuite proceeds and an email is sent to the
email address you used to log in, as notification of the successful authentication.
If you provide five consecutive wrong answers to the security question, you are locked out of NetSuite for
a period of 30 minutes, and an email is sent to your email address and to your account administrator, as
notification of the authentication failure.

1.

2.

When Security Questions are Asked

Update Security Questions Link

■
■

■

■



Since you are not often prompted to respond to the security questions you set up, you may occasionally
forget your questions, or the answers you provided. The easiest way to handle this is when you are logged
in to NetSuite. Click the Update Security Questions link in the Settings portlet. Select new questions, or
provide answers to your existing questions. See Update Security Questions Link for details.

If you are attempting to log in to NetSuite and are prompted to answer a security question but cannot
remember the answer you gave, you might be required to reset your password or ask your account
administrator to do so.

If an account administrator resets your password, your previously saved security questions are erased
and you must set up these questions and answers again. If you reset your own password, the existing
security questions and answers are maintained.

Remember your answers! You will not often be prompted to answer a security question, so you may
forget that you set them up. If you do forget your answers, the following suggestions should help.

To deal with forgotten security questions:

Enter your current NetSuite password.
In the Question 1, Question 2 and Question 3 fields, select questions for which you can
remember the answers.
In the Answer 1, Answer 2, and Answer 3 fields, enter the answers to each question you selected.
You must answer all three questions.

■
■
■
■
■

Each answer must be unique.

Each answer must be at least three characters long.
You cannot use your email address or password as an answer.

Answers are not case-sensitive.
Answers are masked (hidden) by default. Clear the Hide Answers box to see the characters
without the mask.

Click Save.

You have five attempts when answering security questions during login. You have 20 attempts
when answering security questions during password reset. Try the most likely answers you would
have given.
If the first attempt does not succeed, try again. Keep trying the most logical answers to your
security questions.

Tip:Case does not matter, so do not waste an attempt by changing some characters to a
different case.

If you cannot reset your own password, and cannot remember your answers to security questions:
a.
b.

Update your security questions when you are already logged in to NetSuite.
Ask your account administrator to reset your password. If your account administrator
resets your password, your existing security questions and answers are erased. After your
password is reset, you must set up new security questions and answers. If you or your
account administrator cannot reset your password, your account administrator can contact
Support for assistance.
Ask your account administrator to designate your role as a two-factor authentication (2FA)
required role. Roles that are designated as requiring 2FA are never asked security questions.
For more information, see Logging In Using Two-Factor Authentication (2FA).

c.
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3.
4.

5.

6.

1.

2.

3.

If You Forget the Answers to Your Security Questions
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On the NetSuite login page, enter the email address you use to log in to NetSuite.

Use the following procedure when you cannot remember your password. Part of the password reset
process includes answering security questions to verify your identity.

Important:If you did not set up security questions or do not remember the answers to them,
you may need assistance to access your account. If this is the case, contact your NetSuite account
administrator to reset your password. When your Administrator resets your password, you must
set up new security questions and answers.

If you a need to change your password, use the Change Password link in the Settings portlet. For more
information, see Change Password Link. See also Finding Your Settings Portlet.

However, if you cannot remember your password, you can try to reset your password yourself. Go to the
NetSuite login page and click the Forgot Your Password? link. See the following procedure, The Forgot
Your Password Reset, for complete instructions.

Getting Access When You Forget Your Password

The Forgot Your Password Reset

To reset your password:

1.
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The My Login Audit portlet shows information about your login activity. You can add the My Login Audit
portlet to your dashboard. Use the portlet to monitor your previous successful login, your previous failed
login, the IP address associated with your login activity, the date when your password will expire, and other
login information.

      The My Login Audit Portlet cannot be added to the Customer Center or the Employee Center
dashboards.
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Click Forgot Your Password.

On the Reset Password page, enter the email address you use to log in to NetSuite, and click
Continue.
Follow the instructions displayed on the screen.

Check your email client for an email message with directions and a link for resetting your
password.

Note:The link will expire in 60 minutes.

a. If you do not receive an email message, verify whether the email address you entered in the
previous step is correct. (The email address you entered is displayed in the instructions on
the screen.)

If the email address you entered is correct, and you still have not received an email message,
please contact your NetSuite account administrator.

b.

Click the link in the email message.

Note:If you receive an error message that the link has expired, begin the password
resetprocess again at step 1.

Answer the security questions to confirm your identity. Answers are not case sensitive.

Important:You have 20 attempts to answer all three of your security questions
correctly. If you want the answers you enter to be visible on the screen, clear the check
from the Hide Answers box. If you fail all 20 attempts, contact your account administrator
for help.

Click Submit.

You are redirected to the Change Password page. Complete the required fields.

See Change Password Link for more information. See also Creating a Strong Password.

After you have successfully reset your password, a confirmation message is sent to the email
address from which the reset request was generated.

Note:If you have an Administrator role in this account, and are requesting a password
reset, the confirmation email message is also sent to everyone with an Administrator
role in that account. If you have an Administrator role in more than one account, and are
requesting a password reset, the confirmation email message is sent to everyone who has
an Administrator role in any of those accounts.

If you still need assistance to access your account, contact your NetSuite account administrator to
reset your password. When your password is reset, you must set up new security questions and
answers.

2.
3.

4.

5.

6.

7.
8.

My Login Audit Portlet

■



Password Updates tab – options: Last Password Change and Password Expiration.

The value shown for Successful Logins increments each time you switch roles. By switching to
another role, you are (in a sense) logging in to a different role.

The dates and times displayed in the portlet are based on the time zone you selected as your
preference on the General subtab at Home > Set Preferences.
If you are logged in and changed your password, refresh the portlet to display your new Password
Expiration date.

Click Personalize in the upper right corner of your dashboard or use Personalize Dashboard in
the Settings portlet.

In the Standard Content tab of the Personalize Dashboard palette, click or drag and drop the
My Login Audit icon.
To configure the login information displayed in the My Login Audit portlet, click Set Up in the
portlet menu.

Click the Set Up menu option in the My Login Audit portlet to open a window. Multiple tabs let you select
the type of information you want to see in the portlet.

■ Last Login tab - options include:

□
□

□
□

□
□

Last Login

Last Login Using Browser

IP Address of Last Login

Current Login Using Browser

IP Address of Current Login

Last Login Using Mobile Device

Last Login Using Web Service

Successful Logins tab - options for successful logins include: Today, This Week, This Month.

■ Login Failures tab - options: Last Login Failure, IP Address of Last Login Failure, and options for failed
logins include: Today, This Week, This Month.

Note:Entering an incorrect 2FA verification code is counted in the portlet as a Login Failure.
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■

■

■

■

1.

2.

3.

To add the My Login Audit portlet to your dashboard:

Choosing the Information Shown in the My Login Audit Portlet

□

■
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Mobile Devices tab – options for successful logins using mobile devices include: Today, This Week,
This Month.
Web Services tab – options for successful logins using SOAP web services include: Today, This Week,
This Month.

For more information about the options listed on each tab, refer to the field-level help.

Important:As of March 1, 2024, the support ended for 2FA by SMS/voice call.

If you still use SMS/voice call to receive your 2FA code, reset your 2FA settings as soon as possible.

For more information, see:

■
■

■

Reset Your 2FA Settings

Supported Authenticator Apps

Backup Codes for Two-Factor Authentication (2FA)

2FA Setup for Users

Requiring a second factor for authentication is a method of improving security. Your administrator can
assign you a role that requires 2FA authentication. You will receive an email the first time you attempt to
log in to your 2FA role. The email contains instructions and a verification code for your initial login to that
role. The next time you log into a 2FA require role, you will be prompted to set up your 2A preferences in
NetSuite. Use an authenticator app to generate the verification codes necessary during login. While your
session remains valid, you will not be asked again for a verification code when you switch between roles,
even when you switch between roles in different companies.

If you are assigned a role that requires 2FA authentication, you must set up an authenticator application
in NetSuite.

Note:You must complete the initial 2FA setup in the NetSuite UI on your computer. You can log
in using 2FA with the NetSuite Mobile application. However, it is not possible to perform the initial
2FA setup from the mobile app.

For more information about setting up 2FA in NetSuite, see:

■ Set up Your Preferences for Two-Factor Authentication (2FA)

□
□
□

Complete Your 2FA Setup

Supported Authenticator Apps
Troubleshoot Authenticator Apps

Important:If you lose your phone, buy a new phone, change your authenticator app, you must
reset (clear) your 2FA settings in NetSuite. See Reset Your 2FA Settings. After resetting, you will
start the 2FA setup process again.

To log in with a role that requires 2FA, you must first enter your email address and password on the
NetSuite login page, and click Log In. After that step is successful, you are prompted for a verification
code. For more information about using 2FA in NetSuite, see:
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■

■

https://videohub.oracle.com/media/2FA+Setup+for+Users/1_45uvcfhf


Using 2FA

The Logging in Page for 2FA

Managing Your Trusted Devices

Reset Your 2FA Settings

Backup Codes for Two-Factor Authentication (2FA)

Logging In Using Two-Factor Authentication (2FA)

Authenticator apps for generating 2FA verification codes are supported in all NetSuite accounts.
Authenticator apps can generate a verification code even without a cell service. For more information
about selecting an authenticator app, see Supported Authenticator Apps.

Important:If you want to change your 2FA preferences, you must reset your 2FA settings. For
more information, see Reset Your 2FA Settings. This includes changing a device used for 2FA, or
changing your authenticator app.

For more information, see the following topics:

■

■

■

Complete Your 2FA Setup

Supported Authenticator Apps

Troubleshoot Authenticator Apps

The first time you log in to NetSuite with a 2FA required role, you are automatically shown the Security
setup page. If you do not see the Security setup page, you might not be logged in to NetSuite with a role

Important:As of March 1, 2024, the support ended for 2FA by SMS/voice call.

If you still use SMS/voice call to receive your 2FA code, reset your 2FA settings as soon as possible.

For more information, see:

■
■

■
■

Logging In Using Two-Factor Authentication (2FA)

Supported Authenticator Apps

Reset Your 2FA Settings

Backup Codes for Two-Factor Authentication (2FA)

You can skip the prompt to set up 2FA five times before you are required to select an authentication
method and set up your authenticator app. Ten backup codes are generated when you complete the
security setup page.

When using an authenticator app for 2FA, you must enter the verification code obtained from the app to
complete the setup.
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■

□

□

□

□

Set up Your Preferences for Two-Factor Authentication
(2FA)

Complete Your 2FA Setup



When you have installed the authenticator app, click Next.

As of March 1, 2024, the support ended for 2FA by SMS/voice call.

Logging In Using Two-Factor Authentication (2FA)

that requires 2FA. Switch roles to a role that is 2FA required. If you do not know whether you have a role
that requires 2FA, ask your Administrator.

Install an authenticator app on your phone if you have not done so. See Supported Authenticator
Apps. Authenticator apps for generating 2FA verification codes are supported in all NetSuite
accounts.

Note:You must complete the initial 2FA setup in the NetSuite UI on your computer. You
can log in using 2FA with the NetSuite Mobile application. However, it is not possible to
perform the initial 2FA setup from the mobile app.

Important:If you have entered several codes in a row that have been refused,
do not keep trying codes from your app. After five failed attempts, you will
lock yourself out of NetSuite. If the time on your phone or app is not properly
synchronized, NetSuite will not accept the verification codes generated by your app.
See Troubleshoot Authenticator Apps for potential solutions.

Click Next.

Note:You can click Skip to NetSuite to dismiss this prompt up to five times After the
fifth time, you are required to set up an authenticator app or your phone number.

Using the authenticator app on your phone:

a. Scan the QR code displayed, or manually enter the string of characters shown next to the QR
code.

The authenticator app generates a verification code.

Enter the verification code.

Verification codes generated by authenticator apps expire approximately every 30 seconds.
Enter a new code if the initial code you receive expires.

b.
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Important:

To complete your 2FA setup:

1.

2.

c.
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Click Print to print the backup codes, if needed.

Important:Treat backup codes as securely as you would treat a password. This is the
only time these unique ten codes are displayed in the UI. You cannot retrieve these from
the system after you close this window. If you lose these backup codes, you can generate
new ones.

Ten backup codes are displayed in the UI.

These unique backup codes can be used to log in to a 2FA role when you are unable to receive a
verification code. Each backup code can be used only a single time.

Important:Planning a trip to a location where you do not have phone service?
Authenticator apps provide a verification code even when you have no cell service. What if
you do not want to turn on your phone at all? You should also take your back up codes with
you. Keep your backup codes secure. Do not store your backup codes with the device you
use to log in to NetSuite.

Click Next.

3.

4.

5.



to NetSuite.

Logging In Using Two-Factor Authentication (2FA)

You should use an authenticator application for roles that require 2FA. You can select an authenticator
app from the vendor of your choice, as long it complies with the OATH TOTP standard. The following
mobile phone apps are suggested:

■

■

■

■

Oracle Mobile Authenticator

Google Authenticator

Microsoft Authenticator

OKTA Verify

Download the appropriate authenticator app for your device to get started.

After your 2FA setup is complete, the Reset 2FA Settings and Generate Backup Code links appear in
your Settings portlet. If you cannot locate the Settings portlet, see Finding Your Settings Portlet. If you
do not see the links as expected, refresh your browser.

For more information, see the following topics:

■

■

Supported Authenticator Apps

Troubleshoot Authenticator Apps

Important:If you have entered several codes in a row that have been refused, do not keep
trying codes from your app. After five failed attempts, you will lock yourself out of NetSuite.

If you need access to NetSuite right away, change the method by which you will receive the next code to
backup codes.

Do not install the authenticator app on the same device that you use for logging in

Note:The authentication application you choose must support the OATH TOTP, the IETF RFC
6238 standard. OATH is the Initiative For Open Authentication. TOTP means time-based one-time
password. IETF is the Internet Engineering Task Force.

For more information, see the following topics:

■

■

Complete Your 2FA Setup

Troubleshoot Authenticator Apps

If you lost your device, buy a new one, or change your authenticator app, you must reset (clear) your 2FA
settings in NetSuite. See Reset Your 2FA Settings. See also If You Lost or Replaced the Phone You Use for
2FA

Occasionally, NetSuite will not accept verification codes generated by your authenticator app. You may get
an error message that the code is expired. If your phone (and perhaps your app) are not synchronized to
the proper time source, your verification codes will not work.
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Supported Authenticator Apps

Troubleshoot Authenticator Apps

Important:



Use the following procedures to verify settings on your phone and on your authenticator app.

Go to Settings on your phone. Locate the settings for date and time.

The navigation path to the date and time settings, and the exact name of the settings varies
depending on the type of phone you have (Apple or Android) and the version of the operating
system (OS) software on your phone.

If you have an iPhone, go to Settings > General > Date & Time. Verify that the switch for the setting
Set Automatically is on.
If you have an Android, go to Settings > System > Date & Time. Verify that the switch for the
settings Automatic date & time and Automatic time zone is on.
Older software versions on some phones might have a sync time to server setting. Clear the box
if the sync time to server setting is checked. Verify that the time on your phone is synchronized to
network time.

The Google Authenticator app has an internal time sync setting, Time correction for codes. If the time is
not correctly synchronized, the verification codes will not work. A Google Support site, Common issues
with 2–Step Verification, details the steps for correcting the time in the app. Scroll down to the bottom of
the page to the My Google Authenticator codes aren’t working (Android) entry.

If synchronizing time does not help you, try resetting your 2FA.

For more information, see the following topics:

■

■

Complete Your 2FA Setup

Supported Authenticator Apps

Important:If you cannot reset your log in using 2FA, and you cannot reset your 2FA settings,
contact your Administrator.

Authenticator apps for generating 2FA verification codes are supported in all NetSuite accounts.

Important:As of March 1, 2024, the support ended for 2FA by SMS/voice call.

If you still use SMS/voice call to receive your 2FA code, reset your 2FA settings as soon as possible.

After completing the initial 2FA setup, see the following topics about using 2FA in NetSuite:

■

■
■

■
■

■

The Logging in Page for 2FA

Managing Your Trusted Devices

Backup Codes for Two-Factor Authentication (2FA)

Reset Your 2FA Settings

If You Lost or Replaced the Phone You Use for 2FA

Set up Your Preferences for Two-Factor Authentication (2FA)
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To synchronize time on your phone:

1.

2.

3.

4.

To synchronize time on your Google Authenticator app:

Using 2FA

https://support.google.com/accounts/answer/185834?hl=en&ref_topic=2954345
https://support.google.com/accounts/answer/185834?hl=en&ref_topic=2954345


See the following procedure for detailed instructions on how to make a device trusted during a login.
To mark a device as trusted when logging in:

Log in with a role that requires 2FA. Enter your email address and password on the NetSuite login
page, and click Log In.

When you are providing a verification code for logging in to NetSuite, take notice of the Trust this
device... text on the Logging in to... page. The text specifies the length of time that a device can be
trusted. The length of time is configured by your administrator for your 2FA role. If you use this device
often to log in, you should check the box to the left of the text. Checking this box means you will not have
to provide another verification code for the period of time that your administrator specified for this role.
This trusted device time period can range from hours to days.

You can always remove the trust from this device, or from all of your devices, if needed. For example, if
you lose or replace a device, you should remove the trusted status from that device. You can also restore
the 2FA challenge for devices at any time. You have complete control over the management of your
devices.

When your sandbox is refreshed, roles that require 2FA authentication are copied from your production
account to your sandbox. Your 2FA setup is also copied to your sandbox account. No additional 2FA setup
is necessary.

Important:After you set up your 2FA preferences, you may want to change them. For
example, you may want to change your authenticator app. Or you might have lost your
phone, or bought a new one. To change your preferences, you must first reset (or clear)
your 2FA settings in NetSuite. See Reset Your 2FA Settings. After the reset is completed,
you must start the 2FA setup process from the beginning.

If your administrator designated one or more of your roles as 2FA authentication required, you can
use an authenticator app to obtain a verification code, or use one of your backup codes. For more
information, see Logging In Using Two-Factor Authentication (2FA).

■ You can decide whether you want to check the Trust this device box. For more information about this
box, see Managing Your Trusted Devices.
You can click the link to select backup codes for this log in attempt.

Your other roles are listed on the page. You can select an alternative role by clicking Choose to the
right of the role.

■
■

Important:After you set up your 2FA preferences, you may want to change them. For
example, you may want to change your authenticator app. Or you might have lost your
phone, or bought a new one. To change your preferences, you must first reset (or clear)
your 2FA settings in NetSuite. See Reset Your 2FA Settings. After the reset is completed,
you must start the 2FA setup process from the beginning.
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The Logging in Page for 2FA

Managing Your Trusted Devices

2FA Access to Sandbox Accounts

1.

Marking a Device as Trusted When Logging in



After that step is successful, you are prompted for a verification code.

On the Logging in to ... page, enter the verification code.

Check the Trust this device for ... box, if needed.

Click Submit.

Find the Settings portlet on your Home page.

If you cannot locate the Settings portlet, see Finding Your Settings Portlet.

Click the Generate Backup Codes link.

Enter your password. You might also need to enter a verification code or backup code.

See the following procedure for detailed instructions on how to manage devices marked as trusted.

Note:You might have access to NetSuite accounts for more than one company. Marking a
device as trusted for a 2FA authentication required role makes that device trusted across all of the
companies to which you have access.

Backup codes are provided when you successfully complete setup of your 2FA preferences in NetSuite.

Important:Planning a trip to a location where you do not have phone service? Authenticator
apps can provide a verification code even when you have no cell service. What if you do not want
to turn on your phone at all? You should also take your back up codes with you. Keep your backup
codes secure. Do not store them with the device you use to log in to NetSuite.

These codes are associated with your email address and are unique. You are the only person who can use
these codes. A backup code is used for verification on login. Each code can be used only one time. You
can generate new backup codes as needed. Backup codes do not expire, however, if you generate a new
set of backup codes, the previous set of your codes is no longer valid.
You can generate ten new backup codes if you use all your existing backup codes, or if you lose them, or
if you feel your existing codes may have been compromised. Generating new backup codes invalidates
your previous codes.

Find the Settings portlet on your Home page. If you cannot locate the Settings portlet, see Finding
Your Settings Portlet.

Click Manage Trusted Devices.

In this example, you had previously marked a device as trusted upon login. Now you have changed
your mind.

To reverse your earlier choice, select one of the Restore 2FA ... options.

Remember that when the 2FA challenge is restored for a device, the next time you log in, you must
have your authenticator app, or one of your backup codes available.
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2.
3.
4.

1.

2.

3.

1.

2.
3.

Managing Devices Marked as Trusted

To generate backup codes:

To manage trust for your devices:

Backup Codes for Two-Factor Authentication (2FA)
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You need to reset (clear) your 2FA settings in NetSuite if you:

■
■

■

Change your authenticator app.

Lose your phone.

Buy a new phone.

When you reset your 2FA settings, you remove your existing 2FA setup information from NetSuite.

Important:The Reset 2FA Settings link only clears your existing 2FA settings from
NetSuite. You will not be able to set up your 2FA preferences again until the next time you
attempt to access NetSuite with a 2FA-required role. In this case, you receive a verification
code by email. Enter the code and click Submit. You are prompted to set up your 2FA
preferences in NetSuite. See Set up Your Preferences for Two-Factor Authentication (2FA).

You can reset your 2FA settings from the Settings portlet on your Home page (Dashboard) by using the
Reset 2FA Settings link.

Warning:Before you start with the reset process, make sure you have either a device that
can generate a verification code, or a backup code. If you did not face the 2FA challenge
during login phase of this NetSuite session, you will be asked to provide a verification code
or backup code to finish the reset.

Find the Settings portlet on your Home page. If you cannot locate the Settings portlet, see Finding
Your Settings Portlet.

Click Reset 2FA Settings.

4. Click Generate.

Ten backup codes are displayed.

Important:This is the only time these unique ten codes are displayed in the UI.
You cannot retrieve these codes from the system after you leave this window. If
you lose these backup codes, generate new ones. Use the link in the Settings
portlet. You may need a backup code if, for example, you must set up a different
phone. For more information, see Reset Your 2FA Settings.

5. Click the printer icon to print the backup codes, if needed.

Important:Treat backup codes as securely as you would treat a password. Do not store
your codes with the device you use to log in to NetSuite.

6. Click Continue to return to the NetSuite UI.

Each time you use one of your backup codes, you receive an email notification that one of your codes was
used.

Important:If you lose your phone, buy a new phone, or change your authenticator app,
you must reset (clear) your 2FA settings in NetSuite. See Reset Your 2FA Settings. After
the reset is completed, you must start the 2FA setup process from the beginning.
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1.

2.

Reset Your 2FA Settings

To reset your 2FA settings:



Note:If you do not see the Reset 2FA Settings link on your Settings portlet, it indicates
that you have already reset (cleared) your 2FA settings from NetSuite. The next time you
log in to NetSuite with a 2FA-required role, you will be prompted to set up your 2FA
preferences in NetSuite. See Set up Your Preferences for Two-Factor Authentication (2FA).

On the Reset 2FA Settings page, enter your NetSuite password. You might also need to enter a
verification code or backup code.
Click Reset.

When you click Reset, you remove your existing 2FA setup information. A confirmation screen
states that your registered 2FA devices were successfully reset. You also receive an email
notification from NetSuite that your registered 2FA devices have been reset, and can no longer be
used to access your NetSuite account.

The next time you attempt to access NetSuite with a 2FA-required role, you receive a verification
code by email. Enter the code and click Submit, and you are prompted to set up your 2FA
preferences in NetSuite. See Set up Your Preferences for Two-Factor Authentication (2FA).

Note:If you are not able to log in to NetSuite to reset your 2FA settings, contact your
account administrator for assistance.

Click the Reset 2FA Settings link in the Settings portlet. See Reset Your 2FA Settings. You may be
required to enter a backup code to complete the reset. A backup code is required if you are logged in
from a device that is not a trusted device in NetSuite. For more information about trusted devices, see
Managing Your Trusted Devices.

Note:If you cannot locate your Settings portlet, see Finding Your Settings Portlet.

Log out of NetSuite.

Important:As of March 1, 2024, the support ended for 2FA by SMS/voice call.

If you still use SMS/voice call to receive your 2FA code, reset your 2FA settings as soon as possible.

If you have a 2FA-required role in NetSuite, you may be using a phone to obtain verification codes. If you
lost your phone, or purchase a new phone, you must clear the settings (the setup information) of your old
phone from NetSuite. After resetting your 2FA settings, you must set up your 2FA preferences in NetSuite
again. Even if your phone number remains the same, you may not be able to transfer an authenticator
app from one phone to another. You must set up your 2FA preferences in NetSuite again and install and
configure an authentication app on your new phone.

Important:If you lost your phone, you should remove the phone’s 2FA settings from
NetSuite as soon as possible. You may need to contact an Administrator of your NetSuite
account for assistance. An Administrator can use the User Access Reset Tool to help you
if you are not able to log in to NetSuite.

Before you begin, verify that you have a current backup code available. If you cannot locate your current
backup codes, and you are able to log in to NetSuite, generate a new set of backup codes. See Backup
Codes for Two-Factor Authentication (2FA). If you cannot log in to NetSuite, contact your Administrator.
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3.

4.

1.

2.

If You Lost or Replaced the Phone You Use for 2FA

To change your 2FA phone setup in NetSuite:
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Log in to NetSuite with a 2FA-required role. You are prompted to set up your 2FA preferences
before you can access NetSuite. See Set up Your Preferences for Two-Factor Authentication (2FA). A
video about 2FA setup is also available: 2FA Setup for Users.

Follow the on-screen prompts to finish the setup process for obtaining verification codes. See
Complete Your 2FA Setup.
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3.

4.

https://videohub.oracle.com/media/2FA+Setup+for+Users/1_45uvcfhf


Logging out of NetSuite

For security reasons, you should log out of NetSuite manually. To do this, hover over your name in the top
right corner and choose Log Out from the dropdown list:

After a period of no activity in the UI, you are automatically logged out of NetSuite. The default session
timeout value is 180 minutes.
An Administrator can configure a custom session timeout. For more information, see the help topic User
Interface (UI) Sessions.
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Setting Personal Preferences

Setting up Your NetSuite Preferences

This section of NetSuite Basics describes the preferences that are available to you as a NetSuite user.
The Set Preferences page displays options for most aspects of your NetSuite account. These preferences
enable you to set up your NetSuite account to fit your needs. Your user preferences are constrained
by the features enabled for your account, company account-level preferences, and the role-based
dashboards that are set up by your account administrator.

Note:Your password is not a personal preference, it is a setting in NetSuite. If you want to
change your password, see Change Password Link. See also Finding Your Settings Portlet.

These preferences are specific to your NetSuite role. If you have multiple roles in NetSuite, the
preferences you set in one role usually do not affect your other NetSuite roles. For example, changing
the preference for date format does affect all of your roles. However, changing the color for the NetSuite
application only affects the role where you set the preference. The preferences you set do not apply to
other NetSuite users even if they are assigned the same role as you are.

Your account administrator can set preferences that may apply to you by default. The preferences your
administrator sets can be for all users logging in with a role, for all users in a company, or if you are using
NetSuite OneWorld, for all users in a subsidiary. See the help topic NetSuite Preference Levels Overview.
However, the personal preferences you set normally take precedence over these other preferences set
for a role, subsidiary, or company.

To set your personal preferences:

In the General subtab, you can set such preferences as a nickname, language, date and time formatting,
warnings and notifications, and other.

Go to Home > Set Preferences. The General subtab is displayed by default. On this subtab you can set the
preferences in the following table.

1.
2.
3.

Go to Home > Set Preferences.
Click a subtab on the Set Preferences page to edit your preferences for a specific area of NetSuite.
When you are finished setting preferences, click Save.
You can set preferences on multiple subtabs before you click Save.
Your changes appear on the next transaction, or record you enter, or the next time you visit a page
in NetSuite.

The topics listed below describe the options available on each subtab of the Set Preferences page:

■
■
■
■
■

General Personal Preferences
Personal Preferences for Appearance
Personal Preferences for Transactions
Analytics Personal Preferences
Personal Preferences for Activities
Also see Setting Calendar Preferences.
Personal Preferences for Alerts
Personal Preferences for Telephony
Personal Preferences for Restricting Views

■
■
■
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■

https://videohub.oracle.com/media/Setting+up+Your+NetSuite+Preferences/1_unlrzpsv
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General Personal Preferences

The following fields are available, based on the features in your NetSuite account, and the permissions
associated with your NetSuite role.
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Signature

Field Name

User Profile

Nickname

 Language

Search Sorting

From Email Address

Language of the Help
Center

Function

Add Signature to
Messages  

If your signature is already included the in the fax or email template
you are using, your signature will not added twice.

Select the language for your NetSuite account. For more information, see Choosing a
Language for Your NetSuite User Interface.

Select the alphabetical order to use for search results.

■ Language Specific – the alphabetical order specific to your NetSuite language
settings.
English (U.S.) – the U.S. English alphabetical order.■

Select the language for the NetSuite Help Center. Supported languages are English,
German, Japanese, and Spanish.

Note: The HTML must be formatted correctly, including line breaks, hyperlinks,
character formatting such as Bold, and any other special formatting. If the
signature is not correctly formatted, it will not display properly. For an example,
see Customizing Email Signatures and From Fields.

You can also set this preference directly from the NetSuite Help
Center using the dropdown list at the top right corner of the page. For more
information, see Using the Help Center Window.

Whether you select the language preference directly in the Help Center or from Home >
Set Preferences, the preference is maintained until you change it.

Enter the name that you want to appear in the From field of email messages you send from
NetSuite. For example, you can send an email message by clicking the Email subtab on
your employee record.

You can choose a different language for the Help Center than the
language you specify for the User Interface.

Your preference is used the next time you open the Help Center, and this preference is
maintained until you change it. For more information, see Choosing a Language for Your
NetSuite User Interface.

Note:

Note:

Note:

Enter the email address you want shown as the From address in email you send through
the system. Replies to this email are sent to this email address as well. If you do not enter
an email address here, email you send will show your login email address. 

Enter a signature (in HTML markup) you want to appear at the end of email you send from
NetSuite.

messages you send.
 Check this box if you want your signature automatically added to all fax and email

Localization



General Personal Preferences 98

Time Zone

Formatting

Date Format

Field Name

PDF Language

First Day of Week

Calendar System

Use Furigana Field

Long Date Format

Accounting Context

Select the day that you want to start your week on.

Select the date format for all of your NetSuite roles.

If you change the date format, all of the roles associated with your
email and password are affected.

 Select how to display the month, day and year in NetSuite.

Some reports in NetSuite recognize only Sunday as the first day of the
week, regardless of the day you select for this preference.

If you change the time zone, all of the roles associated with your email
and password are affected.

A calendar preference is only available when you select Japanese as the Language
preference.

Select the calendar to use within NetSuite.

■ Gregorian Calendar - This is the default calendar. It is the internationally accepted
civil calendar.

       Japanese Imperial Calendar - This is a specialized Japanese calendar. The imperial
date format is required for some government documents and applications used in
Japan.

The Furigana field is only available on records in the NetSuite Japan edition when you
select Japanese as the Language preference.
Check this box if you want to sort lists of records by the Furigana field.

Function 

This option is no longer used. To print your reports in a different language, change your
NetSuite language in the Language field.

Note:

Note:

Note:

If you have a OneWorld account and one accounting context is defined at Setup >
Company > General Preferences., this dropdown list appears.
An accounting context can be a one-to-one relationship between a country’s local
GAAP (Generally Accepted Accounting Principles) reporting requirements and a
statutory chart of accounts (COA). It can also be a unique relationship that meets
your company’s specific needs. Accounting contexts are useful when you prefer to
work in a local GAAP context, rather than in the consolidated context with one
centralized COA. When you select an accounting context from this dropdown list, all
transactions including system-generated transactions post to the defined COA
account name and number. This field is blank by default. When blank, all transactions
including system-generated transactions post to the consolidated accounts across
all subsidiaries.

Select the time zone where you work. Time zone names are in IANA/Olson Value
format and follow daylight savings time rules for each time zone. Note that the
displayed GMT offset value does not reflect daylight saving changes that are
applied by the system and may be ongoing.

■

For more information, see the help topic Date Formats.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N249143.html
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Field Name

Time Format

Number Format

Auto Place Decimal

Phone Number Format

Negative Number Format

Function

If you change the time format, all of the roles associated with your
email and password are affected.

If you change the Long Date Format, all of the roles associated with
your email and password are affected.

For more information, see the help topic Date Formats.

Select an option for how time displays in your NetSuite account.

Select an option to display phone numbers in your NetSuite account. This phone
number format is used on all online forms that you print.

This setting only applies to seven and ten digit phone numbers.

Check this box to insert a decimal point between the second and third digit from the
right when you enter numbers.
When you first start using NetSuite, this preference is activated.

Clear this box if you are using the Software Verticals Contract
Renewals module. Enabling this preference may cause unwanted updates to
transaction amounts calculated by Contract Renewals transaction processing.
For more information, see the help topic Setting Up Contract Renewals
Preferences.

If you change the Negative Number Format, all of the roles associated
with your email and password are affected.

If you change the Number Format, all of the roles associated with your
email and password are affected.

CSV Column Delimiter Select the symbol to be used as the default column separator when importing data from
CSV files. For more information, see the help topic Setting CSV Import Preferences.

Select whether you want to use a period or a comma as the default decimal mark in
numbers in the CSV files you import. For more information, see the help topic Setting
CSV Import Preferences.

CSV Decimal Delimiter

Defaults 

Use Multicurrency 
Expense Reports reports to enable use of foreign currencies by default.

When this option is enabled, the Use Multi Currency box on Expense Report transactions
is checked by default.
Check this box if you use PDF forms and save them as files.

Clear the box if you use HTML forms, or if you print PDF forms without saving them as
files.

Download PDF Files

Select the format to display negative numbers online for transaction forms, entity forms,
and search results. For more information, see the help topic Number Formats.

Select the format to display numbers online for transaction forms and entity forms for all
of your NetSuite roles. For more information, see the help topic Number Formats.

Note:

Note:

Note:

Note:

Important:

 accounts with the Multiple Currencies feature enabled, check this box for expense

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N249143.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N249143.html
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https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N355760.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N355760.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N355760.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N355760.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N355760.html
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Only Show Last
Subaccount

Show Internal IDs

Field Name 

Only Show Last Subentity

Select a service for generating maps for addresses on forms and records. You can click
the Map icon next to an address on a form or record to see the map.
For more information, see Mapping Addresses on Records and Transactions. Check this

box to be able to view the internal IDs for fields and records in the NetSuite
application.

The Show Internal IDs field is only available when at least one of
the following features is enabled in your account: Client SuiteScript, Server
SuiteScript, SuiteScript Server Pages, SuiteFlow, or Web Services (on the
SuiteCloud tab) or Advanced Site Customization or SuiteCommerce Advanced
(on the Web Presence tab). For more information, see the help topic Enabling
Features.

SOAP web services and SuiteScript code need to reference internal IDs to uniquely
identify objects, so you should enable this preference whenever you are working with
SOAP web services or SuiteScript.

When this preference is enabled:

■ You can view the internal ID for a field by clicking on that field's label to open the field
level help popup window. The internal ID is displayed in the lower right corner of this
window.

You can view the internal ID for a record or a custom field in an Internal ID column
that displays on a list or search results page for that type of record or custom field.

■

Check this box to indent subaccounts in list fields on transactions and forms.
For example, with the box checked, subaccounts appear indented under the parent
account:
Parent account
Subaccount 1
Subaccount 2
With the box cleared, subaccount names include the parent name:
Parent account
Parent account: Subaccount 1
Parent account: Subaccount 2 

Note:

Check this box to indent subrecords in dropdown lists on transactions and forms. This
applies to relationship records, such as customers, partners and leads.
For example:
Parent customer
Subcustomer 1
Subcustomer 2
When the box is cleared, subentity record names include the parent name:
Parent customer
Parent customer: Subcustomer 1
Parent customer: Subcustomer 2

Function 

Address Mapping Type

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N232138.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N232138.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N232138.html
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Field Name

Only Show Last Subitem

Messages

"Save Changes” Warnings

Notify Me Upon Issue
Assignment

Show Notification When AI
Feature Is Used

Function

Check this box to show only subitems and omit parent items in dropdown lists on
transactions and forms.

For example:

Subitem 1

Subitem 2

When the box is cleared, subitem names include the parent name:

Parent item

Parent item: Subitem 1

Parent item: Subitem 2

When records display in popup lists, subentity names always include
the parent name.

If you set issue notification preferences through the Customer Center,
these return to company default settings if your Customer Center access is
suspended.

When records display in popup lists, subitem names always include the
parent name.

Check this box to see a warning when you are about to leave a page before submitting
the transaction you were working on.

Limit CC Field to Contacts
 &   Employees

Select one of the following options to be notified at your login email address when an
issue you have submitted or edited changes:

■   Never – Select this option if you do not want to receive any email notifications about
changes to issue statuses.
  On Any Change – Receive an email every time someone edits the issue record.
  When Base Status is Open – Receive an email when the issue status changes to a

■

base status of Open.
When Base Status is On Hold – Receive an email when the issue status changes to a
base status of On Hold.

When Base Status is Resolved – Receive an email when the issue status changes to
a base status of Resolved.

When Base Status is Closed – Receive an email when the issue status changes to a
base status of Closed.

Check this box to receive a notification at your login email address when an issue is
assigned to you.

Clear this box to stop showing the AI confirmation message when you use Text Enhance.
This box is checked by default.

Note:

Note:

Note:

■

■

■

■

Default Issue Email
Notification

 Check this box so that email messages are only copied to contacts or employees.
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Field Name

Allow Favorites in
Dropdowns

Maximum Entries in
Dropdowns

Number of Rows in List
Segments

Require Exact Match on
Item Type-Ahead

Optimizing NetSuite

Delay Loading of Sublists

Type-Ahead On List Fields

Setting this preference improves page-load times.

Setting the list segment to 25 or less improves page-load times.

Function 

Check this box to delay loading information about subtabs until you click the specific
subtab.

Setting the maximum entries to 25 or less improves page-load times.

The Case/Task/Event field for time transactions is displayed as a
dropdown list only if the sum of all company-wide case, task, and event records
is less than 5000 and less than the number entered here. Roles that can enter
time transactions on behalf of other employees will always have a pop-up field
displayed.

You can select up to five favorite items in the Customer, Add Multiple, and Items fields on
sales orders. In the Add Multiple field, you can show only your favorite items by selecting
the Show favorites only box.

To mark an item as a favorite, click the star icon next to the item name in the dropdown
list.
Favorites are associated with your personal preferences and are specific to your
NetSuite account and role.

Enter a number beyond which a dropdown list becomes a popup list. When the list
reaches the maximum you set here, the list displays in a pop up window.

Be aware that the number you place here is a guideline. If the list of values displayed for
a field is dynamic, a popup may be used even for a smaller number of values. The use of
a popup is especially likely for any custom field with values sourced from a dynamic list
because the size of the list could sometimes be above the maximum.

Enter the maximum number of records to display in each segment.

For example, if you have 200 customers, then enter 25 in this field to see them in groups
of 25 per page.
To go through the list of results, select from the dropdown list or use the previous and
next arrows on the toolbar.
You can alter this amount of higher or lower depending on your visual and scrolling
preferences.

Note:

Note:

Note:

Note:

You can also turn off this preference from the AI confirmation message. Leave the Do
not show this message again box checked, and then click OK to close the AI
confirmation message.

When you turn on the Type-Ahead On List Fields option (above), check this box so
that NetSuite selects a record based on an exact match of the characters you type.
Otherwise, NetSuite chooses a record based on the first character you typed.

When you check this box, NetSuite displays a list of matching records you can select
from when you type characters into a dropdown list field.
This preference may enable you to enter data into list fields more quickly. 



Go to Home > Set Preferences.
On the General subtab, in the Localization section, Language field select a language. The
following choices are supported:

■
■

Chinese (Simplified)

Chinese (Traditional)
Czech

Danish
Dutch

■
■
■
■

English (AU)
English (CA)

English (International)
English (UK)

With the Multi-Language feature, you can choose the language in which NetSuite displays whenever you
log in to your account.

This preference is available only if a user with the Administrator role has enabled the Multi-Language
feature at Setup > Company > Setup Tasks > Enable Features, on the Company subtab.

To set your language preference:
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Show Quick Add Row on
Lists

Display Bounce Warnings
on Campaigns

Prefer Native Select Fields
over NS Dropdowns In
Internet Explorer.

Function

Check this box to use quick add on lists that can be edited inline.

Quick add enables you to create new records from lists and only add basic information.

You can turn this preference off on individual lists.

Clear this box to restrict the automatic scanning of hard-bounced email addresses in
your marketing campaign. When this preference is turned off, you can manually screen
hard-bounced email addresses.

This field is only for users of the Internet Explorer browser.

Select this box to use native dropdown lists rendered by your Internet Explorer browser
rather than dropdown lists rendered by the NetSuite user interface. This can improve
page performance, particularly on pages with many dropdown lists. Page performance
varies due to the interaction of many factors, including:

■
■

■

the type and complexity of the page
whether the page has been customized

the number and type of features enabled in an account

If you continue to experience less-than-optimal page performance even with this option
selected, please contact Technical Support.

SuiteCloud Development Framework

Show App ID Field

Show ID Field on Sublists

Check this box to display the App ID field on custom objects that are supported by SDF.

Check this box to display script ID fields in sublists that are supported by SuiteCloud
Development Framework.

Important:

Choosing a Language for Your NetSuite User Interface

1.
2.

Field Name 

■
■
■



English (U.S.)

Finnish

French

French (Canada)

German

Indonesian

Italian

Japanese

Korean

Norwegian

Portuguese (Brazilian)

Russian

Spanish

Spanish (Latin America)

Swedish

Thai

Turkish

Vietnamese

The following languages are available:

■ (Chinese Simplified)

General Personal Preferences

Important:For the languages listed above, NetSuite provides translation strings for
the user interface and for printed transaction forms. The Multi-Language feature
also supports the use of several additional languages for website translations, but
these languages must be defined in company preferences and translation strings
must be provided. See the help topic Configuring Multiple Languages.

In the Language of the Help Center field, you can select a different language for the Help Center.
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3.

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N247147.html


For more information, see Using the Help Center Window. Whether you select the language
preference directly in the Help Center or from Home > Set Preferences, the preference is
maintained until you change it.
Click Save.4.

This preference does not affect others with access to your account. For the best results when viewing
translated NetSuite pages, set your browser to view UTF-8 encoded pages.
In Firefox, go to Tools > Options, and in General options, click Languages. In the Default Character
Encoding field, select Unicode (UTF-8).

Deutsch (German)
English

 (Japanese)
Español (Spanish)

Note:You can also set this preference directly from the NetSuite Help Center
using the dropdown list at the top right corner of the page.

You can quickly view maps for addresses on records and transactions by clicking the Map links.

To select the mapping website to use to display maps, go to Home > Set Preferences. In the Address
Mapping Type field on the General subtab under Defaults, select whether to open maps in Google Maps,
Yahoo! Maps, or Mapquest.

Note:There is also a Custom option; if you select this option, the mapping type set by the
account administrator for each country is used. For information about setting address mapping
types for different countries, see the help topic Supported Countries.

This feature is especially useful for:

       Deliveries

■
■
■

Door-to-door sales campaigns
Service calls
Contacting hard-to-reach customers, contacts or employees

Transactions or records with address fields have a Map link next to the address. After you fill in the street
address, city, state, zip code and country fields on records, you can click the icon to view a map of the
address location. This map opens in a new window, where you can zoom in or out for a bigger picture or
more detail, and you can print step-by-step driving directions to this address from any location.
The Map link shows on transactions next to Bill To and Ship To fields. On records, the icon shows next to
Billing Address and Shipping Address fields.
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■
■
■
■

Mapping Addresses on Records and Transactions

■ 

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N253846.html
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When viewing a record, click the text of the underlined address to view the map. When you are finished
viewing your map or driving directions, close the map window to return to NetSuite.

In the Appearance subtab, you can set preferences such as color theme, fonts, chart theme, centers and
dashboards, and other.

Go to Home > Set Preferences and click the Appearance subtab to set any of the preferences in the
following table.
The following fields are available, based on the features in your NetSuite account, and the permissions
associated with your NetSuite role.
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Personal Preferences for Appearance

Styles

Screen Font

Color Theme

Field Name

Colors

Redwood Experience

Register Look on Lists

Density Setting for Internet
Explorer

Compensate for Large Fonts

Function

To change the size of the font, use your browser zoom controls.

If the Accessibility preference for displaying a theme with optimal
color contrast is checked, the Color Theme preference is disabled.

Check this box to display lists of records and transactions as registers. This setting
applies shading every other row in your list, making it easier to read. 

■ Higher Density – similar to 80% zoom

The Redwood Experience is a theme which gives NetSuite a different look and feel. This
theme offers different colors, icons, and fonts for the page header, forms and lists, and
dashboards.

By default, the Redwood Experience theme is enabled only for the Login page. If you
want to enable the theme throughout your instance of NetSuite, click Enable.

■ The US edition has color themes for schools (various colleges and universities)
organized by conference.
The Canadian edition has color themes for National Hockey League (NHL) teams.
The UK edition has color themes for Premier League clubs.

■
■

Open Sans is the default font for NetSuite. You may select a different font from the
Screen Font dropdown list in the Appearance subtab. Your selection changes the font
on your pages only and only for your current role. It does not affect any forms or your
website.

Note:

Note:

Select a color theme for your NetSuite pages and tabs. Select a color and click Save to
determine how the scheme looks on your monitor.
Although you can’t modify or add new color themes, some special themes are
available in certain editions of NetSuite in addition to the basic color themes.

Displays easier-to-read layouts if you have set your computer display to use large fonts.

Select the density of your NetSuite pages. This setting is for Internet Explorer 10 and
higher. The options are:

Normal – 100% zoom ■
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Field Name

Landing Page

Chart Themes

Chart Theme

Show Portlet Hint

Chart Background

Centers & Dashboards

Use Classic Interface

Set Customer Dashboard as
Default View on Customer
Record

Function

■ Very High Density – similar to 67% zoom

Other browsers, such as Chrome and Firefox, enable you to set the zoom
independently for each website.

Check this box to use the Classic Center as your NetSuite interface. When you enable
this option, you see the same tabs in NetSuite that the Administrator role does.

This option does not appear when using an Administrator role.

If all users enable this option, they all can see the same tabs and use the same
navigation paths.
Note that the functions available to a role do not change according to the interface
being used. Only the presentation of tabs and the organization of functions within
tabs are affected.

Select the tab that you want to be the first page displayed when you log into your
NetSuite account. If you do not make a selection in this dropdown list, your Home
page is the initial landing page. The list of possible landing pages includes all standard

tabs and custom tabs in your
center.
The page you select here is overridden if your account administrator sets the general
company Landing Page preference to use a custom landing page created by a
Suitelet.

Check this box to display a popup notice when slow-loading dashboard portlets time
out during dashboard loading.
To improve page load time on the dashboard, minimize the slow-loading portlets. 

Defines a default appearance for data in all dashboard charts. (Can be overridden in
individual portlets.) Options are:

■
■

Basic – provides limited color contrast (the default)
Colorful – provides more color contrast

Match Color Theme - Bold – harmonizes with your choices in the Colors section,
using bolder shades
Match Color Theme - Light – harmonizes with your choices in the Colors section,
using lighter shades

A thumbnail is displayed to represent the look of each Chart Theme option.

Defines a default display behind data in all dashboard charts. (Can be overridden in
individual portlets.) Options are:

■ Lines (the default setting)
Bands

Grid

Note:

■

■

■

■

Check this box to set the customer dashboard view as the default view on customer
records.

Entry Forms
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In the Transactions subtab, you can set preferences such as auto fill transactions, transaction warnings,
printing, transaction email attachment, and other.

Go to Home > Set Preferences and click the Transactions subtab to set any of the preferences in the
following table.
The following fields are available, based on the features in your NetSuite account, and the permissions
associated with your NetSuite role.
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Field Name

Basic

Auto Fill Transactions

Accessibility

Display Default Theme with
Optimal Color Contrast

Function

If this preference is selected, the Color Theme preference is
disabled.

Check this box to display a theme with optimal contrast that can aid users with low
vision to view the UI.

Field Name

Limit Entry Forms to Two
Columns

Select the default font for rich text editor fields. 

Expand Tabs on Entry Forms

Enable Rich Text Editing

Default Rich Text Editor Font 

Check this box to enable the Inline Editor Sublist Tooltip.

When you are editing a sublist inline and you hover over a cell, the tooltip appears and
shows the column name. If a sublist has many lines, you can view the column name
when scrolling down the sublist.

If you check this box, information about transaction pages is automatically filled in based on
the last transaction for the entity you have chosen. If you use a custom form, NetSuite will
load the same custom form as was used for the last transaction for the entity, as well.

If you clear this box, click the Auto Fill button on transaction pages and information fills
in based on the last transaction for the entity you have chosen. If you use a custom form,
NetSuite will populate the custom form you currently have open with the information from the
last transaction, and not the custom form that was used in the last transaction.
The date and period information about any transaction remains current and all auto filled
fields can be changed.

Note:

Personal Preferences for Transactions

Function 

Check this box to limit the columns of fields on entry forms to two columns.
By default, fields on entry forms are arranged in three columns.

Check this box to expand tabs on your NetSuite pages. 

Check this box to use the richtext editor in text fields. Each field includes the
Formatted Text header with a link you can click to enter HTML Source Code.
The Formatted Text header includes Font, Size, and Color dropdown lists, and a
toolbar with text style, alignment, and paragraph format options. Use these tools to
format text you enter into the field. 
Clear the box to remove the Formatted Text header on text fields.

Select the default font size for rich text editor fields.

Sublist Column Name Tooltip

Default Rich Text Editor Font
Size
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Field Name

Alphabetize Items
Regardless of Type

Warnings

Duplicate Number
Warnings
Inventory Level
Warnings

Horizontal Print
Offset

Vertical Print Offset

Vendor Credit Limit
Warnings

Printing

Print Using HTML

Transaction Email
Attachment Format

Print GL Impact Per
Subsidiary

If you select the HTML option as a transaction email attachment format, the
system will not use the template set in custom transaction forms.

Enter a positive number in inches to move the text to the right. Enter a negative number in
inches to move the text to the left.

Enter a positive number in inches to move the text lower. Enter a negative number in inches
to move the text higher.

Function

Check this box to list items in alphabetical order, regardless of item type, when you search
for items in the Item column on transactions such as Sales Orders, Purchase Orders, and
Inventory Adjustments.

Clear this box to display items listed in the Item column on transactions grouped by item type
and listed in alphabetical order.
This preference does not affect the order in which items are displayed in the Items subtab on
transactions.

Print separate GL impact statements for transactions with multiple lines assigned to different
subsidiaries (for example, an intercompany journal). NetSuite will print a statement for each
subsidiary in the transaction. For more information, see the help topic Printing the GL Impact
for a Transaction.     

■
PDF – Sends email attachments in PDF format.

Choose from the list how NetSuite responds when you enter a document number you’ve used
before.

Check this box to see warnings when you sell inventory items with quantities at or below their
reorder points.
You must also set these minimum quantities in the Reorder Point field on item records at Lists
> Items.

Customer Credit Limit    Select your preferred method for handling customer credit limits:
Handling

■ Ignore – Enables you to enter sales orders and invoices that exceed the customer's credit
limit without a warning.

      Warn Only – Generates a warning when you enter a sales order or invoice that exceeds
the customer's credit limit. The warning displays in a popup window so you can choose to
enter or cancel the transaction.

Enforce Holds – Blocks you from entering a sales order or invoice that exceeds the
customer's credit limit.

■

Check this box to receive a warning when you exceed the credit limit for a vendor.

Note:

■

■

HTML – Sends email attachments in HTML format.

Choose the format for which transaction email attachments are sent.

Check this box to print transaction forms in HTML format. Clear this box if you prefer to print
transactions forms in PDF format. Printing PDF forms requires Acrobat Reader.

https://system.netsuite.com/app/help/helpcenter.nl?fid=subsect_156215822877.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=subsect_156215822877.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=subsect_156215822877.html


Personal Preferences for Transactions

In the Analytics subtab, you can set preferences such as report by period, default bank account, search,
PDF orientation and font size, CSV export, and other.

Go to Home > Set Preferences and click the Analytics subtab to set any of the preferences in the following
table.
The following fields are available, based on the features in your NetSuite account, and the permissions
associated with your NetSuite role.

Your administrator can customize the layout of your printed forms using advanced PDF/HTML templates.
For information, see the help topic Advanced PDF/HTML Templates.
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Analytics Personal Preferences

Field Name

Reporting

Report by Period

Display Report Description

Show Reports in Grid

Customize Font on Financial
Reports
Print Company Logo

Display Report Title on
Screen

Function

When you select Financials Only or Never, you may encounter
problems with data for KPI scorecards that use accounting periods.

Select what type of reports you want to view by period.

All Reports – Select this option to view all applicable reports by period. When this
option is selected, reports that support reporting by period include a period filter in
the report footer.

Financials Only – Select this option if you want specific financial reports reported
by period. For a list of these financial reports, see Report by Period: Financials Only
Reports.

Never – Select this option if you do not want to exclude reports that can be run in
both by date and by period mode.

In OneWorld accounts, if you post transactions with dates outside
posting periods, best practice is to run all reports by period. Select All
Reports.

This option requires the Accounting Periods feature to be enabled. For details, see the
help topic Accounting Period Management.

Check this box to show reports in the grid. 

Check this box to be able to configure the font settings on custom financial reports.

Check this box to include your company logo on all printed reports. Check this box to

display the report title, company name, and date or period range
at the top of all reports displayed on your screen. Even when this preference is not
enabled, this title information still prints on reports. To display report title information

only on selected reports, do not check this box.
Instead, click Options in the footer of each report, and check the Display Title box.

Check this box to display customization details as part of report title for all reports.
These details are from the Description field in the More Options step of the Report
Builder. To disable the display of customization details for selected reports, click

Options in the
footer of each report, and clear the Print Description box.

Note:

Note:

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_4453550706.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N1445226.html


Function 

Select the bank account to use as the default account for the Bank Register listed on
the Reports page and the Bank Balance snapshot on the Home page.

Check this box to show the weighted forecast value instead of total projected forecast
values on reports.
You can set this preference at both Home > Set Preferences, and at Setup > Sales >
Sales Preferences, on the Forecasts subtab. The setting you select for this preference
on the Set Preferences page overrides the company wide setting for this preference
on the Sales Preferences page.
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Page Search

Popup Auto Suggest

Field Name

 Default Bank

Account
Calculate Forecasts as
Weighted

Global Search Includes
Transaction Numbers

Search 

Show List When Only One
Result

Global Search Auto Suggest

Global Search Sort by Name/
ID

Global Search Customer
Prefix Includes Leads and
Prospects

Include Inactives in Global &
Quick Search

Enabling this preference removes the Starts With and Contains
options from the Quick Search portlet.

Check this box to include inactive records in results returned for keywords entered in
 the Search field or in the Quick Search portlet.

By default, only active records and transactions are searched with these fields. Check

this box to have NetSuite suggest matches for the text you enter in fields as you
type. You can select from the list of matching records to select the record you need.
This box is checked by default. 

NetSuite suggests matches for the text you enter in
the Search field, automatically as you type. You can select from the list of suggested
records to go directly to the record you need.

Enable the Current Page Results feature to see enhanced results in the global search.
This option is enabled by default. For more information, see the help topic Current
Page Results.

Check this box to sort global search results by name, instead of by record type and
then by name within each record type.

By default this box is cleared, and when you type the cu prefix in the Search field, only
customer records display in search results.
Check this box to display leads, prospects, and customers in your search results when
you type the cu prefix in the Search field.

By default, when searching for a number in Global Search, the search results only
include results by document number.

Check this box to list search results, even when there is only one result. If you clear this
box and there is only one result from a search, the record or transaction automatically
opens.

Check this box so that the Quick Search portlet returns records with names that start
with AND records with names that contain the keywords you enter.
If you clear this box, the Quick Search portlet displays Starts With and Contains
buttons. Searches can return records with names that start with keywords OR records
with names that contain keywords, based on the button you select.

You use popup searches when you type a keyword and press TAB to make a selection
in a field on a transaction or form.
Check this box to base search results for popup lists only on keywords that start with
and include all the search terms entered.

Quick Search Uses Keywords

Popup Search Uses
Keywords

Note:

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_161899349589.html#bridgehead_28162751354
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_161899349589.html#bridgehead_28162751354
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_161899349589.html#bridgehead_28162751354
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The following is a list of financial reports that properly execute when the Report by Period preference is
set to Financials Only:

■
■

■
■

■
■

■

Account Detail

Balance Sheet

Balance Sheet Detail

Budget Income Statement

Budget Income Statement Detail

Budget vs. Actual

Cash Flow Statement
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Field Name

PDF Font Size

KPI and Snapshot

Accounting Book

Export

CSV Export Character
Encoding

PDF

PDF Page Orientation

KPI Scorecard with Period
Specific Consolidation Rates

When this box is checked, search results include results whose document number
AND transaction number match the number searched.

If Multi-Book Accounting is provisioned in your NetSuite OneWorld

This preference has no affect on standard KPIs.

This preference is available for all NetSuite user roles.

If you use the Multi-Book Accounting feature, select the Accounting Book you would
like to use for reporting.

Select the accounting period that provides the consolidation rates you would like to
use in the KPI Scorecard report.
The following KPIs are affected by the period consolidation rates you select:

■

■
Bank Balance

Credit Card Balance

      Receivables

      Payables

■

■
Other Current Assets

Other Current Liabilities

Select an alternate character encoding for CSV exports of lists, reports, and searches.

Default encoding is UTF-8. Other options are Windows 1252, the default format for
Microsoft Excel, and Shift-JIS, the most widely used format in Japan.

Select landscape or portrait orientation for your PDF output when you export a report
or search results as a PDF.

Select a font size for the PDF output when you choose to export a report or search
results as a PDF.

Note:

Report by Period: Financials Only Reports

■

■

Function 



Cash Statement Cash

Statement Detail Comparative

Balance Sheet Comparative

Income Statement Deferred

Revenue By Customer Deferred

Revenue By Item Deferred

Revenue By State Deferred

Revenue Reclassification

Deferred Revenue Rollforward

By Customer Summary

Deferred Revenue Rollforward

Summary Deferred Revenue

Rollforward Transaction Details

Financial Layout Description

General Ledger GL Audit

Numbering GST on Purchases

Detail GST on Purchases

Summary GST on Sales Detail

GST on Sales Summary Income

Statement Income Statement

Detail Realized Exchange Rate

Gains and Losses Revenue By

Customer Revenue By Item

Revenue By State Trial Balance

Unrealized Exchange Rate

Gains and Losses VAT on

Purchases Detail VAT on

Purchases Summary VAT on

Sales Detail VAT on Sales

Summary

Note:If you have enabled the GL Audit Numbering feature, select Financials Only to filter the GL
Audit Numbering Report by accounting period.

Set your personal preferences before you start working with your calendar, and activities such as phone
calls and tasks. Here, you can set preferences for sending email invitations, types of reminders, and more.
You can also set a default priority for tasks and phone calls. If you use the Outlook Integration feature
to synchronize records, you can set a default category for contacts synchronized between Outlook and
NetSuite.
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■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

■

Personal Preferences for Activities



Personal Preferences for Activities

Go to Home > Set Preferences, and click the Activities subtab to set any of the preferences in the following
table.

The following fields are available, based on the features in your NetSuite account, and the permissions
associated with your NetSuite role.
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Default Reminder Type

Restrict Invitees to
Employees

Default Event Access
Setting For New Events

Default Reminder Time

Play Audio with Popup
Event Reminders

Tasks & Phone Calls

Default Priority for Tasks

Default New Phone Calls
Public

Default New Tasks Public

Choose an option for Event Access.

Your selection determines how new events appear to others who have access to
the calendar where you create events. You can change Event Access at any time on
individual event records.

Choose one of the following:

■

■
Public - Anyone can see public events, tasks, and calls.

Private – Only you and your account administrator can see events, tasks, and calls
you mark as private. Other invitees with access to your calendar can also see private
events.

Show as Busy - Events marked to show as busy show on your calendar as
unavailable time. The details of these events cannot be seen by anyone except you
and your account administrator.

■

Specify the type of event reminder that you prefer:

■ None – Select this option if you do not want to receive reminders about your
calendar events.

Popup Window – Select this option if you want to receive calendar reminders in a
popup window.

      Email – Select this option if you want calendar reminders emailed to you. Select

the amount of time before an event when you prefer to receive reminders. Check

this box to play a sound with popup event reminders. You must have your
browser set to play sounds in websites.

Field Name Function

Send Invitation Emails Select recipients for email notification about events.

■ Internally - Send email only to employees and groups of employees in your NetSuite
account.
To All Invitees - Send email to everyone invited to the event, including customers,
contacts, partners, etc.

■

Check this box to choose only employees as invitees on event records.

Select a default priority for new tasks. Priority options include Low, Medium, and High.

You can change the priority for a task in the Priority field on the task record.

Check this box to make all new tasks public by default.

You can mark a task private by checking the Private Task box on the task record

Check this box to make all phone calls you create public by default.

Check this box to open events in Edit mode when you click events on your calendar.Edit Activities from 
Calendar

Calendar

■

■



Personal Preferences for Activities

In the Alerts subtab, you can set preferences such as time for an alert email, email address, and other.

Go to Home > Set Preferences, and click the Alerts subtab to set any of the preferences in the following
table.
The following fields are available, based on the features in your NetSuite account, and the permissions
associated with your NetSuite role. For more information about setting preferences for email alerts, see
Receiving Email Alerts. For more information about subscribing to email alerts, see the help topic Enabling
Saved Search Email Alerts.
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Field Name

First Selection

Field Name

Sync

Default Sync Category

Click Here to send a test
email message to <your
email>.

Function

Select the category you want contacts to sync to by default.

By default, this value is set to 12:00 am. If you do not want to receive the
email alerts, you can change this value to be blank.

Function

Select an initial time to receive an email message containing the latest information about
the events, reminders, key performance indicators, and report snapshots displayed in
portlets on your Home page.

Second Selection Select a second time to receive an email message containing the latest information about
the events, reminders, key performance indicators, and report snapshots displayed in
portlets on your Home page.

Select a third time to receive an email message containing the latest information about
the events, reminders, key performance indicators, and report snapshots displayed in
portlets on your Home page.

Check this box to include links to key performance indicators and reminders included in
your alert email.
When you click a link, a browser window opens where you can log in to NetSuite and view
the report for that key performance indicator or reminder.
You must also have the Email Using HTML box checked on the Transactions subtab of the
Set preferences page to include links.
Check this box so that email alert results are based on the date specified in your
Dashboard View filter.

Clearing the box sends email alert results based on a different date. Select an email

Third Selection

Include links in HTML
Alerts

Respect Quick Date
Portlet Settings

E-Mail

Send an On-Demand Alert    Check this box to enable on-demand alerts. On-demand alerts enable you to send email
from this Role to alerts@alerts.netsuite.com or to reply to an alert email and receive an email from

NetSuite with the contents of your dashboard to your login email address.

Click the link to send a test message to the specified email address.

Personal Preferences for Alerts

Note:

 address to which email alerts should be sent.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N681962.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N681962.html


Note:When you remove an Activities, Reminders, Key Performance Indicators, or Report
Snapshot portlet from your home page, alert emails no longer include information from the
portlet you removed.

Personal Preferences for Alerts

On the Alerts subtab of the Set Preferences page, you can choose to receive two different sorts of email
alerts:

■ You can choose to receive a Daily Facts email alert up to three times a day. This standardized
message summarizes the latest information in the Events, Reminders, Key Performance Indicators,
and standard Report Snapshots portlets on your Home page, if these portlets are visible and not
minimized on your dashboard. Note that these messages do not include data from custom and sales
management report snapshots.

Important:The Daily Facts email alert does not include contents from portlets that are
minimized on your dashboard or not showing on your dashboard.

You can also email alerts@alerts.netsuite.com from the email address you use to log in and
automatically receive an email alert.
You can choose to receive email updates when information in one or more of your most important
saved searches changes.

■

Go to Home > Set Preferences. Click the Alerts subtab. Choose the times of day you want to receive

your three email alerts. If you do not want to receive any of these email alerts, change the value for

the First Selection dropdown list to be blank.

Check the Include Links in HTML Alerts box to enable you to click links in email alerts and open
your account to the relevant information.
Check the Send an On-Demand Alert from the Role box to enable you to send email to
alerts@alerts.netsuite.com and automatically receive your email alerts.
You must send email to this address from the email account you use to log in to NetSuite.

To receive email alerts when saved search data changes, select the record type that search is
based on in the Record Type field.

In the Search field, select the name of the saved search.

A search must have the Available as Alert box checked to appear in this list. Only Administrators
can set searches to be available as alerts.

For information about how saved searches are made available for alerts, see the help topic
Enabling Saved Search Email Alerts.
Check the Send on Update box if you want to receive alerts both when new records are added and
when current records are updated.
Click Add/Edit.

Repeat steps 6 – 9 to add up to five saved searches.

Click Save.
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Receiving Email Alerts

1.
2.
3.

4.

5.

6.

7.

8.

9.
10.
11.

To set up email alerts:

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N681962.html


You will now receive email alerts at the times you set.

Personal Preferences for Alerts

In the Telephony subtab, you can set preferences such as telephony option, TAPI device, and other.

The Telephony subtab appears on the Set Preferences page only if you use the Telephony Integration
feature.
To enable the feature an administrator must go to Setup > Company > Enable Features. On the
SuiteCloud subtab, in the Integration Add-Ons section, check Telephony Integration, and click Save.
Go to Home > Set Preferences and click the Telephony subtab to set any of the preferences in the
following table.
The following fields are available, based on the features in your NetSuite account, and the permissions
associated with your NetSuite role.

If you are using TAPI for telephony integration, follow the additional instructions listed on the Telephony
subtab of the Set Preferences page to set up your phone and install the proper drivers.

For more information about using telephony integration, see the help topic Using Telephony Integration.

Click the Restrict View subtab of the Set Preferences page to limit your access to information for the
specific class, location, department, or subsidiary you select. The restrictions apply only for the duration of
your current session. The next time you login, your original settings are restored.

Important:If you use NetSuite OneWorld, some reports do not support consolidation and can
return results for only one subsidiary at a time. Before you can run one of these reports, you must
set your user preferences to restrict your view to a single subsidiary.

Some standard reports return errors when you attempt to run them before setting this preference.
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Personal Preferences for Telephony

Personal Preferences for Restricting Views

TAPI Device

CTI URL

Field Name

Subsidiary

Field Name

Telephony Option

Prefix to Dial Out

Function

(NetSuite OneWorld accounts only)

For more information about setting up partner software to work with
NetSuite, refer to the documentation from Contivio or Five9.

Enter any numbers that should be dialed before the number in a phone number field.

For example, you may need to dial 9 or 1 before you dial out of your phone system.

Function

Select TAPI to use Telephony Integration with a TAPI-enabled phone or software for TAPI
integration.
Select CTI to use a NetSuite partner for integration: Contivio or Five9.

Enter the name of the TAPI device you use to connect your phone to your computer.

Enter the URL for the CTI partner with whom you have an account.

Note:

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N511129.html
https://www.contivio.com/
http://www.five9.com/
http://www.five9.com/
https://www.contivio.com/
https://www.contivio.com/
http://www.five9.com/
http://www.five9.com/


For more information, see the help topics Inactivating Roles and Restrict Your Subsidiary View.

Personal Preferences for Restricting Views 118

Class

Location

Department

Field Name

Include Unassigned

Include Unassigned

Include Unassigned

Include Sub-
Classes

Include Sub-Locations

Include Sub-Subsidiaries

Include Sub-Departments

Function
Restrict your access to those records from the subsidiary you select. The restrictions
apply to the user interface, searches, and reports for the duration of your current
session.

(NetSuite OneWorld accounts only)

Check this box to include records from child subsidiaries, in addition to the selected
parent subsidiary for the current login session.
When you select your root subsidiary above, it does not make sense to check this box.
Records from all the sub-subsidiaries are available by default.

Restrict your access to those records from the department you select. The restrictions
apply to the user interface, searches, and reports for the duration of your current
session. The next time you log in, your original settings will be restored.

Check this box to include records from sub-departments of the selected department
for this session.

Check this box to include records that do not have a designated department in this
session.

Restrict your access to those records from the location you select. The restrictions
apply to the user interface, searches, and reports for the duration of your current
session. The next time you log in, your original settings will be restored.

Check this box to include records from sublocations of the selected location for this
session.

Check this box to include records that do not have a designated location in this
session.

Restrict your access to those records from the class you select. The restrictions apply to
the user interface, searches, and reports for the duration of your current session.
The next time you log in, your original settings will be restored. Check this box to include

records from sub-classes of the selected class for this
session.

Check this box to include records that do not have a designated class in this session.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N289968.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N289968.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N278473.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N278473.html


Using SuiteAnalytics Workbook

SuiteAnalytics Workbook is an analytical tool available in NetSuite. With Workbook, you can create and
fully customize workbooks that combine datasets, tables, pivot tables, and charts using a single tool that
leverages the new analytics data source.

By default, the SuiteAnalytics Workbook feature is enabled in all NetSuite accounts. If you don’t see the
Analytics tab in the NetSuite navigation menu, contact a user with the Administrator role.
See the following sections for information about workbooks and datasets, and workbook and dataset
templates:

■  Workbooks and Datasets

Sharing Workbooks and Datasets

Workbook and Dataset Templates

Watch the following help video for information about navigating the SuiteAnalytics Workbook user
interface:

Navigating Workbooks

To access SuiteAnalytics Workbook, click the Analytics tab in NetSuite. The Workbook user interface
includes the Analytics Home page, the Dataset Builder, and three workbook visualization tabs: table, pivot,
and chart.
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Using SuiteAnalytics Workbook

Navigation

Analytics Home
page

Dataset Builder

The Analytics Home page includes Workbook and Dataset subtabs. From the home page you can
open and view any workbooks or datasets you have access to. For more information, see the help
topic Analytics Home Page.

The Dataset Builder appears after you create a new dataset or open an existing dataset. Use the
Dataset Builder to combine record types, fields, and criteria filters to create queries. For more
information, see the help topic Dataset Builder.

□

□ 

https://videohub.oracle.com/media/Navigating+Workbooks/1_7wyjav7w
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1546886779.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1544220977.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1544220977.html


Workbooks and Datasets

Anyone with access to SuiteAnalytics Workbook can share a workbook or a dataset with individual users
or groups of users based on their assigned roles. However, to prevent data discrepancies, the recipients
of a shared workbook cannot edit the associated datasets. For example, if you share a workbook with
users who have the Accountant role, they can access and save their own versions of the workbook or
connected datasets, but they cannot edit the original workbook or dataset that you shared.

To save and share a workbook or dataset:

1.

2.

Click Share from anywhere within the workbook or dataset.

Select the roles or users you want to share the workbook or dataset with, then click the right
arrow to add them to the distribution list.

In SuiteAnalytics Workbook, you analyze your company data using datasets and workbooks. You can create
datasets and workbooks and share them with anyone in your organization.

Datasets are the basis for all workbooks. In a dataset, you combine record type fields and criteria filters to
create a query. The results of this query act as the source data for your workbook visualizations. A single
dataset can be used in multiple workbooks and workbook visualizations. Changes you make to a dataset
are automatically applied to workbook visualizations based on that dataset.
Workbooks are where you analyze the results of your dataset queries using different visualizations, such
as tables, pivot tables, and charts. You can base a new workbook visualization either on a new custom
dataset, or on any of the existing datasets that you have access to. You can also link two datasets in a
single visualization to compare their metrics. For more information, see the help topic Dataset Linking in
SuiteAnalytics Workbook.

The record types and fields displayed in each workbook and dataset are based on the features enabled in
your account and the permissions assigned to the role you use to log in to NetSuite. If you do not see a
specific record type or field in a workbook that you need to access, contact a user with the Administrator
role.
There are also predefined datasets and workbooks that you can edit and share if you have the Analytics
Administrator permission. For more information, see the help topic The Analytics Administrator
Permission.
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Pivot tab

Table tab

Chart tab

Within a workbook, you can use tables to explore your dataset query results without altering the
source data of any associated workbook visualizations and without having to set a layout. For more
information, see the help topic Table Tab.

To pivot your dataset query results, use the Pivot tab. For more information, see the help topic
Pivot Tab.

With workbook charts you can create graphical representations of your dataset query results. For
more information, see the help topic Chart Tab.

Workbooks and Datasets

Sharing Workbooks and Datasets

https://system.netsuite.com/app/help/helpcenter.nl?fid=article_162627392718.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=article_162627392718.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=article_162627392718.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1536693720.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1536693720.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1536693720.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_158204357886.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_158204357886.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1544221045.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1544221024.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1544221024.html


3. Click Share.

For more information, see the help topic Accessing and Sharing Workbooks and Datasets.

Workbooks and Datasets

There are over 20 predefined workbook and dataset templates in SuiteAnalytics Workbook. You can see
the templates and datasets you have access to on the Analytics Home page.

In a dataset template, all required fields, record types and criteria filters are predefined so that you can
create a workbook without having to first define a complex, custom dataset.
Workbook templates include predefined workbook visualizations such as table views, pivot tables and
charts, so that you can analyze and visualize the results of the accompanying dataset templates.

Important:If you do not have the Analytics Administrator permission, you can access these
templates only if a user with the Analytics Administrator permission shares them with you. If
you do not see one of the listed templates in your account, contact the user with the Analytics
Administrator permission.

If none of the predefined dataset templates and workbooks suit your needs, you can author your own
dataset. For detailed steps, see the help topic Custom Workbooks and Datasets.

121

Workbook and Dataset Templates

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1531766899.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_1544122127.html
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Working with Records, Transactions, and Lists

All the information you need to keep your business running smoothly is organized and stored in records in
NetSuite. These records are accessible from list pages that include all records of a specified type. You can
customize these lists to display various fields from each record type.

This section includes general information about working with records and lists. Transactions, which are
records of financial exchanges, are also included in this section. Instructions for using specific types
of records are included in the help for the functional area. To learn how the help for functional area is
organized, see NetSuite Documentation Overview. This section is divided into the following subsections:

■ Duplicate Record Detection

Working with Groups

Working with Transactions

Working with Lists

Through records, you keep track of all the information from your NetSuite account. You can have records
of your employees, customers, vendors, items, web sites, updates, activities and so on. There are standard
records provided in NetSuite for many business purposes, such as Accounts, Items, Shipping Items,
Marketing Campaigns and so on. You can also create custom record types.

For example, you create a new customer record to track address, phone and email information. Then
you link customer records with contact records to keep track of the individuals you do business with. You
also create records for each of your financial accounts, any items you may sell, marketing campaigns,
customer support cases, phone calls, events, and so on. Any information that you use to conduct business
is tracked in NetSuite on a record.
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Working with Records, Transactions, and
Lists

Working with Records

Working with Records

■

■

■
■



Working with Records

You can create groups of records to communicate with a set of individuals within your organization or
other companies you do business with. For example, you can invite a group of employees to a meeting
or send a marketing email blast to a group of customers. With NetSuite, you can create a dynamic group

The types of records you can view, create, and edit vary according to the roles and permissions assigned
to you. Administrators control which records members of their organization can view and regulate the
operations they can perform on records. For example, you may have been granted only edit permissions
to a certain record type, so can update the record but not delete it or create a new one. Few users have
permissions to view or edit all of the record types in NetSuite. For more information, see the help topic
NetSuite Permissions Overview.

For information about creating records in NetSuite, use the help topics for the specific record type. For more
information, see NetSuite Record Types.

NetSuite uses transactions to record business events. Some transactions post to the general ledger
while other transactions are non-posting. For more information about Transactions, see Working with
Transactions.

After you create records in NetSuite, you can look at account registers, track customer activity, and receive
reminders for upcoming events and phone calls. For more information about filling in the fields on a
record page, see NetSuite Record Pages.
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Groups

Roles and Permissions
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On the page's More menu, click Add To Shortcuts.

Edit name for the shortcut link. By default it is the name of the page.

If you want the linked page to open in a new window, check the Open in New Window box.

Click Save.

Working with Records

Each NetSuite record is represented as a page in the user interface. To enter a record page, go to the
Lists tab and select the relevant record type. Click Edit.

Basic data appears in fields in the upper part of the page (the record form), and more detailed data
(including data from related records) is displayed in lists and fields on subtabs in the lower part of the
page. The fields in the form are often grouped to keep similar or related fields together.

For information about creating records in NetSuite, use the help topics for the specific record type. For
links to these topics, see NetSuite Record Types.

You can add any individual record to your shortcuts. Shortcut links appear as menu options under the
star menu available on every NetSuite page, and in the Shortcuts portlet. If the Shortcuts portlet does
not yet exist on your dashboard, you may be able to add it. For instructions, see the help topic Adding a
Portlet to a Dashboard.

Lists enable you to access existing records in NetSuite. They include controls for working with the whole
list and for working with individual records. For more information, see Working with Lists.

that changes based on record search results, or you can create a static group using a set of records that
you select. For more information, see Working with Groups.
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Lists

NetSuite Record Pages

Creating a Shortcut to a Record

To add a shortcut from the page where you want the shortcut to go:

1.

2.

3.

4.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N580906.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N580906.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N580906.html


Working with Records

For technical information about the fields in a record, such as the data type or maximum field length,
you can use the SuiteScript Record Browser. For more information, see the help topic Working with the
SuiteScript Records Browser.

Record Subtabs
Subtabs on records enable you to enter additional information. They appear at the bottom of the record
page and are called subtabs to distinguish them from the tabs at the top of the page. Subtabs may
contain fields, other subtabs, sublists, and a combination of these elements. Which subtabs are included
depends on the record type. For links to help topics for specific record types, see NetSuite Record Types.

The following screenshot shows a sample customer record in edit mode. The asterisks indicate that the
field is required. The areas of the page are identified by number:
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1

2

3

The record type (Customer in this example) and ID appear at the top with buttons and links that enable you to act on
the record and go to other records.

Horizontal bars divide the fields into related groups. Subtabs divide the record data further. For more information,

see Record Subtabs.

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3169369.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3169369.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N3169369.html


Working with Records

Here is an example of a subtab. It is the Marketing subtab on a customer record. This subtab includes
fields at the top and its own subtabs at the bottom. The selected Item Orders subtab contains a sublist,
only a portion of which is shown here.

Enter data on record and transaction forms using fields, boxes, and buttons. Some fields require a
particular type of entry like a date or currency.

Note:If you are not sure which fields to include when building a report, you can use the
SuiteAnalytics Connect Browser to view table summaries and domain diagrams for the most widely
used domains. For more information, see the help topic Working with the Connect Browser.

Text fields can have only letters, numbers, and basic punctuation. You cannot enter any special characters
or HTML codes in text fields.
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1

Primary subtab – The bold font and pointer below the label indicate that this subtab is selected. This is the
Marketing subtab. Some subtabs appear on most NetSuite records:

      Communication – This subtab messages and files to the record. For more information, see Attaching Files to

Records and Entering Communication Information to a Transaction.
Related Records – This subtab lists records and transactions that are related to the current record and
includes links to these related records. It often includes secondary subtabs to categorize the related records.

■

 System Information – This subtab includes a System Notes subtab that enables you to view details about
changes to the record.

2
Expand Tabs button – When you click this button, the subtabs expand and are stacked vertically on the page.

   header for each subtab includes a button to return the subtabs to their original tabular layout. This rollup
button appears only when your pointer is in the header area. 

Secondary subtab – The bold font and pointer below the label indicate that this subtab is selected. The dot to
the right of a secondary subtab indicates that information is included in the subtab. 

Sublist – Sublists contain references to other records. Each record in the list is referred to as a line item. Sublists
often include links to the record that is referred to. You can see an example in the Item column of this sublist.
Some sublists can be edited. These sublists include buttons for working with each row of the list. For more
information, see Buttons and Menus in NetSuite.

3

4

Record and Transaction Data Fields

Text Fields

■

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4501005441.html


1.
2.

In the Amount field, type = (equal sign).

After the equal sign, enter numbers and the computation symbols.

For example, type =125.36+87.45

To separate actions, use parenthesis, for example, =(10+10)*2.

Click another field on the page, or press Enter, to complete the calculation.

The result appears in the Amount field.

The results for the examples in step 2 appear as 212.81 and 40.00.

3.

For more information, see Currency Field Limitations.

Working with Records

Click the calendar icon next to a date field to open a popup calendar in which you can click the date. If
you know the date format your company uses, you can type the date in the field. For tips, see Keyboard
Shortcuts.

NetSuite includes record types for all areas of your business. Click the links below to learn more about
each record type and how to create new records:

■ Accounting – See the help topic NetSuite Accounting Overview.

Items – See the help topic Creating Item Records.

Shipping Items – See the help topic Creating Shipping Items.

If you use the Shipping Label Integration feature, see the help topic Shipping Integration with FedEx,
UPS, and USPS/Endicia.

Gift Certificates – See the help topic Setting Preferences for Gift Certificate Authentication Codes■

Employees – See the help topic Adding an Employee.

■ Relationships – You can create records for different types of business relationships:

□

□

Leads – See the help topic Lead Management.

Prospects – See the help topic Prospect Records.

Customers – See the help topic Customers.

□ Projects – See one of the following topics in the Help Center:

▬

▬

Creating a Basic Project Record

Creating a Project Record

□ Contacts – See the help topic Contacts.

Amount fields support addition, subtraction, multiplication, and division. You do not need to calculate the
value before you enter it in the field. For example, John Wolfe of Wolfe Electronics wants to write a check
for automobile expenses. The business spent $87.45 on gas for one catering van, and $125.36 on gas for
another van. If John wants to add these expenses together in the same check, he can compute the total in
the Amount field.
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Date Fields

Amount Fields

To compute amounts:

NetSuite Record Types

■

■

■

■

□
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Groups – See Working with Groups.

Groups are a collection of contact, customer, employee, job, partner, or vendor records that you
select. Using groups in NetSuite enables you to communicate efficiently with individuals and
companies you do business with.

Vendor – See the help topic Creating a Vendor Record.

Competitors – See the help topic Competitors.

Other Names – See the help topic Other Name Records.

Commissions – See the help topic Commissions.

Marketing – See the help topic Marketing Automation Overview.

Support Management – See the following topics in the Help Center:

Setting Up Case Management

Issue Management

Knowledge Base

Web Site – See the following topics in the Help Center:

Site Builder Items, Forms, & Images

Site Builder Tabs & Categories

Setting Up Items for the Web Site

Search – See the help topic Defining a Saved Search.

Mass Updates – See the help topic Mass Changes or Updates.

Custom – See the help topic Creating Custom Record Types.

Activities – NetSuite enables you to create records to keep track of your business activities. See the
following Help Center topics:

□
□

□

Scheduling Events

Creating CRM Task Records

Scheduling or Logging Phone Calls

NetSuite includes several search tools to help you find and view your records. Here is a summary of the
available tools with links to more information:

■ Global search – A search field appears in the center of the NetSuite header so that it is accessible
everywhere in NetSuite. You can enter keywords here to search your entire NetSuite account. See
Global Search.

Search crosslink – This link in the upper right of most record and lists pages opens a search page for
the current record type. From this page you can search using the following methods:

Simple search – Use the filters on the page to search. See the help topic Defining a Simple Search.

■

□ Advanced search – Check the Use Advanced Search box to switch to advanced search mode. See
the help topic Defining an Advanced Search)

Saved search – Click Create Saved Search to open a page where you can define a search that you
and others can run repeatedly for dynamically updated results. See the help topic Defining a Saved
Search.

■ Quick find – Many NetSuite pages include an icon (Quick Find) at the top of the page that you can
click to search for other records of the same type. See the help topic Quick Find.
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Searching for Records

□

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2362161.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1096618.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1096940.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N1122333.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N973384.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2421072.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2438260.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2445950.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2582621.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2595349.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2585301.html#section_N2177433
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N676039.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N666653.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2876492.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N645582.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N646177.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N676039.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N676039.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N643277.html


Working with Records

After you create records in your NetSuite account, you can access those records to enter new information
or edit information.

To create a new record, go to the NetSuite navigation menu that lists the record you want, and then click
the New link next to the record type. For more information, see NetSuite Record Types.
Many types of records can also be created from the Create New menu. For more information, see Create
New Menu.

Subtabs on records enable you to enter additional information. For example, address information is often
maintained on a subtab rather than in the main record form. Which subtabs are included depends on the
record type. To learn more, use the help topics for the specific record type. For links to these topics, see
NetSuite Record Types.

Some subtabs contain sublists of related records. These sublists include buttons to add, insert, copy, and
remove records in the list. Sublists are common on transaction records. See Working with Transactions.
The Communication subtab, which is available for most record types, enables you to attach files to the
record. For more information, see Attaching Files to Records.

You can edit an individual record by clicking Edit next to the record in a list. If inline editing is enabled, you
can change data on multiple records from the list page. For more information, see Using Inline Editing.

To view an existing record:

■ Search for it by name or ID. See the help topic Quick Searches.

When you do this, the record is presented in view mode. In view mode, you can see all the information
in the fields on the record but you cannot change the data. Click Edit to add, delete, or edit information
about the record.

Go to the NetSuite navigation menu that lists the selected type of record and click the link for that type
of record to open a list of the records. Then click the View link for the record.
On the list page, you can sort the list of records and customize the list to display certain fields in the
list view. For more information, see Working with Lists.

■

Dashboard search portlets – Several portlets are designed to help you search for records. These are:

Custom Search – Displays the results from a saved search in a list. See the help topic Displaying
Saved Search Results in Dashboard Portlets.
Quick Search – Contains a form where you can search for records of a selected type using a filter
and keywords. See the help topic Quick Search Portlet.

□

Search Form – Similar to Quick Search, but the form is more complex and can be personalized.
See the help topic Adding Personalized Search Forms to NetSuite Pages.
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Viewing and Editing Records

Editing Records

Viewing Records

Entering Subtab Data on Records

□
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You can create transactions from lead, prospect, and customer records.

Working with Records

A rich text editor is a tool that allows you to add content with additional formatting options in text fields
on a record (for example under the Message subtab).

You can enter up to 17 digits including integers and decimals in a currency field on a record.

■ For decimal currencies, the maximum field size is 15 + 2. You can enter numbers with up to 15
integers and 2 decimals. Example: 123,456,765,890,123.12
For currencies without decimals, the maximum field size is 17 + 0. You can enter numbers with up to
17 integers. Example: 12,345,678,905,612,345

■

View-only currency fields such as totals, display up to 18 digits.

■

■

For decimals currencies, the maximum field size is 18 +2. Example: 123,456,789,012,345,678.12

For currencies without decimals, the maximum field size is 18 +0. Example: 123,456,789,012,345,678

View the record by clicking View next to a record in a list.

Click the menu on the record to open a list of records and transactions that you can create and
link to the current record.
Select a transaction type. Some transactions types that are commonly available are sales order,
invoice, and cash sale.

The editor has a header with a link you can click to enter an HTML source code. The header also includes
font, paragraph, and other formatting options, which you can use to format the text you enter into the field.

To enable or disable the rich text editor and set default values to the tool, go to the Appearance subtab at
Home > Set Preferences. For more information, see Personal Preferences for Appearance.
NetSuite uses the Oracle Rich Text Library (ORTL) based on a third-party library, the CKEditor. When using
the ORTL, follow the syntax and usage guidelines included in the documentation on the CKEditor website.
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Using the Rich Text Editor

Currency Field Limitations

Creating a Transaction from a Record

1.

2.

3.

To create a transaction from a record:
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Click the Communication subtab on the record.

Click the Files subtab. The subtab looks like this:

When you create a transaction from a record, the record is automatically linked to the transaction.

You can attach documents in the File Cabinet to records and transactions using the Communication
subtab. This is useful if, for example, you want to keep a copy of a contract or license on a customer
record. You do not need to edit the record to attach a file. You can also attach files in view mode.

Here you can attach a file that is already in the File Cabinet or add a new file to the File Cabinet and
attach it.

■ To attach a file that is already in the File Cabinet:

1.

2.

Select a file from the Attach Existing Files list.

Click Attach.

■ To add a new file and attach it:

1. Click New File.

To add a file from your computer, select a File Cabinet destination from the Folder list.
To create a new folder, click the plus sign next to the Folder field. A popup window
Document Folder appears. Fill in the folder name and other optional information about
the folder and click Save.

Click Browse to open a popup window and select the file you want to add.
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Attaching Files to Records

To attach a file to a record or transaction:

1.

2.

2.

3.



Working with Records

The Duplicate Detection & Merge feature helps you find duplicate records in your NetSuite account and
use the information in them to create a single record.

An administrator can turn on the Duplicate Detection & Merge feature at Setup > Company > Enable
Features (Administrator) on the Company subtab in the Data Management section. The administrator

1.

2.

3.

Check the Show Inactives box. The page automatically reloads to display the Inactive column.

In the Inactive column, check the boxes next to the records you want to inactivate.

Click Submit.

After a record is marked inactive, it no longer appears in dropdown lists or popup lists in NetSuite. You
can see inactive records on list pages by checking the Show Inactives box.

Important: After you inactivate a record, it will not show on transactions for selection
in lists. However, if the Search option shows in the dropdown list for a field, the search
will return inactive records if the Inactive filter is set to Either or Yes. Inactive records in
these search results can be added to transactions. To filter inactive records out of
search results, be sure to set the Inactive filter to No in the search criteria.

As your business grows, you may no longer need certain records in your NetSuite account. Rather than
deleting a record you do not currently use, you can mark the record as inactive.

When you mark a record as inactive, the record remains in the system for future reference. However, the
inactive record does not show on transactions for selection in lists.
Inactivating records is a quick and useful way to clean up your lists and keep your records up to date. By
keeping only current records active, it is easier to find the right selection in lists on transactions because
outdated choices do not show in the list. This makes form entry easier, accurate, and less prone to error.

You can make records inactive one at a time by checking the Inactive box on individual records. The
Inactive box shows for users with the appropriate permission to change records.
You can also make many records inactive at one time by marking them on a list page, as described below.

4. Click Save. The file you selected is saved to the filing cabinet and attached to the record.

When anyone in your company opens the record, they can also view files associated with the record.
Access to the File Cabinet folder is required to view a file from that folder when it is attached to a record
or transaction. For information about access to File Cabinet folders, see Restricting Access to File Cabinet
Folders.

Important:A file in the Attachments Sent folder or Attachments Received folder cannot
be attached to records or transactions. You must move the file to another folder. For more
information, see Moving and Copying Files in the File Cabinet.
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Inactivating Records

To inactivate list records:

Duplicate Record Detection



Note: System notes are not transferred from duplicate entity records to the primary entity
record during a merge. Merging entities updates the system notes and last modified date for all
transactions associated with the duplicate entity or entities. The system notes for these
transactions will indicate that they were updated by the Duplicate Resolution process.

configures the types of records you detect duplicates of and also chooses which fields to consider when
finding duplicates. For more information about the setup of this feature, see the help topic Setting Up
Duplicate Detection.

Four types of records support duplicate matching: 

   Customer

   Vendor

   Partner

   Contact

Warning:Merging entities is a data-intensive operation, and complex merges of many records
such as transactions, custom fields, or workflows may time out when processing. You should test
the merge process in a sandbox account first to ensure that it can be completed.

You should designate the entity with the most transactions as the primary entity and entities with
fewer transactions as duplicates to reduce the time it takes to complete the merge. You should
also avoid merging entities with large numbers of transactions whenever possible.

With this feature enabled, you receive notification before saving a record that might be a duplicate.
Notification occurs in two ways:
    When you create a new record and enter matching data in fields the administrator set up as duplicate

criteria, a warning appears at the top of the record with a link to the potential duplicates. If you have
permission to view those records, you can click the link to resolve these matching records.

    When you add a record from a list by using Quick Add or use the Edit button to make changes to a
record that would make it a duplicate, you receive a popup warning.

You can also go to Lists > Mass Update > Entity Duplicate Resolution to search for all possible duplicate
records based on criteria you have set. With the duplicate resolution mass update, you can find and
resolve large numbers of duplicate records in your NetSuite account in a single operation.

For more information about how to manage duplicate records, see Manage Record Duplicates Page.

Note:Private contacts are excluded from the Duplicate Detection process.

You must have full permissions to the entity types you are merging. For example:

■

■

You must have full permissions for Vendors to merge two vendors.

You must have full permissions for both Contacts and Customers to merge Individual Customers,
which are composed of both.

You must have full permissions for both Customers and Vendors to merge into a Customer/Vendor
entity.

■

Duplicate Customers and Vendors can be detected across subsidiaries. The subsidiary a potential
duplicate customer or vendor belongs to is shown in the Primary Subsidiary column. You must first
enable the Detect Duplicates Across Subsidiaries feature at Setup > Company > Company Management >
Duplicate Detection.
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For more information, see the following:

■

■

■

Merging or Deleting Duplicate Records

Merging Large Numbers of Records

Merging Different Types of Records

      Words Excluded from Duplicate Detection Matching

Note:System notes are not transferred from duplicate entity records to the primary entity
record during a merge. Merging entities updates the system notes and last modified date for
all transactions associated with the duplicate entity or entities. The system notes for these
transactions will indicate that they were updated by the Duplicate Resolution process.

Duplicate Record Detection

When you find duplicate records in your NetSuite account, you can merge them, resulting in one
complete record for each person or company you do business with.

The Administrator role is required to set up which types of records you detect duplicates for and how
you determine that two records are duplicates. An administrator selects fields on records to check for
matching information. When matches are found, the system identifies the records as possible duplicates.
For example, the administrator may choose to identify duplicates based on matching email addresses. If
the selected fields are blank, they do not match.

When you merge records, the records' transaction histories are also merged. The original data, such as
entity name, is retained to preserve a transaction's history. Your administrator may have restricted the
ability to perform merges to specific roles.

Warning:Merging entities is a data-intensive operation, and complex merges of many records
such as transactions, custom fields, or workflows may time out when processing. You should test
the merge process in a sandbox account first to ensure that it can be completed.

You should designate the entity with the most transactions as the primary entity and entities with
fewer transactions as duplicates to reduce the time it takes to complete the merge. You should
also avoid merging entities with large numbers of transactions whenever possible.

You can merge duplicate entity records that have login access but have different email addresses only
if an administrator has set the Resolve Duplicates with Conflicting Login Access preference to By
deleting the duplicates' access. This setting deletes the login access of records you define as duplicates.
When this preference is set to the default value of Manually, you must first manually remove the login
access of one record before you merge. The person whose access is removed must use the login access
defined on the primary record. Be sure to notify this person of the change because the deleted login will
no longer work.

To prevent you from merging records that are not duplicates, you can only merge records if they have the
same tax registration numbers or if both records do not have tax registration numbers.
This section is divided into the following subsections:

■

■

Manage Record Duplicates Page

Submitting Merge Operations

Merging Records with Active Workflow Instances

■ Status and Timing of Merge Operations
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Merging or Deleting Duplicate Records
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Duplicate Record Detection

Note:For NetSuite OneWorld accounts: entities associated with different subsidiaries can be
merged only if they are the same type.

For more information administrators should see the help topic Setting Up Duplicate Detection.

All potential duplicate records are grouped together on this page. These groups are assigned a number
in the Group # column. For example, if you are searching for duplicates by phone number and have three
records with the same phone number, all of these records have the same group number.

The Fields column shows how many fields on each record contain data. Often duplicate records have less
information entered than primary records do.
You can customize the columns displayed on the Manage Customer Duplicates page by clicking
Customize View. Creating a customized view can be helpful when the default view does not display

The Manage Duplicates page presents lists of records that NetSuite has identified as possible duplicates.

You can access this page in two ways:

■ The Manage Duplicates page opens when you click the link on a duplicate warning message. These
warning messages appear when you open a record that has been identified as having potential
duplicates or when you attempt to save a new record with information that matches an existing
record.
If you use the administrator role or have a role with the Mass Updates permission, you can access
this page at Lists > Mass Update > Entity Duplicate Resolution. From here, you can search matching
records and resolve many duplicates in a single operation. For more information, see the help topic
Setting Up Duplicate Detection.

■

On the Manage Duplicates page, you specify which records are duplicates and which are not. You can also
specify a primary record for each set of possible duplicates. If the primary record and duplicate record
have different information for the same field, the information from the primary record takes precedence
and is preserved. The information in the duplicate records for these fields is lost.
In the Merge Type field at the top of the page, you select how to process the records in the list. For more
information, see Submitting Merge Operations.
For duplicate searches of customer and contact records, some common words are excluded to prevent
false matches. For a list of these words, see Words Excluded from Duplicate Detection Matching. Also
note that in OneWorld accounts, records associated with different subsidiaries are never considered
duplicates even if the information in those records matches.
In the following screenshot, you can see an example of the Manage Duplicates page. The list of records
is filtered to show customers. You can change the Entities filter value to see duplicates of other types of
records.
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Click the notice in the duplicate record.

Note:System notes are not transferred from duplicate entity records to the primary entity
record during a merge. Merging entities updates the system notes and last modified date for all
transactions associated with the duplicate entity or entities. The system notes for these
transactions will indicate that they were updated by the Duplicate Resolution process.

Note:You must have the full level of the Duplicate Entity Management permission to merge
duplicates. By default, the Sales Person role has only view level. The Sales Manager and
Administrator roles have full level.

Warning:Merging entities is a data-intensive operation, and complex merges of many records
such as transactions, custom fields, or workflows may time out when processing. You should test
the merge process in a sandbox account first to ensure that it can be completed.

You should designate the entity with the most transactions as the primary entity and entities with
fewer transactions as duplicates to reduce the time it takes to complete the merge. You should
also avoid merging entities with large numbers of transactions whenever possible.

Warning:Merging entities is a data-intensive operation, and complex merges of many records
such as transactions, custom fields, or workflows may time out when processing. You should test
the merge process in a sandbox account first to ensure that it can be completed.

You should designate the entity with the most transactions as the primary entity and entities with
fewer transactions as duplicates to reduce the time it takes to complete the merge. You should
also avoid merging entities with large numbers of transactions whenever possible.

columns for the fields you are most interested in. For example, if you are searching for duplicates based on
the Email field, you may want to create a view called My Duplicates where the Email field is displayed as a
column.

You can use the following buttons to quickly select and resolve duplicate records:

      Click Mark All As Dup. to check all the boxes in the Duplicate column. When you click Merge
Selected, these records are processed according to the option you select in the Merge Type filter.
Click Mark All As Not Dup. to check all the boxes in the Not A Dup. column. These records are not
merged.

Click Unmark All to clear all the boxes.

Note:System notes are not transferred from duplicate entity records to the primary entity
record during a merge. Merging entities updates the system notes and last modified date for
all transactions associated with the duplicate entity or entities. The system notes for these
transactions indicate that they were updated by the Duplicate Resolution process.
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Submitting Merge Operations

To search for possible duplicates:

■

■

■
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Expand the Filters area at the top of the list to display the filters.

In the Entities filter, select a type of record to view possible duplicates for that type.

For example, select Contacts to view all contacts you have access to that have some of the same
information as other contact records.

Important:You can merge two records that both have login access only if those
records have different login email addresses and passwords.

In the Merge Type field, select how you want to merge the selected records:

For each group of records, check the box in the Master column next to the record you want to
designate as the main record. Information from duplicate records is merged into empty fields on
the primary record.

Check the box in the Duplicate column next to any record that is for the same person as the
primary record. Information from these records is merged into the primary record.
You can also click Mark All As Dup. to check all boxes in the Duplicate column.

Check the box in the Not A Duplicate column next to any record that is not for the same person as
the primary record. These records remain unchanged.

You can also click Mark All as Not Dup. to check all boxes in the Not a Dup column.

Click Submit Selected to complete the action you selected in the Merge Type field.
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3.

4.

5.

6.

7.

8.

Option 

Mark all selected as not
duplicates
Make duplicates subcustomers of      This option is available only for customer records. It makes the duplicate

Description

This leaves all records without any changes.

master
record a subcustomer of the primary customer record. For more
information, see the help topic Creating a Subcustomer Record. This

merges all information from the duplicate records into empty fields
in the primary record. If information is entered in the field on both the
primary and the duplicate, the information about the primary record
remains the same.

This saves the record with the earliest date in the Created column and
places information from selected duplicated records into any empty
fields on the saved record.

Merge duplicates into master
record

Merge duplicates into record
created the earliest

Merge duplicates into record with     This saves the record with the highest number in the Fields column and
most populated fields places information from selected duplicate records into any empty fields

on the saved record.

Merge duplicates into record with      This saves the record with the most recent date in the Last Activity
most recent activity column and places information from selected duplicate records into

empty fields on the saved record. This saves only the record you

selected as the primary and deletes all
records you selected as duplicates.

This saves the record with the earliest date in the Created column and
deletes all other selected records in this group.

This saves the records with the highest number in the Fields column
and deletes all other selected records in that group.

This saves the record with the most recent date in the Last Activity
column and deletes all other selected records in the group.

This saves the record you designate as the original, primary record and
converts those you mark as duplicates into its subrecords.

Delete duplicates, keep master
record

Delete duplicates, keep record
created the earliest

Delete duplicates, keep record
with most populated fields

Delete duplicates, keep record
with most recent activity

Make duplicates subrecords of
master
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Warning:Merging entities is a data-intensive operation, and complex merges of many records
such as transactions, custom fields, or workflows may time out when processing. You should test
the merge process in a sandbox account first to ensure that it can be completed.

You should designate the entity with the most transactions as the primary record and entities with
fewer transactions as duplicates to reduce the time it takes to complete the merge. You should
also avoid merging entities with large numbers of transactions whenever possible.

Historical log records for duplicate merge tasks are saved in NetSuite for only seven days before the
information is permanently erased.

When you submit a duplicate merge operation, it is placed in a queue and is executed when operations
ahead of it in the queue are completed. Go to Lists > Mass Update > Duplicate Resolution Status to view
the Duplicate Resolution Status page. Here you can view the status of duplicate merge operations, the
number of records merged, and the number of records that could not be merged. You can view possible
errors that occur during the operation by clicking the Details link in the Errors column.

After you submit a duplicate merge operation, you can continue to work in NetSuite without waiting for
the merge operation to finish. Records you have marked as duplicates cannot be edited during the time
that the duplicate operation is queued or running. The primary record is locked only for a brief time when
the merge operation begins.

Note:System notes are not transferred from duplicate entity records to the primary entity
record during a merge. Merging entities updates the system notes and last modified date for
all transactions associated with the duplicate entity or entities. The system notes for these
transactions will indicate that they were updated by the Duplicate Resolution process.

When you merge records, the records may have active workflow instances running on them. In this case,
NetSuite keeps the workflow instance running on the record that you choose to keep and cancels any
other workflow instance.

For example, you merge duplicate customer records that each have an active workflow instance named
Process Customer running. Depending on the options you choose in the Merge Type list on the manage
duplicates page, NetSuite keeps one of the records, merges the other entity fields with that record, and
cancels any workflow instances on the duplicates. In this example, only one instance of the Process
Customer workflow will run on the record after the merge operation.

Note:System notes are not transferred from duplicate entity records to the primary entity
record during a merge. Merging entities updates the system notes and last modified date for
all transactions associated with the duplicate entity or entities. The system notes for these
transactions will indicate that they were updated by the Duplicate Resolution process.

Warning:Merging entities is a data-intensive operation, and complex merges of many records
such as transactions, custom fields, or workflows may time out when processing. You should test
the merge process in a sandbox account first to ensure that it can be completed.

You should designate the entity with the most transactions as the primary record and entities with
fewer transactions as duplicates to reduce the time it takes to complete the merge. You should
also avoid merging entities with large numbers of transactions whenever possible.

For more information about the types of merges that you can perform, see Submitting Merge Operations.
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Duplicate Record Detection

Sometimes duplicate records exist between record types, such as a vendor record and a partner record
for the same person or company. The Duplicate Detection feature only searches for possible matches
within the same record type, but if you know of duplicated between two record types, you can merge
them manually.

Warning:Merging entities is a data-intensive operation, and complex merges of many records
such as transactions, custom fields, or workflows may time out when processing. You should test
the merge process in a sandbox account first to ensure that it can be completed.

You should designate the entity with the most transactions as the primary record and entities with
fewer transactions as duplicates to reduce the time it takes to complete the merge. You should
also avoid merging entities with large numbers of transactions whenever possible.

NetSuite can merge an unlimited number of records using the Mass Update functionality. Administrators
set the rules for the merge process to determine which record in a set of duplicates is the primary record
and configure the criteria to control the search results.

Note:System notes are not transferred from duplicate entity records to the primary entity
record during a merge. Merging entities updates the system notes and last modified date for
all transactions associated with the duplicate entity or entities. The system notes for these
transactions will indicate that they were updated by the Duplicate Resolution process.

1.
2.

Go to Lists > Mass Update > Mass Updates.

In the Action column, expand the Duplicate Resolution options, and click the type of record you
want to merge.
Use the dropdown list in the Master Selection Mode field to define the primary record. You can
use the following modes:

3.

■ Created earliest – This mode selects the record that was created first as the primary record.
Most populated fields – This mode selects the record that has the most fields containing data
as the primary record.
Most recent activity – This mode selects the record with the most recent activity as the
primary record.

4. Use the Record Selection Mode list to define which records are selected. You can use the
following modes:
     All from duplicate group – Both the primary record and the duplicate records are selected

from the complete group of duplicate records, and search results are used only to determine
the groups.

     Master from duplicate group – The primary record is selected from the whole group, and
duplicates are selected from the search results only.

Master and duplicates from search only – Both the primary record and the duplicate records
are selected only from the search results.

You can use various criteria to define which records are included in the operation and schedule regular
duplicate merge operations to take place automatically at regular intervals.
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To merge large numbers of duplicate records:

■

■

■

■

■



You can merge Customer/Vendor entities across subsidiaries, creating a single multi-subsidiary
Customer/Vendor entity. Merging two entities from different subsidiaries results in the following:

■
■
■

The primary subsidiary becomes the Master Entity subsidiary.

The Duplicate Entity subsidiary becomes a secondary subsidiary for each entity.
The Contact from the primary subsidiary is linked and synchronized with the primary entity.

Note:System notes are not transferred from duplicate entity records to the primary entity
record during a merge. Merging entities updates the system notes and last modified date for
all transactions associated with the duplicate entity or entities. The system notes for these
transactions will indicate that they were updated by the Duplicate Resolution process.

Duplicate Record Detection

Warning:Merging entities is a data-intensive operation, and complex merges of many records
such as transactions, custom fields, or workflows may time out when processing. You should test
the merge process in a sandbox account first to ensure that it can be completed.

You should designate the entity with the most transactions as the primary record and entities with
fewer transactions as duplicates to reduce the time it takes to complete the merge. You should
also avoid merging entities with large numbers of transactions whenever possible.

You can merge records between the following record types:

      Partners
      Vendors 
      Customers

Records are listed as duplicates when they have either matching or similar information. When searching
for similar information, NetSuite excludes certain words or phrases that occur often in fields to avoid false
duplicates. This list is organized by field name.

1. Open the duplicate record you want to merge into a primary record in edit mode. Do not make any
changes to the record.
Click Merge. This opens a new page.
In the Master field, select the name of the customer, partner, or vendor record into which the record
should be merged.
The record selected in the Master field becomes the primary record.
A summary of the files to be merged will appear in the Duplicate/Master Summary.
Click Save.

2.
3.

4.
5.

The merged record opens. All activities, transactions, messages, files, cases, contacts, and other subtab
lists are combined on the merged record. Fields previously blank on the primary record are filled with
information from the duplicate record, but no field data is replaced.

Note:Administrators can restrict the ability of users to merge records. For more information
about how to limit the merge function by role, see the help topic Duplicate Entity Management
Permission.
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To merge records of different types:

Words Excluded from Duplicate Detection Matching

■
■
■
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Duplicate Record Detection

The following words or abbreviations are not considered when searching for similar information to
prevent false matches in the company or customer name field:

      Corp.
      Corporation

Co.
      Company
      Inc.
      Incorporated
      Enterprise(s)
      Firm
Note that duplication detection also ignores variations of these terms, such as abbreviations without
periods at the end.

If you identify duplicates based on matching email address, you can set duplicate criteria on Email (full) to
identify duplicates only if the full email addresses of two records match exactly.

If you set duplicate criteria based on Email (domain only), the domain names listed below are not
considered when searching for similar information to prevent false matches for email addresses.
Administrators can add or remove a domain from the default list in the Excluded Domains subtab
on the Set Up Duplicate Detection page at Setup > Company > Company Management > Duplicate
Detection.Administrators can also configure a unique list of domains to be excluded from Email (domain
only).
    adelphia.net
    altavista.com
    ameritech.net
    aol.com
    attbi.net
    att.net
    bellsouth.net
    bigfoot.com
    comcast.net
    cox.net
    earthlink.com
    excite.com
    gmail.com
    home.com
    hotmail.com
    ix.netcom.com
    juno.com
    lycos.com
    mindspring.com
    msn.com
    netscape.net
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Duplicate Record Detection

Addresses are considered potential duplicates based on the street number and name. Similar numbers
with a street name match are considered potential duplicates, for example.

The following words or symbols are not considered when searching for potential duplicates in the
Address field:

      Street/St.
      Avenue/Ave.
      Court/Ct.
      Suite/Ste.
      Apartment/Apt.

■ #
      Lane/Ln.
      Highway/Hwy.
      Road/Rd.
      West/W.
      North/N.
      East/E.
      South/S.
      NW
      SW

■ SE

When searching the phone number field for duplicates, all prefixes and extensions are excluded so that
only the 9 digit or 6 digit numbers are considered. If two matching phone numbers are compared, one
with an area code and one without, they are not detected as duplicates.

Address

netzero.com
pacbell.net
prodigy.net
qwest.net
sbcglobal.net
swbell.net
sympatico.ca
verizon.net
worldnet.att.net
yahoo.com
yahoo.co.uk

Note:Potential duplicate results are determined differently when using the email address from a
customer record than from a contact record. Customer records are flagged as potential duplicates
when the domain name portion of the address matches, provided the domain name is not listed
on the Excluded Domains list. Contact records are flagged as duplicates only if the entire email
address matches. This difference prevents false potential duplicate results when multiple contact
records from one company use the same domain name in their email addresses.
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Working with Groups

A group is a set of employees, contacts, customers, partners or vendors. You can create groups of
records to communicate with a set of individuals. For example, invite a group to a meeting, or create
folders in the File Cabinet for a specific group in your organization.

With groups you can do the following:

■
■
■
■

Invite everyone in a group to the same event.
Use the shared calendar to see when the group meets or has other scheduled events.
Create folders in the File Cabinet that only group members can view.
Assign cases, leads, and support or sales territories to groups if the Support Group or Sales Group box
is checked on the group record.
If you use the Marketing Automation feature, customer, lead and prospect groups can be selected as
target groups for marketing campaigns. You also send email, mail or faxes in bulk to a group using the
Mail Merge feature. You can divide groups into marketing test cells that enable you to test different
versions of a marketing template.
If you use the Team Selling feature, you can create sales teams. For more information, see the help
topic Setting Up a Sales Team.

■

■

You can create groups by choosing members individually or by using a search of records. To create a
group, go to Lists > Relationships > Groups > New.

You can create two types of groups: 

      Dynamic groups – Dynamic group membership changes to include anyone who meets the group's
criteria.
For example, you can set search criteria to create a group of all employee sales reps. When a new
sales rep is hired, the rep automatically becomes a member of this dynamic group. When a sales rep
takes a position in another department, that rep is removed from the group automatically. Whenever
you use the Mail Merge feature to send bulk email to this dynamic group, NetSuite uses the search
criteria to determine the current group members.
You can create dynamic groups from new searches or saved searches. See Creating a Dynamic Group.
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Working with Groups

■ Static groups – The membership of static groups does not change.
You can create static groups by selecting members from lists or with a search. Support and sales
groups must be static groups. See Creating a Static Group.
You can use also CSV Import to create static groups. For more information, see the help topic Group
Import.

Note:Be aware that you cannot create a static group with more than 10,000 members. For
groups larger than 10,000, you must create a dynamic group.

When you create a group, the Restrict Group Editing to Owner box is checked by default. Please be
aware that if you clear this box, anyone with access to the group can modify it, delete members and
access File Cabinet folders. You should ensure that the appropriate permissions have been applied to the
roles assigned to this group.
For detailed information about groups, see the following topics:

■
■
■
■

Creating a Dynamic Group
Creating a Static Group
Creating a Contact Group
Adding and Removing Members of Groups

Go to Lists > Relationships > Groups > New.
On the Create Group page, choose Dynamic.
Choose the kind of members you would like this group to contain.
Click Continue.
Enter a name for this group.
Select an existing saved search in the Saved Search list.

■
■

Only saved searches that include the kind of members you selected in step 3 appear in the list.
For more information about saved searches, see the help topic Defining a Saved Search.
Depending on the kind of group you are creating, you can use joined searches to generate your
results. For example, if you are creating a customer group, you can use a transaction search
to give you the desired results. If you are creating a contact group, you can search for vendors
that meet the criteria.
After you select or create a saved search, the members of the group are shown on the
Members subtab.

If the owner of this group is someone else, select that person in the Owner field.

Dynamic group membership changes to include anyone who meets the criteria defined in a saved search.

For example, you can set search criteria to create a group of all employee sales reps. When a new sales
rep is hired, the rep automatically becomes a member of this dynamic group. When a sales rep takes a
position in another department, that rep is removed from the group automatically. Whenever you use
the Mail Merge feature to send bulk email to this dynamic group, NetSuite uses the search criteria to
determine the current group members. You can create a dynamic group from an existing saved search or

you can create a new saved search
when you create the group.

To create a dynamic group:
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Go to Lists > Relationships > Groups > New.
On the Create Group page, choose Static.

Working with Groups

The membership of a static group remains constant. You can create static groups by selecting members
from lists and with a search. Support and sales groups must be static groups.

You can also use CSV Import to create and update static groups. For more information, see the help topic
Group Import.
You can add or remove members from a static group at any time.

Note:You cannot create a static group with more than 10,000 members. For groups larger than
10,000, you must create a dynamic group.

Note:Owners for dynamic groups and saved searches are configured separately. Only
the owner of the saved search can save changes when editing a saved search.

8.
9.

10.

(Optional) If this group shares an email alias, enter the email address in the Email field.

(Optional) Enter other information about this group in the Comments field.
(Optional) Check the Private box if you want to restrict viewing (and also editing) of this group to
its members.
(Optional) If you want to restrict access to this group to members of another group, select the
group in the Restrict To field.

11.

Note:Restricted groups cannot be marked private. Restricted groups can only be used by
members of the group you select in the Restrict To field.

12. (Optional) Clear the Restrict Group Editing to Owner box if you want to allow other group
members to edit this group. By default, this box is checked.
You should check the Restrict Group Editing to Owner box when you set up a group that
controls access to sensitive information such as access to particular File Cabinet folders.
If you intend to grant other members of the group editing permissions, You should either make
the group private or restrict it to another group by enabling the relevant setting on the group
records page. Do not store sensitive material in a File Cabinet folder that is accessible from a public
group.
You should also ensure that the role used to access the group has an appropriate CRM Groups
access level assigned to it on the relevant manage roles page. Go to Setup > Users > Role >
Manage Roles.
If you clear the Restrict Group Editing to Owner box and choose to make your group public, any user
with access to a role with edit-level access to CRM Groups can access and edit your group’s content.
This includes access to File Cabinet folders as well as adding and deleting members.
For more information about assigning role-based permissions, see the help topic Reviewing
Permissions Assigned to Roles.

Click Save.13.

Now, every time a record of this type is created, it is added to this group if it matches the criteria in the
saved search.
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Working with Groups

Choose the kind of members you would like this group to contain.

Click Continue.

Enter a name for this group.

If applicable, complete the following:

■ If the owner of this group is someone else, select that person in the Owner field.

If this group shares an email alias, enter the email address in the Email field.

Enter other information about this group in the Comments field.

■ Check the Private box if you want to restrict viewing (and also editing) of this group to its
members.
If you want to restrict access to this group to members of another group, select the group in
the Restrict To field.

■

Note:Restricted groups cannot be marked private. Restricted groups can only be used
by members of the group you select in the Restrict To field.

■ Check the Restrict Group Editing to Owner box if you want to restrict editing permissions to
the group owner as specified in the Owner field.
You should enable the Restrict Group Editing to Owner preference whenever you are setting
up a group to control access to sensitive information. For example, when restricting access to
certain File Cabinet folders.

If you intend to grant other members of the group editing permissions, either make the group
private or restrict it to another group by enabling the relevant setting on the group records
page. Do not place sensitive material in a File Cabinet folder that is accessible from a public
group.

Also ensure that the role used to access the group has an appropriate CRM Groups access level
assigned to it on the relevant manage roles page. (Go to Setup > Users > Role > Manage Roles.)
If you disable Restrict Group Editing to Owner and choose to make your group public, any
user with access to a role with edit-level access to CRM Groups, can access and edit your
group’s content. This includes access to File Cabinet folders as well as adding and deleting
members.
For more information about assigning role-based permissions, see the help topic Reviewing
Permissions Assigned to Roles.

If you are creating an employee group, the following fields are available:

■ Support Group – Check this box to mark this group a support group.

On case records, support groups are listed in the Assigned To field. When you assign a case
territory, support groups are listed in the Support Rep. field.
Product Team – Check this box to mark this group as a product team.

Product team groups can be selected in the Product Team field on issues. Product teams
designate who is responsible for resolving an issue. Members of this team are emailed when an
issue is first entered so that everyone is aware of the problem.

Functional Team – Check this box to mark this group as a functional team.

Functional teams can be emailed copies of the issue from the Communication subtab on issue
records. You may want to check this box for all product team groups and then create additional
function team groups for other teams you want to email.

Issue Role – Select a role that corresponds to the role of this group's members, and this group
can be assigned to issues.

■

On the Members subtab, do one or more of the following:
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Working with Groups

Go to Lists > Relationships > Groups > New.
Select Static.
Choose the kind of record you want to enter criteria for.
In the example mentioned above, you would choose Customers. When you select Contact, the
group can include members from more than one entity type.
Enter a name for your group.

On the Members subtab, click Add With Search.
Choose the criteria you want to use for the search.

Enter criteria for the records whose contacts you want to create a group from.
Click Search & Select.

Click Add Static Members.

You can create contact groups based on searches for the record they are associated with. For example,
you could search for all customers with a specific sales rep and create a group of all contacts associated
with these customers.

To create a static contact group based on customer or other criteria:

You can create a contact group from the contacts associated with an entity search or entity groups.
If your company deals with customers, vendors, and other entities that are more often companies
as opposed to individuals, you probably use contact records for the people you work with in those
companies.

You can create contact groups based on contact record criteria or on criteria for the entity records those
contacts are associated with. For example, you might want to create a group of contacts for all customer
companies in a certain country. Your contact group would be based on customer search criteria.

To add individual members, enter part of a member's name in the Name column, and press
Tab. Select a member, and click Add. Repeat these steps for each member.

Click Add Multiple, and hold CTRL to select more than one member from the list.

Click Add With Search to enter search criteria for the members you want to add.
You can use more than one of these methods to add members to the same group. For
example, you can select a few members individually and then add all the members that meet
search criteria.

Depending on the kind of group you are creating, you can use joined searches to generate your results.
For example, if you are creating a customer group, you can use a transaction search to give you the
desired results. If you are creating a contact group, you can search for vendors that meet the criteria.

Note:To access a Group’s calendar, use the dropdown menu below the date selector on the
calendar portlet.

To add a member to this group, open the group record. On the Members subtab, use one of the
methods in step 8 to add a member.
To remove a member from this group, open the group record. On the Members subtab, click Remove on
the row of the member you want to remove.
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On the Create Static Group page, click Save.
When the record has saved, click Group Contacts.

Go to Lists > Relationships > Groups > New, and choose Dynamic.
In the dropdown list, select Contact.

Working with Groups

Dynamic groups are defined by search criteria. This means that the membership of a dynamic group
changes as new contact records are created that meet your criteria and as existing contact records are
edited and no longer meet the group criteria.

To create a dynamic contact group based on customer or other criteria, you should first go to Lists
> Relationships > Contacts > Search and create a saved search for the contacts based on fields from
customer or other records.

12.
13.

Enter a name for the static contact group.
If you want to remove any of the contacts from the group, choose the contact name and click
Remove.
Click Save.14.

You can also create static contact groups from an entity group. To do this, open an entity group record,
and click Group Contacts at the top of the record.
You can also use CSV Import to create and update static Contact groups. For more information, see the
help topic Group Import.

Creating a Dynamic Contact Group
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Click Continue.
Enter a name for the group.
In the Saved Search field, select the saved search you created.
Click Save.

In the following procedure, see how to remove members from a static group.
To remove members from a static group:

Working with Groups

Dynamic group membership is updated automatically as the results of the saved search change. You
must add and remove members of static groups manually.
To add members to a static group:

Go to Lists > Relationships > Groups, and click the link to open the record for the group you want to
add a member to.
On the Members subtab, do one or more of the following:
      To add individual members, enter part of a member's name in the Name column, and press

Tab. Select a member, and click Add. Repeat these steps for each member.
      Click Add Multiple, and hold CTRL to select more than one member from the list.
      Click Add With Search to enter search criteria for the members you want to add.

You can use more than one of these methods to add members to the same group. For
example, you can select a few members individually and then add all the members that meet
search criteria.

Go to Lists > Relationships > Groups, and click the link to open the record for the group you want
to add a member to.
On the Members subtab, click Remove on the row of the member you want to remove.

A transaction is a record of a business event. Many transactions record financial agreements between
your business and its customers or vendors, such as sales and purchase orders, invoices, vendor bills, and
so on. Other transactions record events such as inventory adjustments and assembly build transactions.

Many transactions result in the posting of an amount to the general ledger (GL). Some examples of
posting transactions are bank deposits, vendor bills, and credit memos. Those transactions that do
not impact the general ledger are called non-posting transactions. Some examples of non-posting
transactions are purchase orders, sales orders, and return authorizations.

Note:Processed lines for some transaction types contribute to the Monthly Transaction Lines
metric that counts toward maximum limits for your NetSuite service tier. For more information, see
the help topic Transaction Types Included in Monthly Transaction Lines Metric.

A transaction is a specialized type of a record. For general information about records, see Working with
Records.
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Working with Transactions

Click a link below for information that is specific to transactions:

■
■
■
■

Creating Transactions
Entering Transaction Line Items
Entering Relationships on a Transaction
Entering Communication Information to a Transaction

Tips for Working with Transactions
■
■
■
■
■

Finding Transactions
Voiding, Deleting, or Closing Transactions
Memorized Transactions
Preferred Transaction Delivery on Customer and Vendor Records
Transaction Detail Report

Transaction Detail Workbook Overview
■ Limits for Display of Transaction Lists and Sublists

Most transactions support scripting using SuiteScript. For a list of scriptable transactions, see the
help topic Transactions. The individual transaction topics in this area include a brief description of the
transaction and a link to detailed information.

Note:For information about permissions, when working with transactions, see the help topic
Permissions Documentation.

Click the tab where you access transactions, and click the kind of transaction you want to create.
The transaction page opens with default information completed.
Enter or verify information in the required fields on the page. Required fields are indicated by an
asterisk (*).
This information may include the transaction date, transaction number, transaction status, class/
department/location classification, or a memo.

Note:In OneWorld accounts, after you select a subsidiary on a transaction and save it, the
subsidiary cannot be changed.

Enter information in the required fields in other areas of the page.

The types of transactions you can create and view depend on your role. Many roles have no access to
transactions. The set of tabbed pages you see in NetSuite, called a center, also depends on your role. The
centers are organized to facilitate your work. Most centers do not have a tab dedicated to transactions.
You may find transactions on tabs with a variety of names, such as Customers, Vendors, Revenue, or
Financial.

Note:Processed lines for some transaction types contribute to the Monthly Transaction Lines
metric that counts toward maximum limits for your NetSuite service tier. For more information, see
the help topic Transaction Types Included in Monthly Transaction Lines Metric.

If you use the classic interface for NetSuite, you have a Transactions tab that provides access to all of
the transaction types for which you have permission. This is a user preference in NetSuite. For more
information, see Personal Preferences for Appearance. 

To enter a transaction:
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Working with Transactions

When you create transactions, the shipping and billing addresses from the entity record are used by
default on the Shipping and Billing subtabs. If no shipping or billing address is available for an entity, the
address field is left blank. You must enter shipping and billing information for the transaction.

When entering transactions, you can add or edit shipping or billing addresses on entity records from
within the transaction. You can also enter a custom address that is used only for the specific transaction
and not stored on the entity record.

Note:If you use an address in an entity record and then change the address after creating the
transaction, ensure that you update the transaction record with the correct address. Otherwise,
some address fields might be blank.

See the following sections:

NetSuite automatically completes certain data based on information you enter.
For example, when you select a customer on an invoice, the customer's default ship to and bill to
addresses automatically appear on the transaction. An administrator can configure the default
values.
Enter data in the remaining fields as needed, including any custom fields that you have created.
Enter additional information for the transaction on each subtab.
For example, sales order, cash sale, and invoice transaction pages include an Items subtab. When
you select an item and click Add, the item appears as a line item on the transaction. Click on an
existing line item to add or edit, insert, remove or clear that line item.
When you have finished entering data for the transaction, NetSuite provides various options for
saving the transaction:

4.
5.

6.

■
■
■

Click Save to save the information and return to the Transactions page.

Click Save & New to save the information and open a new transaction page of the same type.
Click Save & Print to save the information and send the transaction to the print queue.

Click Save & Email to immediately save and email the transaction. The email message includes
the transaction as a PDF attachment, which is created using the customer’s preferred language.

Note:When processing transactions, you must save one page at a time. If you do not save each
page, information is not retained and can be lost when you click a different page.

NetSuite prompts you if any required field is not completed. It also checks for basic data entry errors.

If you have not completed a required field, you receive an error message about the missing data. Enter
data in the required field, and click Save again. When the information is correct and complete, NetSuite
accepts and records the transaction.

You can create and edit related records as you enter transactions. The following topics in this section
include information about transactions and related records:

     Working with Addresses on Transactions

■
■

Creating New Records as You Enter Transactions
Editing Records as You Enter Transactions

Defining Subsidiaries for OneWorld Transactions

■
■

Using Transaction Links

Linking a Transaction to a Support Case
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You can edit an existing address from a transaction.

You can add or edit an address for an entity from the transaction record.

You can add custom shipping or billing addresses for a single transaction.

Working with Transactions

To add or edit address on the entity record, see Adding or Editing a New Address from a Transaction.

To enter or edit a custom address for this transaction, see Adding or Editing a Custom Address for a
Transaction.
To change your state or province preference, see Setting the State or Province Field Preference.

Create a transaction. For more information, see Creating Transactions.

Enter entity in the appropriate field. For example, on a sales order, select a customer in the
Customer field.
The default shipping and billing addresses display on the Shipping and Billing subtabs. If a
shipping or billing address has not been entered for the entity, the Ship To or Bill To field is blank.
Click either the Shipping or the Billing subtab.

Select New in the Ship To Select or Bill To Select field, or click the + icon.

■
■

Check the box to make this address the default for shipping or billing.

Check the Residential Address box if this address is not a business. This helps retrieve
accurate rates when you use UPS or FedEx integration.

Enter a label to be displayed for this address in dropdown list address selectors.

Ensure the value for Country is correct. If it not, select a different country.
■
■

Enter the address information and click Save.

The address is saved on the entity record.

Create a transaction. For more information, see Creating Transactions.

Enter an entity in the appropriate field. For example, on a sales order, select a customer in the
Customer field.
The default shipping and billing addresses display on the Shipping and Billing subtabs. If a
shipping or billing address has not been entered for the entity, the Ship To or Bill To field is blank.
Click either the Shipping or the Billing subtab.

Select a different address in the Ship To Select or Bill To Select field.

A popup window appears. Edit address information as required.

Click Save.

The address changes are saved on the entity record.
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Adding or Editing a Custom Address for a Transaction

Editing a New Address

To add a new address from a transaction:

To edit an existing address from a transaction:



You can edit a custom address on an existing transaction.

To edit a custom address on an existing transaction:

Go to Setup > Company > Preferences > General Preferences ( Administrator ).

Open the transaction record.

Click the Shipping or Billing subtab.

In the Ship to Select or Bill To Select field, select Custom, and then click the Edit icon.

A popup window displays address fields where you can change the address.

Click Save.

Working with Transactions

Custom addresses are created on transactions automatically when an address has been used in
transactions and then the address is changed on the entity record. When the entity address is changed,
the address used in the transactions is changed to a custom address to keep it unchanged.

To enter a custom address on transactions:

Create a transaction. For more information, see Creating Transactions.

Select an entity in the appropriate field. For example, on a sales order, select a customer in the
Customer field.
The default shipping and billing addresses display on the Shipping and Billing subtabs. If a
shipping or billing address has not been entered for the entity, the Ship To or Bill To field is blank.
Click either the Shipping or the Billing subtab.

Select Custom in the Ship To Select or the Bill To Select field.

A popup window appears. Enter address information as required.

■ Check the Residential Address box if this address is not a business.

This helps retrieve accurate rates when you use UPS or FedEx integration.

Ensure the value for Country is correct. If it not, select a different country■
Enter the address information and click Save.

The address appears only on the transaction where it is entered and is not saved on the entity
record.

Note:After a custom address is entered, to change it on the transaction you must select Custom
again in the Select field.

The Allow Free-Form States in Addresses preference affects the few cases where the state field appears as
a body field on a record. In most cases, the state field is not a body field, but is part of a subrecord, and is not
affected by this preference. When the state field is part of a subrecord, states entered as free text are
automatically converted to abbreviations.

When the state field of the address appears as a body field on a record, you can set the format of the
state or province field. Check the Allow Free-Form States in Addresses box to enter any text you choose in
the State or Province field on addresses.

To set your State or Province field preference:
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Working with Transactions

2. Choose an option for the Allow Free-Form States in Addresses box:

■ Clear the box to disable free-form text entry in the State/Province field. Then, any text you
enter is converted to standard state or province identifiers.
Click here for more information about standard province identifiers.

Check the box to enable free-form text entry in the State/Province field. Then, you can enter
any text and it is not converted to standard state or province identifiers.

■

3. Click Save.

This preference does not affect your web store address form entries or UPS and FedEx shipping.

When you are entering transactions, you can create new records as you complete the transaction fields.
You do not need to leave the transaction record to create new records.

The following transactions in NetSuite require you to select an entity prior to adding a record from the
transaction:

     Write Checks – You must select a payee before you can create a new account.

■ Enter Sales Orders – You must select a customer before you can create a new job.

      Accept Customer Payments – You must select a customer before you can create a new bank
account.

For example, you are entering checks and want to enter a new bank account. Select a payee and then
click next to the Accounts field. In the popup window, enter the new bank account name, account
number, and whether the account is a subaccount of another. When you click Save, the Check page
appears displaying the new account in the Accounts field.

In NetSuite, some fields on transactions pages have an open icon next to them. Click the open icon to
view the selected record in a new tab. In the new tab, click Edit and make changes as needed.

For example, when you are entering a sales order you may want to enter a new phone number for the
customer. On the sales order, select the customer and then click the open icon. On the open customer
record, click Edit and enter the new phone number. Then click Save. The changes you make to the open
record are included in the sales order you are entering.

Each transaction in NetSuite OneWorld, except advanced intercompany journal entries, is tied to one
subsidiary. When a transaction includes an entity, such as a customer, the transaction is assigned to the
same subsidiary as the entity. For transactions without entities, you must manually select a subsidiary.
When you process transactions in bulk, such as fulfillments, bill payments, or commission authorizations,
select the appropriate subsidiary to filter the list of transactions to process.

Intercompany journal entries post to two subsidiaries. These journal entries record transactions between
subsidiaries. Each advanced intercompany journal record includes an originating subsidiary and one or
more receiving subsidiaries. For more information, see the help topic Making Advanced Intercompany
Journal Entries.
Some time entries and expense transactions may be associated with multiple subsidiaries. Each time or
expense record is associated with the subsidiary of the employee. In addition, a customer or project can
be defined for each line of these records. If the Intercompany Time and Expenses feature is not enabled,
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You can link the following types of transactions to support cases:

■ Sales orders

      Invoices

■ Purchase orders

Estimates

■ Cash sale

      Opportunity
      Work order For example, your company can create an invoice for a repair service performed for a

customer and
associate it with the support case that originated the service request.

To link a transaction to a support case:

Working with Transactions

Most transactions in NetSuite provide links to other related transactions. You can use these links to drill
down to the related transactions.

Some transactions provide links to the transactions from which they were created. For example, on a
sales order the Created From link opens the estimate used to generate the sales order.
Other transactions have a link to the transaction created from them. For example, estimates have an
Orders and Sales link. Click the link to open the sales orders, cash sales, and invoices created from the
estimate.

Transactions such as payments or credits provide links to the transactions to which they are applied.
For example, on a deposit the Payments subtab displays the payment transactions associated with that
deposit. Clicking the date link next to a payment opens the payment transaction.

each line-level customer or project must be associated with the same subsidiary as the employee. If this
feature is enabled and related accounting preferences are set, customers and projects from other
subsidiaries can be selected at the line-level. For more information, see the help topics Enabling
Intercompany Time and Expenses, Expense Reports, and Understanding Time Tracking.

When a transaction has line-level associations to more than one subsidiary, the general ledger posts
only to the subsidiary identified in the transaction header. Advanced intercompany journal entries can
be created to transfer time, expense, or both charges from one subsidiary to another. An automated
adjustment process is available for intercompany expenses. For more information, see the help topic
Creating Intercompany Adjustments for Time and Expenses.

Note:In NetSuite OneWorld, List view pages and search results convert the transaction currency
to the base currency of the user’s subsidiary. For more information about List view pages, see List
View.

Open a transaction record.

Click the Related Records subtab.

Click Support Cases.

Click New Case to create a new support case or click Attach to link an existing support case to the
transaction.

155

Using Transaction Links

Linking a Transaction to a Support Case

1.
2.
3.
4.

■

■

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1476983.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1476983.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N908140.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N908140.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N902265.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N902265.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1478200.html


Check the box next to the line you are choosing.

If there are data fields, enter values into them.

In the following procedure, you see how to select and enter data and add them as a line item.

To enter line items by entering data:

Working with Transactions

Add the line-item information to the form.

Click Add to add the information as a line item.

The transaction total is updated in the header as you add each line item, and a new, empty line is
added.
Add more line items as necessary.

Click Save.

Most transactions require you to enter one or more line items to account for the transaction total. Line
items you enter determine the changes that post in NetSuite when you process the transaction. For
example, when you enter line items on an invoice and post it, the inventory total decreases and the
accounts receivable total increases, reflecting account changes for that transaction.

Note:The limit for transactions submitted through the user interface is 500 lines. For
transactions submitted through CSV import or SOAP web services, the limit is 5,000 lines per
transaction. After you submit transactions exceeding the 500 lines limit through the CSV import or
SOAP web services, you must do all additional changes and edits through the CSV import or SOAP
web services. For journal entries, these limits are 1,000 lines for the user interface and for

synchronous SOAP
web services, and 10,000 lines for CSV import and asynchronous SOAP web services.
You should limit yourself to 200 lines or less on a purchase order unless they are to be received by
WebServices.

Note:Processed lines for some transaction types contribute to the Monthly Transaction Lines
metric that counts toward maximum limits for your NetSuite service tier. For more information, see
the help topic Transaction Types Included in Monthly Transaction Lines Metric.

The method for entering line items depends on the type of transaction you are creating. Line-item
information is entered by either selecting and entering data and adding as a line item, or by selecting
lines with check boxes.

In the following procedure, you see lines of data, each with a box on the left. Many pages have data-entry
fields on the line.

To enter line items by selecting them from a list:
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Working with Transactions

1.
2.

On the transaction page, click the Relationships subtab.
Under Contacts , enter the contact's name, title, email address, phone number, subsidiary, and
role, and click Add.
Click Save.3.

You can also add contacts in view or edit mode after the transaction has been created.

You can associate contacts with a transaction by adding them on the Relationships subtab. If you have

the Multi-Partner Management feature enabled, you can associate partners with the
transaction. For more information, see the help topic Associating Partners With Customers and
Transactions. The Relationships subtab shows only on transactions that involve working with customers,

partners, or
other entity records. Entity records include company, contact, vendor, and employee.

To add contacts when creating a transaction:

3. Repeat Steps 1 and 2 until you have chosen all your line items.
The transaction total is updated in the header as you check each line item.
Click Save.4.

To change a line item, click on the line in the list. When the line-item data appears in the center of the
page, make your changes and then click Edit.
To remove a line item, click on the line in the list and then click Remove.

If you use the U.S. Version of NetSuite, you can charge taxes on a line item basis. For more information,
see the help topic Setting U.S. Tax Preferences.

Use the Communication subtab to create and send messages to your customers. You can also create
tasks, events, and phone calls and associate them with a transaction.

After you save the transaction, this information is combined on an Activities subtab. This enables you to
track meetings and conference calls you schedule in the process of finalizing a sale.
Not all transaction records have a Communication subtab.

When you change the tax code on a line item, the system recalculates the amounts depending on the order
of the columns on the form.

If the Amount column is before the Gross Amt column, then whenever you change the tax code on the
line item, the system updates the value in the Gross Amt column based on the tax rate of the selected tax
code. The value in the Amount column does not change.

If the Amount column is after the Gross Amt column, then whenever you change the tax code on the
line item, the system updates the value in the Amount column, based on the tax rate of the selected tax
code. The value in the Gross Amt column does not change.

For information about rearranging the order of the columns, see the help topic Configuring Fields or
Screens.
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Customize

■
■

Use Options
Print, Fax, Email, and Copy

Memorize
Maintain

Close

■
■
■

View the General Ledger

Use Shortcuts & Keyboard shortcuts
Get help

Working with Transactions

You can attach documents in the File Cabinet to records and transactions using the Communication
subtab. For more information, see Attaching Files to Records.

You can add messages as HTML, PDF, letter, or fax attachments. You can also embed the transaction
within the body of the message.

To attach messages as PDF, letter, or fax, you must have the Mail Merge feature enabled. For more
information, see the help topic Working with Mail Merge.
The Communication subtab tracks all related email and faxes sent and received. For information about
sending messages, see Sending Email from NetSuite.

You can create and track activities directly from the transaction. For more information, see the help topic
Attaching Events, Tasks, and Calls to Records and Transactions.

Most transaction forms can be customized by using the Customize menu at the top of the page. The
appropriate permission is required to customize the form. If you do not see the Customize menu,
your current role does not include the permission.
Click List to open a list of all transactions of a specific type. From these lists, you can view and edit
transactions, print and export your lists, and go to transactions' registers. Your customization of the
viewing and sorting of the list will retain for the future views. You can change the list sorting by clicking
another column heading.

To add any notes related to the record or transaction you are working with, on the Communication
subtab, click the User Notes subtab. Then click New Note. The list permission Notes Tab controls access to
the User Notes subtab. You need at least Create level access to see the New Note button and add a note.
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Refer to the following sessions for tips when working with transactions:

■
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NetSuite Basics

Working with Transactions

Amount fields in transactions and records support computation. For more information, see Amount
Fields.

Memorize a transaction to recall and use it again later. To memorize a transaction, go to the transaction
type you want to memorize. Add the appropriate information to the form. From the Actions list, select

When you post a transaction, you can print, fax, or email a copy of the form:

Check the To Be Printed box to save the form in a queue for printing later.
Check the To Be E-mailed box and enter or verify an email address to email the form.
Check the To Be Faxed box and enter or verify a fax number to fax the form.

Administrators configure the fax and print setup at Setup > Company > Preferences > Printing & Fax
(Administrator). For more information, see the help topic Setting Printing and Fax Preferences.
Administrators configure the e—mail setup at Setup > Company > Email > Email Preferences
(Administrator). For more information, see the help topic Setting Email Preferences.
When you view a transaction, you can make a copy of the transaction:

From the Actions list, select Make Copy to replicate all the information from the original
transaction and link it to the original transaction.
For example, if an invoice is created from a sales order, the value in the Created From field is
copied to the new transaction. The new transaction is also displayed in the history of the original
transaction.

From the Actions list, select Make Standalone Copy to make a copy of the original transaction
that includes inventory costing but is not associated with the original.
For example, click Make Standalone Copy on a transactionw that uses advanced shipping to
create a cash sale or invoice that has the same items as the original and includes the cost of good
sold (COGS) account impact in addition to revenue. Because a standalone copy is not linked to the
original, it does not retain the value in the Created From field. The new transaction is not part of
the history of the original transaction and is considered a brand new transaction.

Some fields on transaction forms display a double arrow button that you can click for the List, Search,
and New options:

Click List to display a popup list of stored records from which to choose.
Click Search to search for a record.
Click New to open a window and create a new record for that field.

On transactions and records that have buttons with a dropdown list, you can select a different button
option. Use the Tab key to go to the dropdown button. Then use the Down Arrow key to expand the
dropdown list. Click Enter to select the desired action. To collapse the dropdown list, use the Up Arrow
key.
For more information, see Popup and Dropdown Lists and Buttons and Menus in NetSuite. Click Add

Multiple in the Items subtab to open the Choose Item window. This window displays a list
of items you can add. You can filter the list by item type or search for all or part of a name. When you
click an item in the left pane, it is added to the right pane, where you can enter a quantity for the item.
When you click Done, items and quantities shown in the right pane are added to the transaction.
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You can search for transactions in several ways.

To review or edit an existing transaction, select from these five procedures:

Working with Transactions

Memorize. The Memorized Transaction page opens showing the information you entered. For more
information, see the help topic Memorized Transactions.

To view the general ledger results of posting transactions, from the Actions list, select GL Impact. The
details of the general ledger impact of lines on the originating transaction are displayed.

■ To maintain performance, the limit for transactions submitted through the user interface is 500 lines.
For transactions submitted through CSV import or SOAP web services, the limit is 5,000 lines per
transaction.
For journal entries, the limits are 1,000 lines for the user interface and for synchronous SOAP web
services, and 10,000 lines for CSV import and asynchronous SOAP web services.

■

For more information, see the help topic Entering Transaction Line Items.

Close a line item on a transaction if you do not expect to fulfill or receive the item. To close a line item
on a transaction, click Edit on the transaction. Click the line you want to close and then check the
Closed box. Click Done and then click Save.
Close an entire transaction so that it no longer has an open status. When you view sales orders,
purchase orders, and return authorizations, click Close to check the Closed box for all lines on the
transaction. Then when you click Save, the transaction is no longer open.

Click the Help link at the top of the page to get help specific to the transaction you are working with.
Click the field name to display a popup window with field level help.

Important:When processing transactions in bulk, you must submit one page at a time. If you
do not process each page individually, information is not retained and can be lost when you click a
different page.

Use the Shortcuts menu to place a shortcut link on your home page to frequently-used transactions.
For more information, see Navigation Menu.
Transactions support many of the same keyboard shortcuts as other records. When using tabbed
display, you can switch between subtabs by using keyboard shortcuts. Each subtab has a single letter
underlined in the title. Press and hold the Alt key on your keyboard and then press the corresponding
letter to switch to that subtab. The first field on the subtab is automatically selected. For information,
see Keyboard Shortcuts.
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Quick Find

Previous or Next

Go To Register

Search by Account

Search Transactions

Use the register to find a specific transaction.

To find a transaction through the register:

Use the Previous or Next icon to see the transaction you want.

To find the previous or next transaction:

Use the Quick Find tool for a quick search for transactions and other items.

To find a transaction with the Quick Find tool:

Click the Transactions tab.

Click the type of transaction you want to find.

On the transaction page, from the Actions list, select Go To Register.

If the transaction you want doesn't appear on the register, clear the Open box to see all
transactions.
Click Submit.

On the full register, scroll to find the transaction you want.

Working with Transactions

Click the Transactions tab.

Click the type of transaction you want to find.

On the transaction page, click Previous or Next  until you see the transaction you want.

Select the appropriate button to edit, print, email, credit, or otherwise work with this transaction.

On any Transaction page, click Quick Find  at the top of the page.

When the Quick Find page pops up, enter some information to help you find this transaction or
related group of transactions:
      In the Name field, select the company or contact from the list whose transactions you'd like to

find.
In the Date field, enter or pick the posting date of the transactions you'd like to find.■
In the Number field, enter the number of the transaction you'd like to find.

For example, enter 1135 to find check #1135.

Click Submit.
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Use the chart of accounts to find a transaction.

To find a transaction by account:

Use the Search Transactions tool to find a transaction.

To find a transaction with the Search tool:

Working with Transactions

Click the transaction date in the left-hand column to see the details. A view-only version of the
transaction opens.

Select the appropriate button to edit, print, email, credit, or otherwise work with this transaction.

Go to Lists > Accounting > Accounts.

Click the name of the account with the transactions you want to see.

For example, if you want to locate a recent invoice, click an Accounts Receivable account.

When the register appears, clear the Open box if you want to see all transactions.

Click Submit.

Scroll to find the transaction you want.

Click the transaction date in the left-hand column to see the details.

A view-only version of the transaction opens.

Select the appropriate button to edit, print, email, credit, or otherwise work with this transaction.

Go to Transactions > Management > Search Transactions.

The type of search form you see is the type of search you last used to search for transactions.

If you see the search fields you want to use, enter criteria in the fields and click Submit for quick
results.
If you do not see fields displayed, you are using Advanced Search Mode. If you are not in Advanced
Search Mode and do not see the fields you want to use, check the Use Advanced Search box at
the top of the page.

1. In Advanced Search Mode, use the Criteria subtab to select the filters you want to use
when searching.
In the criteria popup, enter criteria for that filter.

Click Add/Edit.
On the Results subtab, you can select the fields from the resulting transactions that you
want to see on your results list.
Select a field, and click Add.

2.
3.
4.

Note:For a transaction search, adding a field that has multiple values for one
record causes that record to occur multiple times in the search result. Also, if results
include a record with a link type that has multiple values for that record, duplicates
occur in results, even if the link type field is not included as a search results field.

5. Click Submit to run the Search.
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You may need to change a transaction you have entered if it has errors or you do not intend to complete
it. The following sections explain the differences between voiding, deleting, and closing transactions:

■
■
■

Voiding Transactions

Deleting Transactions

Closing Line Items and Transactions

Important:Before you delete or void a posting transaction, check to ensure that the
transaction is not part of a match on the Reconcile Account Statement page. You should not
delete transactions that have been reconciled. For more information, see the help topic Viewing
Submitted Transactions.

1.
2.

Open the transaction for editing.

Click Void.

If the preference to void transactions with a reversing journal entry has been enabled, only certain
types of transactions can be voided. For more information, see the help topic Void Transactions
Using Reversing Journals Preference.

Voided sales orders do not show on the Transactions subtab of customer records. To view voided sales
orders, go to Transactions > Sales > Enter Sales Orders > List.
Additional help is available for some transaction types as follows:

■
■

For information specific to check transactions, see the help topic Voiding a Check.

For information specific to credit cards, see the help topic Voiding Credit Card Transactions.

Important:If the Use Deletion Reason feature is enabled in your account, users must provide
a reason for deleting transaction records. For more information about the feature, see the help
topic Recording a Reason for Deleting a Transaction.

You may want to remove a transaction from the system entirely. For example, after entering a transaction
you may realize it contains many errors. You can delete it and reenter the transaction.
From the Actions list on the transaction, select Delete. This option appears only if the Void Transactions
Using Reversing Journals preference is not enabled. Only users with a role that has full permission to

Voiding a transaction sets its total and all its line items to 0 but does not remove it from the system. This is
the preferred way to cancel an existing transaction because the audit trail is preserved. After you void a
transaction, you cannot make changes that have general ledger impact to the original transaction, including
changing the posting period.

If you void a transaction that was created to close another transaction, the original transaction is
reopened. For example, if an invoice was created to bill a sales order, voiding the invoice reopens the
sales order and sets the order’s status to pending billing. Then you must invoice the order again. Another
example is a bill payment that has been applied to a bill. If you void the bill payment, the bill is reopened.
Another payment must be entered against the bill.

To void a transaction:
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You can manually close transaction line items when you do not intend to fulfill or receive open items
on the order. For example, you sell 10 items to a customer and have already fulfilled five of them. Then
you discontinue the item and cannot fulfill the remaining five. If you close the line manually instead of
changing the quantity, you retain a record of how many were ordered originally.

To close a line item on a transaction, click Edit on the transaction. Click the line you want to close, check
the box in the Closed column and click Done. Then click Save.

Note:You must bill the sales order before you manually close the line. When all lines on a sales
order are fulfilled or closed manually, the sales order is removed from the billing and receiving
queues.

When you view sales orders, purchase orders, and return authorizations, click the Close or Close
Remaining button to close the entire transaction. This action checks the Closed box for all lines on the
transaction and changes the status of the transaction to Closed. You can reopen a closed transaction by
clearing the Closed box for all lines on the transaction.
For specific information about sales orders, see the help topic Closing a Sales Order.

a type of transaction can delete that type of transaction. If you do not have the necessary permission,
Delete does not appear on the Actions list.

If inline editing is enabled in your account and you have the necessary permission, you can delete
transactions from the transaction’s List page. Hover over the New column and click Delete Record from
the menu that appears. For more information about inline editing, see Using Inline Editing.

If the Use Deletion Reason feature is enabled in your account, both deletion methods open a Delete
popup window specific to the type of transaction being deleted. You must select a deletion reason and
may optionally include a memo. If you select the deletion reason Other, you must include a memo. When
you click Delete, the transaction record is removed from your system.
A deleted transaction does not retain a record of the transaction details. However, a record of the deleted
transaction remains in your audit trail.

Note:You cannot delete a transaction if it is linked to other transactions. For example, you
cannot delete an invoice that has been paid. You can, however, close linked transactions.

Note:To work with memorized transactions, you need a View level of the Memorized
Transactions permission.

A memorized transaction is a transaction you set up to recur in NetSuite, such as recurring journal
entries. Memorized transactions eliminate data entry and serve as useful reminders. A memorized
transaction consists of two parts: 

    The Memorized Transaction Template defines the transaction to be created.

    The Memorized Transaction Definition sets the parameters for when to create the transaction,
whether they are recurring, and how many transactions to create.

When you memorize a transaction, you set up the transaction to recur over time. You choose whether the
transaction automatically posts or if you are reminded to post it. Set the frequency the transaction should
occur and set posting options. You can specify that the transaction should recur forever or a set number
of times.
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When you edit or delete a memorized transaction, the change is tracked on the system notes of the
memorized transaction.

The following are limitations for posting memorized transactions in locked and closed periods:

■ A user must have the Override Period Restrictions permission to enable the Allow Posting in Locked
Period option for a memorized transaction. When this option is enabled, memorized transactions
can post in locked periods even if users initiating these transactions do not have the Override Period
Restrictions permission.
Transactions can never be posted in closed periods. If the posting date for a memorized transaction is
in a period that has been closed, it is posted to the next open period.

■

In NetSuite, you can memorize the following transactions:

      Checks

      Deposits

■
■

Credit Cards

Purchase Orders

Bills

■ Sales Orders

Invoices

Estimates

■
■
■

Cash Sales

Journal Entries

Statement Charges

Work Orders

■
■

Purchase Requisitions

Transfer Orders

Opportunities

■ Custom Transactions

The Reminders portlet includes a standard reminder for Memorized Transactions due. For more
information, see the help topic Setting Up Reminders.
After you have memorized a transaction, you can view and manage transactions created by the
memorized transaction by going to Transactions > Management > Enter Memorized Transactions. Click
Edit next to the transaction. The Transactions subtab shows associated transactions.

The time when the system runs memorized transactions varies by location, but is usually shortly after
midnight each day. The system checks for memorized transactions every four hours, and processes them
according to the start date. If the start date is the current day, the system processes the transaction
immediately, and then at the usual time each day afterward. If the start date is in the future, the system
processes the transaction at the usual time on that future date, and each day afterward. If the start date
is in the past, the system processes a transaction for each past day every four hours until caught up to the
current day, then processes a transaction at the usual time each day afterward.

By default, when NetSuite creates a memorized transaction automatically, it lists the last user who edited
the memorized transaction definition as the user who created the transaction. This user is visible in the
memorized transaction definition. To list the user as –System- for automatic memorized transactions,
set the Create Automatic Memorized Transactions as –System- preference at Setup > Company
> Preferences > General Preferences (Administrator). Changes to this preference take effect when
you create a new memorized transaction definition or you edit and save an existing one. For more
information, see the help topic Setting General Account Preferences.
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Note:When set, this preference does not support server-side scripting. If you want to use
server-side scripting and SuiteFlow on transactions, disable the preference.

For specific instructions, see the following topics in this section:

■
■
■
■
■
■

Memorizing a Transaction

Submitting Memorized Transactions
Editing Memorized Transactions

Customizing the Memorized Transactions List
Viewing the Status of Memorized Transactions

Deleting Memorized Transactions

Working with Transactions

For a list of the types of transactions you can memorize, see Memorized Transactions.

When you create a memorized transaction, the update is tracked on the system notes of the memorized
transaction.

■
■

To memorize a transaction:

Automatic Memorized Transactions

Edit the transaction you want to memorize, and make sure the appropriate information is filled in.

■ Posting transactions that contain serial or lot numbers cannot be memorized. This includes
creating invoices, entering cash sales, and fulfilling sales orders.
Non-posting transactions with serialized or lot items can be memorized, if the serial or lot
numbers are not entered on the transaction. This includes preparing estimates and entering
sales orders.
Memorized non-posting transactions with serialized items require serial numbers to be
entered at item receipt or fulfillment time. For example, you create a sales order that includes a
serialized item but do not enter the serial number for that item. Later, when you fulfill that sales
order, you will be required to enter the serial number for the serialized item.

If you select to email or fax your customer, your customer automatically receives an email or fax
each time the memorized transaction occurs.
If you enter credit card payment information, this credit card is automatically charged each time
the memorized transaction occurs.

■

■

■

From the Actions list, select Memorize.

When the Memorized Transaction page opens, the payee, vendor, customer, or project name you
selected when entering your memorized transaction appears in the Name field.
If you want to change the name of the memorized transaction, enter a new Name.

The name you enter appears in the list of memorized transactions but does not affect the name
you entered on the original transaction.
Choose one of three options in the Action dropdown list in the Primary Information section:
     Choose Template Only if you want to create a memorized transaction that will be used as a

template, but will not create any transactions.
     Choose Reminder if you want to be reminded when this transaction is due so that you can view

and edit it before you save it.
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      Choose Automatic if you want this transaction to automatically post. For information about this
option, see Automatic Memorized Transactions.

Check the Inactive box to prevent the memorized transaction from creating any more
transactions.
Check the Override Transaction Date box if you do not want the transaction to post on the
creation date. Then you must do the following:

■ In the Next Date field in the Recurring subtab, enter the next date you want the transaction to
be generated.
If you want this transaction to automatically occur, you must enter a next date here. If you do
not enter a next date, the transaction will not automatically post.
In the Next Transaction Date field beside Next Date, enter the date you want the transaction
to post.
For example, today's date is 7/15. You want the first transaction to be generated on 7/16 and to
post on 7/20. Check the Override Transaction Date box and enter 7/16 in the Next Date field
and 7/20 in the Next Transaction Date field beside Next Date.

■

Check the Allow Posting in Locked Period box to enable the transaction to post to an accounting
period for which transactions are locked. You must have the Override Period Restrictions
permission to check this box.
When this box is checked, memorized transactions can post in locked periods even if the user who
initiates the transaction does not have the Override Period Restrictions permission. Transactions
can never be posted in closed periods. If the posting date for a memorized transaction is in a
period that has been closed, it is posted to the next open period. For more information, see the
help topic Accounting Period Management.
Check the Update Addresses box to have the memorized transaction use the customer email, fax,
and address information that is current as of the date the transaction is created. This option applies
only to addresses on the customer record. Any other addresses, such as those included in the To Be
Emailed list, must be updated manually.
Check the Update Prices box to have the memorized transaction use sales pricing that is current
as of the date the transaction is created.
There are two options for setting the frequency of the memorized transaction:

Note:You will not be able to set a frequency if you selected Template Only in the Action
list in the Primary Information section.

■ To create recurring transactions based on the number of occurrences within a time period,
enter the following in the Recurring subtab:
□
□

Select the Next Date on which the memorized transaction will create a new transaction.
Select the number of times in a time period a transaction will be created in the Repeat
Every field.

Select the Time Period over which transactions will be created.
□ Enter the total number of transactions which should be created in the Number Remaining

field. If you do not want to set a limit on the number of transactions created, clear the field
and check the Indefinite box.

If you checked the Override Transaction Date box in the Primary Information subtab,
enter the Next Transaction Date on which you want the transaction to post.

■ To create transactions on specific dates, enter the Next Date to generate a transaction in the
Custom Dates subtab and click Add. If you checked the Override Transaction Date box in
the Primary Information subtab, enter the Next Transaction Date on which you want the
transaction to post.
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Go to Transactions > Management > Enter Memorized Transactions.

Working with Transactions

After you have set up memorized transactions you can submit all transactions due to be posted at one
time.

To create memorized transactions, see Memorizing a Transaction.

The frequency determines how often you receive the reminder if you choose Remind Me. If you
choose Automatic, it determines how often the transaction occurs.

Note: If Monthly is selected, and the Next Date selected is the last day of a month,
NetSuite will schedule all following transactions for this memorized transaction for the last
day of each month. For example, if you select a Monthly frequency and set the Next Date as
2/28/2019, subsequent transactions will occur on 3/31/2019 and 4/30/2019.
If you want your transactions to occur on the 28th, 29th, 30th, or 31st of every month, set
up a custom frequency in the Custom Dates subtab.

11.

12.

When you have finished, click Save.

If you clicked Automatic for this memorized transaction, you will be prompted to continue. Click
OK.

Your memorized transaction is saved.

After you create a memorized transaction, you can review it in the following ways:

■
■

Go to Transactions > Management > Enter Memorized Transactions > List. Select it from the list.

Go to Transactions > Management > Enter Memorized Transactions. Click View or Edit next to the
transaction.

Go to your NetSuite Home page and click the reminder you set up.

Clicking the reminder takes you to a list showing memorized transactions that are currently due. To
see all your memorized transactions, check the Show All box and click Refresh.

■

To view a list of memorized transactions due to be entered, go to Transactions > Management > Enter
Memorized Transactions.

If an error occurs when automatically executing a transaction, NetSuite generates an alert message
and changes the memorized transaction from Automatic to Remind Me. In this case, the transaction
will no longer be automatically generated. You must determine the cause of the error, then update the
transaction to correct the problem. After you update the memorized transaction, you can again select the
Automatic option on the memorized transaction. The memorized transaction will run automatically on the
next scheduled date.

For example, an account used in a memorized journal entry has become inactive. You receive an alert that
the transaction cannot be run. Update the journal entry with an active account number. Then select the
Automatic radio button on the memorized transaction to reset the journal entry to execute as scheduled.
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Note:There must be at least ten transactions for NetSuite to split the transactions into multiple
workqueues.

To view a list of all memorized transactions, go to Transactions > Management > Enter Memorized
Transactions > List.

On the Enter Memorized Transactions page, use the following filters to show transactions in the
list:

      Date

Enter or select the date you want these transactions to post.

The current date defaults in this field.

Use Next Date

Check this box to use the date of the next scheduled occurrence of the transaction as the
posting date. For transactions without a next date, the current date is used.
When this box is unchecked, the current date shows in the date field and is the posting date.

NetSuite remembers your preference for this box and checks or clears it the next time you use
this form.

■

       Has Remaining

□

□

□

Select Yes to show only transactions with remaining scheduled occurrences.

Select No to show transactions with no remaining occurrences.

Select All to show all memorized transactions.

■ Next Date

□ Select a date range to filter the list to show only transactions whose Next Date falls within
this range.

Select all to show all memorized transactions.□

 Action

□

□

Select All to show all memorized transactions.

Select None to show no memorized transactions.

       Select Automatic to show memorized transactions that automatically post and do not send
a reminder.

      Select Reminder to show memorized transactions that send a reminder for you to post
them.

      Select Template Only to show memorized transaction templates which do not create
transactions.

View
If you have customized list views, select a custom view in this field.

To edit an individual transaction, click its Edit link.

To process several memorized transactions at one time, check the box in the Enter column next to
each transaction you want to process.

You can also choose to click the Enter link next to a transaction to enter it individually.

To change all memorized transactions from Automatic to Remind Me, or from Remind Me to
Automatic at the same time, click Switch Action.

Click Submit.

A list of the new transactions shows on the Processed Transactions page.
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Go to Transactions > Management > Enter Memorized Transactions > List.

Click Customize View.

If the Results subtab is not displayed, click the Results subtab.

Select additional fields or change existing ones using the lists in Fields column.

Working with Transactions

When you view the Memorized Transactions list, you can customize the list view to show columns with
additional information. For example, you can display whether transactions are set to be emailed.

Important:When the Allow Posting in Locked Period option is enabled for a memorized
transaction, transactions can post in locked periods even if users initiating these transactions do
not have the Override Period Restrictions permission. Transactions can never be posted in closed
periods. If the posting date for a memorized transaction is in a period that has been closed, it is
posted to the next open period. For more information, see the help topic Accounting Period
Management.

1.
2.

Go to Transactions > Management > Enter Memorized Transactions > List.

Click Edit next to the transaction you want to change. For a description of the fields, see
Memorizing a Transaction.

Note:You must have the Override Period Restrictions permission to enable the Allow
Posting in Locked Period option. After this option is enabled, memorized transactions can
post in locked periods even if users initiating these transactions do not have the Override
Period Restrictions permission. Transactions can never be posted in closed periods.
If the posting date for a memorized transaction is in a period that has been closed, it is
posted to the next open period. For more information, see the help topic Accounting Period
Management.

3. Make the appropriate changes and then click Save.

Your memorized transaction is now updated with the current information.

You can make name, type, and schedule changes to a memorized transaction. You can also specify
posting options and update addresses to ensure that your information is accurate. However, if the field
that you want to edit on the memorized transaction is dimmed or not included on the page, you must
create a new original transaction and then memorize that transaction.

Some details that appear on the Memorized Transactions page at Transactions > Management > Enter
Memorized Transactions > List do not appear when you edit the transaction. For example, the transaction
amount appears on the Memorized Transactions page, but not when you edit the transaction. You can
edit such fields on the original transaction. For more information, see Working with Transactions.
When you edit a memorized transaction, the change is tracked on the system notes of the memorized
transaction.
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To edit specific details of a memorized transaction:
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Go to Transactions > Management > Enter Memorized Transactions > List.

Click Edit next to the transaction you want to delete.

From the Actions list, select Delete.

Note:If you do not see the Actions list with a Delete option, your role does not have
the correct permission level. You must have the full level of the Memorized Transactions
permission to delete a memorized transaction. For more information, see the help topic
Memorized Transactions.

NetSuite prompts you to confirm the deletion.

Click OK.

You can view the status of memorized transactions by going to Transactions > Management >Enter
Memorized Transactions > Status.

Each scheduled memorized transaction is shown along with the status. The statuses include:  

      complete – The transaction has been successfully created.

■

■

■

Failed – The transaction was not completed due to an error.

Pending – The transaction has been queued and will be processed in turn.

Processing – The transaction is currently being created.

If a memorized transaction fails, an Error link is shown in the Message column. Click this link to open the
error message that explains why the memorized transaction process failed.
You can customize the list of memorized transactions by clicking Customize View.

You can delete a memorized transaction if you no longer want it to recur. Deleting a memorized
transaction does not delete the associated transactions.

When you delete a memorized transaction, the change is tracked on the system notes of the memorized
transaction.

Note:It is not possible to delete a memorized transaction that is used by auto-create rules. You
need to delete the auto-create rule first to be allowed to delete the related memdoc.

To display whether transactions are set to be emailed, for example, select Transaction Fields...
and then in the Transaction Field list in the popup window, select To Be Emailed.

When you have finished with a row, click Add or OK.

When you finished your changes, click Save.

5.

6.

The Memorized Transactions list is a list view similar to other in NetSuite. For more information about how
you can customize lists, see Customizing List Views.
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Because each customer and vendor can have an individual preference for how to receive transactions,
you can set a preferred transaction delivery method on their records as the default way to deliver
transactions to them.

NetSuite automatically generates transaction email whenever the following records are saved:

1. Open the entity record.

■ For Customers: Go to Lists > Relationships > Customers > New. Click Edit next to the customer
whose record you want to update.
For Vendors: Go to Lists > Relationships > Vendors > New. Click Edit next to the vendor whose
record you want to update.

■

2.

3.

Click the Preferences subtab.

Next to Send Transactions Via, check the appropriate boxes:

      Email – Check this box to check the To Be Emailed box by default on transactions when this
entity is selected.
Print – Check this box to check the To Be Printed box by default on transactions when this
entity is selected.
Fax – Check this box to check the To Be Faxed box by default on transactions when this entity
is selected.

■

■

4. Click Save.

After you save these settings on their record, these boxes are checked by default.

On each customer and vendor record, define the entity’s preferred way to receive transactions: by regular
mail (printing), by email, by fax, or by a combination of the three. Then, the preferred delivery method is
marked by default in the following situations:

■

■

■

on transactions when you select that customer or vendor

on transactions created from that customer or vendor record

on transactions that are copied or converted from a transaction that uses these settings

For example:

□ If you click Make Copy on an invoice, then the delivery preferences default from the customer
record on the new copy of the invoice.
If you click Bill on a sales order, then the delivery preferences default from the customer record on
the bill that is created.

□
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Preferred Transaction Delivery on Customer and Vendor
Records

Blanket Purchase Order

Estimate

Purchase Order

Revenue Commitment

Transfer Order

Cash Refund

Invoice

Request For Quote

Revenue Commitment Reversal

Vendor Request For Quote

Cash Sale

Opportunity

Requisition

Revenue Contract

Work Order

Credit Memo

Purchase Contract

Return Authorization

Sales Order

 

To define the preferred transaction delivery method on entity records:

■



Open the transaction you want to print in edit or view mode.

Click the Print icon.

Working with Transactions

Note:To be able to print checks and other transaction, you need the View level of the Set Up
Company permission.

Note:These settings override any customized settings on transaction forms you use.

For more information about printing and emailing transactions, see Printing Checks and Other
Transactions and Emailing Transactions.
You can also set values these fields using the Mass Update function. For information, see the help topic
Mass Changes or Updates.

You can print transactions as you enter them, or you can print a group of similar transactions at the same
time. Transactions can be printed in HTML or PDF format. This topic includes general instructions for
printing transactions. For information about printing specific transactions or records, see the following
help topics:

■

■

■

■

■

■

■

■

Printing Bar Code and Item Labels

Printing Checks

Printing Deposit Slips

Printing Direct Deposit Vouchers

Printing a Picking Ticket

Printing a Sales Receipt

Printing Shipping Labels

Printing an Invoice

To print PDF files, you must install Adobe Reader. Visit the Adobe website to download the latest version
at no charge.
Your administrator can customize the layout of your printed forms using Advanced PDF/HTML templates.
For information, see the help topic Advanced PDF/HTML Templates.
If you print using PDF, files open in the default Adobe application. You can also download files and save
them to print later. To do this, go to Home > Set Preferences and check the Download PDF Files box.
You can print transactions on blank paper, or you can purchase compatible customized checks and forms
from the Forms Fulfillment Center, a NetSuite partner at www.netsuiteforms.com.

Important:If the Multi-Language feature is enabled in your account, you can choose from
different languages for printed transactions. However, only the system-supported languages
available in user preferences are supported because pre-translated strings are provided
for general terms in these languages. Additional languages that are available as company
preferences are not supported for printed transaction forms, but they are supported for website
translations. For more information, see the help topic Configuring Multiple Languages.
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To print an individual transaction from the transaction form:
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On each transaction record that you want to print, you must mark the record to be printed. To do this,
check the To Be Printed box. The location of this box depends on the type of transaction. For example,
on the check record, this box appears in the header of the record. For a purchase order, this box appears
on the Messages subtab.

After you have saved the transaction records, you can print them all at one time.

Note:To access the Print Checks and Forms page, you need the View level of the Print Checks
and Forms permission.

Email is now the accepted method of sending transactions to customers for the vast majority of users.
With NetSuite you can email the transaction directly from the active screen. NetSuite automatically saves a
copy of the message and records the audit trail. Users with the Email Templates and Custom Transaction
Forms permissions can select which transaction email template to use for each transaction type when
sending transaction emails with a PDF attachment. For information about determining the content of the
email message, see the help topics Working with Email Templates and Assigning an Email Template to a
Transaction Type.

Note:If you use the Multi-Language feature and have customers that use a different
language than the one you set at Home > Set Preferences, when you point to the Print
icon, you can select Print in Customer’s Locale to translate the transaction into the
customer’s predefined language. For more information, see the help topic Configuring
Multiple Languages.

To print:
■
■

If you print using HTML, click Print on your browser.
If you print using PDF, click Print in Acrobat Reader.
If you have the Download PDF Files preference enabled at Home > Set Preferences > General,
you must save the PDF to your computer and open it from there to print it.

Go to Transactions > Management > Print Checks and Forms.
Click the name of the transaction you want to print.
Check the box beside each transaction you want to print, or click Mark All to select and print all
transactions in the list.
If the list has multiple segments, use the From – To dropdown list to see a different set of records.
Click Print.

Note:If you use the Multi-Language feature and have customers that use a different
language than the one you set at Home > Set Preferences, when you point to the arrow on
the Print button, you can select Print in Customer’s Locale to translate the transaction into
the customer’s predefined language. For more information, see the help topic Configuring
Multiple Languages.

When the preview page opens:
■
■

If you print using HTML, click Print on your browser.
If you print using PDF, click Print in Acrobat Reader.
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Multiple printing

To print multiple similar transactions:
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Working with Transactions

Warning:To send a bulk e-mail with a mass update on a transaction, don't exceed the 4000
character limit for the field (including HTML tags), otherwise, the e-mail doesn't save.

Bulk transaction email can be generated from scriptable templates and can include attachments.
Sending transaction email in bulk is useful if, for example, you want to send reminder email for multiple

No special permission is required to email a transaction, but your account needs to be set up to enable the
action. An administrator must do the setup. For information, see the help topic Setting Email Preferences.

Following are methods to email a transaction:

   To send the transaction by email as you complete or edit it, select Save & Email from the Save menu.

Save & Email verifies that the To Be E-Mailed box is checked and the field contains an email address.
The box and field are located on the Communication > Messages subtab of the transaction record.

The To Be E-Mailed box must be checked and the field must contain an email address. If the field
is blank, NetSuite prompts you to provide an email address. If the field contains an email address,
the Save & Email method immediately saves the transaction and sends an email message with the
transaction.
The default address in the To Be E-Mailed field is the email address specified in the header of the
customer or vendor record. The box is automatically checked when the Email box is checked on the
Preferences subtab of the entity record.

A log of sent transaction email, including any attachments is viewable from the entity record on the
Communication > Messages subtab. A list of sent email is also available in the same location on
the transaction record. To view the list, your role must include at least View level access to the Track
Messages permission, and meet one of the following criteria:

□
□

□

you are the author, the recipient, or a related entity

you have access to the author, the recipient, or a related entity

or you have access to a related record, such as a transaction, event, or custom record.

For information about how to set up a history log of all recently sent transaction email, see Creating a
Sent Log for Transaction Email.

To send the transaction to one or more specific email addresses, go to the Communication >
Messages subtab, check To Be E-Mailed. Enter the email address you want to send the transaction
to. Separate multiple addresses with semicolons. Optionally, you can select a standard message from
the Select Message list or type a message in the Customer Message field.

To send a saved transaction by email in view mode, from the Actions list, select Email.

Note:Transactional email is not subject to monthly send limits. You can send an unlimited
number of transactional email messages during the month.
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Go to Lists > Mass Update > Mass Updates.

Click Transactions to expand the mass update options.

Click Bulk Email.

The Mass Update page opens.

On the Criteria subtab, define the transactions you want to send email for using the Filter
dropdown list. For example, you can create a list of all unpaid invoices by doing the following:

a.

b.

c.

d.

Select Type in the Filter column.

In the popup window, select Invoice, and click Set.

In the next row, select Status in the Filter column.

In the popup window, select Invoice:Open, and click Set.

On the Recipients subtab, select which email address to use and the order in which the email
fields are searched.
For example, in the screenshot below NetSuite first searches for an email address in the
transaction record. If none is found, NetSuite searches for an email address in the customer
record. If none is found, the email address in the contact record is used.

transactions for which payments have not been received. You enter search criteria to generate a list of
transactions and then select which transactions you want to send email for.

Transaction Email refers to the email field that appears on the Communication subtab of a
transaction such as a sales order.

Customer Email refers to the email field on the main Customer record page.

Contact Email refers to the email address related to the named contact within the company.

On the Message subtab of the Mass Update form, select the scriptable template to use or enter
the text for the message in the Message field. Templates can be up to 4 MB in size.
Do one of the following:

■

■

Click Preview to view a list of transactions that match your search criteria.

Click Save to save this mass update to use later.

When you click Preview, the Mass Update Preview Results page opens with a list of the
transactions that match your criteria.
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In the Apply column check the transactions for which to send email.

Click Perform Update.

A status page opens that displays progress and completion information.

Working with Transactions

Go to Lists > Search > Saved Searches > New.

Select Message.

Selecting items from the Filter dropdown list, add the following:

a.

b.

Date – Specify the required date range for the search.

Subject – Add any text which the transaction email is likely to contain in the subject header,
for example “invoice”.
Attachment Fields – Select File Type and specify what type of file was attached to the
transaction mail, for example PDF.

c.

Click the Preview button to check the search returns the expected results.

Add a Search Title and check the Public box if you want to make this search available to other
users.

Click Save.

You can keep track of what email has been sent to a particular entity by looking at the log found in the
Communication > Messages subtab of that record. You can also view a log of all recently sent transaction
email messages by creating a simple saved search. For example, you might want to check that a bulk
mailing of invoices was successfully delivered to their recipients.

A Transaction Detail report lists, in chronological order, all transactions entered during a specific time
period. Both posting and non-posting transactions are included.

To view this report, your role must include the Transaction Detail report permission.

The report includes the following columns:

■

■

Type - the type of transaction

Date - transaction date

Document Number - a reference number (like an invoice number)

Name - a name (of a vendor, customer or employee)

Memo - a memo

■

■

■

Account - the general ledger account associated with the transaction

CLR - a notation whether the transaction has cleared your bank account

Split - the other account involved in the double-entry bookkeeping notation. If more than one account
was used to offset this distribution, you see the notation -Split-.

QTY – the quantity■
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To create a sent log for bulk transaction email:

Transaction Detail Report

■

■

■



Amount - amount (the transaction amount or transaction line amount)

If using Multi-Book Accounting, a Primary Accounting Book filter is also included by default.

Working with Transactions

This template combines fields from the Transaction and Transaction Line record types to list all
transactions entered during a specific time period. It forms the source data for the Transaction Detail
Workbook.

Go to Reports > Financial > Transaction Detail.

A message appears indicating that your report is loading. The status bar indicates the progress as your
report loads. You can click Cancel Report to stop the report from loading.

The Transaction Detail dataset combines fields from two record types and multiple criteria filters. To edit
the dataset, see the help topic Defining a Dataset.

SuiteAnalytics Workbook offers many workbook and dataset templates, each with predefined source data,
criteria, pivot tables, and charts.

This section contains the information for the SuiteAnalytics Transaction Detail workbook in NetSuite. For
more information about SuiteAnalytics Workbook, see the help topic Workbook and Dataset Templates.

■ Transaction Detail Dataset

     Transaction Detail Workbook
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Dataset Configuration

To see a Transaction Detail report:

Transaction Detail Workbook Overview

Transaction Detail Dataset

Root Record
Type

Transaction

Joined Record
Type

Transaction Line

Custom
Formula Fields

(none)

Data Grid

The following fields are
included in the dataset.

Transaction:

      Date

■ Internal ID

      Transaction

      Type

Transaction Line:

■ Amount (Transaction
Currency)

     Entity
     Memo

     Subsidiary

Criteria Filters

The following criteria is used to
filter the dataset:

■ Transaction: Date on or
after start of this month
Transaction Accounting
Line: Amount (not
consolidated) is not empty

Transaction Accounting
Line: Accounting Book is
Primary Accounting Book

Account: Type none of <NO
VALUE>, Non Posting

■

■

■

■

■

■

■

■

■

■
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Field Name in Saved Search Record Location in
SuiteAnalytics Workbook

Join Path in SuiteAnalytics
Workbook

Field Name in SuiteAnalytics
Workbook

Date Transaction Transaction Date

Name Transaction Transaction Entity

Document Number Transaction Transaction Document Number/ID

Memo Transaction Transaction Memo

Period Transaction Transaction Posting Period

Status Transaction Transaction Status

Amount Transaction Transaction Total Amount (Transaction
Currency)

Working with Transactions

If you create a saved search to obtain this information, all the required fields are available through the
transaction record type in the Saved Search application.

The following table lists key differences between the saved search and the dataset:

This dataset uses fields from the Transaction record type so that you can see all of the transactions you
have created within the last year. It forms the source data for the My Transactions Workbook.

The Transaction Detail Workbook for SuiteAnalytics Workbook by default includes the same fields as the
Transaction Detail Report in NetSuite, but can be further modified to provide more data. The report lists, in
chronological order, all transactions entered during a specific time period. Both posting and non- posting
transactions are included.

As with all standard workbooks, only Administrators can access the Transaction Detail Workbook.

This workbook includes the following pivot tables:

    Transaction Overview — The default definition includes a row for account type and a Transaction

Count measure and a grand total of all accounts.

    Account Turnover — For OneWorld accounts. The default definition includes a row for Account, a
Subsidiary column, and Amount (Sum) measures.

SuiteAnalytics Workbook offers many workbook and dataset templates, each with predefined source data,
criteria, pivot tables, and charts.

This section contains the information for the SuiteAnalytics Transaction Detail workbook in NetSuite. For
more information about SuiteAnalytics Workbook, see the help topic Workbook and Dataset Templates.

■ My Transactions Dataset

My Transactions Workbook
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My Transactions Dataset

Transaction Detail Workbook

My Transactions Workbook

Key Field Differences

■

■

■
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The My Transactions dataset uses fields from the Transaction record type and two criteria filters. To edit
the dataset, see the help topic Defining a Dataset.

Consider the following information before you edit the dataset:

■ If you enable the Multi-Book Accounting feature for your account, you can use the Accounting Book
field in a criteria filter to view data for specific accounting books.
To access the Accounting Book field, use the join path Transaction > Transaction Line > Transaction
Accounting Line.

■

This workbook is based on the My Transactions dataset and displays all transactions you have created
within the last year by default.

Customize views with additional filters and data by modifying the workbook template and dataset
template. You can choose to visualize the data as a table, chart, or pivot. The dataset template is based on
the transaction record. As with all standard workbooks, only Administrators can access the My Transactions

workbook. The workbook includes the following pivot tables:

     Summary by Currency - Displays transactions by type, currency, and status

     Summary by Period - Displays a count of transactions by type and posting period
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Root Record
Type

Transaction

Joined Record
Type

(none)

Custom Formula
Fields

(none)

Data Grid

The following fields are
included in the dataset:

Transaction:

      Date

      Entity

■ Internal ID

      Memo

■ Posting Period

      Status

■ Total Amount (Transaction
Currency)

      Transaction
      Type

Criteria Filters

The following criteria is
used to filter the dataset:

■
■

Created By is me
Date within previous
one year

Dataset Configuration

My Transactions Workbook

Field Name in Saved Search Record Location in
SuiteAnalytics Workbook

Join Path in SuiteAnalytics
Workbook

Field Name in SuiteAnalytics
Workbook

Transaction Transaction Transaction Transaction

Name Transaction Transaction Type

Type Transaction Transaction Currency

■

■

■

■

■

■

■

■
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When creating a transaction, the total number of lines per transaction should not exceed the following
limits:

In NetSuite, there are specific limitations for lines when working with transactions. You should follow
these limitations, otherwise the system may not perform the requested action. The line limitation
applies to creating transactions, importing transactions (CSV, SOAP, user interface, and SuiteScript), and
displaying transactions.

See one of the following tables with specific line limits for different transaction interactions:

■
■

■
■

Limitations for Creating Transactions

Limitations for Importing Transactions

Limitations for Displaying Transactions

Entering Transaction Line Items

When working with transactions in NetSuite, the number of records, transactions, or rows of data that can be
accessed at one time is limited to 10,000. This limit applies to all transaction types unless otherwise stated.
For example, the maximum number of lines that can appear on a transaction record’s sublist is 10,000.

Warning:Transactions with more than 1,000 lines may negatively affect NetSuite’s performance
or cause timeouts.

For example, if you know that you have more than 10,000 invoices, use the Customize button on the
sublist to filter the invoices that are listed. For example, when working with the Credit Memo record, you
can click the Customize button on the Apply sublist to narrow the list of invoices.

For more information about transaction line limits, see Line Limitations for Transactions.

Note:The limits for submission of transactions are different than the limits for display of
transactions. The limit for transactions submitted through the user interface is 500 lines per
transaction. For transactions submitted through CSV import or SOAP web services, the limit is
5,000 lines per transaction.
For journal entries, these limits are 1,000 lines for the user interface and synchronous SOAP web
services, and 10,000 lines for CSV import and asynchronous SOAP web services.

Use the Summary by Currency pivot table to search for specific transactions. You can also use the status
information to identify the next workflow steps for transactions, such as for period closing.

Use the Summary by Period pivot table to report on user or team performance during each period and by
transaction type.
To access the workbook, click the My Transactions link from the Workbook Templates list on the
Workbooks subtab of the Analytics Home page.
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Limits for Display of Transaction Lists and Sublists

Line Limitations for Transactions

Limitations for Creating Transactions
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Type of Transaction Line Limit Details

Expense Allocation Schedules 10,000 Creating Expense Allocation Schedules 

Journal Entries 200 Journal Entries 

Revenue Recognition Journal Entry 1,000 Generating Revenue Recognition Journal Entries

Merge Revenue Arrangements 10,000 Combination and Modification of Performance
Obligations 

Generating Revaluations 2,000 Generating Revaluations

Reclassification Journal Entries 1,000 Creating Reclassification Journal Entries 

Journal Entry Allocation 200 Paycheck Expenses to Projects

Invoices 200 Invoices

Sales Orders 500 Sales Orders

Software Vertical Contract Renewals 10,000 Contract Renewals Best Practices

SuiteTalk SOAP Web Services Transactions 200 Usage Notes for Transaction Record Types

Custom Actions using the Workflow Action script 100,000,000 Custom Action

Type of Transaction CSV
Import

SOAP
Import

NetSuite
Application Import Details

Transactions 5,000 5,000 500

Software Vertical Contract Renewals 5,000 5,000 500

Single Inventory Worksheet Import 1,000 — —

Sales Orders — 1,000 —

Journal Entries 10,000 10,000 10,000

timeouts.

timeouts.

Working with Transactions

Transactions with more than 1,000 lines may negatively affect performance or cause

Transactions with more than 1,000 lines may negatively affect performance or cause

To maintain performance, when you import transactions, the total number of lines per transaction should
not exceed the following limits:
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Warning:

Warning:

Transactions Import Type Contract

Renewals Best Practices

Single Inventory Worksheet Import

Sales Orders You may notice a

performance impact
during import and in the user interface
for journal entries with over 1,000 lines.
For more information, see the help topic
Making Journal Entries

Limitations for Importing Transactions
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1 There are few types of records where you can import from record-specific pages outside of the CSV
import, such as the Translation Collections where you can import and export XLIFF files.

You can use NetSuite lists to access individual records or to work with multiple records at one time. The
location and access of lists of records depends on the role you use to log in. Only the Administrator
role has access to all record types. For more information about permissions, see the help topic NetSuite
Permissions Overview.

To access lists of records, go to Lists tab and select a relevant list.

When working with transactions in the NetSuite UI, the number of records, transactions, or rows of data
that can be accessed at one time should not exceed the following limits:

Warning:Transactions with more than 1,000 lines may negatively affect performance or cause
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Type of Transaction CSV
Import

SOAP
Import

NetSuite
Application Import Details

Intercompany Journal
Entries

10,000

Type of Transaction

Transactions

Sublists on iPhone records

Software Vertical Contract Renewals

Gross Requirements Inquiry

Generate China VAT Transactions

China Subledger Report

China Cash & Bank Journal Report

10,000

Line Limit

10,000

300

10,000

1,000

10,000

5,000

5,000

—

Details 

Limits for Display of Transaction Lists and Sublists

Working with Sublists

 Contract Renewals Best Practices 

Gross Requirements Inquiry

 Known Limitations of NetSuite China Localization

Known Limitations of NetSuite China Localization

Known Limitations of NetSuite China Localization

Intercompany Journal Entry Body and
Sublist Fields

Limitations for Displaying Transactions

Working with Lists
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You can do the following with most lists: 

      Select a preconfigured view from the View list or click Customize View to create your own. See Working
with List Views, Sublist Views, and Dashboard Views.
Click a button near the top to create a new record to add to the list, New Customer in this example.

Expand the Filter area to show and use the filters provided.

Select an option from the Style dropdown list.

Use the controls in the row at the top of the list to do the following:

■

■

■

■

□

□

□

□

□

Click one of the export icons to export the list as a CSV, Microsoft Excel, or PDF file.

Click the print icon to print the list.

Check the Show Inactives box to see inactivated records.

Select an option in the Quick Sort list.

Large lists of records may be broken down into smaller sections. Use the dropdown list to see a
different page of records. Use the left and right arrows to move forward and back in the list.

■

■

■

Click a column heading to sort the list by that column.

Click Edit next to a name to make changes to the record.

Click View or the name to view the record.

When the Inline Editing feature is enabled, click the Edit switch in the list toolbar to edit fields directly in
the list. Inline Editing is available on the following lists:

      Campaigns

      Cases

      Contacts

■ CRM Tasks

Customers

Employees

Events

Issues

Items

Leads

Partners

■

■

Phone Calls

Projects (Jobs)

     Prospects

     Solutions

     Transactions

     Vendors For more information, see Using Inline Editing.

For more information about filling in the fields on a record page, see the help topic NetSuite Record
Pages.
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Note:If exported lists and files are marked as encrypted or read-only, you need to know your
password for such files.

Use the Edit switch at the top of the page to turn on inline editing. When editing is off, the switch
displays an x. When editing is on, the switch has a green check.

Note:If your account administrator enabled the Tableau® Workbook Export feature and
assigned you the corresponding permission, your list toolbar also contains the Export to Tableau
Workbook icon .

For results exported to a CSV or XLS file, you may save the file or open it immediately in Microsoft Excel.
For results exported to a PDF file, the file opens immediately.
Internal ID field values are generated by the NetSuite system for each record. These values, which serve
as unique identifiers, are always included as a results column in the list to be exported.
Each export format has advantages and limitations. Review the limitations before selecting a preferred
format. The format you select can affect data accuracy and report readability. For details on the export
formats and their limitations, see Comparing Export Formats.

You can export NetSuite lists as files that you can open in external applications. The toolbar at the top of
the list has icon buttons to support the following file export types:

■

■

■

Click 

Click 

Click 

(Export - CSV) to export results to a CSV file.

(Export - Microsoft® Excel) to export results to an XLS file.

(Export - PDF) to export results to a PDF file.

Inline list editing enables you to update records quickly by changing data directly in a record's row on the
list page. This capability supports faster and easier editing because you do not have to go into each record
to edit it. You can also edit multiple records simultaneously by using keyboard commands. Addresses
cannot be edited on list pages using inline editing.

Inline list editing is available when the Inline Editing feature is enabled. To enable the feature, go to Setup
> Company > Enable Features. On the Company subtab in the Data Management section, check the Inline
Editing box and click Save.

When you open a CSV file directly, Excel treats long numeric sequences as numbers and displays them
using scientific notation. This treatment leads to a loss of precision when the number has more than
16 digits and to lost information when digits beyond position 16 are truncated. Even when the text is
qualified by apostrophes or double quotes, it is recognized by Excel as a number. To avoid this limitation,
open CSV files using the Excel multistep Text Import Wizard. The wizard enables you to set column
formatting in the last step ("Text" format).
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Using Inline Editing

1.

Known Excel Limitation for Values with More Than 16 Digits

To use inline editing:



Edit and Customized List Views

Working with Lists

The list page refreshes to display an edit icon in each column header that contains editable fields.
You can also identify editable fields by placing the cursor on them. A field is editable if the cursor
turns into a hand when on the field.

Important:Display types affect whether fields are available for editing or not. For more
information, see the help topic Setting Display Options for Custom Fields.

Important:Columns that display an edit icon in the header may include field values that
are not available for the inline editing due to data validation that prevents editing generally.
The edit icon does not mean that you can use inline editing for every field in the column.

2.
3.

Click the field where you want to enter or change information.

Click away from the field to save your changes.

The data is automatically saved on that record.

Use the following keystrokes to move among editable fields:

■
■
■
■
■
■
■

Press Tab to move right.

Press Shift+Tab to move left.
Press Shift+Enter to move up.

Press Enter to move down.
Press Alt+X to edit the first editable field on the page.

Press Ctrl+Z to revert the value in a field back to the previous value.
Press Esc when you are done editing a field to save the new value and close the field.

You can also use the following tools to increase your data entry performance when inline editing is
enabled:

■ Edit the same field on multiple records by pressing Ctrl and holding it as you select multiple fields.

Note:Note that you can only edit multiple fields in the same column. You cannot edit
multiple fields across different columns simultaneously.

■
■

Click Add above the list to open a Quick Add popup window for the current record type.

Click the icon in the New column to open menu of related records. Select an option to create the
new record on a separate page. The icon appears when you move your pointer over the column.

If you change many field values in one session using inline editing, NetSuite may have to update multiple
records simultaneously. In this case, you may receive the following message: “Too many inline edits.
Please wait a few seconds and try the edit again.” You should be able to complete your most recent edit
after a brief wait.
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Limitations for Inline Editing on Referenced Fields

Additional Setup Option for Custom Search Portlets

Allow Editing Option for Custom Records Is Unrelated

NetSuite offers two ways to view a list of records you recently accessed.

Working with Lists

If a field on a record is referred to by a formula custom field, you cannot edit the referenced field with
inline editing. For more information about sourcing, see the help topic Creating Formula Fields.

You can customize the list view to display certain fields from a record type on the list page. For more
information, see Customizing List Views. Note that if the Use Expressions option is enabled for a search,
inline editing is disabled in list, dashboard, and sublist views based on the search. If you want inline
editing to be available for a view, ensure that the Use Expressions box on the Criteria subtab is not
checked for the search that filters view results. See the help topic Using Expressions in Search Criteria.

When the Inline Editing feature is enabled, editing is available by default for all search results in
dashboard portlets. However, each Custom Search portlet has an Allow Edit setup option that you can
use to enable or disable the Edit feature for specific portlets. See the help topic Displaying Saved Search
Results in Dashboard Portlets.

When you are editing a sublist inline and you hover over a cell, the tooltip appears and shows the column
name. If a sublist has many lines, you can view the column name when scrolling down the sublist.

You can enable or disable the tooltip by checking or clearing the Sublist Column Name Tooltip box
which is located on the Appearance subtab at Home > Set Preferences.

Each custom record type created in NetSuite has an Allow Editing option that is different from the general
editing that is available when the Inline Editing feature is enabled. When enabled, the custom record type
option permits records of this type to be edited directly when they display in a sublist on a parent record.
Enabling this option does not control whether records of this type can be edited inline in their own list
pages and views. This option is not related to the Inline Editing feature or to the Edit buttons that display
on list pages when the feature is enabled.
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Working with Lists

NetSuite provides you with several different options for viewing lists of records in your account, including
the following:

■
■
■

List View

Sublist View

Dashboard View

The list view is displayed when you go to the NetSuite tab that lists the record you want, and click the
task link for that type of record. You can customize this view by changing the fields that display on the list
page. A customized view is based on a custom search that you create for that record type.

To customize a list view, click Customize View or Edit View. Note that the Edit View button only appears
when the list view has already been customized. For more information, see Customizing List Views.

Hover over the Recent Records icon , to see a list of records you recently viewed or edited. This is the
Recent Records menu. From here you can click a link to open a record in view mode, or move your cursor
over the link and click Edit to open the record in Edit mode. You can also click All Recent Records to view a
list of the 100 most recent records. This list includes the record type and the date the record was last
accessed.

You can also create a Recent Records portlet on your dashboard to show the last 12 records you viewed
or edited. Click Personalize Dashboard (under the tabs at the top of your dashboard) and then select
Recent Records in the Add Content panel.

The difference between using the Recent Records menu and the Recent Records portlet is that the portlet
constantly displays a list of recent records on the dashboard. The menu only displays recent records on
demand, when you click or hover over the icon.
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Working with Lists

Most records include subtabs that display additional fields or lists of other records. You can create a
separate customized sublist view that displays different data than a list view. For more information, see
Customizing Sublist Views.

On the list page you want to customize, click Customize View or Edit View.

If the list view of this record type has not been previously customized, the Customize View button
is displayed. If the view has been customized, the Edit View button is displayed. In the example
below, the Customers & Jobs page has Customize View button.

You may choose to display a list of records in a portlet on your dashboard. NetSuite enables you to create
a separate customized view for list portlets on your dashboard. For more information, see Customizing
Dashboard Views.

You can customize the list view for most record types. Customizing the list view enables you to change the
columns displayed in the list and select the filter options available in the footer of the list page.

You can create custom views for any list that includes the Customize View or Edit View button on the list
page.
If a saved search has been made available as a list view, you can select that saved search as your list view
instead of customizing a new one. These searches are available from a View dropdown list. See Selecting
an Existing Saved Search as a Custom View.

Your existing list, sublist, and dashboard views may be based on preferred view settings specified by your
administrator or by another user with Publish Search permission, rather than on system-defined defaults.
For information about how preferred view settings are defined, see the help topic Using a Saved Search as a
View.
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Dashboard View

Customizing List Views

To create a custom view for lists:

1.
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Clicking Customize View takes you to the page to customize the view.

Working with Lists

In the Search Title field, enter a different name for your custom view if desired.
Default search title is the word Custom followed by the record type and the selected view, for
example, Custom Customer General View.
On the Results subtab:

■
■
■

Select a different field to use for sorting if desired.
Add, remove, and move fields as desired.
Enter custom labels for fields as desired. The default label is the field name.

On the Available Filters subtab:
■
■
■

Add, remove, and move fields to be displayed as filter lists on the list page.
Enter custom labels for filter lists as desired. The default label is the field name.
Leave the Show in Filter Region setting as Yes for all fields. If you change this setting to No,
the filter list is not displayed.

When you have finished making changes, click Save. This customized view is now used for the
selected record type's list page.
You also can do the following:
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On the sublist you want to customize, click Customize View.

Working with Lists

You can customize most of the views used for a list that appears on record's subtabs. Available
customizations include changes to displayed results columns and filter dropdown lists.

Note:If an existing saved search is available as a sublist view, you can select that search to
customize your subtab view instead of creating a new one. These searches are available from a
View list. See Selecting an Existing Saved Search as a Custom View.

Note:When you switch between custom views on a sublist, the filters on the sublist do not
update automatically. For more information, see SuiteAnswers article Switching Between Custom
Views on a Sublist Does Not Automatically Update Filters.

Click More Options to display a full saved search definition page where you can edit other
options, such as filter criteria. (Note that if you make changes to other options on this page,
these settings are preserved when you return to the customization page even though they are
no longer visible.)

Click Cancel to return to the list page, with no changes.

Click Restore Defaults to return to the list page that uses your previously defined preferred
search settings, if any, or system-defined defaults. (Note that this button only displays after you
have customized the list view.)
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To create a custom view for a sublist:
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Working with Lists

You can customize the view used for a record type's lists in dashboard List portlets. Available
customizations include changes to displayed results columns and filter dropdown lists. This is different
from personalizing dashboards, which refers to changing the portlets on the dashboard.

Note:If an existing saved search is available as a dashboard view, you can select that search to
customize your dashboard view, instead of creating a new one. These searches are available from
a View dropdown list. See Selecting an Existing Saved Search as a Custom View.

In the List portlet that display the dashboard list you want to customize, click the Customize View
or Edit View link.

If the dashboard view of this record type has not been previously customized, the Customize View
link is displayed. If has been edited, the Edit View link is displayed.
In the Search Title field, enter a different name for your custom view, if desired.

Default search title is the word Custom followed by the record type and the selected view, for
example, Custom Item Basic View.

On the Results subtab:

■
■

Select a different field to use for sorting if desired.

Add, remove, and move fields as desired.

In the Search Title field, you can enter a different name for your custom view.

Default search title is the word Custom followed by the record type and the selected view, for
example, Custom Item Transaction Sublist View.
On the Criteria subtab, add the desired Filter.

On the Results subtab:

■
■
■

Select a different field to use for sorting if desired.

Add, remove, and move fields as desired.

Enter custom labels for fields as desired. The default label is the field name.

On the Available Filters subtab:

■
■
■

Add, remove, and move fields to be displayed as filter lists on the list page.

Enter custom labels for filter lists as desired. The default label is the field name.

Leave the Show in Filter Region setting as Yes for all fields. If you change this setting to No,
the filter list is not displayed.

When you have finished making changes, click Save. This customized view is now used for the
selected record type's sublist.
You also can do the following:

      Click More Options to display a full saved search definition page where you can edit other
options. (Note that if you make changes to other options on this page, these settings are
preserved when you return to the customization page even though they are no longer visible.)

Click Cancel to return to the record that includes the sublist, with no changes.

Click Restore Defaults to return to the sublist that uses your previously defined preferred
search settings, if any, or system-defined defaults. (Note that this button only appears after you
have customized the sublist view.)

■
■
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Customizing Dashboard Views

To create a custom view for list portlets on dashboards:

■



Working with Lists

Note:A List portlet displays only the first 7 columns when the portlet is placed in the
center of the dashboard and only 2 when it is on the side.

An administrator or another user with the Publish Search permission can make an existing saved search
available as a list view, a sublist view, and a dashboard view. This enables you to select this search from a
View dropdown list to customize your view, instead of clicking Customize View and creating your own.

If a View list is not displayed, it means that no saved searches of that record type have been set as
available for that type of view.
The following screenshot shows the View list for a dashboard view:

■ Enter custom labels for fields as desired. The default label is the field name.

On the Available Filters subtab:

■
■
■

Add, remove, and move fields to be displayed as filter lists on the list page.
Enter custom labels for filter lists as desired. The default label is the field name.
Leave the Show in Filter Region setting as Yes for all fields. If you change this setting to No,
the filter list is not displayed.

When you have finished making changes, click Save. This customized view is now used to display
the selected record type in List portlets.
You also can do the following:

      Click More Options to display a full saved search definition page where you can edit other
options, such as filter criteria. (Note that if you make changes to other options on this page,
these settings are preserved when you return to the customization page, even though they are
no longer visible.)
Click Cancel to return to the page displaying the List portlet, with no changes.
Click Restore Defaults to return to the page with the List portlet that uses your previously
defined preferred search settings, if any, or system-defined defaults. (Note that this button only
appears after you have customized the list view.)

■
■
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Working with Lists

For information about how saved searches are made available as custom views, see the help topic Using a
Saved Search as a View.

You can customize how saved search results are printed if your site uses advanced PDF/HTML templates.
For more information about creating a custom template to print results from saved searches, see the help
topic Advanced Templates for Printing Saved Search Results.

Important:If the Use Expressions option is enabled for a search, editing is disabled in list,
dashboard, and sublist views based on the search. If you want editing to be available for a view,
ensure that the Use Expressions box on the Criteria subtab is not checked for the search that
filters view results. See the help topic Using Expressions in Search Criteria.
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The ability to track time in NetSuite is also required for Time Tracking for CRM.

Working with Your Calendar and Activities

The topics below provide more information about working with your calendar and activities: 

    Working with Events describes how to create and edit events, as well as how to track time on event
records.

    Working with CRM Tasks describes how to create CRM tasks and Project tasks, as well as how to track
time on CRM tasks.

    Working with Phone Calls describes how to schedule phone calls, track time on phone calls, and use
telephony with NetSuite.

The calendar and activities features in NetSuite help you to make effective use of your work time. Use the
calendar to manage your activities, including events, tasks, and phone calls. Access the calendar from the
Activities tab as shown.

You must set preferences before you start using your calendar and working with activity records in
NetSuite. For more information, see Personal Preferences for Activities.

Read Using Your Calendar to learn how to set preferences for sharing your calendar with others in your
organization and how to synchronize your calendar using NetSuite for Outlook.
You can set up several calendar portlets on your Activities page to display combinations of personal,
group, or team calendars. These portlets act independently of each other, so you can also display a
variety of time frames for the same calendar. For example, you may set a monthly overview portlet on the
left of your screen and in the center, a weekly view. See the help topic Calendar Portlets.
When you use the Time Tracking for CRM feature, you can track time on tasks, phone calls, events, and
cases. Tracking time on these activities can help you become more aware of how much time is spent on
certain projects.

NetSuite enables you to manage your schedule by using a calendar that you can customize. The Activities
page displays events you create in NetSuite automatically on your calendar.

To display tasks and phone calls on your calendar, check the Reserve Time box on task and phone call
records, and then enter the start and end times.
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1.
2.
3.

Go to Home > Set Preferences.

On the General subtab, in the Time Zone field, select your time zone

Click Save.

The next step in setting up your calendar is Setting Calendar Preferences.

Using Your Calendar

The first step in setting up your NetSuite calendar is to make sure your calendar reflects the time zone in
which you work. The time zone you choose affects events and the data returned by reports and searches
for date fields with timestamps.

Read the following topics for information about how to set up and use your NetSuite calendar:

■ Setting Your Calendar Time Zone describes how to share events and meetings with your co-workers
across the country or around the world.
Setting Calendar Preferences describes how to make appointments visible on your calendar and how
to share your calendar with other NetSuite users in your organization.
Navigating Your Calendar describes how to best use the calendar page.

Synchronizing Your Calendar describes how to use the NetSuite for Outlook client for viewing your
appointments and making changes to your schedule without logging in to NetSuite. You must use the
Outlook Integration feature to take advantage of this functionality.

■

■
■

Before you begin working with your Activities page, you must set preferences for how you want to use
your calendar. These preferences determine the following about your calendar:

■
■

privacy settings

calendar display

      sharing

Prior to setting your calendar preferences, set the time zone to make sure your calendar reflects the time
zone in which you work. For more information, see Setting Your Calendar Time Zone.
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To set your Calendar Time Zone:

■



Using Your Calendar

The options on the Preferences subtab determine how the calendar displays when you are logged in to
NetSuite. You can choose a daily, weekly, or monthly view and designate a start and end time for your
calendar day.

1. In the Default View field, choose to display your calendar in a daily, weekly, or monthly format.

You can always change the view on the calendar by clicking Day, Week or Month in the calendar.

Click the Activities tab.

In the page header, click Calendar Preferences to view the Personal Calendar Setup page.

In the Title field, enter a name for this calendar.

You are the only person who can see this title. If you give others access to your calendar, they see
your name when viewing your availability.
Use the Sharing field to set preferences for access to your calendar. Note that you can choose a
different Event Access setting on individual event records.

■
■

■

Public – This gives everyone in your company access to your calendar.

Private – This restricts everyone in your company from seeing your calendar.

Defined Below – This enables you to select who can view and schedule appointments on your
calendar using the Calendar Access subtab. For details, see Calendar Access.

If you choose Defined Below in the Sharing field, click the Calendar Access subtab to select the
names of people you want to have access to your calendar.
Click Preferences to choose a default view for your calendar, set your time preferences, and
enable sharing with iCal-compatible devices and applications. For details, see Preferences.
After you have set all of your preferences, click Save.

Use the Calendar Access subtab to define how your events appear when others in your NetSuite account
view your calendar.

1. In the Grant Access to column, select who should have access to your calendar. Note that only
NetSuite users with login access to your account appear in this list.
In the Access Level column, choose one of the following access levels:2.
■

■

View – This person can see events you mark public and busy times for events you mark busy.

Edit – This person can see, change and remove events you mark public and see busy times for
events you mark busy. They cannot delete events on your calendar.
Full – This person has view and edit access to public events on your calendar, can delete
events on your calendar and also accept events on your behalf.
To grant access to your private events, check the Can Access Private Events box for the
selected NetSuite user.

■

■

3. Click Add.

Note:Administrators are able to view or edit, including delete, any task, event, or call,
even if it is not assigned to them and regardless of the event access settings.
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Using Your Calendar

You can share your NetSuite calendar with devices and applications that support iCal format internet
calendars, including iPhones, Android devices, and Microsoft Outlook. This enables you or others to view
(but not edit) your current NetSuite calendar outside of the NetSuite application and does not require login
credentials.

First you must set up your calendar for sharing. This creates URLs that you can use to share your
calendar.

To set up your NetSuite calendar for sharing:

1.
2.
3.

In your NetSuite account, go to Activities > Setup > Calendar Preference.

Click the Preferences subtab.

Under Calendar Sharing, check the Public Calendar box if you want to share the events on your
calendar that are public.
Check the Private Calendar box if you want to share all of your calendar events.

Click Save.
4.
5.

When you check these boxes, URLs are automatically generated. You can distribute these URLs to anyone
you want to share your calendars with. You can reset these URLs at any time if you want to require the
use of a new URL to view your calendar. After resetting these URLs, you must communicate the new URLs
to those you’d like to share your calendar with.
As with any Internet calendar, reminder settings on events are not supported for Google Calendar and
Outlook, but they are supported on iOS devices (using iOS version 7.1.0 or later).

2.
3.

In the Daily section, in the Start Time field, select the time your calendar day begins.

In the End Time field, select the time your calendar day ends.

These can be the start and end of the work day.

In the Time Increments field, select how you want to display time on your calendar's daily view.

Under Calendar Sharing, check the Public Calendar box if you want to share your public calendar
with iCal-compatible devices and applications.
Checking this box generates a URL that you can use to view all public events on your NetSuite
calendar.
Check the Private Calendar box if you want to share all of your calendar events (including private
events and those shown as busy) with iCal-compatible devices and applications.
Checking this box generates a URL that you can use to view all private and public events on your
NetSuite calendar.

4.
5.

6.

Note:These options only enable you to view calendar events in an iCal application. You
cannot update or edit NetSuite events from other devices. This is supported on iOS devices
using iOS version 7.1.0 or later. For more information, see Sharing Your Calendar with iCal-
Compatible Devices and Applications.

Now you can begin using your calendar. When you or others go to your calendar, your calendar appears
according to your settings on the Preferences subtab.
Additional setup preferences are available for each calendar portlet. For details, see the help topic
Calendar Portlets.
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In a browser, open your Google Calendar.

Open the options next to Other calendars, and click Add by URL.

Paste the URL generated on the Calendar Preferences page in NetSuite.

Click Add Calendar.

For information about how to make your calendar events public or private by default, see Setting
Calendar Preferences.

See the following sections:

■
■
■

Android Devices and Google Calendar

Microsoft Outlook

Mac OSX Devices

Using Your Calendar

Important:The Google Calendar Android app only supports viewing of subscribed calendars.
To add a calendar, you must use the browser version of Google Calendar.

To view your NetSuite calendar on an Android device, you can either use the native NetSuite for Android
app or share it with your Google calendar. For more information about the NetSuite for Android app, see
the help topic NetSuite for Mobile Overview.

Note:Google Calendar refreshes events from Internet calendars approximately every 24 hours.
If you would like to update your calendar more frequently, you can use other Internet calendar
applications.
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Open your calendar in Outlook.
Right click My Calendars.
Select Add Calendar > From Internet.

In Calendar, choose File > New Calendar Subscription.

Paste the URL generated on the Calendar Preferences page in NetSuite.
Click OK.

Using Your Calendar

To view NetSuite events in Microsoft Outlook, you can use NetSuite for Outlook or you can add it as an
Internet calendar.

To add an internet calendar to Outlook:

Enter the NetSuite calendar URL from the Calendar Preferences page and then click Subscribe.
Enter a name for the calendar in the Name field and choose a color from the adjacent pop-up
menu.
If you have an iCloud account, choose whether you want the calendar on that account.

Note:To view a subscription calendar in Calendar on your Mac and on devices with iOS 5
or later without resubscribing to it, choose your iCloud account.

To get the calendar’s event attachments or alerts, clear the appropriate Remove boxes.
To update your copy of the calendar when changes to it are published, choose the update
frequency from the Auto-refresh pop-up menu.

In some cases you may prefer to view your events using the Calendar application rather than logging into
NetSuite. To do this you need to subscribe to the NetSuite calendar.

To view your NetSuite calendar on a Mac
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7. Click OK.

To make changes to the calendar, click the name of the calendar, and then choose Edit > Get Info.

Using Your Calendar

The figure above illustrates actions you can complete with the calendar. Both calendars are calendar
portlets, but one is set to monthly view in the narrow dashboard column, and the other is a daily view in
the wide column. The numbered options below correspond with the numbers in the figure above:

To view your NetSuite calendar on an iOS device, you can use the native NetSuite for iPhone app, or you
can add it as a subscribed calendar. For more information about NetSuite for iPhone, see the help topic
NetSuite for Mobile Overview.

Note:This is supported on iOS devices using iOS version 7.1.0 or later.

Your Activities page includes a monthly calendar on the left and a list of calendar events in the center by
default. You can view your calendar by day, week, or month.

To see your calendars, click the Activities tab.

For more information, see Setting Calendar Preferences.

Go to Settings > Calendar.

Tap Accounts, then Add Account.

Tap Other.

Tap Add Subscribed Calendar.

Paste the URL generated on the Calendar Preferences page in NetSuite into the Server field.

Tap Next.

Important:Do not enter your NetSuite user name and password. This is not required to
view your NetSuite calendar on your iOS device.

Tap Save.
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Click Today to highlight today’s date. The same button In daily view in the wide column displays all events
scheduled for today.

Click the arrows at the top of a calendar to view the next or previous increment of the view. For example, the
arrows in the narrow calendar move through the months. In the wide calendar the arrow move through the days.

Click Print in the portlet menu to print the events listed in the center of the page. Click the 
contents of the calendar. 

Select a calendar from the dropdown list. You can see only calendars and calendar entries that have been shared 
with you or made public. 

Click Daily, Weekly, or Monthly to change the calendar view. In the narrow calendar, these options are included
in a dropdown list instead of buttons. in daily view, click a time to open a popup and create a new Event, Call, or Task.
When you click a day in weekly view, the calendar changes to daily so that you can create a new entry. In monthly
view, the behavior when you click a day depends on whether the calendar is narrow or wide. In narrow calendars,
the view changes to daily. In wide calendars, the Create New popup opens.

Click an event to view the event's record in a wide calendar.

In the narrow monthly calendar, click the date to view events for that day. Hover over a date to see the events in a
popup without changing the calendar view.

You can display the Calendar portlet on your NetSuite Home page.

Colors denote the status of your events.

■
■

■

Solid green shows an event you have accepted.

Thin diagonal green lines show an event to you have tentatively accepted.

Gray shows an event to which you have not yet responded.

       White indicates a calendar entry that is not an event.

If you decline an event or an event is canceled, it does not show on your calendar.

Using Your Calendar

Go to Home > Dashboard.

Click the Personalize link in the upper right of the page. The Personalize Dashboard palette opens
at the top of the page.
In the Standard Content panel, click Calendar to add the portlet.

Click Set Up in the portlet menu to set your preferences.

With synchronization, you can quickly import and update your contacts, calendar events, tasks, and phone
calls between NetSuite, Microsoft Outlook, and the Microsoft Outlook Exchange Server.
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Displaying Your Calendar

1.
2.

3.
4.

To show the Calendar portlet on the Home page:

Synchronizing Your Calendar

■



Using Your Calendar

NetSuite for Outlook provides unidirectional and bidirectional synchronization of contact, event, task,
and phone call records between NetSuite and Outlook, as well as the ability to save Outlook messages to
NetSuite records. You can download this client from NetSuite and run it as an Outlook Add-In.

For information about using NetSuite for Outlook for synchronizations, see the help topic NetSuite for
Outlook.

In NetSuite, you use event records to reserve time on your calendar for appointments and meetings.
When you create an event, you are the owner. If you are invited to an event and you accept, then you are
an attendee. You can click on an event displayed on your calendar to see more information about it, such
as the location and a list of the people invited.

Read the topics below to learn more about working with events:

■ Scheduling Events describes how to create new event records and how to use the Scheduler portlet to
schedule events.
Sending Event Invitations describes how to send an email invitation with details about the event,
including the date, time, and location.
Setting Up Recurring Events describes how to create a record for an event that occurs on a regular
basis, such as a weekly or monthly meeting.
Using Resource Records on Events describes how to use event records to reserve certain resources,
such as a conference room or a speaker phone.
Tracking Time for Events describes how to keep track of time spent on events for reporting purposes
and billing. Note that you can only track time on events if you use the Tracking Time for CRM feature.
Responding to Event Invitations describes how to accept, decline, or mark an event invitation as
tentative.
Setting Up Event Reminders describes the different types of event reminders and how to set them up
when you edit an event record or respond to an event invitation by email.

■

■

■

■

■

■
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Working with Events

Use an event record to send an email invitation, attach a document for discussion, and to reserve a
resource such as a conference room.

When you create an event, you are the owner and automatically designated as the organizer. Only you
can create events on your calendar. The event’s organizer, owner, or any role who has edit- or full-level
permissions to events on your calendar can make changes to the event records including assigning or
changing organizers.

Note:Administrators are able to view or edit, including delete, any task, event or call, even if it is
not assigned to them and regardless of the event’s access settings.

You can schedule an event through an event record or by using the Scheduler portlet. The Scheduler is
convenient when organizing an event for a group. You can click the link to the event on your calendar to
make changes if necessary.

For more information about scheduling events, see the following:

■
■
■

To understand how to enter information about an event record, read Creating a New Event Record.

To learn how to invite a group of people to an event, read Using the Event Scheduler Portlet.

To find out about keyboard shortcuts, managing conflicting events, and marking events as private, see
Event Scheduling Notes.
To add a resource to an event, read Using Resource Records on Events.

To learn how to cancel an event, or how to remove it from your calendar, read Canceling or Deleting
Events.

■
■

Canceling or Deleting Events describes the difference between canceling and deleting events, as well
as how to cancel one-time and recurring events.

Searching Event Records describes how to set filters and find events that are not listed on your Events
page.
Sharing Your Calendar with iCal-Compatible Devices and Applications explains how to share your
NetSuite calendar with Outlook, iOS devices, and Android devices.

Go to Activities > Scheduling > Events > New.

Under Primary Information:

1.
2.
3.
4.
5.

You can select a Custom Form (optional).

In the Title field, enter the subject or title for this event.

Fill in the Location field, and select the date of this event.

Select whether the status of the event is Confirmed, Tentative or Canceled.

In the Event Access field, select how you want this event to appear on your calendar.

■
■

Public – This event and its information appear to everyone with access to the calendar.

Private – This event appears only to you and to invitees with access to the calendar. For
more information, see Event Scheduling Notes.
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Creating a New Event Record

To create a new event record:



Working with Events

■ Show as Busy – This event appears as a busy time slot to everyone with access to the
calendar. No other information about this event is displayed.

6. In the Organizer field, select the person who is organizing this event. The event organizer
is automatically set as an accepted attendee for this event.
If you edit the event record to change the organizer, the new organizer is not automatically
added to the attendee list.

3. Under Date and Time:

1.
2.

Select a date for the event.

Check the All Day box, if this event will last the entire day.

When you check this box, the start and end times fill in automatically based on your
calendar preferences.

Note:If you need to create an event that spans multiple days, create an all day
event for the first day, and on the Recurrence subtab, choose Daily and set the last
day of the event in the End By field.

3. Check the Reserve Time box if you want to reserve time on your calendar for this event.

Events that do not reserve time appear first on your calendar on the day they are
scheduled. These can include events such as birthdays or anniversaries.

Select the start and end times for this event. If the selected time slot conflicts with any
existing events, a popup warning displays on the screen.
In the Reminder Type field select the type of reminder you want to receive.

In the Reminder field, select a time before the event when you want to be reminded. For
more information, see Setting Up Event Reminders when Creating or Editing Events.

4.

5.
6.

4. On the Message subtab, enter the message you want to show in the email invitation that is sent to
attendees and is shown on the event record.
Optionally, you can get writing help for the Message field from our generative AI service, NetSuite
Text Enhance. Click the Enhance Text button to use the available options. For more information
about using this capability, see Text Enhance.

Click the Attendees subtab.

In the Send Invitation To column, select a name from the list. For more information, see Sending
Event Invitations.
In the Attendance column choose whether this attendee is a required or an optional participant.

Click Add.

Repeat these steps for each attendee.

On the Resources subtab, you can reserve the necessary resources for this event such as a
conference room or presentation materials. For more information, see Reserving Resources for
Events.

The availability of those individuals and materials you have selected on the Attendees or
Resources subtabs shows on the Availability subtab.
Click the arrows next to the date to view the availability on other days. The window of time shown
on this subtab is the same as the Daily start and end times set in your calendar preferences.

Click the Recurrence subtab if the event is part of a series of events. For more information, see
Setting Up Recurring Events.
When you have finished entering all of the information for this event, click Save.

5.
6.

7.
8.
9.

10.

11.

12.

The following are optional settings on the event record:
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Click Activities Overview on the Activities tab.

By default, the Scheduler portlet is located at the bottom of the Activities page.

From the View Group list, select the group for which you want to schedule an event.

Select the date of the event.

The earliest available time slot for everyone in the group is highlighted.

Click on a time slot for the event.

Drag the slider bars, under the time, to set the duration of the event.

Clear the boxes next to the group members you do not want to invite to the event.

The organizer is not invited to the event by default.

Click Add Invitees or Add Resources to include people or resources that are not a part of the
group you selected.
After you save the event, the event displays on the invitees’ personal calendar.

Click Create New Event.

Enter the title and other information concerning the event.

The Scheduler portlet is a quick way to enter event records. The Scheduler enables you to select people
to invite, and see their availability directly on the Activities tab in NetSuite. It is useful for creating a
group event. When you select the group in the View Group list, the list of group members displays in the
Scheduler. After you set the date and time, click Create New Event to create the event record.

On the Related Records subtab:

Select a company if this event is related to a customer, vendor, partner, or other name. The event
record is attached to the entity record.
The Contact field lists the contacts for the entity you have selected. Select the contact with whom
this event is associated, if any.
If this event pertains to a support case, select the case number in the Support Case field. The event
record is attached to the case record.
If this event is related to a transaction, select the transaction number. The event is listed on the
Events subtab of the transaction record.

□

□

□

Use the Time Tracking subtab, if you use the Time Tracking for CRM feature and want to track time
for this event. For more information, see Tracking Time for Events.
Click the Communication subtab to attach a file to this event. For more information about how to
attach files, see Attaching Files to Records.
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To schedule an event by using the Event Scheduler portlet:



Click Save.

On the event record, click the Attendees subtab.

As you are scheduling events, be aware of the following:

■
■
■

Scheduling Events

Calendar Hot Keys for Events

Using the Event Scheduler Portlet

Warning for Conflicting Events

■ Marking Events as Private

Use the Attendees subtab on the Event record to select attendees for an event and to send email
invitations.

After you save an event record, it appears on the NetSuite calendar for each person invited.

Working with Events

On an event record, when you select start and end times that conflict with an existing event, NetSuite
displays a warning that clearly indicates the name and time of the conflicting event.

You can use keyboard shortcuts to quickly set dates on events and transactions. In NetSuite date fields,
use the following keyboard shortcuts to quickly change dates:

■
■

■
■

■
■

Press Shift + t to enter tomorrow's date.

Press t to enter today's date.

Press y to enter yesterday's date.

Press m to enter the end of the month.

Press the Plus key (+) to move forward one day.

Press the Minus key (-) to move back one day.

An event marked as private can only be viewed by the owner of the event and its attendees. Private events
do not show on the calendar, and they appear as Busy when checking availability on event records. If you
have checked the Can Access Private Events box for one or more users, these users see private events.
Only attendees can track time against a private event.

Note:Only the owner of a private event can delete it. Even those with the Administrator role
cannot delete private events from another user's calendar. These events must be deleted through
the Delete Events mass update. See the help topic Mass Deleting an Employee's Events.
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To create and send event invitations:

Sending Event Invitations
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Working with Events

If an event occurs on a regular basis, such as weekly, monthly, or a specific day of the month, you can set
a recurrence pattern for the event. The event appears on the calendar on the dates when it occurs.

2. In the Send Invitation to column, select the name of the person or group you are inviting to this
event.

The Availability field is automatically filled by NetSuite. When those invited are not in your
company, this field always says Available.
If the person or group is in your company, their availability depends on whether they have
conflicting events in their NetSuite calendars. You can view availability on the Availability subtab.
The Response column defaults to the status No Response when you add an invitee.

When those invited receive the invitation to the event, they can accept, decline, or tentatively
accept the invitation. Their status displays here, on the event record. For more information, see
Responding to Event Invitations.

In the Email column, check the box next to each person to whom you want to send an email
invitation.
Check the Notify Attendees by Email box to send email to attendees in the list based on your
preference for sending invitation email. For more information, see Personal Preferences for
Activities.

In the Attendance column, select whether each person's attendance is optional or required.

Click Add.

Repeat these steps for each person or group you want to invite.

When you have added everyone you want to invite, click the Availability subtab to see if they are
all available at the selected time, or click Save if you are finished with this event.

3.

4.
5.

6.
7.

You can restrict the contacts that appear in the Send Invitation To column by setting the Restrict Invitees
to Employees preference on the Activities subtab at Home > Set Preferences. If you check this box, only
employees appear in the Send Invitation To column.

On the event record, click the Recurrence subtab.

Select how often this event should occur:

■ Daily – Enter the interval between days if this event is every day or every few days, or select
every weekday if this event is every day except Saturdays and Sundays.
Enter 1 as the interval if this event is every day, for example, or enter 2 if the event is every other
day.

     Weekly – Enter the interval between weeks, and select the day of the week this event repeats
on.

     Monthly – If this event occurs on the same day of every month or every few months, enter the
date the event repeats, and select the interval between months.
If this event occurs on the same day of the week every month or every few months, select the
week, the day of the week, and enter the interval between months.
Yearly – If this event occurs one time a year, select the month and day of the event, or select
the week, day and month.

■

In the End By field, set the date this event stops recurring.
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■

■
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When you create a resource record, you are also creating a calendar associated with the resource. If the
resource is public, then any NetSuite user in your account can select the resource on the calendar page
and see when the resource is booked for a certtain day, week, or month.

Go to Activities > Setup > Resources and click New.

In the Name field, enter a name for this resource. This name appears in the list on the Resources
subtab of event records.
The Owner field displays your name by default as the creator of this resource record. You can
select another user to be responsible for this resource record.
Enter a brief description of this resource in the Description field.

Check the Private box if you only want the owner to be able to view the resource calendar.

The Title field displays the name of the resource. You can edit this field to have a different title.

In the Daily Start Time and Daily End Time fields, select the time this calendar day begins and
ends.

This can be the start and end of the work day, or any time you want to see events on this resource
calendar.
Click Save.

4.
5.

If the event continues indefinitely, check the No End Date box.

If you need resource materials for this event, click the Resources subtab. For more information,
see Using Resource Records on Events.
Click Save to save the event.6.

To edit a recurring event, go to the calendar in NetSuite and click the event link. Select the occurrence or
series.
Invitees can choose to decline either the entire series of events or specific dates in the series.

Note:If you change your time zone preference at Home > Set Preferences > Activities and then
edit an event created in your original time zone, you may need to review the recurrence settings
for that event to ensure they are set properly before saving your changes.

Resources can be anything from conference rooms to speaker phones that you use within your company
for meetings, and conferences. In NetSuite, you create resource records to reserve these items.

You must use the Resources subtab on the event record to reserve a resource for an event. If someone
else creates an event for the same time, and attempts to reserve the same resource, the availability shows
as busy.

For information about using resource records, see the following:

■

■

Creating a Resource

Reserving Resources for Events
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Creating a Resource

To create a resource record:



Now you can reserve this resource when you schedule events. For more information, see Reserving
Resources for Events.

Working with Events

After you create a resource record, you can select the resource in the My Calendar list on the calendar to
check for availability.

Make changes to the resource record and its calendar preferences by going to Activities > Setup >
Resources, and clicking Edit next to a resource.

The following fields display on the Calendar Preferences subtab of the Resource record:

■ Title – The resource name entered in the Name field appears here as the name of the calendar.
Daily Start Time and Daily End Time – Select the time that this calendar should begin showing
events, and the time when this calendar should stop showing events.
Default View – Choose to display this calendar in a daily, weekly or monthly format.■
Daily Time Increments – Select the increments of time for this calendar's daily view.

■ Sharing – Choose a level of access for this calendar. Note that you can still specify on event records
how you want events to appear on this calendar.
□
□

Public – This gives everyone in your company access to this calendar.

Defined Below – This restricts everyone in your company from seeing this calendar except the
people you select in the section below.
Give certain individuals access to this calendar by selecting a name in the User column. Only
NetSuite users with login access appear in this list.
In the Access Level column, choose the level of access for each person who is allowed to see this
calendar:

▬
▬
▬

None – This person cannot access this calendar.

View – This person can see events marked public and busy times for events marked busy.
Edit – This person can see, change and remove events marked public and see busy times for
events marked busy.
Full – This person has complete access for viewing and editing this calendar.▬

Note:Private events are not shown even to those with access to this resource calendar. To grant
access to private events, check the Can Access Private Events box for the selected user.

Reserving resources is similar to inviting attendees. You must create resource records at Activities > Setup
> Resources > New > New before you can reserve them for events.
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1.

2.

3.

Go to Activities > Scheduling > Events.

On the Events list, click the event for which you want to track time.

On the Event record, click the Time Tracking subtab.

Note:If any case, task, or event record has more than 9500 time entries to display on the
Time Tracking subtab, all events display a static list of time entries. You cannot edit entries
directly from the list.

4. Click New Time.

A new time transaction window opens.

Your name is selected in the Employee field by default. Other employees, as well as vendors, can
be selected here.

5.

Note:For private events, only employees and vendors listed as attendees on the event
record can track time against the event.

6. Enter information for this time transaction.

For more information about entering time for Time Tracking, see the help topic Entering a Time
Transaction.

For more information about entering time for Timesheets, see the help topic Timesheets.

When you have finished, click Save.7.

If the Billable box is checked, you can bill the customer for this time on the Billable Time subtab when
you create an invoice. View reports for time spent on cases, tasks and events on the Reports tab, under
the Project/Time Tracking heading.

Time Tracking for CRM enables you to keep track of time spent on events with the option to bill that time
to customers. Before you can use this feature, an administrator must enable the Time Tracking for CRM
feature. See the help topic Enabling Time Tracking for CRM.

1.

2.

On the event record, click the Resources subtab.

In the Resource column, select the resource you need to reserve. The resource availability for the
time of this event shows in the Availability column.
Click Add.

You can view the availability of the resource for other times on the Availability subtab after you
have added the resource.

3.

If you have not provided a location for your event, NetSuite uses the location associated with the resource
you are planning to use as the suggested location for the event. For example if you add “Conference
Room A, San Mateo” to an event with a blank Location field, the location will be updated to San Mateo.
This only happens when first adding a resource. If you subsequently change an event resource the main
event Location field remains the same, assuming you want to use a resource from another location, but
not change the physical event location.
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All employee names are listed on the Time subtab by default.

Working with Events

When you are invited to an event, you can choose to accept or decline the invitation or mark it as
tentative. Unless the event organizer selects a response for you on the event record, your status is “No
Response” until you respond.

Email

Click the Accept, Tentative or Decline link displayed in the email invitation you receive.

You do not need to log in to NetSuite to respond to the event with this method.

Note that you do not have the option to set up an event reminder with this method.

Events List

Go to Activities > Scheduling > Events. This is useful when you have several events to respond to.

To accept all events at one time, click Accept All on the event list.

To respond to individual events, click Edit next to the event, and then click the appropriate button on
the event record.
Calendar

Go to the Activities tab to see your calendar, or go to Activities > Scheduling > Calendar.

Click the event in the calendar to display the event record, and then click the appropriate button to
respond.
Calendar Portlet

Go to a Calendar portlet on your Home or Activities tab.

Hover over the event in the portlet to display the event popup.

Click the appropriate button on the event popup.

Note:To display the Calendar or Reminders portlet on your home page, click the Personalize
link at the top of the Home page, and then select Calendar or Reminders from the Standard
Content panel.

Listed below are the available responses for an event invitation: 

    Quick Accept — Accept the event without responding to the event organizer or setting a reminder.
For more information, see Quickly Accepting Event Invitations.

Accept — Agree to go to the event. With this option you have the option to send an email response to
the event organizer.

Tentative — Wait to respond to this event.

Decline — Defer from going to this event. With this option you also have the option to send an email
response to the event organizer.

If the status for an event is Declined, the event is removed from your calendar.

Decline This Date — Decline only this occurrence of a recurring event.
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Responding to Event Invitations

To respond to an event invitation choose one of the methods
listed below:
■

■

■

■

■

■

■
■

■



If your access level to a colleague’s calendar is Edit or Full, you may accept event invitations on their
behalf. To assign a colleague access to your calendar see Calendar Access

Working with Events

If you receive several event invitations on a daily basis, you can quickly accept your events by clicking the
Quick Accept button on event records.

Using the Quick Accept button:

■
■

■

Accepts the event without asking you to set a reminder or respond to the event organizer.

Marks the event accepted.

Makes the event appear on your calendar.

To quickly accept an event, open the event record, and click Quick Accept.

If you accept your events from the email invitation, you can click the Accept the event link on the email
message to quickly accept the event.

Event reminders are sent either as email messages, or they appear as popup messages in NetSuite.
Reminders show the day, date, time, title and location of the upcoming event.

Event reminders are helpful when an event is scheduled far in advance.

When you receive a popup reminder, you can choose from the following:

      Click Dismiss to close the window

■

■

Click Go to Event to open the event record in a new window.

Click Snooze to select the amount of time before you want to be reminded again.

By default, reminders are set to include audio. You can change this preference, and set other preferences
for event reminders on the Activities subtab at Home > Set Preferences.
When you are logged in to NetSuite with your default role, the preference you set for Default Reminder
Type determines the type of reminder you receive for events. If you are not logged in with your default
role, then the type of reminder you receive is determined by a company-wide preference set by an
account administrator. For more information, see Personal Preferences for Activities.
You set event reminders when you create or edit an event, or when you accept or tentatively accept an
event invitation. For instructions, see the following help topics:

Unless you click Quick Accept in NetSuite, when you respond to the event, a popup window opens. Here,
you can email your response to the event organizer, and set your personal reminder for this event. For
more information, see Setting Up Event Reminders.

If you choose not to send an email when you respond to the event invitation, the event organizer can still
see the status for each invitee on the event record. People with permission to see the event's record can
also see the status of those invited.

To set default preferences for events, see Personal Preferences for Activities.
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Setting Up Event Reminders when Creating or Editing Events

Setting Up Event Reminders when Responding to Event Invitations

Working with Events

Note:If you select None in either the Reminder field or the Reminder Type field, you will not
receive a reminder.

To set a reminder when you respond to an event invitation, you must log in and accept the invitation in
your account. You cannot set reminders when using the links included in the email invitation.

Log in to your NetSuite account.

On the Home page, click the link in the Calendar portlet to respond to the event invitation.

The event record appears in view mode with buttons to respond to the invitation.

For a complete list of ways in which to respond to an event invitation, see Responding to Event
Invitations.
Click Accept to accept the invitation, or click Tentative to tentatively accept the invitation.

A window pops up where you can choose to email the event organizer and set your reminder for
the event.

Choose whether to send the event organizer an email including your response. If you decide to
email the organizer, you can add your own message to the email.

Go to Activities > Scheduling > Events.

Click Edit next to an event in the list.

In the Reminder field, select the amount of time in advance of the event that you would like to be
reminded.
In the Reminder Type field, select how you want to be reminded.

Popup reminders pop up in a window at the designated time if you are logged into your NetSuite
account.

Email reminders are sent to the email address you use to log in to NetSuite.

Click Save.

NetSuite offers different options for event reminders. You can choose to receive your reminder in an
email message, or in a popup window when you are logged in to NetSuite. Note that others invited to the
event can set their own reminders when they accept or tentatively accept the event invitation.

To ensure that you receive your reminder at the correct time, make sure the clock on your computer is set
to your time zone, and then go to Home > Set Preferences to set the same time zone in NetSuite.
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Setting Up Event Reminders when Responding to Event
Invitations

Setting Up Event Reminders when Creating or Editing Events

To set up event reminders when creating or editing an event:

To set up event reminders when responding to an event invitation:



Go to your calendar in NetSuite, and click the name of the event.

If the event is recurring, select Open this occurrence or Open the series in the popup.

In the event record, click Edit.

In the Status dropdown list, select Canceled.

Working with Events

In the Reminder field, select the amount of time before the event's start time that you want to
receive a popup or email reminder.

In the Reminder Type field, select which kind of reminder you want to receive: popup, email or
none.

If you use NetSuite for iPhone, canceled events are not included in the iCalendar export.

Note:To edit events from the calendar, you must have checked the Edit Activities from Calendar
box on the Activities subtab at Home > Set Preferences.

For more information, see the following:

■

■

Canceling Events

Deleting an Event

You can cancel an event from the Events list or from your calendar. Only an event's organizer can cancel
or delete an event.

Only an event's organizer can cancel or delete an event.

When canceling an event, you can use the event record to alert attendees and to update the event's
status. If your event is recurring, you can choose to cancel one instance or cancel the entire series of
events.

Canceled and deleted events are both removed from the calendar unless you enable the Show Canceled
Events option in your portlet setup. For more information, see the help topic Calendar Portlets.

Note:Administrators can mass delete events for an employee no longer with your company. See
the help topic Mass Deleting an Employee's Events

Note:If you select None in either the Reminder field or the Reminder Type field, you will
not receive a reminder.

7. Click OK.

Your event now shows on your calendar with a reminder icon. Note that if you decline an event invitation,
you are not given the option to set a reminder. The event does not show on your calendar.
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Canceling or Deleting Events

Canceling Events

To cancel an event:
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Go to your calendar in NetSuite, and click the name of the event.

If the event is recurring, select Open this occurrence or Open the series in the popup.

On the event record, click Edit or Edit This Date for a single instance of a recurring event.

In the Actions dropdown list, click Delete.

Working with Events

5. On the Attendees subtab, check the Notify Attendees by Email box to update everyone invited
about the status of the event.

Click Save.6.

If you do not need to notify those invited and want to remove the event from your Events list, you can
delete the event. For more information, see Deleting an Event.

Note:Administrators can mass delete events for an employee no longer with your company. See
the help topic Mass Deleting an Employee's Events

1.

2.

Go to Activities > Scheduling > Events > Search.

Define at least two search filters. You can choose more than one option from each filter. To choose
multiple options, click the names while holding the Ctrl key.

Important:Defining the Date filter alone displays only the matched events which you
are invited to. Set additional filters to expand the search.

3. Click Submit.

For more information about running simple searches in NetSuite, see the help topic Defining a Simple
Search.

You must be the organizer to delete an event. Note that when you delete an event, the attendees are not
notified, and the event is removed from the calendar.

You can find a list of public and private events on the Events page at Activities > Scheduling > Events. Note
that the list only displays events where you are listed as an attendee regardless of your ownership of the
event and the event’s access settings. If you want to see a list that includes events where you are not an
attendee, you can run a defined search.
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Deleting an Event

To delete an event:

To search event records:

Searching Event Records
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Working with CRM Tasks

In NetSuite, tasks are records used to track work items that need to be completed within a certain time.
Tasks can be assigned to you or to another person in your organization. NetSuite enables you to create
two different types of tasks: CRM Tasks and Project Tasks.

You can also assign tasks to partners. Go to Lists > Partners, click the partner record you want to work
with, and then check the Assign Tasks box on the partner's record. The Assign Tasks box appears only if
your administrator has enabled the company general preference Assign Tasks to Partners.

Each record contains details about the work that needs to be completed. If you were assigned a task, you
can change or update information by clicking Edit next to a task from the tasks list. You can also update
the status of your tasks as you make progress or complete them. A task shows on your list of tasks until
you mark it Completed or you delete it. For more information, see Creating CRM Task Records.
If your administrator has enabled the Time Tracking for CRM feature, you can track time of tasks records
to help you manage your time. For more information, see Tracking Time on CRM Tasks.
CRM tasks may be associated with a project but are not considered part of the project's schedule unless
they are explicitly included using the Include CRM Tasks in Project Totals box. For more information, see
the help topic Including CRM Tasks in Project Totals.

You can view tasks associated with a customer record in the Tasks portlet of the customer dashboard.
For information about displaying CRM Tasks and Project Tasks on your dashboard, see Tasks and Project
Tasks Portlets on Your Dashboard. Tasks that are related to one or more customers are displayed in each
dashboard’s Activities portlet. If you want to see the list of companies that are related to a task record,
go to the Task page through the Task portlet or through Activities > Scheduling > Tasks. Then, go to the
Related Records subtab and see the list under Companies and Contacts.

You can create a task record and assign it to an employee for completion or create a task and then assign
it to yourself as a reminder.
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CRM Tasks
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Working with CRM Tasks

Use project task records instead of CRM task records to track information for projects. For more
information, see the help topic Setting Up Project Management.

You can create a project task record only if you use the Project Management feature. Each project
task represents an individual work item that must be completed to finish a project, and can only be
created on a project record. Project tasks are used to facilitate project planning. On project records, the
Financial subtab now shows the Project Revenue Recognition Summary information, which is visible when
the Project Revenue Recognition feature is enabled. The summary information shows total revenue,
recognized revenue, planned revenue, and a link to Revenue Arrangement. This improvement helps you
find the respective revenue arrangement for the project and it provides more transparency.

Create a new CRM task record to track work items that need to be completed. Administrators can use the
Import Assistant to import CRM tasks from another system into NetSuite. For more information, see the
help topic Tasks Import.

To track tasks associated with projects, use Project Task records. For more information, see the help topic
Project Task Records.
To set a preference for CRM Tasks to display on your calendar, go to Activities > Setup > Calendar
Preference > Preferences subtab. Check the Display Non-blocking Tasks in Calendar box.

To create a CRM task:
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Open a new task record by doing one of the following:

■
■

         Go to Activities > Scheduling > Tasks and click New. Click Task in the Create New menu. In the  

         Primary Information field group:

Select the form you want to work with in the Custom Form field. This field appears only if

multiple task forms are available.
Enter a Title for the task. The title should describe the task.

In the Assigned To field, select the employee who is assigned to the task.

Your name appears in this field by default.

■
■

Note:In NetSuite OneWorld accounts, employees from all subsidiaries show in this
field.

Check the Notify Assignee by Email box to send an email notification to the person who is
assigned to the task. This email informs the person that a task has been created or edited and
assigned to them. If this person's record does not include an email address, no message is sent.

Select the appropriate level of priority for this task.

Use the Insert Before field to change the order of tasks. Select a task from the list that the new
task should be placed above.
Select a Status for this task. Only someone with permission to edit the task record is allowed
change the status.
(Optional) Check the Private Task box if you want only you or the person in the Assigned
To field to see this task. If you also use Time Tracking for CRM, only the person assigned to a
private task can track time against the task.

■
■

■

■

Project Tasks

Creating CRM Task Records

1.

2.

■
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Working with CRM Tasks

In the Date and Time field group:

■
■

Set the Start Date for this task.

In the Due Date field, enter the date when this task should be completed.

After the task is finished, fill in the Date Completed field.

Note:The value in the Date Completed field can be modified even after you set the
Status to Completed.

(Optional) Check the Reserve Time box to turn the task into a scheduled task which can be
displayed on the calendar. When you check this box, the Start Time and End Time fields
become required fields.

     Select the Start Time and End Time.

Note:Use the Availability subtab to view when the person assigned to the task is
available.

      In the Reminder Type field, select a type of reminder for scheduled tasks that appear on the
calendar:
None – No reminder is triggered.

Email – An email reminder is sent to the email address on the employee record for the
person selected in the Assigned To field.

Popup – A popup reminder opens when the person assigned to this task is logged in to
NetSuite.

      In the Reminder field, select a time before the task begins when you want to see the
reminder.

Note:You must select both a Reminder Type and a Reminder time to trigger the
reminder. The person assigned to this task can edit the task record to change the
reminder settings.

In the Message field, enter notes or a description about this task. These comments appear in the
email message sent to the person this task is assigned to.

Optionally, you can get writing help for the field from our generative AI service, NetSuite Text
Enhance. Click the Enhance Text button to use the available options. For more information about
using this capability, see Text Enhance.

Related Records subtab:

      Select a Company if this task is related to a customer, vendor, partner, or other name.
■ The Contact field lists the contacts for the company you have selected. Select the contact

associated with the task.

If this task pertains to a support case, select the case number in the Support Case field.

If this task is related to a transaction, select the transaction number in the Transaction field.

Select and add multiple companies and contacts associated with this task.

For example, you can add the contact who requested the task or requires reporting on this task
in the Companies and Contacts list.

■
■
■

Availability subtab – Displays the availability of the user assigned to the task.

Communication subtab:
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Review and edit other subtabs as necessary. 

Message subtab:

■



Working with CRM Tasks

Click Edit next to an existing task record on the Tasks list at Activities > Scheduling > Tasks. For
more information, see Creating CRM Task Records.

Click the Time Tracking subtab on the task record.

Note:If any case, task, or event record has more than 9500 time entries to display on
the Time Tracking subtab, all CRM tasks display a static list of time entries. You cannot edit
entries directly from the list.

You can enter time transactions to track the amount of time spent on each task. To track time on tasks an
administrator must enable the Time Tracking for CRM feature. See the help topic Enabling Time Tracking for
CRM.

With Time Tracking for CRM, you can track time on tasks, phone calls, events, and cases. Tracking time on
these activities can help you manage your company by being aware of how much time is spent on certain
activities.

■ Click the Files subtab to attach a file to this event. For more information about attaching files,
see Attaching Files to Records.

Click the User Notes subtab to add any notes concerning this event.■

Time Tracking subtab:

If you have enabled either the Time Tracking for CRM or Project Management feature, you can
track time for this task. For more information, see Tracking Time on CRM Tasks.

5. After entering information about these subtabs, click Save.

You can change or update information for existing tasks by clicking Edit next to a task from the tasks list.

As you work on your tasks or complete them, update the status of the tasks. If the tasks are not marked
private, others can see your progress and know what you are working on. This facilitates communication
between departments within your company.

Note:If you use the Project Management feature, you can include CRM tasks in project
totals. Note, however, that you must use project task records to track tasks associated with
specific projects.

The fields below display on the Time Tracking subtab only when you use the Project Management
feature.

Initial Time Budget – Enter your first estimate of the time this task requires. Later you can
increase or decrease your time estimate in the Current Time Budget field. By maintaining an
initial time estimate in this field, you can compare your initial estimate to your current estimate.
If you entered a time estimate on a project task template, that amount shows in this field.
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Tracking Time on CRM Tasks

To track time on CRM tasks:
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Working with CRM Tasks

Note:For private tasks, only employees listed as assigned to the task can track time
against the task.

4. Enter information for this time transaction.

For more information about entering time for Time Tracking, see the help topic Entering a Time
Transaction.

For more information about entering time for Timesheets, see the help topic Timesheets.

Repeat this process to track time for additional customers or employees for this task.

Click Save.

5.

6.

For instructions on limiting employees' ability to enter time records, see the help topic Restricting
Employee Time Tracking Entries . Employees can also use the Employee Center to track their time. For
more information, see the help topic Giving an Employee Access to Time Tracking.

You can view employee time on the Reports page under the Time & Billables heading.

Use the Tasks portlet on your home page to track work you need to complete on CRM tasks.

If you use the Inline Editing feature, you can change a task's status to Completed in the Tasks portlet.
Changes made to a task in the portlet are automatically changed on the task record. You can also click
Edit next to a task in the Tasks portlet to update the information about a task. For more information, see
Using Inline Editing.

Current Time Budget – If your estimate of the time required by this task increases or
decreases from your original estimate, enter the revised estimate in this field.

Actual Time – This field shows the total amount of time entered against this task.

Time Remaining – This field shows the estimated remaining amount of time for this task. Time
remaining is calculated as (Initial Time Budget - Actual Time).

If you have entered a Current Time Budget amount to update your initial time budget, then
the time remaining for the task is calculated as (Current Time Budget - Actual Time).

Percent Time Complete – This field shows the calculated total of work that has been
completed to date in percent format. The percent complete is calculated as (Actual Time *
100%) / Initial Time Budget.

If you have entered a Current Time Budget amount, then the percent complete is calculated
as follows (Actual Time * 100%) / Current Time Budget.

Percent Complete – Enter an estimate of how much of the total amount of work for this task
is already completed. For example, if half the work toward completion is done, enter 50%. The
percentage you enter in this field overrides the auto-calculated figure in the Percent Time
Complete field and is used for task calculations.

Your name appears in the Employee field. Depending on your role access, you can select another
employee if you are entering time for someone else.

NetSuite provides two portlets to help you manage tasks. You can add a portlet to show CRM tasks and, if
the Project Management feature is enabled, a portlet to display project tasks.
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Working with CRM Tasks

By default, the Tasks portlet displays each task's due date, title, company involved, priority, and status.
To change the displayed fields, click Customize View on the portlet menu or choose from the View field if
available.

You can also:

■

■

■

■

Choose an option in the Quick Sort field to change the order in which tasks appear.

Click New Task on the portlet menu to enter a new task record.

Click Set Up to set the number of tasks that show in the portlet.

Click the refresh icon to update the portlet after you update or complete tasks.

For information about working with CRM tasks, see Working with CRM Tasks.

Use phone call records to document business calls. Phone call records include information about the call,
such as the organizer and the date completed. You can also display phone calls on your NetSuite calendar
and link the phone call to another record type, such as company, contact, or support case. After a phone
call is linked to another record type, the phone call appears on the Activities subtab of that record.
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If you use Project Management, the Project Tasks portlet displays project tasks on your dashboard. The
portlet shows project tasks assigned to all resources and provides quick access to project task information.
For more info, see the help topic Project Tasks Portlets.

If you use the Inline Editing feature, you can change a project task's status in the Project Tasks portlet.
Changes made to a task in the portlet are automatically changed on the task record. You can also click
Edit next to a task in the Tasks portlet to update the information about a project task record.

By default, the project tasks portlet displays the project, task ID, task name, estimated work, actual work,
start date, and end date for each task. To change the displayed fields, click Customize View on the portlet
menu or choose from the View field if available.

Use the portlet filter options to select the range of tasks to display in the portlet. Filter selections are
sticky changes, meaning your selections are saved until you change them.

■ Assignee – Display all project tasks or only tasks assigned to a specific resource or group of resources.
You can also select to display unassigned tasks.
Priority – Select to view project tasks by importance.

View – Create a custom database view if you want to limit the project tasks displayed in the portlet to a
segment of all project tasks.

■

■

From-To – View a range of tasks based on the project task column selected. For example, if you select
to sort by task name, you can then select a range of task names to display on the portlet.

For information about working with project tasks, see the help topic Project Tasks.

Displaying Project Tasks

Working with Phone Calls

■
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Working with Phone Calls

When you use the Telephony Integration feature, you can initiate calls from the following pages in
NetSuite:

■
■
■
■
■
■
■

Relationship record lists

Phone call list

Phone call records

Relationship records

Saved search results that include phone numbers

Subtab lists on records that include phone numbers

Any record, list, or saved search with a phone custom field

Note:The Telephony Integration feature must be setup and enabled by your account
administrator. See the help topic Using Telephony Integration. After the feature is enabled, users
must set their personal preferences. See Personal Preferences for Telephony.

To make a call, click on the phone icon or underlined phone number from a list or record.

To end the call, you can hang up the phone or click the next phone number to end the current call and
begin a new call.

For more information about working with phone calls, see the following:

■
■

Scheduling or Logging Phone Calls describes how to create phone call records in NetSuite.

Tracking Time on Phone Calls describes how to use phone call records in NetSuite to track time spent
on each call. Note that you must use the Time Tracking for CRM feature to take advantage of this
functionality.
Making Calls From NetSuite describes how to make outbound calls directly from records in your
NetSuite account.

■
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Working with Phone Calls

You can use phone call records to schedule calls and list them in order of the due date and priority. Or you
may use phone calls to document customer feedback whenever a customer calls you. NetSuite stores the
information about a record in the Phone Call list on the customer record who calls and on the contact's
record who called for the customer.

When you receive a phone call from a customer, for example, go to the customer record, click Call in the
New bar at the top of the record, and enter the details and reason the customer is calling.

To schedule or log a phone call:

For example, you go to Activities > Scheduling > Phone Calls > Search and click Create Saved Search to
create a search of the phone calls that need to be completed today. From your list of results, you click the
phone icon next to the first phone number in the list. Your phone then rings to signal the call is ready.
When you pick up the receiver, the phone number is dialed, and your call is connected. To end the call,
you click the phone number of the next customer and continue with the process.

Go to Activities > Scheduling > Phone Calls > New.

If you have created a custom form you want to use for this record, select that form in the Custom
Form field.
In the Subject field, enter the main subject of the discussion.

In the Organizer field, select who is responsible for making the call. Your name appears here by
default.

In the Phone Call Date field, enter the date the call is scheduled for.

Check the Reserve Time box to schedule this phone call on the calendar.

If you want phone calls that do not reserve time on your calendar, check the Display Non-
blocking Phone Calls in Calendar box on the Personal Calendar Preferences page at Activities >
Setup > Calendar Preference.

If you are scheduling this call, select the Start Time and End Time.

Use the Availability subtab to see when the organizer (you) and all added participants with
NetSuite records are available.
In the Date Completed field, enter the date this call was completed if different from the scheduled
date.
In the Phone Number field, you can enter the number dialed to make this call if it is different from
the number of the participant selected below.
In the Status field, select whether this phone call is Scheduled or Completed.

Check the Private Phone Call box to display this call only in your list of calls. If you use Time
Tracking for CRM, only employees listed as participants on the phone call record can track time
against a private call.

If this is a scheduled call, select the Reminder Type you want:

■ None – No reminder is triggered.

Email – An email reminder is sent to the email address on the employee record for the person
selected in the Organizer field.
Popup – A popup reminder opens when the organizer is logged in to NetSuite.■

You must also select a reminder time to set the reminder.

In the Reminder field, enter the time increment before the time set in the From field that a
reminder should be triggered.
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Working with Phone Calls

Tracking time on phone calls can help you manage your company by being aware of how much time is spent
on the phone. The Time Tracking for CRM feature must be enabled to track time on phone calls. An
administrator must enable the Time Tracking for CRM feature. For more information, see the help topic
Enabling Time Tracking for CRM.

To track time on phone calls:

Go to Activities > Scheduling > Phone Calls

Click New Phone Call to create a new phone call, or click Edit next to the call you want to track
time for.
Click the Time Tracking subtab.

Note:If any case, task, or event record has more than 9500 time entries to display on
the Time Tracking subtab, all phone calls display a static list of time entries. You cannot edit
entries directly from the list.

Click New Time. A popup window opens with a new time entry form.

Your name appears in the Employee field. Depending on your role access, you can select another
employee if you are entering time for someone else.

Note:For private phone calls, only employees and vendors listed as participants on the
phone call record can track time against the call.

Enter information for this time transaction.

You must also select a reminder type to set the reminder.

On the Message tab, enter notes or a description of the content of the phone call.

Optionally, you can get writing help for the Message field from our generative AI service, NetSuite
Text Enhance. Click the Enhance Text button to use the available options. For more information
about using this capability, see Text Enhance.

On the Related Info subtab, select a company if this call is related to a customer, vendor, partner,
or other name.
The Contact field lists the contacts for the entity you have selected.

In the Contact field, select the contact with whom this call is associated.

If this call pertains to a support case, select the case number in the Support Case field.

If this call is related to a transaction, select the transaction number.

On the Participants subtab, you can add listings for those participating in the call. Choices are
available from the Participant dropdown list. Available choices include employees, customers,
partners, vendors, and other names.

Attach files relating to this call on the Files subtab.

Click Save.

14.

15.

16.
17.
18.
19.

20.
21.

Your phone call is now documented. If the phone call was set as completed when it was created, it
remains in the tasks list until it is marked Completed.
To mark a phone call Completed, go to Activities > Scheduling > Phone Calls and click Edit next to the
phone call that has already been placed to open its record and change the status. If inline editing is
enabled, you can change the status directly in the list. For more information, see Using Inline Editing.
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Working with Phone Calls

For more information about entering time for Time Tracking, see the help topic Entering a Time
Transaction.

For more information about entering time for Timesheets, see the help topic Timesheets.

Repeat this process to track time for additional customers or employees for this call.

When you have finished entering information for this call, click Save.
7.

8.

Employees must enter their time in the Employee Center even if they also track time on phone calls.
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Working with Email

NetSuite supports Transport Layer Security (TLS) for incoming and outgoing email messages. Note the
following:

■

■

TLS support applies to the SMTP protocol only.

For outgoing email, TLS support depends on the recipient email server. NetSuite attempts to deliver
outgoing email in an encrypted form, but if the recipient email server does not support encryption,
email is delivered in plain text form.

You can send information using your NetSuite account and can track all communication between you and
those you do business with. Whether through email, letters or over the phone, all of the information you
need can be planned and executed through NetSuite. See Sending Email from NetSuite.

You can also install NetSuite for Outlook which enables you to save messages from your Outlook mail
account to NetSuite records. For more information, see the help topic NetSuite for Outlook.
For a complete list of accepted top level domains you can use for setting up your email address, see the
Internet Assigned Numbers Authority Web site.
For information about size limits for outbound and inbound email, see the help topic Size Limits for Emails
and Attachments.

You can send email to the people you do business with directly from the NetSuite application. For
information about sending email from NetSuite, see the following:

■

■

■

■

■

■

■

Sending Email from Records

Sending Email Directly from Lists and Records

Emailing Transactions

Sending Search and Report Results Email

Attaching Files to Email Messages

Customizing Email Signatures and From Fields

Using Variable Envelope Return Paths

Email sent from NetSuite uses one of the following as the From address:

■ the email address set in the From Email Address field at Home > Set Preferences > General under User
Profile, or
if there is no from email address entered on the Set Preferences page, the employee's login email
address

■

When the recipient replies to the email message, this reply is sent to the email address used to send the
original message.
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Note:If you want your emails to include records of phone calls or tasks, for example, export
them at Activities > Scheduling > Phone Calls into a file of your preference and send them
manually.

Contact

Customer

Lead

Prospect

Vendor

Company
■ Other Name

Partner

Opportunity

Transactions

Sending Email from NetSuite

Email messages you send from NetSuite records are saved on the Messages subtab for each contact
receiving the message as well as on the record you send the email from.

On the record you want to send an email message from, click the Communication subtab. For
some non-administrator roles and record types, click the General subtab.

Files attached from your computer to email you send from within NetSuite are stored by default in the
Attachments Sent and the Attachments Received folders in the File Cabinet. These folders are also used
when you save messages you receive outside of NetSuite to a record.

The attachment folders are system-generated folders in the File Cabinet only used to hold these files, so
files in these attachment folders are not available to select as attachments when sending email. If you
want to attach a file from one of these folders to an email message, you must move the file to another
folder prior to sending the email message.
For more information, see Moving and Copying Files in the File Cabinet. See also, Sending Email from
Records.

For more information about where to find the sent email list, see the help topic Using the Sent Email List.

To generate the list of all email, you can use the Message record to define a saved search. For more
information, see the help topic Saved Searches.
You can also send personalized email messages in bulk using the Email Merge feature. For more
information, see the help topic Working with Mail Merge.
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1.

To send email from a record:

You can choose to email a contact from the following types of records:

■

■

■

■

■

■

■

■

■
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Sending Email from NetSuite

On the Messages subtab, do one of the following:
■ If you are replying to or forwarding an email message, click View next to the email message,

and then click Reply, Reply to All, or Forward.
If you are replying, attachments are not included by default and can be added on the
Attachments subtab. Forwarded messages include attachments by default.

Note:You cannot forward messages on employee records or on contact records that
are not associated with a company.

if you are sending a new email message, click Email.

On the Recipients subtab, select the contact you want to email in the Recipient field and enter an
email address.

1. In the Recipient Type field, select the record type you want to send the message to. This
field is only visible if the Recipient has more than one type of relationship assigned, such
as an employee who is also a contact. For more information, see the help topic Records as
Multiple Types.
In the Additional Recipients column, select the other contact you want to send this
message to.
In the Email field, enter an email address if the contact does not have one preset already.
Check the To box to add another recipient. This contact is expected to react to the
message. Check the Cc box to send a copy of the message. To send a blind copy to the
contact, check the Bcc box.
Click Add for each contact you want to include.

2.

3.
4.

5.
Click the Message subtab.

1. To use an email template in this message, select a category to filter the list of templates to
show only those in this category.
This field is only available if you have enabled the CRM Template Categories feature.
Select a template you have uploaded to NetSuite.
For more information about creating email templates, see the help topic Creating New
Email Templates.
Check the Update box to update your template with any edits you make in the Message
field.
In the Subject field, enter a subject for this message. This field is required.
Check the Request Read Receipt box to request read receipts from individual recipients.
For more information about creating email templates, see Requesting Read Receipts.
Choose the template format you want to use for this message.
For more information, see the help topic Creating New Email Templates.

2.

3.

4.
5.

6.
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Sending Email from NetSuite

Read receipts ensure that recipients have received a message, which is important when sending
important information or time-sensitive transactions. With NetSuite, you can include read receipts on
outgoing email messages to individual recipients.

7.
8.

Use the Field Type field and the Insert Field to add field tags in your message.
In the Message field, enter your email message. NetSuite uses your browser’s spelling
checker to check your text. Click CTRL + right-click to view the context menu and select the
correct spelling.
If you selected a template file, you can edit the message in this field.

Note:You can send an inline picture by copying and pasting the picture into the
message field.

5. Click the Attachments subtab.
1.
2.

Check the Zip Attachments box to compress the files you are sending.
In the Attach Document Template field, select a letter template to format your
attachment.
To attach a statement to this message, check the Include Statement box, and select the
date of the statement.

3.

■ In the Start Date field, you have the option of entering the date of the oldest
transaction you want to appear on the statement.
In the Type field, you can select the type of statement to attach.

You can enable the Show Only Open Transactions option to include only open
transactions in the attached statement. If you enable this option and do not enter a
start date, the statement includes all open transactions in the customer's history.

■
■

4. In the Attach File column, select the file from your File Cabinet you want to attach to this
message. Select New to upload a new file from your hard drive. Email attachments must be
5MB or smaller.

Note:A file in the Attachments Sent folder or Attachments Received folder
cannot be associated with records or transactions. You must first move the file to
another folder. For more information, see Working with Files Attached to Email
Messages.

5. Click Add after each attachment you want to add.
6. Click Send, or if you use the Mail Merge feature, click Merge & Send. For more information, see the

help topic Working with Mail Merge.

If contacts for your customers, vendors or partners reply to the email you send from NetSuite, that reply
is both sent to the email address you log in with and automatically saved to the Messages subtab of the
contact record and customer, vendor or partner's record.

You can also save messages you receive. For example, if you receive a phone call from a customer
contact, you can record the message of the call on the customer's record. For more information, see the
help topic Saving Messages from Contacts.

Note:If you use the UK Edition, to comply with UK law, your business address and VAT number
are included in the footer of all email you send to those outside of your company. You can click
View History to view all messages sent to and from contacts.
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Sending Email from NetSuite

In NetSuite, you can send email to the people you do business with by sending email directly from
NetSuite lists and records using your personal email account.

Important:These messages are not saved in NetSuite, and you cannot receive replies to these
messages in NetSuite.

When you check the Request Read Receipt box on an email message in NetSuite, the email client of the
recipient receives a read receipt request. Email clients handle read receipt requests in various ways.
Depending on the configuration of the recipient’s email client, the recipient can decide to respond to the
read receipt request when the message is viewed. All received read receipts are forwarded to the original
sender of the message and tracked on the message record in NetSuite, providing an audit trail within the
application. You can view the status of read receipts on the Read Receipts subtab of a message record.

The status may contain either of the following values:

     Confirmed — The message was displayed to someone reading the recipient's mailbox. There is no
guarantee that the content has been read or understood.

     Message Deleted — The message was deleted without reading. There is no guarantee that the
recipient has seen the message

On the Lists tab, under the Relationships heading, select the type of record for the person to
whom you want to send an email (such as customer or vendor).
If the email address is not already showing in the list, make a selection in the View filter of the list
to display a list with an Email column. (For example, the All view and the Basic view include an
Email column.)
Click the Compose Email icon next to an email address. This opens a new message window in your
personal email account with the To field completed.
Enter a subject and message text, and click Send. Then you can continue working in NetSuite.

Tip: NetSuite uses your browser’s spelling checker to check your text. Click CTRL + right-click to
view the context menu and select the correct spelling.
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Sending Email Directly from Lists and Records

To send email from a list:

To send email from a record:

■

■



You can set up an email profile to determine the following for email you send through NetSuite:

Sending Email from NetSuite

On the record, click the icon next to an email address for a contact. This opens a new message
window in your personal email account with the To field completed.

Enter a subject and message text, and click Send. Then you can continue working in NetSuite.

You can attach documents including PDFs to email messages sent through NetSuite.

Note, however, that files in the Attachments Sent and the Attachments Received folders are not available
to be attached. These attachment folders are system-generated folders used as repositories for files you
attach from your computer to email messages you send from NetSuite and also for files attached from
messages you save in NetSuite.
If you want to attach a file from one of these folders to an email message, you must move the file to
another folder prior to sending an email message. For more information, see Moving and Copying Files in
the File Cabinet.

Note:Email messages cannot exceed 15,000,000 bytes (approximately 15 MB) in size. This
includes the size of the message body and all attachments.

You can send other users email containing results from searches and reports of NetSuite data.

An Email button is available on most report and search results pages.

■ For information about sending email directly from a report results page, see the help topic Emailing a
Report.
For information about sending email directly from a search results page, see the help topic Emailing
Search Results.

■

If you are an administrator or have at least Create level of the Publish Search permission, you can enable
system-generated search email messages on the Email subtab of a saved search page. You can use
saved search email to share complete search results with other users, to schedule long-running searches
for low usage times, and to alert targeted users about changes to their important records. For more
information, see the help topic Saved Search Email.

On the Email Message popup, click the Attachments subtab.

Check the Zip Attachments box if you want to compress the files you are attaching.

In the Attach File column, select the file and click Add. Repeat this for each file you want to attach.

Note:Files in the Attachments Sent folder and the Attachments Received folders are not
available to select here.

When you are finished composing your email, click Merge & Send.
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Attaching Files to Email Messages

Sending Search and Report Results Email

Customizing Email Signatures and From Fields

To attach a file to an email message:
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the name that appears in the From field

the From email address

a custom signature

Go to Documents > Templates > Email Templates > New.

Enter your signature information in the editor.

Optional: to add an image to a signature, first make sure the image has been uploaded to
NetSuite’s File Cabinet. See Uploading Files to the File Cabinet.

a.

b.

c.

Open a new browser tab/window and go to Documents > Files > File Cabinet.

Locate the required image file and click Edit.

Copy the URL which begins https://system.netsuite.com/.

Sending Email from NetSuite

If you are not familiar with working with HTML, the simplest way to create an email signature containing
rich-formatted text, images and links, is to use NetSuite email editor. You can either access the editor
from an entity record (Customer, Company, Lead, and others) by clicking the Communications subtab >
Messages > Email. Or use the following procedure to access the editor from Email Templates. The editor
is the same in all cases.
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Go to Home > Set Preferences, in the User Profile area of the General subtab.

In the Nickname field, enter the name you want to appear in the From field on the email you send.

In the Signature field, enter an email signature using HTML markup.

For information about how to create an HTML signature file, see Adding Images and Links to an
Email Signature.

Note:You can enter up to 4000 HTML characters in this field.

4. In the From Email Address field, enter the email address you want to appear in the From field on
email you send.
Click Save.5.

To include your email signature, you must include the following FreeMarker syntax in the email:
${preferences.message_signature} You can also place this marker in email templates. If you do not enter
a nickname or a From address, your login email address appears in the From field.

■

■

■

1.

2.

3.

To set up your email profile:

To create an email signature using NetSuite email editor:

Adding Images and Links to an Email Signature



8.
9.
10.
11.

Go to Home > Set Preferences.

Clear any existing content from the Signature field, and paste in the copied HTML.

Check the Add Signature to Messages box.

Click Save.

For more information about how to create, modify, and delete email templates, see the help topic
Working with Email Templates.

Sending Email from NetSuite

Return to the email editor. Click the image icon (top left hand corner of editor).

Paste the File Cabinet image URL into the Source field. Input sizing and alignment options as
required. Click Save.
Switch to the editor’s markup view by clicking the Source code icon (top left corner of editor).

Copy all lines of the markup code.

a.
b.

Optional: save the email template file for future use.

Discard the template file.
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File Cabinet Overview

Every file loaded into the File Cabinet has a system notes record to track changes made to the file,
including the context and when the changes were made. For more information, see the help topics
System Notes Overview and Searching System Notes.

System notes for JSON, XML, and JavaScript files also include a File Content Hash field. The File Content
Hash field is calculated by NetSuite based on the file contents, so it changes every time the file changes.

Your NetSuite account configuration or configuration of other critical business systems may depend on data
in files stored in your NetSuite File Cabinet. In the File Cabinet, you cannot restrict edit access at the file
level. You can restrict access only to the folder that contains the file. You should set strict access control for
which classes of users can modify or, if applicable, view those files in specific folders. Otherwise, an account
user may be permitted to change the configuration data in the file. A configuration change can potentially
break the system or cause it to function in a way in which it was not intended.

Consider a critical workflow system that relies on a configuration containing a value
APPROVER=email@example.com, and this configuration is accessed from a File Cabinet file. A user able
to edit the configuration file can replace the email address and subvert the approval mechanism. Ensure
that only users suitably authorized to make edits on the file have edit privileges. For more information,
see Restricting Access to File Cabinet Folders. You can prevent unauthorized access to a File Cabinet file

through the internet, or enable all company
users to have view access to a file by checking the required preference box. For more information, see
Preferences on File Records.

To use the File Cabinet, the File Cabinet feature must be enabled. For more information, see the help topic
Enabling Features.

Only users with the Administrator role and users with the Documents and Files permission can use the
File Cabinet.
You can use the NetSuite File Cabinet to store and organize your business documents in much the same
way as you store any files on your computer. You can store files that you receive or plan to send by email.
Also, you can attach files stored in the File Cabinet to records in NetSuite, such as customer records,
transactions, and issues. Most File Cabinet folders can be restricted either by the folder owner or an
administrator.

The File Cabinet in NetSuite includes some folders that are created by default, depending on the features
enabled in your account. You can identify the folders that are created by NetSuite because the Internal
ID is a negative number. In some cases, these folders serve a specific purpose. For example, SuiteScript
script files are stored in the SuiteScripts folder.
Some files in the File Cabinet contain links that use URLs. Ensure that the URLs linking to
those files contain account-specific domains. For example, the File Cabinet link should be
<accountID>.app.netsuite.com, where <accountID> is a variable representing your account ID. Use the
Traffic Health tool to identify any existing data center-specific domains in links that you should update
to account-specific domain links. For more information, see the File Cabinet Traffic Health topic in Traffic
Health.
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The File Cabinet and Your Website

When a remote file that was added to the File Cabinet using a URL is modified, the File Content Hash
field changes when you download this file or its parent folder from the File Cabinet. The value of the File
Content Hash field also changes when NetSuite accesses the modified file through an internal process,
such as a SuiteScript method call, or a SuiteFlow workflow step. This change is reflected in the system
notes for that file.

If you use Site Builder or SuiteCommerce Advanced, all website assets, including SSP Applications are
stored in the Website Hosting Files folder. For more information, read the following topics:

      For information about hosting HTML files for a Site Builder website, read the help topic Website

Hosting with Site Builder.
For more information about SSP Applications, read the help topic SSP Application Overview.■

For more information about SuiteCommerce Advanced, read the help topic Commerce Website
Developer Documentation Overview.

You can also create a company intranet site and post links to files stored in the File Cabinet. The following
features are required to publish files to an intranet site:

■

■

File Cabinet

Document Publishing

Intranet

When the File Cabinet feature is enabled, users with the Administrator role and users with the Documents
and Files permission can access File Cabinet files. Roles and permissions affect which document folders
are visible to users. For more information, see the following topics:

■

■

■

Enabling Features

Setting Permissions

Permissions and File Cabinet Files

To access the File Cabinet, go to Documents > Files > File Cabinet.

The File Cabinet page consists of two main panes. The left pane contains a full table of contents which
you can use to browse the folder structure and locate the files you need. The right pane provides more
detailed information about the folders or files, which includes size, last modified date, and type. To
download a file or the contents of a folder, click the related Download link.
On the File Cabinet page, you can also:

■

■

■

Create new folders

Add, copy, delete and move files

Search for files

The following screenshot shows an example of the File Cabinet page:
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■

■

■
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You can view the files available in the File Cabinet.
To view a file in the File Cabinet:

From the File Cabinet page, you can view File Cabinet folders and files, as well as search for specific
folders and files.

File Cabinet Page Overview

To search for a file, enter a keyword in the Search box, and then click Search. A list of files and folders
displays in the right panel. You can search based on keywords found in file names and folder names.

You can click a file name to view the file. If the file is an image file or PDF, a preview window opens and
displays the file. Other types of files are automatically downloaded.

If you want to print a report of files saved in the File Cabinet, use NetSuite search pages. For more
information, see the help topic Running Searches.
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Find the record where the file is attached.
Click the Communication subtab.
Click the Files sublist.
Click the file name.

You can view files attached to a customer or other record type.

To view a file attached to a customer or other record type:

Go to Document > Files > File Cabinet.
To view a list of files within that folder, click the folder name.
To view the file, click the file name.

When you edit your files in the File Cabinet, you can check the following boxes:

Searching for and Viewing Files in the File Cabinet

Users with the Administrator role and users with the Documents and Files permission can access File
Cabinet files. For more information, see the help topic Setting Permissions.

Note:Users without the Documents and Files permission can access the content of files if they
are provided with a URL that is based on file ID, and if the file is related to a record the user has
access to. For example, if a user with the Customer Center role uses a URL to access a file on an
invoice, they also must have access to the invoice record.

Using Permissions in the File Cabinet

This is the second video in a 2–part series of videos about the File Cabinet. To watch the first part of the
series, go to Working with Files in the File Cabinet.
Note that you cannot restrict files on an individual basis. To learn about how to restrict access to files in
certain folders, read Restricting Access to File Cabinet Folders.
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Preferences on File Records

Viewing a File Attached to a Customer or Other Record
Type

Permissions and File Cabinet Files

Note:

Preference

Inactive

Available for
SuiteBundles

Hide in SuiteBundle

Description 

Prevents files from appearing on lists. When you check this box, the file or files no longer
appear on lists unless you check the Show Inactives box.

Makes the file available to include in a bundle.

If you include this file in a bundle, clearing this box does not remove the file
from the bundle. If you want to remove the file from a bundle, you have to update the
bundle and remove the file.

Prevents the viewing of the file contents by those who install this file as part of a SuiteBundle.
This setting is most applicable to server SuiteScripts.
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The following screenshot shows the location of preferences on a file record:

Permissions and File Cabinet Files 239

Preference

Company-Wide
Usage

Available Without
Login

Generate URL Time
Stamp

Description

Users with the Administrator role can also use Web Site Hosting Files Always
Available and SuiteBundle Files Always Available preferences. For more information,
see the help topic Making Web Site Hosting Files Always Available.

If this file is a client SuiteScript file, checking this box result in a validation
error. You may also receive a validation error on client SuiteScript files that do not have
this box checked but reference another file that has this preference set.

Makes the file available on your website. If files will not be published on your website, clear this
box. Note that Available Without Login takes precedence over Company-Wide Usage.

This box is checked by default in the Images folder and the Web Site Hosting Files folder.

Adds view access to a file for every company user. For example, if an image used in an email
message is marked for company-wide usage, all company users can view the image. You can
make a file available for all company users, even if the file is within a private folder or otherwise
inaccessible to a specific group. When you enable the Company-Wide Usage feature, company
users with existing permission to edit the file continue to have both view and edit access. Other
company users can only view the file.

The Company-Wide Usage feature applies to all centers and roles, including users with
specialized center roles. For more information about specialized centers, see the help topic
NetSuite Specialized Centers. Note that Available Without Login takes precedence over

Company-Wide Usage. If this box is not checked, the file will not be available in any advanced

template printouts that
reference the file.
You can also perform a mass update to define a list of files that should be available for
company-wide usage. For more information about mass updates, see the help topic Mass
Changes or Updates. You can configure an image available in an advanced printing template to

make it available
to all company users. For more information, see the help topic Including Images in Advanced
Templates. 

Note:

Note:

Adds a time stamp parameter to the URL for this file. This is useful when you are building a
web site and you want to view the most recent updates to the files on your site. The URL time
stamp is ignored by NetSuite but indicates to the browser cache and network that content has
changed.
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Click the Documents tab.

On the File Cabinet page, click New Folder.

In the Folder Name field, enter a name for this folder.

You will select this name when you attach documents and images to records.

In the Sub-Folder of field, select this folder's parent folder if one exists.

Permissions and File Cabinet Files

Users with the Administrator role and users with the Documents and Files permissions can create File
Cabinet folders. For more information, see the help topic Setting Permissions.

Users with the Administrator role can make files in the Web Site Hosting Files and SuiteBundles folders
always available to override the Available Without Login box and the Company-Wide Usage box. For more
information, see the help topic Making Web Site Hosting Files Always Available.

When the Company-Wide Usage box is checked in the File Cabinet, the filecabinet FreeMarker directive is
used in the source code. In WSYISWG mode, this directive is added automatically. If you edit templates in
the source code, you can use the filecabinet FreeMarker directive to reference files directly from the File
Cabinet.

For more information about the filecabinet FreeMarker directive, see the help topic Syntax for Advanced
Template Fields.
For more information about setting the File Cabinet property, see the help topic Including Images in
Advanced Templates.
When you use OneWorld, access to various NetSuite records, including File Cabinet files, can be restricted
by subsidiary. For more information, read the following topics:

■

■

■

Control Employee Access to Subsidiaries

Customizing or Creating NetSuite Roles

Restrict Your Subsidiary View

You can use folders to organize the files in your File Cabinet. Permissions applied to File Cabinet folders
determine who can see files stored there. You can create your own folders, but some folders already exist
in the NetSuite File Cabinet by default. If you use the Web Store feature or the Marketing Automation
feature, a folder already exists where you can store your files for these purposes.

You can also restrict access to files in folders that you create. For more information, read Permissions and
File Cabinet Files.
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FreeMarker Directive for Company-Wide Usage

1.

2.

3.

4.

File Cabinet Folders

Creating File Cabinet Folders

To create a new File Cabinet folder:
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Click the Documents tab.

Find the internal ID for the folder.

a. Point to the folder name as shown in the following sample screenshot.

File Cabinet Folders

In the Shortcuts portlet on your NetSuite Home page, you can add links to the File Cabinet folders you
most frequently use. To create a shortcut for a folder, use the folder's internal ID to construct a URL that
points to the folder. Next, use the URL to set up a new shortcut in the Shortcuts portlet.

Note:Large file sizes and many subfolders may affect performance and slow down
processing time as you work with the files and folders. Avoid creating large numbers of
subfolders wherever possible. If you attempt to move files to another folder using the Move
To dropdown list, the number of displayed folders is limited to 20,000. Furthermore, you
should not create more than 50,000 subfolders because it becomes increasingly difficult to
organize files in a large number of subfolders. If you do require a large number of subfolders,
you should manage file movements using the mass update files method. For more
information, see the help topic Defining a Mass Update.

5. NetSuite populates the Type field with the appropriate type for the subfolder selected. In most
cases, the type folder is set to Documents and Files.
In the Description field, enter a brief message describing what you store in this folder.

You can restrict the folder based on various classification settings in your account. Only users with
the selected settings can access the files in the folder. Folder contents do not appear in searches
or any other area of NetSuite for users outside of the selected class, department, location, group,
or subsidiary. Users with the Administrator role and the owner of this folder can always access the
contents of this folder.

Complete the restriction fields, as required. For more information, see Restricting Access to File
Cabinet Folders.
If you want to make the contents of this folder visible only by you, check the Private box.

If you want to make this folder inactive, check the Inactive box.

If the User Notes subtab is displayed, add any notes pertaining to this File Cabinet folder, as
needed.
Click Save.

6.

7.

8.

9.

10.

11.

Your folder is immediately available in the File Cabinet. You can upload files to the folder. The files are
available to others who have access to your NetSuite account, based on the restrictions you set on the
folder.
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1.

2.

Creating a Shortcut to a File Cabinet Folder

To create a shortcut on your NetSuite Home tab:
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Note the following when you restrict access to a folder with subfolders:

File Cabinet Folders

b. Find the internal ID for the folder. The internal ID displays at the bottom left of the browser
window. You can also set your personal preferences to display the folder internal IDs on the
File Cabinet page. For more information, see General Personal Preferences.

Click the Home tab.

In the Shortcuts portlet, click New Shortcut.

Note:If the Shortcuts portlet does not display on your Home tab, click Personalize in the
upper right, and then select Shortcuts in the Personalize Dashboard area.

Add your folder's internal ID to the end of the URL that displays a File Cabinet folder:
https://<accountID>.app.netsuite.com/app/common/media/mediaitemfolders.nl?folder=
For example:

For more information, see the help topic Shortcuts Portlet.

Click Save.6.

After creating the shortcut, you can go directly to this folder by clicking the link in the Shortcuts portlet on
your NetSuite Home page.

Within your organization, you can restrict access to files by setting permissions on File Cabinet folders.
You cannot restrict individual files, but you can restrict access to the enclosing folder. You can set
permissions based on various criteria, such as location and department.

When a folder is marked as private, only the person who created that folder and the account
administrator have access to it. Administrators can view the contents of any folder, including private
folders and folders that have been restricted. If you create a folder, you become the owner of that folder.
The owner of a folder always has access to the folder regardless of restrictions.
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3.
4.

5.

https://<accountID>.app.netsuite.com/app/common/media/mediaitemfolders.nl?folder=8

Restricting Access to File Cabinet Folders

Restricting Access to Subfolders
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You can delete a folder that contains files that are no longer needed.

Go to Documents > Files > File Cabinet.

Locate and click the parent folder of the folder you want to delete.

Click Delete Files.

File Cabinet Folders

If a subfolder is created under a parent folder after the parent folder was restricted to a group,
the subfolder automatically inherits the parent folder's restriction. You can change the subfolder's
restriction.

If a parent folder's restriction is changed after a subfolder was created, the subfolder does not
automatically inherit the new restriction. You can manually apply the restriction to the subfolder.

1.

2.

3.

4.

Log in to NetSuite with a role that has access to the folder.

Go to Documents > Files > File Cabinet.

Click Edit on the folder to which you want to restrict access.

To restrict access in the following categories, select from the dropdown lists. Note that the
following list names may be different depending on record naming customization in your NetSuite
account:

■

■

■

■

Restrict by Class

Restrict by Department

Restrict by Location

Restrict by Group. If you choose a dynamic group, for performance reasons, the folder is
restricted to a snapshot of the dynamic group members. The snapshot is updated twice a day.
For more information, see Working with Groups.

Restrict by Subsidiary. Note that employees assigned to the parent subsidiary can access all
child subsidiary folders. To change this behavior you can restrict the folder by group. For more
information, see File Access Restriction by Subsidiary in File Cabinet (SuiteAnswers ID: 35400).

■

5. Click Save.

All files in the folder are available based on the restricted access settings you selected.

Users with the Administrator role and users with the full Documents and Files permission can delete File
Cabinet folders. For more information, see the help topic Setting Permissions.

You can delete a folder that contains files and subfolders, or you can delete an empty folder. If the folder
contains a file that is attached to a record, the delete operation fails. A popup alert displays indicating that
you must remove the file from the record to proceed.
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■

■

1.

2.

3.

To delete a folder containing files:

To change the restricted access setting in a folder:

Deleting Folders from the File Cabinet

Deleting a Folder Containing Files

https://system.netsuite.com/app/help/helpcenter.nl?fid=bridgehead_N288727.html


Click Delete.

Go to Documents > Files > File Cabinet.

Locate the empty folder you want to delete.

Click Edit next to the folder name.

Expand the Actions menu.

Click Delete.

You can delete empty folders from the File Cabinet.

To delete an empty folder:

File Cabinet Folders

This section includes information about actions you can take on file records in NetSuite.

NetSuite Basics: Working With Files in the File Cabinet

This is the first video in a 2–part series of videos about the File Cabinet. To watch the second part of the
series, go to Using Permissions in the File Cabinet.

You can upload a file by clicking the Documents tab, and then selecting a folder. NetSuite accepts all file
formats in the File Cabinet. The File Cabinet shows the file extension and lists the file type. You can also

A list displays of files and subfolders in the parent folder. Check the box next to the folder you want
to delete.

244

4.

5.

1.
2.
3.
4.
5.

Deleting an Empty Folder

Working with Files

Uploading Files to the File Cabinet
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Working with Files

Note:When a remote file that was added to the File Cabinet using a URL is
modified, the File Content Hash field changes when you download this file or its parent
folder from the File Cabinet. The value of the File Content Hash field also changes
when NetSuite accesses the modified file through an internal process, such as a
SuiteScript method call, or a SuiteFlow workflow step. This change is reflected in the
system notes for that file. For more information, see File Cabinet Overview.

Verify that the Destination Folder is where you want to upload the files.

To automatically extract files into the Destination folder as they are uploaded, check the
Unzip files box.

(Optional) To make the files available on your website, check the Make all Files Available
Without Login box. If files will not be published on your website, clear this box. Note that
Make All Files Available Without Login takes precedence over Make All Files Available
for Company-Wide Usage.

Note:Enabling the Files Available Without Login capability prevents broken images
and links in your website. This box is checked by default in the Images folder and the
Web Site Hosting Files folder.

(Optional) To make the files available to all company users, check the Make All Files
Available for Company-Wide Usage box.

Click the Documents tab.

In the right pane, click the name of the folder where you want to store files.

If the Use Employee Specific Expense Folders feature is enabled, expense file attachments are
automatically uploaded to a system-defined employee expenses folder.
To upload one file from your computer, click Add File.

To add a file from the internet, or to add a .zip file, click Advanced Add.

a. To upload a .zip file, in the Zip Archive to Add field, click Choose File, and then find the file
you want to upload to NetSuite. Click Open.
In the Character Encoding field, choose the proper character encoding for the file.

To upload a single file from the internet, in the URL field, enter URL path for the file location
on the internet.

b.

c.

upload files by clicking the Communications subtab on transaction records and relationship records. When
you attach files to records, you are required to select or create a folder where the document can be stored in
the File Cabinet.

If Use Employee Specific Expense Folders is enabled, expense file attachments automatically submit to a
dedicated employee expenses folder, predefined by the system.
You can make the files available to all company users, even if the file is within a private folder or otherwise
inaccessible to a specific group. Check the Company-Wide Usage box on the file record. For example,
you may want to make images that will be used in advanced PDF/HTML template printing available to
company users only. For more information, see Preferences on File Records.
All files uploaded to the File Cabinet are scanned for viruses and malicious content automatically. For
more information, see the help topic Antivirus Scanning on File Cabinet Files.
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To upload files to a File Cabinet folder:

1.

2.

3.

4.

d.

e.

g.

f.
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Working with Files

The following characters are not supported in file names uploaded to the File Cabinet. It is strongly
advised that even if these characters are permissible by your operating system, you avoid using them as

Note:When the box is checked, files are also available for viewing in the Customer,
Vendor or Partner Centers.

h. To overwrite files that exist in the File Cabinet with the files in the .zip file, check the
Overwrite Files with Same Name box. When the box is checked, files of the same name
are automatically updated with the latest version you upload in this archive. When this box
is cleared, files in the .zip archive that have the same path and name as existing files in
File Cabinet are not extracted to the File Cabinet. The same rules apply to individual files
uploaded using a URL path.
Only users with the Administrator role and users with the Edit level permission or higher can
overwrite files in the File Cabinet.

Important:This setting does not apply to locked files and folders that have been
installed by a bundle. You cannot edit or overwrite locked files and folders installed
by a bundle.

i. To upload the.zip file, click Add.

To inactivate files being added using the Advanced Add form, check Make all Files Inactive. When you
check this box, the file or files no longer appear on lists unless you check the Show Inactives box.

Note:Users with the Billing Information permission can look up the amount of space the File
Cabinet currently uses on the Billing Information page. Go to Setup > Company > View Billing
Information. The Current Used Quantity column for File Cabinet Size (GB)** component shows the
current amount of space used.

Additional Information:

■
■

Attaching Files to Records

Attaching Files to Email Messages

The following list contains best practices for preparing your files for upload to the File Cabinet: 

      When uploading files, include the file extension according to the file type. For example, PDF files must
include the file extension, .pdf.

      Work with files of 100 MB or smaller. Note that various factors may affect the time it takes to upload
and download files greater than 100 MB, such as network speed, time-out settings, and overall space
limitations.

Ensure the name of the file you upload is fewer than 99 characters including the file extension.

Ensure that any File Cabinet files containing URL links use account-specific domains. For more
information, see the File Cabinet Traffic Health topic in Traffic Health.

■
■

Important:Unless you have purchased additional storage space, each NetSuite account comes
with 10 GB of total storage space.
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Unsupported Symbols in File Names

Best Practices for Preparing Files for Upload to the File Cabinet

■

■
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Working with Files

You can edit files that are 512 KB or smaller directly on the file record. The following file types support
direct file editing:

The procedure you use for editing a file depends on the file type you are working with. You can edit
many file types directly on the file record. Other files, you must download to your computer, make your
modifications, and then upload again.

When you edit your file records in the File Cabinet, you can update your preferences to grant or restrict
access to your files. For more information, see Preferences on File Records.

■
■
■

Editing Files Directly

Editing Other File Types Stored in the File Cabinet
Making a File Cabinet File Inactive

they can cause unexpected behavior when used on systems and browsers that do not support them. This
is especially important when adding multiple files to a ZIP archive, as these files cannot be pre-validated.

Also note that zip files containing file names with international characters are supported only if they meet
the following conditions:

■
■

The file names of the zip entries are encoded in UTF-8.

Special general purpose bit 11 (UTF-8 flag) is set according to APPENDIX D -Language Encoding
(EFS)) paragraph D.1 and D.2 of the PKWARE official zip documentation.

When zipping your files, you should use a dedicated zipping application that supports these conditions.

Note:The preceding information is applicable to the file names only, and is not related to the
content of the zipped files.
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Character

:

/

?

<

>

\

*

|

“

%

&

#

Description

colon

forward slash

question mark

single left-pointing angle quotation mark

single right-pointing angle quotation mark

backslash

asterisk

pipe (vertical bar)

quotation mark

percentage sign

ampersand

number sign, hash

Editing Files in the File Cabinet

Editing Files Directly
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HTML
Plain Text
CSS
XML
JavaScript
CSV
SuiteScript Page
SuiteScript File
Text

Click Save on the file record.

Click the Documents tab.
Click a folder to find the file you want to edit.
Click Edit next to the file.
Click download on the file record.

Click the Documents tab. Click a folder to find the file you
want to edit. Click Edit next to the file you want to modify.
Click Edit on the file record to open the file content screen.

Modify the file on your computer, and then save it.
Click Choose File on the file record in NetSuite to select the updated file on your computer.

Working with Files

The process is different to edit file types other than the ones listed earlier and files larger than 512 KB.
You must first download the file from the File Cabinet, modify it on your computer, and then upload the
file to replace the previous version.

To edit larger files and other file types stored in the File Cabinet:

Make your changes.
Click Save. Your changes are saved when you click Save in the file content screen. Note that the file
content is changed, but settings on the file record are not changed.
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■
■
■
■
■
■
■
■
■

1.
2.
3.
4.

5.
6.

1.
2.
3.
4.

5.
6.

7.

To edit a file directly:

Editing Other File Types Stored in the File Cabinet



Click the Documents tab.
Go to the folder that contains the file you want to move.
Click Move Files.

You can inactivate files that are referenced by other records in NetSuite.

To make a file inactive:

Moving files lets you transfer specific files to different folders in your File Cabinet.

To move a file:

You can move files between folders in your File Cabinet. You can also copy files to other folders.

Working with Files

6. When you have finished, click Move.

The selected file is now stored in the new folder and has been removed from the original location. You
can move files in bulk by using the Move Files to Folder mass update at Lists > Mass Update > Mass
Updates.

Click the Documents tab.
Click a folder to find the file you want to edit.
Click Edit next to the file you want to modify.
To make the file inactive, click the Inactive box. You can make the file active again at any time by
clearing the Inactive box.
Click Save.

Check the box next to the file you want to move. You can move more than one file at a time.
Under the Filters subtab, select Move To. Then, select the folder where you want to move the file.
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Moving Files in the File Cabinet

Making a File Cabinet File Inactive

1.
2.
3.
4.

5.

1.
2.
3.

4.
5.

Moving and Copying Files in the File Cabinet



You can also copy files to other folders to store files in multiple folders.

Working with Files

You can delete files to help organize and clean your NetSuite File Cabinet. Only users with the
Administrator role and users with the full Documents and Files permission can delete File Cabinet files.
For more information, see the help topic Setting Permissions.

1.
2.
3.

Click the Documents tab.

Go to the file or folder you want to download.

Click Download next to the file or folder.

When you download a folder, all of the files and subfolders are downloaded in a ZIP file to maintain
the folder hierarchy. File names must include the file extension so that you can use the appropriate
application to open your files after unpacking the downloaded ZIP from the File Cabinet.

Note:You should work with files of 100 MB or smaller. Note that various factors may affect the
time it takes to upload and download files greater than 100 MB, such as network speed, time-out
settings, and overall space limitations.

You can download individual files or entire File Cabinet folders and their contents. If you do not have
permission to view files in a certain folder, then you cannot use the Download link to save files from that
folder on to your computer. Note that the same restrictions applied to a File Cabinet folder also apply to
the Download link.

Important:The Move Files action is not available for files that have been installed from a
bundle and are marked as locked in the bundle, or to files that are contained in a folder that has
been installed from a bundle and is marked as locked in the bundle. If you choose Move Files for a
File Cabinet folder that includes any locked files, the Folder Contents page clears the box for these
files and displays a lock icon for each one.

1.
2.
3.
4.
5.

To access the File Cabinet, go to Documents > Files > File Cabinet.

Go to the folder that contains the files you want to copy.

Click Copy Files.

Check the box next to each file you want to copy.

Under the Filters subtab, select Copy To. Then, select the folder where you want to save copies of
the files.
When you have finished, click Copy.6.

The selected files are now saved in both the original folder and the new folder.
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Copying Files

To copy files:

To download a file or folder from the File Cabinet:

Deleting Files from the File Cabinet

Downloading Files from the File Cabinet

https://system.netsuite.com/app/help/helpcenter.nl?fid=bridgehead_N288727.html


Check the box next to each file you want to delete.

Click the Documents tab.
Go to the folder that contains the files you want to delete.
Click Delete Files.

Working with Files

Important:The Delete Files action is not available for files that have been installed from a
bundle and are marked as locked in the bundle, or to files that are contained in a folder that has
been installed from a bundle and is marked as locked in the bundle. If you choose Delete Files for a
File Cabinet folder that includes any locked files, the Folder Contents page clears the box for these
files and displays a lock icon for each one.

5. Click Delete.

You cannot delete files that are referenced by other records in NetSuite. Alternatively, you can inactivate
files you no longer use.
The Mass Update functionality enables you to specify the criteria that define the files you want to delete.
For more information about Mass Deletes, see the help topic Performing Mass Deletes.

You can upload any type of file to the File Cabinet. The Documents pane shows the file extension and lists
the file type. The following file types are recognized in the NetSuite File Cabinet:
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To delete files:

1.
2.
3.

4.

File Types Recognized in the File Cabinet

File Type Extension(s)

AppCache Manifest File .appcache

AutoCad .dwg, .dwf, .dxf, .dwt, .plt

BMP Image .bmp

Certificate File .cer, .crl, .crt, .csr, .der, .key, .p10, .p12, .p7b, .p7c, .p7r, .p8, .pem, .pfx, .spc

CFF File .cff

Compressed Tar File .tgz, .tbz

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4098351672.html


File Type Extension(s)

Configuration File .config

CSS File .css

CSV File .csv

EOT File .eot

Excel File .xls, .xlsx

Flash Animation .swf

FreeMarker Template File .ftl

GIF Image .gif

GNU Zip File .gz

HTML File .html, .htm, .shtml

Icon Image .ico, .icon

Image .jpg, .jpeg, .pjpeg, .gif, .png, .bmp

JavaScript File .js, .json

JPEG Image .jpg, .jpeg

JSON (No extension provided)

LZH File .lzh, .lha

Message RFC .eml

MP3 Audio .mp3

MPEG Video .mpg, .mpeg

OTF File .otf

Other Binary File .bin

PDF File .pdf

PJPEG Image .pjpeg

Plain Text File .txt, .prn

PNG Image .png

PostScript File .ps, .eps

PowerPoint File .ppt, .pptx

Project File .mpp

QuickTime Video .mov

RTF File .rtf

SMS File .sms

SuiteScript File .ss

Working with Files 252



File Type Extension(s)

SuiteScript Page .ssp

SVG Image .svg

Tar File .tar

Text File .txt, .css, .htm, .html, .xml, .htc, .sql, .csv, .log

TIFF Image .tiff, .tif

TTF File .ttf

Visio File .vsd

WOFF File .woff

WOFF2 File .woff2

Word File .doc, .dot, .docx

XML File .xml

XSD File .xsd

Zip File .zip

Working with Files

Although NetSuite accepts all file formats in the File Cabinet, if a file format is not recognized, the file type
is listed as Other Binary File. NetSuite cannot determine unrecognized file formats uploaded in a .zip file.
If you see other binary files in a folder, but want to ensure that the file extension displays, then upload
those files individually.
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Unrecognized File Types



 Exporting to Word

■

■

■

■

Exporting to PDF

Exporting to Excel

Exporting to CSV

Exporting to Tableau

Exporting Reports, Searches, and Lists

You can export reports, searches and lists into various formats. Exporting provides you with additional
flexibility in reviewing and analyzing your business's data.

For information about exporting, see the following sections.

■

■

■

Exporting a Report

Exporting Search Results

Exporting Lists

Supported Versions – Reports are exported in Word 97 - 2003 format.

Expand/collapse – Settings are maintained. The report will be displayed as it is currently viewed on
the screen. If you have collapsed a section of the report (hiding some rows), then those rows will not
be available in the word document. You will not be able to expand and view hidden rows.

Company Logo – The logo will display when the report is exported to MS Word, if it has been set as a
preference in the Analytics subtab at Home > Set Preferences.

Expand/collapse – Settings are maintained. The report will be displayed as it is currently viewed on
the screen. If you have collapsed a section of the report (hiding some rows), then those rows will not
be available in the word document. You will not be able to expand and view hidden rows.

Company Logo – The logo will display when the report is exported to MS Word, if it has been set as a
preference in the Analytics subtab at Home > Set Preferences. However, the uploaded image is used
as is, and is not resized to fit the PDF layout.

Formatting – By default, a PDF of an exported report/search has a font size of 8 and a portrait
orientation. You can change these settings by modifying the PDF Page Orientation and PDF Font Size
preferences on the Analytics subtab at Home > Set Preferences. See the help topic Setting Formats for
Reports Exported to PDF.
Size Limitations – Exported PDFs currently have some output limitations. You may encounter issues
if your report results include a large number of rows or columns, or extremely long field values.
You cannot export reports with more than 30 columns and NetSuite truncates exported records for
reports with more than 10 columns. To work around these issues, try adding criteria to reduce the
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Comparing Export Formats

Exporting to PDF

Exporting to Word

Each export format has its own advantages and limitations as detailed below:

■

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N736119.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N663983.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N717175.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N717175.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N717175.html


number of rows and columns in results, or try eliminating fields with long values. For details, see
Limitations on Exports to PDF.

Exporting Reports, Searches, and Lists

Supported Versions - Only XLS files are supported. XLSX files are not supported.

Expand/collapse - Settings are not maintained. All rows included in the report are exported.
Collapsed (hidden) rows are also exported and will appear in the excel spreadsheet fully expanded
(unhidden)

Company Logo - The company logo is not displayed when the report is exported to Excel, even if the
Print Company Logo option is enabled on the Analytics tab at Home > Set Preferences.
Unicode - Supported.

Decimal precision - Excel offers high decimal number precision (same precision as displayed in the
report/search)

Limitations - For item records that include the Detailed Description field, the length of this field in the
search results is limited to 1,300 characters.

■
■

Supported Versions - Tableau Desktop 8.3 or later.

Expand/collapse - Settings are not maintained. All rows included in the report or search results will be
exported.

Company Logo - The company logo is not displayed when the report or search is exported as a
Tableau workbook.
Unicode - Supported.■
Decimal precision - Tableau Desktop supports the same level of precision as displayed in each report
or search.
Limitations - Sort settings may not be preserved when search or report results are exported as a
Tableau workbook.

See the following topics for export limitations:

■ Limitations on Exports to PDF

Expand/collapse - Settings are not maintained. All rows included in the report will be exported.
Collapsed (hidden) rows will also be exported and will appear in the excel spreadsheet fully expanded
(unhidden).

Company Logo - The company logo is not exported.

Unicode - Not supported.

Decimal precision - All decimal numbers are truncated at 2 decimal places. If you require a higher
level of precision, you should export the report to Excel. After you open the file in Excel, you can save it
as a CSV file.

Handling Special Characters - If you use Microsoft Excel to open an exported CSV file that contains
data in languages other than English, some special characters may appear corrupted. If you encounter
this issue, you should export data to Excel instead of CSV. After you open the file in Excel, you can save
it as a CSV file. For more information, see Limitations on CSV Exports of Data with Special Characters.
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Exporting to Excel

Exporting to Tableau
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Limitations on CSV Exports of Data with Special Characters

Export data to Microsoft® Excel, instead of CSV.

Open the file in Excel.

Save the file as a CSV file, if desired.

Note that Excel adds a BOM character to the beginning of the CSV file.

Limitations on Exports to PDF

All PDFs you export are verified against the BFO document type definition (DTD). BFO is a a set of third-
party libraries used for generating PDF documents. The BFO documentation is available at 
bfo.com/products/report/docs/userguide.pdf.

http://

Exported PDFs have some output limitations. If your export includes more than 10,000 rows, exporting
them to PDF may cause an error. Also, if your export includes a large number of columns or extremely
long field values, you may encounter formatting issues.

To avoid performance problems, exports with more than 30 columns are not supported. Exports with
more than 10 columns are truncated to a limited number of rows, as shown in the following table:

If you export data in a language other than English to a CSV file, and you use Microsoft® Excel to open the
file, some special characters may appear corrupted.

Exported CSV files are plain text files that do not include any BOM (byte order marker) characters to
provide character encoding information. These files use UTF-8 character encoding, but their lack of BOM
causes Excel to use a character encoding other than UTF-8 for them, causing their special (non-ASCII)
characters to appear corrupted.
This issue does not occur when you open an exported XLS file in Microsoft® Excel. It also does not occur
when you open an exported CSV file in Notepad, or in another text or CSV editor.
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Limitations on Exports to PDF

Limitations on CSV Exports of Data with Special
Characters

To avoid this issue:

Number of Columns PDF Export Truncated to

1-9 columns 3000 rows

10-20 columns 2000 rows

21-30 columns 1000 rows

More than 30 columns Not supported

http://bfo.com/products/report/docs/userguide.pdf
http://bfo.com/products/report/docs/userguide.pdf

